17. Archive Procedures

Archive processing procedures support and maintain the process by which the Data Server
Subsystem (DSS) manages persistent storage of earth science and related data, and through
which the DSS provides search and retrieval access to the data. Through archive processing, data
products that have been ingested into the system or produced by data processing on previously
stored data are archived to tape for permanent storage and distributed to users via hard media
(tape or disk) or electronic means. The DAAC Archive Manager’s job entails working with the
Science Data Specidist, the Science Coordinator, and the Resource Manager, as well as
providing direction for the Data Ingest Technician. The physical archive is one or more
StorageTek (STK) Powderhorn Model 9310 Automated Cartridge System tape storage towers,
providing a mass storage system of jukeboxes for removable media (tape cartridges). The File
Storage Management System (FSMS) software, hosted on a Silicon Graphics Inc. (SGI) Origin
2000, is the Archival Management and Storage System (AMASS), a product of Advanced
Digital Information Corporation (ADIC). AMASS is a UNIX file system that manages files,
volumes (media), drives and jukeboxes. The AMASS System Administrator’s User Guide can be
viewed using Adobe Acrobat and is available electronically on drg servers (e.g., g0drg0O1,
e0drgl1, 10drg01, n0drg0l) in directory /usr/amass/books.

Archive processing activities include operating functions associated with the AMASS software,
managing and operating the physical archive, and using ECS custom software for monitoring
archive functions and maintaining the stored data. The Archive Manager may also work with the
Automated Cartridge Storage Library System (ACSLS) software and the AMASS Graphical
User Interface (GUI). Finally, the Archive Manager conducts archive troubleshooting and
problem resolution procedures.

Subsequent sections related to Archive Processing address procedures for the following
functions:

e Section17.1 Starting and Stopping AMASS.

» Section 17.2 Loading, removing, and managing archive media.

e Section17.3 Monitoring and managing the archive with ECS custom GUIs.
» Section17.4 Deleting granules from the archive.

e Section17.5 Backing up and restoring AMASS.

* Section 17.6 Backing up and restoring archived data.

e Section17.7 Archive troubleshooting.

» Section 17.8 ACSLS procedures.

e Section17.9 Using the AMASS GUI.

* Section 17.10 Data Pool Maintenance Tasks.
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For each set of functions, an Activity Checklist table provides an overview of the tasks to be
completed. The outline of the Activity Checklist is asfollows:

Column one - Order shows the order in which tasks could be accomplished.
Column two - Role lists the Role/Manager/Operator responsible for performing the task.
Column three -Task provides a brief explanation of the task.

Column four - Section provides the Procedure (P) section number or Instruction (1) section
number where details for performing the task can be found.

Column five - Complete? is used as a checklist to keep track of which task steps have been
completed.

17.1 Starting and Stopping AMASS

To stat AMASS, the Archive Manager or System Administrator first ensures that the physical
storage system is powered up and then enters commands at the FSM S server host (e.g., e0drgll,
g0drg01, 10drg01, nOdrg0l) to start AMASS. Stopping AMASS is accomplished by killing the
required daemons. Rebooting AMASS involves killing the daemons and then restarting the
application.

Table 17.1-1 provides an Activity Checklist for Starting and Stopping AMASS.

Table 17.1-1. Starting and Stopping AMASS - Activity Checklist

Order Role Task Section Complete?

1 System Starting the AMASS Application P)17.1.1
Administrator or
Archive Manager

2 System Shutting Down AMASS Tape Archive (P)17.1.2
Administrator or System
Archive Manager

3 System Rebooting AMASS (P)17.1.3

Administrator or
Archive Manager

17.1.1 Starting the AMASS Application

Starting the AMASS FSMS requires actions to ensure that the STK Powderhorn storage system
Is powered up as well as actions at the SGI FSM S host. Powering up the STK requires actions at
its control panels, including the Library Management Unit (LMU) and Library Control Unit
(LCU) [the Library Storage Module (LSM) is powered through the LCU]. Note: Preconditions
include that 1) the FDDI network is up and running and 2) power to all units is functional and
available.
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Table 17.1-2 presents the steps required to start the AMASS application. If you are aready
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed
procedure:

1 Make sure power switches for the StorageTek LCU and LMU are ON.
* The LCU should be the last unit powered up, but otherwise there are no dependencies
within the group.

2 If it isnot already running, boot the FSM'S SGI host (workstation x0dr g#) normally.

» Thex inthe workstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n =NSIDC, 0 = ORNL, a=ASF, ] = JPL; the ## will be
an identifying two-digit number (e.g., nOdrg01 indicates an FSMS SGI host at
NSIDC).

» There are no dependencies on other hosts, COTS or custom software.

*  AMASS normally starts automatically on bootup. If it does, go to Step 5. If it does
not, or if you are restarting AMASS after a shutdown, go to Step 3.

3 At the FSMS SGI host, log in asroot.

4 Type /usr/amass/tools/amass_start and then press the Return/Enter key.
*  The AMASS application starts.

5 To verify that AMASS has started correctly, type /usr/amass/bin/amassstat -c and then
press the Return/Enter key.
* Themessage FILESYSTEM ISACTIVE isdisplayed.

Table 17.1-2. Starting AMASS

Step What to Do Action to Take
1 Power switches ON. Observe/set switches
2 Boot FSMS SGI host Normal workstation boot
3 Log in as root press Return/Enter

4 amass_start press Return/Enter

5 amassstat -c press Return/Enter

17.1.2 Shutting Down AMASS Tape Archive System

Table 17.1-3 presents the steps required to shut down AMASS. If you are aready familiar with
the procedure, you may prefer to use this quick-step table. If you are new to the system, or have
not performed this task recently, you should use the following detailed procedure:
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1 Loginasroot (system administrator) at the FSMS SGI host (workstation xOdr g##).
* Thex intheworkstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n =NSIDC, 0 = ORNL, a=ASF, j = JPL; the ## will be
an identifying two-digit number (e.g., nOdrgO1 indicates an FSMS SGI host at
NSIDC).

2 Type /usr/amass/toolg/killdaemons and then press the Return/Enter key.
* A messageisdisplayed indicating that all daemons have been terminated.

Table 17.1-3. Shutting Down AMASS

Step What to Do Action to Take
1 Log in as root press Return/Enter
2 killdaemons press Return/Enter

17.1.3 Rebooting AMASS

The AMASS file system may need to be rebooted during certain anomalous conditions (e.g.,
system "hang," interruption of communication between AMASS and ACSLS, arequired daemon
Is down). AMASS needs to have the following daemons running at all times: amassmain,
daemong/Im_ip -a fdock, klogd, amass iocomp, gset, libsched, libio_tape,. To verify they are
running, ssimply search for the AMASS processes (refer to Section 17.7.1.1, Checking Daemons
and Using healthcheck). To check the health of AMASS while it is still running, execute the
healthcheck command (refer to Section 17.7.1.1).

In order to reboot AMASS you must have root privileges. The following procedure demonstrates
the steps to reboot AMASS. Table 17.1-4 presents the steps required to follow the reboot
process. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Loginasroot (system administrator) at the FSMS SGI host (workstation xOdr g##).
* Thex inthe workstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n=NSIDC, 0=0ORNL, a=ASF, j = JPL; the ## will be
an identifying two-digit number (e.g., nOdrg01 indicates an FSM S SGI server at
NSIDC).

2 To kill the daemons, type killdaemons and then press the Return/Enter key.
* A messageisdisplayed indicating that all daemons have been terminated.
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3 If you want to test AMASS before restarting, go to Step 4; otherwise, type amass_start
and then press the Retur n/Enter key.
The AMASS application starts.

To test the AMASS filesystem prior to starting AMASStype: install_tests, and pressthe
Return/Enter key.

Tests the operation jukebox operation and cache partitions, then restarts AMASS.

Table 17.1-4. Rebooting AMASS

Step What to Do Action to Take
1 Log in as root press Return/Enter
2 killdaemons press Return/Enter
3 amass_start press Return/Enter
4 install_tests press Return/Enter

17.2 Loading, Removing, and Managing Archive Media

For the STK storage facility, each Powderhorn is equipped with a 21-tape Cartridge Access Port
(CAP). In automatic mode, tapes may be placed in the CAP for automatic loading. Tapes are
also gected through the CAP when identified for gection using a command at the host for the
STK Automated Cartridge System Library Software (ACSLS). It is also possible to bypass the
CAP and manually load media directly into the library bins, typically only done at theinitial load
of the system or if it is otherwise necessary to load large numbers of volumes. Newly loaded
volumes may need to be placed online and formatted. It is aso necessary to ensure the ready
availability of drive cleaning cartridges in the specially designated volume group for that

purpose.
Table 17.2-1 provides an Activity Checklist for Loading, Removing, and Managing Archive
Media
Table 17.2-1. Loading, Removing, and Managing Archive Media -
Activity Checklist

Order Role Task Section Complete?
1 Archive Manager Automatically Loading Archive Media P)17.2.1
2 Archive Manager Manually Loading Archive Media (P)17.2.2
3 Archive Manager Formatting a Volume (P)17.2.3
4 Archive Manager Removing Archive Media (P)17.2.4
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17.2.1 Automatically Loading Archive Media

Automatic loading of media is appropriate when there are relatively small numbers of media to
be loaded. Up to 21 volumes at atime may be loaded through the Cartridge Access Port (CAP).
With automated loading, AMASS assigns each cartridge a unique volume number, enters the
volumes in its database, and marks the volumes Online in the database.

Table 17.2-2 presents the steps required for automated medialoading. If you are already familiar
with the procedure, you may prefer to use this quick-step table. If you are new to the system, or
have not performed this task recently, you should use the following detailed procedure:

1 Loginasamassor root at the FSMS SGI host (workstation xOdr g##).

2 The x in the workstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n=NSIDC, 0=0ORNL, a=ASF, ] = JPL; the## will bean
identifying two-digit number (e.g., n0drg01 indicates an FSMS SGI server at NSIDC).

3 At the FSM S hosgt, type /usr/amass/bin/bulkinlet SP and then press the Retur n/Enter

key.

* The Cartridge Access Port (CAP) door unlocks (audible unlatching sound).

* Note: If you have removed an existing volume and are re-inserting it, do not use the
SP option, which puts the volume in the general space pool. Instead type
/usrfamass/bin/bulkinlet <volgrp>, where <volgrp> is the volume group from which
the volume was removed. Thiswill put the volume back where it was before
removal.

4 Write down or note the bar code number(s) on the label(s) of the cartridge(s), open the
recessed latch on the CAP door and insert the tape(s), solid black side up, with the bar
code label facing you, and close the door.

* Therobot scans all the volumes.

» Datafor the newly inserted media are displayed, including bar codes, associated
volume numbers, and, in the flag column, the letters 1UO, indicating that the volumes
areinactive (1), unformatted (U), and offline (O).

5 For any newly inserted media, it is necessary to issue a formatting command. For the
new 9940 tapes, type /usr/amass/bin/volfor mat -b 256k ###, where ### is the volume
number, and then press the Return/Enter key. Y ou can enter more than one, separating
each number from the preceding one with a space.

* A message reguests confirmation that you wish to continue.

6 Typey and then press the Return/Enter key.
* A messageis displayed requesting further confirmation, stating that The following
volumes will be formatted: and listing volume numbers, followed by (Y-N).
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7 Typey and then press the Return/Enter key.
» After afew minutes, a message Completed for matting all volumesis displayed.

8 To verify that the volume(s) are inserted, type /usr/amass/bin/vollist and then press the
Return/Enter key.
» Datafor the media are displayed; the flag column shows that the newly formatted
volumes areinactive (1).

9 To activate the mediafor use, type /usr/amass/bin/volstat and then press the
Return/Enter key.
» Datafor the media are displayed; the flag column shows that the volumes are now
active (A).

Table 17.2-2. Automatically Loading Archive Media

Step What to Do Action to Take

1 Log in as amass or root enter text; press Return/Enter
2 bulkinlet SP (unless re-inserting removed volume) press Return/Enter

3 Place cartridge(s) in CAP close door

4 volformat -b 256k < volumenumber > press Return/Enter

5 y (to continue) press Return/Enter

6 y (to confirm/continue) press Return/Enter

7 Vollist press Return/Enter

8 Volstat press Return/Enter

17.2.2 Manually Loading Archive Media

Media may be introduced into volume groups in the storage facility without AMASS initial
monitoring and assignment. This may be done using the CAP, as illustrated in the following
procedure, or it may be done during an initial loading of the system. For such an initial loading,
large numbers of cartridges may be placed directly in storage slots without using the CAP (i.e.,
with the Powderhorn library door open before the system is powered up). Manual loading uses
an AMASS command different from that used for automatic loading; the command used here
enables AMASS to determine what media have been placed in the library and convey the
information to its database.

Table 17.2-3 presents the steps required for manual media loading. If you are aready familiar
with the procedure, you may prefer to use this quick-step table. If you are new to the system, or
have not performed this task recently, you should use the following detailed procedure:
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To manually insert atape into the Powderhorn, login to the control software (ACSLS)
using the acssa account at an ACSL S workstation (e.g., €0drs03, g0drs03, 10drs02,
nOdrs03).

Type enter 0,0,0 and then press the Return/Enter key.
* The Cartridge Access Port (CAP) door unlocks (audible unlatching sound).

Write down or note the bar code number(s) on the label(s) of the cartridge(s), open the
recessed latch on the Cartridge Access Port (CAP) door and insert the tape(s), solid black
side up, with the bar code label facing you, and close the door.

¢ Therobot scans al the volumes.

At the AMASS host, type /usr/amass/bin/bulkload -s SP and then press the

Return/Enter key.

* The AMASS database is populated with data for the volumesin the library, including
bar codes, associated volume numbers, and status -- inactive (1), unformatted (U), and
offline (O). The data may be reviewed using the vollist command.

* Note: If you areloading avery large number of volumes, such as at initial load, and
choose to bypass the CAP and place the volumes directly in the library dlots, data
about the volumes will not be immediately available to ACSLS for communication to
AMASS. You will first have to use the ACSLS audit command to initiate an audit of
the library, a process that may take severa hours.

Caution
Inactivate AMASS before using the following command.

Toview alist of mediain the library, type /usr/amass/utilsymedialist -3, and then press

the Return/Enter key.

* The-3 option indicates the STK Powderhorn.

» The utility reads the library element status stored in the library, and information about
thelibrary contents, including the status (FULL or EMPTY) of the elements.

Table 17.2-3. Manually Loading Archive Media

Step What to Do Action to Take

1 Log in as acssa enter text; press Return/Enter
2 enter 0,0,0 press Return/Enter

3 Place cartridge(s) in CAP close door

4 bulkload —s SP press Return/Enter

5 medialist -3 press Return/Enter
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17.2.3 Formatting a Volume

To format avolume, it must be online. A volume is placed online using the volloc command. For
a tape cartridge, you must first set the tape length using the tapelength command. Formatting a
volume destroys any files on that volume. Before formatting a volume, check to make sure it
does not have any files that should be saved. Table 17.2-4 presents the steps required to follow
the formatting process. If you are already familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1 To put the volume online, at the FSM S hogt, type /usr/amass/bin/volloc -n ###, and then
press the Return/Enter key.
o ###isthe number of the volume.

2 To verify there are no files on volume, type /usr/amass/bin/volfilelist <Vol. No.> , and
then press the Return/Enter key.
* Nofilesaredisplayed.
« If alist of filesisreturned, indicating that the volume is not empty, before proceeding
verify that you have the correct volume and that it is to be formatted.

3 To format the volume, type /usr/amass/bin/volformat -b 256k ###, and then press the
Return/Enter key.
o ###isthe number of the volume.

4 To verify status of the volume, type /usr/amass/bin/volprint -a ####, and then press the
Return/Enter key.
o ###isthe number of the volume.

Table 17.2-4. Formatting a Tape Volume

Step What to Do Action to Take
1 volloc -n volnumber press Return/Enter
2 volfilelist volnumber press Return/Enter
3 volformat -b 256k volnumber press Return/Enter
4 volprint -a volnumber press Return/Enter

17.2.4 Removing Media

Table 17.2-5 presents the steps required to remove media from the STK Powderhorn. If you are
already familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:
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1 Loginasamassor root at the FSMS SGI host (workstation x0dr g##).
* Thex intheworkstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n=NSIDC, 0=0RNL, a=ASF, j = JPL; the ## will be
an identifying two-digit number (e.g., nOdrg01 indicates an FSM S SGI server at
NSIDC).

2 Determine which volumes you want to remove by utilizing the volume number. |If
necessary to review volume numbers and other information, at the FSMS host, type
/usrfamassg/bin/vollist and then press the Return/Enter key.

* Alist of volumesisdisplayed.

3 If there are only afew volumes to remove, for each volume to be removed type
lusrfamasg/bin/voloutlet ##, where ### is the volume number, and then press the
Return/Enter key.

*  AMASS marks the volume off-line and the volume is transferred to the CAP.

4 Open the recessed latch on the Cartridge Access Port (CAP) door and remove the tape(s).

Table 17.2-5. Removing Media from the Storage Library

Step What to Do Action to Take

1 Log in as amass or root enter text; press Return/Enter
2 vollist press Return/Enter

3 voloutlet volumenumber press Return/Enter

4 Remove tape(s) from CAP open CAP latch

17.3 Monitoring and Managing the Archive with ECS Custom GUIs

Custom Graphical User Interfaces (GUIS) in the ECS software can provide helpful information
concerning the relationship between physical storage archives (Library Storage Modules, or
LSMs) and the Archive Server software applications at the site. For example, a data repository
identified as DRPL is served by the software application ECDsStArchiveServerDRP1.

Subdivisions within LSMs (e.g., for storage of different data types) are reflected in the Storage
Management database, where each Volume Group (a logical group of volumes in the archive)
has its own path. Each path maps to an AMASS volume group, and thus to a physical volume
group in the archive.

Information concerning archive servers and the logical volume groups served may be obtained
from the Storage Management Control GUI. The Storage Configuration tab on the Storage
Management GUI permits display of server information and access to related status information.
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Table 17.3-1 provides an Activity Checklist for Monitoring and Managing the Archive with ECS
Custom GUIs.

Table 17.3-1. Monitoring and Managing the Archive - Activity Checklist

Order Role Task Section Complete?
1 Archive Manager Launching DSS GUIs (P)17.3.1
2 Archive Manager Using Storage Management GUIs to (P)17.3.2
Display Archive Path Information
3 Archive Manager Monitoring Archive Requests using the (P)17.3.3
Storage Management GUI
4 Archive Manager Monitoring Distribution Requests using (P)17.3.4
the Data Distribution GUI
5 Archive Manager Setting Checksum Calculation (P)17.35

17.3.1 Launching DSS GUIs

The following software applications are associated with DSS:

» Science Data Server (SDSRV).
. Storage Management (STMGT) Servers.
Request Manager Server.
— Staging Disk Server.
— Cache Manager Server.
— Archive Server.
— Request Manager Server.
- FTP Server.
— D3/9940 Tape Server.
— 8mm Tape Stacker Server.
» DataDistribution (DDIST) Server.
» DDIST Graphical User Interface (GUI).
 STMGT GUIs.
» Science Data Server GUISs.

Access to Storage Management, Data Distribution (DDIST), and other GUIs is gained through
the use of UNIX commands. The procedure for launching the GUIs begins with the assumption
that the applicable servers are running and that the operator (Archive Manager or System
Administrator) has logged in.

Table 17.3-2 presents the steps required to launch DSS GUIs using UNIX commands. If you are
already familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:
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1 Access the command shell.
*  The command shell prompt is displayed.

NOTE: Commandsin Steps 2 through 9 are typed at a UNIX system prompt.

2 Type setenv DISPLAY clienthame: 0.0 and then press the Retur n/Enter key.

* Useeither the terminal/workstation | P address or the machine-name for the
clientname.

3 Start the log-in to the DDIST client server by typing /tools/bin/ssh hostname (e.g.,
e0dis02, g0dis02, 10dis02, or n0dis02) and then press the Return/Enter key.

* If you receive the message, Host key not found from thelist of known hosts. Are
you sure you want to continue connecting (yes/no)? typeyes (“y” aone does not
work).

» If you have previously set up a secure shell passphrase and executed sshremote, a
prompt to Enter passphrasefor RSA key '<user @ ocalhost>" appears; continue
with Step 4.

» If you have not previously set up a secure shell passphrase; go to Step 5.

4 If aprompt to Enter passphrase for RSA key '<user @ ocalhost>' appears, type your
Passphrase and then press the Return/Enter key. Go to Step 6.

5 At the <user @remotehost>'s password: prompt, type your Password and then press the
Return/Enter key.

6 To change directory to the directory containing the startup scripts for DSS, type cd
/usr/lecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
The<MODE> will most likely be one of the following operating modes:
— OPS (for normal operation).
— TSl or TS2 (for testing).

* Note that the separate subdirectories under /usr/ecs apply to different operating
modes.

7 To launch the Storage Management Control GUI, type the following command:
EcDsStmgtGuiStart <MODE>, where <MODE> is the one selected in Step 6, and then
press the Return/Enter key.

» The Storage Management Control GUI, used for review of storage events and status
of devices, isdisplayed.
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8 To launch the Data Distribution GUI, use asimilar procedure and type the following
command: EcDsDdistGuiStart <MODE>, where <MODE> is the one selected in
Step 6, and then press the Return/Enter key.
» The DataDistribution GUI is displayed.

9 To launch the DSS Science Data Server GUI, log in to the host for Science Data Server
(e.g., e0acs05, g0acs03, 10acs03, or n0acs04). Use asimilar procedure and type the
following command: EcDsSdSrvGuiStart <MODE> and then press the Retur n/Enter
key.

* The Science Data Server Operator GUI is displayed.

Table 17.3-2. Launching DSS GUIs

Step What to Do Action to Take

1 Access command shell

2 setenv DISPLAY clientname:0.0 enter text, press Return/Enter
3 ftools/bin/ssh hostname enter text, press Return/Enter
4 Passphrase (or, if none, go to Step 5) enter text, press Return/Enter
5 Password enter text, press Return/Enter
6 cd /usr/ecs/<MODE>/CUSTOM/utiliites press Return/Enter

7 EcDsStmgtGuiStart <MODE> (for STMGT GUI) press Return/Enter

8 EcDsDdistGuiStart <MODE> (for DDIST GUI) press Return/Enter

9 EcDsSdSrvGuiStart <MODE> (for SDSRV GUI) press Return/Enter

17.3.2 Using Storage Management GUIs to Display Archive Path Information

If requested to provide archive path information for a particular Earth Science Data Type (ESDT)
stored in the archive, the Storage Management GUI can be used to obtain the needed
information. Table 17.3-3 presents the steps required to use the Storage Management GUIs to
Display Archive Path information. If you are aready familiar with the procedure, you may
prefer to use this quick-step table. If you are new to the system, or have not performed this task
recently, you should use the following detailed procedure:

1 Launch the DSS Storage Management GUI using UNIX commands (see Section 17.3.1,
Launching DSS GUI s).
* The DSS Storage Management GUI is displayed.

2 Click on the Storage Config. tab to ensure that the Storage Configuration display is

available.
* The Storage Config. tab is displayed.
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3 Inthefield listing Server Type, click onthe ARCHIVE lineto highlight it.
» Thesdected lineis highlighted and the Server Name and Status of archive servers
are displayed in the field listing Server Name.

4 Click onthe Vol Grp Config. tab.
* TheVolume Group Information is displayed showing volume groups and their
current paths.

5 If it isdesirable to display the path history for a datatype, on the Vol Grp Config. tab,
click on the Data Type Name entry for the specific data type for which path history
information is desired.

» Theselected lineis highlighted.

6 Click on the Display History button.
* A Volume Group History window is displayed showing the path history for the
highlighted data type.

Table 17.3-3. Using Storage Management GUIs to Display Archive Path
Information and History

Step What to Do Action to Take

1 Launch the DSS Storage Management GUI Use procedure in Section 17.3.1
2 Select Storage Config. tab single-click

3 Highlight Archive in Server Type field single-click

4 Select Vol Grp Config. tab single-click

5 Highlight a selected data type line single-click

6 Activate Display History button single-click

17.3.3 Monitoring Archive Requests Using the Storage Management GUI

A primary GUI tool for monitoring of archive processing is the Request Status window,
accessible from the Storage Management Control GUI. Using the Request Status tab the
Archive Manager or Distribution Technician can detect stalled requests or servers that appear to
beidle.

The Request Status window displays the following information:

* Operation isthe type of operation represented by the request.

* Request ID isauniqueidentifier for the request.

* Progressisthe stage of processing on which the request is currently working (may
include a numeric progress indication).

» Status providesinformation about processes attempted and the outcome (e.g.,
DsEStDRExecuteFailed, DSEStARPathSearchExhausted, OK, . . WriteFailed, . . .).
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Priority is Xpress, Very High, High, Normal, or L ow.

When Submitted is the time and date when the request was received by the Storage
Management server that is responsible for the request.

Last Updated is the time and date when the status was last updated for the request.

The operator can reduce the displayed list of requests by clicking on the Filtering pull-down
menu just above the Request Status Information list on the window. This permits filtering on
four areas or filter types selectable from the pull-down menu:

Server controls what activity is displayed by limiting the list to the requests
being/having been serviced by a specific server. Selecting All displays all requests
throughout Storage Management. Other selections include the individual archive
servers, cache manager servers, ftp servers, request manager server, and staging disk
servers.

Operation alows the operator to focus on a specific type of operation. Thelist of
operations is dynamically generated to reflect those operations for which requests are
currently in queue (e.g., All, CMLink, ArStore, ArRetrieve, FtpPull, FtpPush).
Processing State allows the operator to differentiate anong requests that are being
actively processed; have been completed, either successfully or to aretryable error
state; or have been suspended and are awaiting the outcome of another event. The
following selections are available: All, Processing, Suspended, Completed.
Submitter allows the Distribution Technician to see the status of requests submitted
by a specific client process. The list of possible clientsis dynamically generated to
reflect the list of clients with outstanding requests (e.g., All, DSDD, HDFC, SDSV,
this, [various serverg)).

Table 17.3-4 presents the steps required to monitor archive requests using the Storage
Management Control GUI. If you are already familiar with the procedure, you may prefer to use
this quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1

Launch the DSS Storage M anagement Control GUI using UNIX commands (see
Section 17.3.1, Launching DSS GUI s).

The DSS Storage Management Control GUI is displayed.

Click on the Request Status tab.

The Request Statustab is displayed.

Observe information displayed on the Request Status tab of the Storage M anagement
Control GUI.

The Request Status I nfor mation table displays the following information:
— Operation.

— Request ID.

— Progress.

- Status.
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— Priority.
- When Submitted.
— Last Updated.

* By default all storage management server requests for the last 24 hours are shown in
the Request Status I nformation table of the Request Status tab.

» Clicking on any of the column headers of the Request Status Information table
causes the listed requests to be sorted in order by the column selected.

— For example, clicking on the Last Updated column header causes requests to be
listed in order from the least recently updated to the most recently updated.

* TheOperator Messagesfield at the bottom of the GUI displays messages concerning
events occurring in storage management operations.

* Note that storage management servers control virtualy all datainserted into or
retrieved from the archive; the resulting large amount of activity on the Request
Status tab may make it useful to restrict the number of requests displayed by
applying afilter (see next step).

Tofilter the list of requests, use the Filtering pull-down menu above the top |eft corner

of the Request Status I nfor mation table, selecting as desired to display requests

associated with a particular Server, Operation, Processing State, or Submitter.

» Thelist of requests displayed in the Request Status I nformation table is restricted
by the filtering choice.

Observe the Storage Management requests displayed in the Request Status I nfor mation
table.

* TheProgress and Status column entries in the table may provide indication for
particular requests of potential problems or conditions requiring attention.

Repeat Steps 4 and 5 as necessary to monitor Storage Management requests.

To exit, follow menu path File> Exit.

Table 17.3-4. Monitoring Archive Requests Using the Storage Management GUI

Step What to Do Action to Take

1 Launch the DSS Storage Management Control GUI Use procedure in Section 17.3.1

2 Select Request Status tab single-click

3 Observe listed request information read text

4 Select Filtering option click-hold and drag cursor or
execute three clicks

5 Observe selected (filtered) requests read text

6 Repeat Steps 4 and 5 as necessary

7 File>EXxit (if necessary/desirable) single-click
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17.3.4 Monitoring Distribution Requests Using the Data Distribution GUI

Distribution requests result from orders for ECS data, placed by users or subscriptions, and by
requests for data by interna ECS processes (e.g., those related to data processing). As ECS
responds to these requests, the Archive Manager or other operators can monitor the progress of
the distribution requests. Table 17.3-5 presents the steps required to monitor distribution
requests using the Data Distribution GUI. If you are already familiar with the procedure, you
may prefer to use this quick-step table. If you are new to the system, or have not performed this
task recently, you should use the following detailed procedure:

1

Launch the DDIST GUI using UNIX commands (see Section 17.3.1, Launching DSS
GUls).
» TheData Distribution GUI tool is displayed.

Click onthe Distrib’n Requests tab.
» TheDistribution Requests window is opened.
* Alist of requestsis displayed.

Follow menu path View—Filter.

* TheDistribution Filter Requests window opens.

» Threefilter types are displayed in aradio box at the top of the Distribution Filter
Requestswindow: Request 1D, Requester, and All Requests.

In the radio box at the top, click on one of the radio buttons to select filtering by Request

ID, Requester, or All Requests as desired.

* Theselectionisindicated by the radio button depressed appearance.

» If thesdectionisRequest ID or Requester, the cursor moves to the text entry field
to the right of the selected button.

If the selection is Request 1D or Requester, enter the request 1D or requester’ s name,
respectively, in the appropriate text entry field.

Inthe Media Type: areaof the Distribution Filter Requests window, click on the All
button or click on one of the entriesin the Media Type: field to select for filtering on
FtpPull or FtpPush (because of the incorporation of the Product Distribution System to
handle media distributions, any media distribution requests are reflected as FtpPush
distribtions to the Product Distribution System).

» Selected entriesin the M edia Type: window show as highlighted.

In the State: area, click on the All button to select all states, or click on one or more radio
buttons to select one or more states for the filtering.
* Any selected State: toggle buttons show as depressed.
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8 Click on the OK push button, located at the bottom of the window.
* The other push buttons located at the bottom of the window are Apply, Cancel, and
Help.
* TheFilter Requestswindow is closed.
» TheDistribution Requests screen shows any requests that meet the filter criteriain
the Data Distribution Requestsfield.

9 If necessary, use the scroll bar at the bottom of the Data Distribution Requestsfield to
scroll horizontally to view the state of the selected request(s).

Table 17.3-5. Monitoring Distribution Requests Using the Data Distribution GUI

Step What to Do Action to Take
1 Launch the DSS Data Distribution GUI Use procedure in Section 17.3.1
2 Select Distrb’n Requests tab single-click
3 View->Filter single-click
4 Select Filtering type single-click
5 Enter any required information for Filtering type enter text
6 Select Media Type: filtering option(s) click to highlight
7 Select State: filtering option(s) click to select
8 Click OK to apply filters and close Distribution single-click
Filtering Requests window
9 Observe filtered Distribution Request(s) list, scrolling as | read text
necessary

17.3.5 Setting Checksum Calculation

The system design for ECS incorporates calculation of a checksum when a granule is inserted
into the archive. If such a checksum is calculated, it can then be used as an indicator to
determine if there is data corruption within the archive. Comparison of the origina checksum
with one calculated, for example, when the granule is retrieved (e.g., for processing or
distribution) can detect whether the inserted file and the retrieved file are the same. If the
checksums do not match, then the operator can investigate (refer to Section 17.7.4,
Diagnosing/Investigating Read Errors). The checksums are set in the configuration for the
archive server, with variables that set calculation on granule insert and calculation on retrieval.
The Storage Management GUI provides an easy way to set these configuration parameters. The
settings are available from the Storage Config. tab, by highlighting the Archive Server and
clicking on the M odify Server button. This opens the Archive Server Configuration window.
The window includes option buttons to Enable Checksumming On Store: and Enable
Checksumming On Retrieve:
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Calculation of checksums can be time consuming. System throughput may be significantly
improved if checksum calculation on granule insert is turned off, and therefore the default
reflects checksum calculation turned off. Unfortunately, turning checksums off compromises the
ability to detect data corruption in the archive. This problem may be alleviated somewhat by
calculating a checksum when a granule is first retrieved from the archive and storing that
checksum to be compared with one calculated upon alater retrieval. However, this approach will
not guard against the possibility of data corruption on initial insertion (e.g., through /O errors).
If it becomes necessary to enable calculation (e.g., for troubleshooting), use the Storage
Management GUI. Table 17.3-6 presents the general steps required for setting checksum
calculation. If you are aready familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Launch the Storage Management GUI using UNIX commands (refer to Section 17.3.1,
Launching DSS GUI s).
* The DSS Storage Management GUI is displayed.

2 Click on the Storage Config. tab to ensure that the Storage Configuration display is
available.
* The Storage Config. tab is displayed.

3 Inthefield listing Server Type, click onthe ARCHIVE lineto highlight it.
» Thesdlected lineis highlighted and the Server Name and Status of archive servers
are displayed in the field listing Server Name.

4 In the field listing Server Name, click on the archive server (e.g.,
EcDsStArchiveServer DRP1) for which the checksum variables are to be set.
» Theselected lineis highlighted.

5 Click on the M odify Server button.
» TheArchive Server Configuration window is displayed showing configuration data
for the selected archive server.

6 Click on the option button in the Enable Checksumming On Store: block.
* A pop-up display offersthe choice of Yesor No.

7 Click on the desired choice to enable (Y es) or disable (No) checksumming when a
granuleis stored.

» The pop-up display is closed and the selected choice appears as the label on the
option button.

8 Click on the option button in the Enable Checksumming On Retrieve: block.
* A pop-up display offersthe choice of Yesor No.
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9 Click on the desired choice to enable (Y es) or disable (No) checksumming when a
granuleisretrieved.
The pop-up display is closed and the selected choice appears as the label on the

option button.

10 Click on the OK button.
The Archive Server Configuration window is closed and the changes take effect.

Table 17.3-6. Setting Checksum Calculation

Step What to Do Action to Take
1 Launch the DSS Storage Management GUI Use procedure in Section 17.3.1
2 Select Storage Config. tab single-click
3 Select ARCHIVE server type single-click to highlight
4 Select archive server for which to set checksumming single-click to highlight
5 Select Modify Server button single-click
6 Display options for Enable Checksumming on Store: | single-click
7 Select Yes to enable or No to disable single-click
8 Display options for Enable Checksumming on single-click

Retrieve:

9 Select Yes to enable or No to disable single-click

10 Select OK button single-click

17.4 Deleting Granules

The Granule Deletion capability alows operators to delete products on demand. There are

several circumstances that may require deletion on demand, such as:

New PGE versions have been created and are used to reprocess large amounts of past

data, creating new ESDT versions. As reprocessing progresses, Operations del etes
the granules for the old ESDT versions from the archive and inventory.

It is determined that certain lower-level (e.g., Level 2) products are of little or no
Interest to the science or public user community. In concert with the science teams,
DAAC operations personnel decide to remove these products from the inventory.

Since the products are still referenced by higher-level products as inputs, the DAAC

decides to keep the inventory records for production history purposes.
One or more granules were found defective and were reprocessed on an individual
basis. When the reprocessing is compl ete, the operator wishes to delete the old,

defective granule(s) from the inventory.
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* A DAAC has extended ECS with subsetting services. The subsetted products are
produced outside ECS, but are then inserted into the ECS archive to take advantage of
the ECS distribution capability. The DAAC writes a script to delete the subsetted
products on aregular basis.

The Science Data Server provides an application programming interface (API) for deleting
granules from the archive, or from both the archive and inventory since earlier releases, but the
Granule Deletion capability adds a front-end command-line utility that provides severa ways for
selecting granules for deletion. Confirmation is generally required so that granules are not
inadvertently deleted. However, the confirmation may be suppressed so that operators can run
regularly scheduled deletion scripts using background execution. This suppression possibility
presents an opportunity for inadvertent loss of data and so must be used with care and only after
thorough testing of any deletion script.

The Science Data Server captures deletions and related errors in the application log. Operators
may also specify a separate and independent delete log for immediate analysis of the success or
failure of a delete operation.

Deletion Sequence. The deletion of granules from the archive involves three elements, and
therefore actually occurs in stages. Two of the elements are parts of the Science Data Server
(SDSRV), and the third is a part of the Storage Management (STMGT) software and Graphical
User Interface (GUI).

» Logical Deletion: For thefirst stage, acommand-line delete utility specifies selection
criteriafor deletion of granules and "logically” deletes from the inventory those
granules that meet the criteria. These granules are flagged as 'deleted’ and can no
longer be accessed, but their inventory entries are not yet removed. The logical
'deletion’” may specify, viacommand line input, removal of granule files from the
archive (Deleted From Archive, or DFA) only, leaving the inventory record, or it may
specify Physical Deletion, which entails removal of the inventory record as well as
removal of the files from the archive. The deletion flag consists of records in the
SDSRYV database. Specifically, in the DsMdGranules table, the value of the
DeleteFromArchive entry is changed from N to Y, and the granule is entered in the
DsMdDeletedGranul es table with a time stamp recording the logical deletion time.

» Physical Deletion: The second stageis actua deletion from the inventory of those
granules marked for physical deletion (not DFA only), which occurs when the
operations staff runs the physical deletion cleanup utility script. For Physical
Deletion, the script removes al inventory rows for granules that were flagged as
'deleted,” including rows referencing related information (e.g., QA data). The script
writesto the STMGT database (and therefore must be run under alog in by
sdsrv_role with authorization to write to that database), creating entries in the
DsSdPendingDel ete table for granules to be deleted. Thisincludes entries for
granules that are to be physically deleted, as well as those designated DFA only. The
operations staff controls the lag time between logical deletion and physical deletion.
That lag time is entered into the physical deletion script, which deletes only inventory
entries for granules that have been logically deleted prior to that time period.
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* Deleted from Archive (DFA): STMGT provides a GUI screen that allows the operator
to initiate the removal from the archive of the fileslisted its deletion table (popul ated
by SDSRV). STMGT creates requests to the archive serversto delete files. The
STMGT GUI can be used to look at the state of the deletion requests. Files that are
successfully deleted have their associated rows removed from the STMGT database
table.

Periodically, as sufficient data removal from the archive makes it appropriate, operations may
elect to reclaim the tape space and recycle archive tapes. The AMASS software commands
(volcomp, volclean, volformat, volstat) are used for that purpose.

Table 17.4-1 provides an Activity Checklist for Deleting Granules from the Archive.

Table 17.4-1. Deleting Granules from the Archive - Activity Checklist

Order Role Task Section Complete?
1 Archive Resetting the Lock on the P)17.4.1
Manager/Database | DsMdDeletedGranules table
Administrator
2 Archive Manager Selecting Granules for Deletion (P)17.4.2
3 Archive Manager Selection by ESDT ShortName, (P)17.4.21
Version, and Granule Time Coverage
4 Archive Manager Selection by ESDT ShortName, (P)17.4.2.2
Version, and Granule Insert Time
Range
5 Archive Manager Selection Using a Separate Input File (P)17.4.2.3
6 Archive Manager/ Deleting Granules from the Inventory (P)17.4.3
Data Base and Archive (Physical Deletion)
Administrator
7 Archive Manager Deleting Granules from the Archive (P)17.4.4

17.4.1 Resetting the Lock on the DsMdDeletedGranules Table

The DsMdDeletedGranules table may become locked during execution of the Deletion Cleanup
task if thereis aneed to restart the Science Data Server or if thereis a problem with Sybase. The
lock can prevent granules being marked for deletion upon subsequent runs of the Granule
Deletion utility, and it is therefore necessary to reset the lock. Thisis accomplished using a Perl
script, EcDsResetL ock.pl. Table 17.4-2 presents the steps required to run the EcDsResetL ock.pl
script. If you are already familiar with the procedure, you may prefer to use this quick-step table.
If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:
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Log into the SDSRV host (e.g., €0acs05, g0acs03, |0acs03, n0acs04) with an ID
authorized with permissions to execute the EcDsResetL ock.pl script.

To change directory to the directory containing the script, type cd
/usr/ecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
*  The<MODE> will most likely be one of the following operating modes:
— OPS (for normal operation).
— TSlor TS2 (for testing).
» Theworking directory is changed to /usr/ecss<MODE>/CUST OM/utilities.

To execute the script, type EcDsResetL ock.pl and then press the Return/Enter key.
* The script prompts Enter M ode of Operation:.

To identify the mode in which the script isto be run, type OPS, TS1, TS2, or other
<MODE>, and then press the Return/Enter key.
» Thescript prompts Enter Log File name:.

Type ResetL ock.log or another name of your choosing for the log, and then press the
Return/Enter key.
* Thescript prompts Enter Sybase User Name:.

Type sdsrv_role and then press the Return/Enter key.
* The script prompts Enter Sybase password:.

Type the Sybase <password> (may require input from Database Administrator) and then
press the Return/Enter key.
» Thescript prompts Enter Sybase SQL Server Name:.

Type x0acsOn_srvr and then press the Return/Enter key.

» Thex will begfor GSFC, efor EDC, | for LaRC, or n for NSIDC. Then will bea
number identifying the Sybase SQL Server (may require input from the Database
Administrator).

* The script prompts Enter SDSRV’s database name:.

Type EcDsScienceDataServer 1 <MODE>, and then press the Return/Enter key.

» The script attempts to access the locked table, generating a number of errors, before
resetting the lock so that marking for deletion can proceed.
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Table 17.4-2. Resetting the Lock on the DsMdDeletedGranules Table

Step What to Do Action to Take

1 Log in to SDSRYV host enter text

2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press Return/Enter
3 EcDsResetLock.pl enter text; press Return/Enter
4 <MODE> enter text; press Return/Enter
5 ResetLock.log enter text; press Return/Enter
6 sdsrv_role enter text; press Return/Enter
7 <password> enter text; press Return/Enter
8 x0acsOn_srvr enter text; press Return/Enter
9 EcDsScienceDataServerl <MODE> enter text; press Return/Enter

17.4.2 Selecting Granules for Deletion

Selecting granules for deletion consists of running the Granule Deletion Command line tool to
accomplish logical deletion, or marking (by entries in the SDSRV inventory database) of
granules for deletion. It specifies either DFA only, leaving the inventory record, or Physica
Deletion, which will result in removal of the inventory record as well asremoval of the filesfrom
the archive.

17.4.2.1 Selection by ESDT ShortName, Version, and Granule Time Coverage

Table 17.4-3 presents the steps required to select granules for deletion using the ESDT
ShortName, version, and granule time coverage. If you are already familiar with the procedure,
you may prefer to use this quick-step table. If you are new to the system, or have not performed
thistask recently, you should use the following detailed procedure:

1 Log into the SDSRV host (e.g., €0acs05, g0acs03, |0acs03, n0acs04) with an ID
authorized with permissions to execute the Granule Deletion utility.

2 To change directory to the directory containing the script, type cd

/usr/ecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
The <MODE> will most likely be one of the following operating modes:

— OPS (for normal operation).
— TSlor TS2 (for testing).

The working directory is changed to /usr/ec§<MODE>/CUST OM/utilities.
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Type the command to run the Granule Deletion utility specifying ESDT ShortName,
ESDT version, and granule time coverage (granule beginning date and time, and granule
ending date and time), and specifying DFA or physical deletion, and then press the
Return/Enter key.

For deletion from archive only, the command is:

EcDsGranuleDeleteClientStart <MODE> -name <ShortName> -version <version
no.> -BeginDate <granbegdate/time> -EndDate <granenddate/time> -log
/usr/ecs’<MODE>/CUST OM/logs/GranDel<n>.log -DFA.

For physical deletion, the command is:

EcDsGranuleDeleteClientStart <MODE> -name <ShortName> -version <version
no.> -BeginDate <granbegdate/time> -EndDate <granenddate/time> -log
/usr/ecs’<MODE>/CUST OM/logs/GranDel<n>.log -physical.

The utility executes and displays the number of granules for deletion, and prompts the
user Do you want to continue [y/n]?.

Note: It ispossibleto suppress the continuation prompt by including the argument
-noprompt with the command.

Typey and then press the Return/Enter key.

The process continues to completion.

Note: The deletion actions are displayed in the Deletion log and in the Science Data
Serve ALOG, including information on the user 1D of the requester, the ShortName,
VersionlD, and granule coverage time of the request. It is also possible to view the
SDSRYV database to verify the granule tagging for deletion; the granule should appear
in the database with values depending on whether the deletion request specified -DFA
or -physical (see matrix below).

DsMdGranules Table DsMdDeletedGranules Table

Request Type DeleteEffective Date | DeleteFromArchive Transaction Time DFA Flag
-DFA NULL Y Current Time 1
-physical Current Time N Current Time 0
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Table 17.4-3. Selection by ESDT ShortName, Version, and Granule Time

Coverage
Step What to Do Action to Take
1 Log in to SDSRYV host enter text
2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press Return/Enter
3 Run Granule Delete utility Execute Step 3 of Section
17421
4 y (at continuation prompt y/n?) enter text; press Return/Enter

17.4.2.2 Selection by ESDT ShortName, Version, and Granule Insert Time Range

Table 17.4-4 presents the steps required to select granules for deletion using the ESDT
ShortName, version, and granule insert time range. If you are aready familiar with the
procedure, you may prefer to use this quick-step table. If you are new to the system, or have not
performed this task recently, you should use the following detailed procedure:

1

Log into the SDSRV host (e.g., €0acs05, g0acs03, |0acs03, n0acs04) with an ID
authorized with permissions to execute the Granule Deletion utility.

To change directory to the directory containing the script, type cd
/usr/lecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
The<MODE> will most likely be one of the following operating modes:

— OPS (for normal operation).

— TSl or TS2 (for testing).
» Theworking directory is changed to /usr/ecs’<MODE>/CUST OM/utilities.

Type the command to run the Granule Deletion utility specifying ESDT ShortName,
ESDT version, and granule insert time range (insert beginning date and time, and insert
ending date and time), and specifying DFA or physical deletion, and then press the
Return/Enter key.

» For deletion from archive only, the command is:

» EcDsGranuleDéeleteClientStart <MODE> -name <ShortName> -ver sion <version
no.> -insertbegin <insbegdate/time> -insertend <insenddate/time> -log
/usr/ecs’<MODE>/CUSTOM/loggGranDel<n>.log -DFA.

» For physical deletion, the command is:

» EcDsGranuleDeleteClientStart <MODE> -name <ShortName> -ver sion <version
no.> -insertbegin <insbegdate/time> -insertend <insenddate/time> -log
/usr/ecs’<MODE>/CUST OM/logd/GranDel<n>.log -physical.

» The utility executes and displays the number of granules for deletion, and prompts the
user Do you want to continue[y/n]?.

* Note: Itispossibleto suppress the continuation prompt by including the argument
-noprompt with the command.
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4

Typey and then press the Return/Enter key.

The process continues to completion.

Note: The deletion actions are displayed in the Deletion log and in the Science Data
Serve ALOG, including information on the user ID of the requester, the ShortName,
VersionlD, and granule insert time of the request. It isalso possible to view the
SDSRYV database to verify the granule tagging for deletion; the granule should appear
in the database with values depending on whether the deletion request specified -DFA
or -physical (see matrix below).

DsMdGranules Table DsMdDeletedGranules Table

Request Type DeleteEffective Date | DeleteFromArchive Transaction Time DFA Flag
-DFA NULL Y Current Time 1
-physical Current Time N Current Time 0

Table 17.4-4. Selection by ESDT ShortName, Version, and Insert Time Range

Step What to Do Action to Take

1 Log in to SDSRV host enter text

2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press Return/Enter

3 Run Granule Delete utility Execute Step 3 of Section
17.4.2.2

4 y (at continuation prompt y/n?) enter text; press Return/Enter

17.4.2.3 Selection Using a Separate Input File

The tool permits referencing alist of granules in a file created for the purpose of providing that
list as input to the tool. The desired deletion is achieved by creating a file containing identifying
information for the granule(s) to be deleted. The file can list multiple granules. Several options
are available for identifying granules, and for controlling how the utility executes:

the input file can specify SDSRV Granule IDs (geol Ds).

the input file can specify logical, or "local,” Granule IDs.

the command to execute the Granule Deletion utility can include the -display
argument, which resultsin alisting of the geolD and logical ID of each granule
selected for deletion.

by default, the number of granules selected for deletion is displayed and the operator
Is prompted to confirm the deletion, but the command to execute the Granule
Deletion utility can include a-noprompt argument, which suppresses the
confirmation prompt.

the operator can choose whether selected granules are to be deleted from the archive
and the inventory or from the archive only.
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* by default, any BROWSE, QA, and PH granules associated with physically deleted
granules are deleted if no longer referenced otherwise, but the command to execute
the Granule Déeletion utility can include a-noassoc argument, which suppress
deletion of these associated granules.

Table 17.4-5 presents the steps required to select granules for deletion using a separate input file.
If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1

Log into the SDSRV host (e.g., €0acs05, g0acs03, |0acs03, n0acs04) with an ID
authorized with permissions to execute the Granule Deletion utility.

To change directory to the directory containing the script, type cd
/usr/ecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
*  The<MODE> will most likely be one of the following operating modes:
— OPS (for normal operation).
— TSlor TS2 (for testing).
» Theworking directory is changed to /usr/ecss<MODE>/CUST OM/utilities.

Type the command to run the Granule Deletion utility specifying an input file type and
file name, a granule deletion log file path, type of deletion (DFA or physical), omission
of prompt (if prompt is not desired), argument to suppress deletion of associated
BROWSE, QA, and PH granules (if deletion of those associated granulesis not desired),
and then press the Return/Enter key.

* Theform of the command is:

EcDsGranuleDeleteClientStart <MODE> [-geoidfile <geoidfilename>]
[-localgranulefile <localfilename>] -log /usr/ec§<MODE>/CUST OM/logs/
GranDel<n>.log -DFA [-noprompt] [-noassoc]

OR

EcDsGranuleDeleteClientStart <MODE> [-geoidfile <geoidfilename>]
[-localgranulefile <localfilename>] -log /usr/ec§<MODE>/CUST OM/logs/
GranDel<n>.log -physical [-noprompt] [-noassoc].

» The utility executes and displays the number of granules for deletion, and, unless the
command included the -noprompt option, prompts the user Do you want to
continue [y/n]?. If the-noprompt option was used, the process continues to
completion (see Note under Step 4).

If prompted at the end of Step 3, type y and then press the Retur n/Enter key.

» The process continues to completion.

* Note: The deletion actions are displayed in the Deletion log and in the Science Data
Serve ALOG, including information on the user ID of the requester, the ShortName,
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VersionlD, and granule insert time of the request. It isalso possible to view the
SDSRYV database to verify the granule tagging for deletion; the granules should
appear in the database with values depending on whether the deletion request
specified -DFA or -physical (see matrix below). By default, if there are any
BROWSE, QA, and PH granules associated with the science data granules to be
deleted and these associated granules are not referenced by other granules, the
associated granules will also be tagged for deletion. However, the command may
include the -noassoc argument to suppress deletion of these associated granules.

DsMdGranules Table DsMdDeletedGranules Table

Request Type DeleteEffective Date | DeleteFromArchive Transaction Time DFA Flag
-DFA NULL Y Current Time 1
-physical Current Time N Current Time 0

Table 17.4-5. Selection Using a Separate Input File

Step What to Do Action to Take

1 Log in to SDSRYV host enter text

2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press Return/Enter

3 Run Granule Delete utility Execute Step 3 of Section
17.4.2.3

4 If prompted, y (at continuation prompt y/n?) enter text; press Return/Enter

17.4.3 Deleting Granules from the Inventory and Archive (Physical Deletion)

Once granules are marked for deletion, the operator runs the Deletion Cleanup Utility, a Perl
script, EcDsDeletionCleanup.pl. This script identifies those granules that were marked for
deletion to the STMGT database for removal from the archive. In addition, if the granules were
marked for physical deletion in the SDSRV database, they are deleted from the SDSRV database.
A lag time, specified as a number of days, is used so that the operator can request that not al the
granules marked for deletion are immediately deleted -- i.e., the Deletion Cleanup Utility deletes
granules marked for deletion a specified number of days prior to the current date. A lag time of O
may be used to implement immediate deletion. The script also asks for entry of a batch size, by
which the operator specifies the increments for transfer of files from the SDSRV database to the
STMGT database. For large numbers of deletions, a large batch size may be specified (up to a
maximum of 10,000).

Table 17.4-6 presents the steps required to delete granules from the inventory and archive. If you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are
new to the system, or have not performed this task recently, you should use the following
detailed procedure:
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Log into the SDSRV host (e.g., €0acs05, g0acs03, |0acs03, n0acs04) with an ID
authorized with permissions to execute the Deletion Cleanup utility.

To change directory to the directory containing the script, type cd
/usr/lecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
The<MODE> will most likely be one of the following operating modes:

— OPS (for normal operation).

— TSl or TS2 (for testing).
» Theworking directory is changed to /usr/ecs’<MODE>/CUST OM/utilities.

To run the Deletion Cleanup Utility, type EcDsDeletionCleanup.pl and then press the
Return/Enter key.
* Thescript prompts Enter lag timein days..

Type <n>, where n isthe lag time in days specifying a number of days prior to the
current date during which granules marked for deletion are not yet to be deleted, and then
press the Return/Enter key.

* Note: Usealagtime of O to indicate immediate deletion of all marked granules.

» Thescript prompts Enter mode of operation:.

Type <MODE>, where <MODE> is the mode in which you are making the deletion
(typically OPS, TS1, or TS2) and then press the Return/Enter key.
» The script prompts Enter log file name:.

Type DelCleanupl.log and then press the Retur n/Enter key.
* Thescript prompts Enter Sybase User:.

Type sdsrv_role, and then pressthe Return/Enter key.
* Thescript prompts Enter Sybase User Password:.

Type <password>, where <password> is the Sybase password (Note: This step may
require input by the Database Administrator).
» The script prompts Enter sgl server:.

Type <x>0acg<nn>_srvr (e0acgll srvr at EDC, g0acg0l srvr at GSFC, [0acg02_srvr
at LaRC, or nOacg0l1_srvr at NSIDC) and then press the Retur n/Enter key.
* Thescript prompts Enter DBName:.

Type EcDsScienceDataServer 1 <MODE>, where <MODE> is the mode in which you
are making the deletion (typically OPS, TS1, or TS2) and then press the Retur n/Enter
key.

» The script prompts Enter STMGT DBName:.
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Type stmgtdbl <MODE>, where <MODE> is the mode in which you are making the

deletion (typically OPS, TS1, or TS2) and then press the Return/Enter key.

* Note: If you do not know the STMGT DB Name, contact the Database
Administrator.

» The script prompts Enter Batch size:.

Type <n> where n is the batch size specifying the increments for transfer of filesfrom
the SDSRV database to the STMGT database (maximum 10,000), and then press the
Return/Enter key.

* The script prompts Do you wish to continue deleting these granules?:

Typey and then press the Return/Enter key.

* The Deletion Cleanup Utility script displays the number of granules to be deleted
from the archive (DFA) and physically deleted, with a confirmation prompt. If the lag
time was specified as 0, al granules in the DeletedGranules table are displayed.

Typey (response to the confirmation prompt) and then press the Return/Enter key.
» Execution of the Deletion Cleanup Utility script completes.

* Note Inthe SDSRV database, the SDSRV Staging table (DsMdStagingTable) can be

observed for transfer of datato the STMGT database (in increments of the specified
batch size); when the transfer is complete, the tableis empty. Inthe STMGT

database, the STMGT Pending Delete table (DsStPendingDel ete) can be observed for
receipt of the data; all granules specified in the delete request are received. The
Deletion Cleanup log displays messages about the actions, indicating that information
Is placed in the STMGT database in increments of the specified batch size.
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Table 17.4-6. Deleting Granules from the Inventory and Archive

Step What to Do Action to Take

1 Log in to SDSRYV host enter text

2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press Return/Enter
3 EcDsDeletionCleanup.pl enter text; press Return/Enter
4 <n> (lag time, in days) enter text; press Return/Enter
5 <MODE> enter text; press Return/Enter
6 DelCleanup.log enter text; press Return/Enter
7 sdsrv_role enter text; press Return/Enter
8 <password> enter text; press Return/Enter
9 x0acgOnn_srvr enter text; press Return/Enter
10 EcDsScienceDataServerl_<MODE> enter text; press Return/Enter
11 stmgtdbl <MODE> enter text; press Return/Enter
12 <n> (increments for transfer of files, maximum 10,000) | enter text; press Return/Enter
13 y (to continue) enter text; press Return/Enter
14 y (to confirm/continue) enter text; press Return/Enter

17.4.4 Deleting Granules from the Archive

Once the STMGT database receives the data on the granules to be deleted (reflected in the
STMGT Pending Delete table, DsStPendingDelete), the operator uses the Storage Management
GUI to initiate the removal from the archive of the listed files. This completes the physical
deletion for those granules selected for removal from the archive and inventory, and
accomplishes the removal from the archive of those granules selected for Deletion from the
Archive (DFA) only. Table 17.4-7 presents the steps required to delete granules from the
archive. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1

Launch the DSS Storage Management GUI using UNIX commands (see Section 17.3.1
Launching DSS GUIs).
* The DSS Storage Management GUI is displayed.

On the STMGT GUI, to view the ESDTs with granules targeted for deletion, follow

menu path Delete—Batch Delete.

» TheBatch Delete window is displayed, listing the granules tagged for deletion as
ESDT/Version pairs with numbers of filesin the Granule Deletion I nfor mation
field.

To select data for deletion from the archive, click on an ESDT/Version pair.
» Theseected ESDT/Version pair is highlighted.
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4 Click the Delete button.

A confirmation Delete Warning prompt asks Are you sure you want to delete the
selected files?

5 To confirm the deletion, click the OK button.

The delete request continues to completion and the ESDT/Version pair isremoved
from the list of granules tagged for deletion in the Granule Deletion Infor mation
field of the Batch Delete window.

Note: The delete actions can be tracked via messages in the Archive Server log files
(EcDsStArchiveServer. ALOG, EcDsStArchiveServerDebug.log)

Table 17.4-7. Deleting Granules from the Archive

Step What to Do Action to Take

1 Launch the DSS Storage Management GUI Use procedure in Section 17.3.1
2 Delete->Batch Delete single-click

3 Select an ESDT/Version pair single-click

4 Activate Delete button single-click

5 Click OK (to confirm deletion) single-click

17.4.5 Undelete Capability

In the event that it is desirable to restore granules that have been marked for deletion (although
not yet actually removed physically from the archive), the Granule Deletion Tool provides an
undelete capability. This is implemented by command line options for use with the command
EcDsGranuleDeleteClientStart and its selected options as follows:

-undelphysical to undelete granules marked logically deleted by the -physical
option;

-undel DFA to undelete granules marked logically deleted by the -DFA option;
-displayUndelPhysical to display granules that will be undeleted with the
-undelphysical option and other selected options (Note: the number of granules
returned with this option is limited by MaxGeoidFileLines and MaxCollectorSize
parameters in the EcDsGranuleDel ete.CFG file and/or the DBMAXRESULTS
parameter for the Science Data Server);

-displayUndelDFA to display granules that will be undeleted with the -undelDFA
option and other selected options (Note: the number of granules returned with this
option is limited by MaxGeoidFileLines and MaxCollectorSize parametersin the
EcDsGranuleDelete.CFG file and/or the DBMAXRESULTS parameter for the
Science Data Server).

These options are used in conjunction with other command line options of the Granule Delete
tool. For example, it is possible to undelete or display granules using the command line options
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for selection by ESDT short name, version, and granule time coverage, or to undelete or display
granules using the command line option to specify a separate input file.

17.5 Backing Up and Restoring AMASS

A key responsibility of the Archive Manager is to guard against loss of the AMASS database and
functioning. Thisis achieved through creation of backups that can be used to restore functioning
in the event of database corruption or other failure. The archive storage format used by AMASS
iIsaproprietary format designed to optimize storage and retrieval speed. The command vgexport
-q can be used to create a text file, storable on magnetic media, which can be used with the
AMASS format archive tapes and the command vgimport to recover from the loss. This
command exports the AMASS database for a specified volume group to standard out (stdout), a
file containing the directory structure and media attributes (e.g., media type, ownership,
timestamp) for the volume group. The file islocated in /usr/amass/filesysdb and is exported as
standard ASCI| text.

Table 17.5-1 provides an Activity Checklist for activities related to backing up and restoring
AMASS.

Table 17.5-1. Activity Checklist for Backing Up and Restoring AMASS

Order Role Task Section Complete?
1 Archive Manager/ Creating a Backup for AMASS (P)17.5.1
System
Administrator
2 Archive Manager/ Replacing the AMASS Database (P)17.5.2
System Backup Volume (Volume 1)
Administrator
3 Archive Manager/ Restoring the AMASS Database (P)17.5.3
System
Administrator

17.5.1 Creating a Backup for AMASS

Table 17.5-2 presents the steps required to create a backup for AMASS. If you are aready
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed
procedure:

1 Log into the FSMS host (e.g., €0drgl1, g0drg01, 10drg01, or n0drg01) as amass or r oot.

2 Type /usr/amass/bin/vgexport -g and then press the Retur n/Enter key.
» A filenamed stdout is created in /usr/amass/filesysdb.

17-34 611-EMD-001




NOTE: The stdout fileisuseful only with the archive volumes represented in the
AMASS database.

Table 17.5-2. Creating a Backup for AMASS

Step What to Do Action to Take
1 Log in as amass or root enter text; press Return/Enter
2 vgexport —q enter text; press Return/Enter

17.5.2 Replacing the AMASS Database Backup Volume (Volume 1)

The AMASS database backup is stored in the archive on Volume 1. "Volume 1," hard coded to
be the backup volume, actually designates one of the last volumes in the StorageTek Library
Storage Module, to prevent its inadvertent use as a data volume. Whenever amassbackup is
run, AMASS issues an e-mail message with information on volume capacity and usage. Itisalso
possible to issue the command vollist 1 to display how much space is left on the volume, or
volprint 1 for till more detail. If the volume becomes full during a backup attempt, the backup
will fail and it is necessary to initialize a new backup volume and perform a full backup as
described in the following procedure. Table 17.5-3 presents the steps required to replace the
AMASS database backup volume. If you are already familiar with the procedure, you may
prefer to use this quick-step table. If you are new to the system, or have not performed this task
recently, you should use the following detailed procedure:

1 Log into the FSMS host (e0drg11, g0drg01, 10drg01, or n0drg01) as amass or r oot.

2 Type /usr/amasg/bin/voloutlet 1 and then press the Return/Enter key.
* TheLSM robot places the Backup Volumein the CAP.

3 Open the recessed latch on the CAP door; remove the Backup Volume tape and storeiit in
asafe place.

4 Physically designate the new Backup Volume tape so that it can be easily discriminated
from other volumes (e.g., write “Backup Volume” on the tape, color code the tape, or
make and display a note of its home storage slot or preprinted barcode).

5 Note the pre-printed number on the volume label (e.g., 112102), insert the new Backup
Volume in the CAP, and close the door.
* Therobot scans the volume.

6 At the AMASS host, type /usr/amass/bin/bulkinlet -u and then press the Return/Enter

key.
*  AMASS assigns the Backup Volume a unique volume number.
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*  AMASS marksthe volume ONLINE in the AMASS database.
*  AMASS assigns the Backup Volume to the last barcode position in the library.
*  AMASS givesthevolumeaBACKUP VOLUME labdl.

Type /usr/amass/bin/vallist 1, and then press the Return/Enter key.
*  AMASS displays the following:

VOL VOL JUKE POSs VoL FLAGS USED AVAIL DEAD ERRS
NUM GRP NUM LABEL (MB) (MB) (%
1 0 1 BACKUP- VOLUVE | 0 20000 O 0

To change the Volume Label field from BACKUP-VOLUME to the preprinted media
number (e.g., 112102), type /usr/amass/bin/vollabel 1 112102 and then press the
Return/Enter key.

Type /usr/amasg/bin/vollist 1, and then press the Return/Enter key.
*  AMASSdisplaysthe following:

VOL VOL JUKE POS VOL FLAGS USED AVAIL DEAD ERRS
NUM GRP NUM LABEL (MB) (MB) (%
1 0 1 112102 | 0 20000 O 0

Type /usr/amass/bin/volfor mat -u and then press the Retur n/Enter key.
* A message requests confirmation that you wish to continue.

Typey and then press the Return/Enter key.
* A messageisdisplayed requesting further confirmation, stating that The following
volumes will be formatted: 1 (Y-N).

Typey and then press the Return/Enter key.
» After afew minutes, a message Completed formatting all volumesis displayed.

To verify that the volume isinserted, type /usr/amass/bin/vollist 1 and then press the

Return/Enter key.

» Datafor the media are displayed; the flag column shows that the newly formatted
volumeisinactive (1).

Type /usr/amass/bin/amassbackup -fv and then press the Return/Enter key.

*  AMASS performs afull backup with the verbose option of the AMASS database and
transaction logs.
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Table 17.5-3. Replacing the AMASS Database Backup Volume

Step What to Do Action to Take

1 Log in as amass or root enter text; press Return/Enter
2 voloutlet 1 enter text; press Return/Enter
3 Remove Backup Volume open CAP door

4 Physically designate Backup Volume mark volume

5 Note pre-printed number on volume label read label

6 bulkinlet —u enter text; press Return/Enter
7 vollist 1 enter text; press Return/Enter
8 vollabel 1 nnnnnn (number from Step 5) enter text; press Return/Enter
9 vollist 1 enter text; press Return/Enter
10 volformat —u enter text; press Return/Enter
11 Y (to continue) enter text; press Return/Enter
12 Y (to confirm volume to be formatted) enter text; press Return/Enter
13 vollist 1 enter text; press Return/Enter
14 amassbackup —fv enter text; press Return/Enter

17.5.3 Restoring the AMASS Database

The AMASS database is restored manually by the System Administrator or the Archive Manager
using the AMASS command amassrestore. This command restores the last full backup, the last
partial backup, and all journal transactions that have occurred since the last backup. It creates a
sub-directory under filesysdb called journal. All restored files are copied to the journal
directory. The following restore procedure uses a backup volume or tape device. Table 17.5-4
presents the steps required to restore the AMASS database. If you are already familiar with the
procedure, you may prefer to use this quick-step table. If you are new to the system, or have not
performed this task recently, you should use the following detailed procedure:

1 Log into the FSMS host (e0drg11, g0drgO1, 10drg01, or n0drg01) as amass or root.

Caution

Do not use the amassr estor e command when AMASS is
running. To shutdown AMASS, refer to the Special
Shutdown Procedures in the AMASS technical
documentation Installing AMASS,

2 To inactivate the AMASS file system, type /usr/amass/bin/amassstat -i.
» The AMASSfile system isinactivated.
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3 Make sure the backup drive is available.
» If thereisanother volumein the drive, return it to its home slot by entering
/usr famass/daemons/amassr ecovery -s (the option -s prevents system startup and
performs file recovery).

4 Type /usr/amass/bin/amassr estor e -v -L <barcodelabel> and then press the
Return/Enter key.
» If you do not know the barcode label number for the backup volume, it can be
obtained by entering /usr/amass/bin/vollist 1.
* The AMASS database is restored from the backup volume.

Table 17.5-4. Restoring the AMASS Database

Step What to Do Action to Take

1 Log in as amass or root enter text; press Return/Enter

2 amassstat —I enter text; press Return/Enter

3 Ensure backup drive is available (if necessary, enter text; press Return/Enter
/lusr/lamass/daemons/amassrecovery -s)

4 amassrestore -v -L <barcodelabel> enter text; press Return/Enter

17.6 Backing Up and Restoring Archived Data

The ECS archive design incorporates programmed backups of archived data.  System
requirements specify that a percentage of archived data be duplicated for local and offsite storage
to provide for data safety. However, the large volume of ECS archived data merits finding
aternatives to complete backup of all volumes in the libraries. Selection of data for backup is
based on assessment of the feasibility of recovery in the event of dataloss.

It is imperative to back up data that would be irretrievable if lost. Such data are saved to the
archive, saved to local backup, and saved to offsite backup. Many data elements that will be
archived, however, could be retrieved in the event of loss. For example, in the event of loss of a
higher level product that is an output of processing a lower level product, it would be possible to
restore the higher level product by reprocessing the lower level product. As another example,
ECS will often archive a lower level product from a data provider, but that product may also be
retained in the archives of the data provider, as is the case with EDOS, where there are
maintained archives of Level 0 products that are also provided to ECS. If the product were lost
from the ECS archive, it would be possible to ingest it again from the data provider, using
appropriate Ingest procedures. Also, ECS archives can provide replacement for lost Level 0 data
at EDOS.

Thus, when unique data are inserted into the archive (e.g., through Ingest, from Processing), up
to three copies of the data may be created, reflecting different types of data use:
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the active archive copy, available for distribution or other use (volume group is
specified in the Archive ID).
acopy to be retained for local backup (volume group is specified in the Backup ID).
acopy to be sent to offsite backup storage (volume group is specified in the Offsite

ID).

The Archive Manager has the responsibility for ensuring and managing necessary backups of
archived data and, in the event of loss, executing or supporting efforts to recover lost data. Table

17.6-1 provides an Activity Checklist for backing up and restoring archived data.

Table 17.6-1. Activity Checklist for Backup and Restoration of Archived Data

Order Role Task Section Complete?
1 Archive Manager/ Creating Offsite Backups (P)176.11
Science Data
Specialist
2 Archive Manager/ Creating Replacement Backups (P)17.6.1.2
System Manually from Existing Archives
Administrator
3 Archive Manager Manual Data Recovery from Local (P)17.6.21
Backup Tapes
4 Archive Manager Manual Data Recovery from Offsite (P)17.6.2.2
Backup Tapes
5 Archive Manager Manual Data Recovery from Damaged (P)17.6.2.3
Cartridge
6 Archive Manager Data Recovery for Known Files (P)17.6.2.4
7 Archive Manager SDSRYV Retrieval of File Location (P)17.6.25.1
Metadata
8 Archive Manager SDSRYV Retrieval of Granule Production | (P) 17.6.2.5.2

History Metadata

17.6.1 Backups for Archive Data

The paths for creation of the data copies are specified for each ESDT when it is loaded. The
Archive ID (for the archive copy) and the Backup ID (for the local backup copy) should reflect
different archives if possible (i.e., different Library Storage Modules), to spread the risk of loss.
The Offsite ID will not be arremote site path, but rather alocal path for making copies to be sent
for offsite storage. The requirements to implement creation of offsite backups include:

creating a subdirectory and volume group for offsite backups.
using the Vol Grp Config. tab of the Storage Management GUIs to add the volume

group to the appropriate archive server and set the offsite ID to be the three-character
specification for the local site (e.g., EDC, GSF, LAR, NSC).
adding volumes to the volume group as needed.
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17.6.1.1 Creating Offsite Backups

Each site is responsible for arranging its own secure offsite storage. The offsite backup
cartridges are removed from the archive storage facility using procedures already described (see
Section 17.2.4). For local and/or offsite storage of specific archive data, the Archive Manager
generates or directs the generation of alist of selected data. At the time the files are archived,
they are written to specific and separate volume groups that correspond to the three data usage
types identified previoudy (i.e., active archive, local backup, offsite backup). Only files
belonging to the data usage type are written to the tapes in a specific volume group. The Archive
Manager or Science Data Specialist sets up these volume groups when an Earth Science Data
Type (ESDT) isinstalled. Table 17.6-2 presents the steps required to create offsite backups. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DSS Storage Management GUI using UNIX commands (see Section 17.3.1
Launching DSS GUI s).
* The DSS Storage Management GUI is displayed.

2 Click onthe Vol Grp Config. tab to display the Volume Group information.
* TheVoal Grp Config. tab information is displayed.

3 Click onthe Add . . . button below the VVolume Group Information field.
* TheAdd Volume Group window is displayed.

4 In the Add Volume Group window, click inthe Data Type.Version: field.
* Thecursor movesto the Data Type Version: field.

5 Typethe ESDT ShortName and Version (e.g., MODO01.001) of the data type for which
the volume group isto be created.
* Thetyped entry appearsin the Data Type.Version: field.

6 In the Add Volume Group window, click on the pull-down arrow at the end of the
HWCI: field.
* A pull-down menu displays designators of the hardware configuration items available
for storing data.

7 Click on the designator for the hardware configuration item where the archive copies of

datafor the ESDT are to be stored.
» Theselected designator is displayed in the HWCI: field.

8 In the Add Volume Group window, click in the Volume Group Path: field.
* The cursor moves to the Volume Group Path: field.
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Type the full path identification for the storage of active archive datafor the ESDT
(typically, the path will be of the form dss_stkn/<MODE>/xxxxx, where n is a number
designating a StorageTek Library Storage Module, MODE is OPS, TS1, or TS2, and
XXxxx is ashort identifier for what is being stored; e.g., dss_stk1/OPS/modIO0).

* Thetyped entry appearsin the Volume Group Path: field.

In the Volume Group Type: radio box, click on the PRIMARY button.
* The button depressed appearance indicates selection of PRIMARY/, signifying that
the volume group being created is for primary storage for active archive use.

Click on the Save and Add Next VG button at the bottom of the Add Volume Group

window.

» Thevolume group is created for display in the Volume Group I nformation field on
the Vol Grp Config. tab of the Storage Management GUI.

In the Add Volume Group window, click in the Volume Group Path: field.
* The cursor movesto the Volume Group Path: field.

Change the data entered at Step 9 to identify the full path for the storage of local backup
datafor the ESDT.

* Note: Thisstepisonly for those ESDTs that require local backup.

* Thetyped entry appearsin the Volume Group Path: field.

In the Volume Group Type: radio box, click on the BACKUP button.
» The button depressed appearance indicates selection of BACK UP, signifying that the
volume group being created is for storage for local backup use.

Click on the Save and Add Next VG button at the bottom of the Add Volume Group

window.

* Thevolume group is created for display in the Volume Group I nformation field on
the Vol Grp Config. tab of the Storage Management GUI.

In the Add Volume Group window, click in the Volume Group Path: field.
* The cursor movesto the Volume Group Path: field.

Change the data entered at Step 13 to identify the full path for the creation and initial
storage of offsite backup data for the ESDT.

* Note: Thisstepisonly for those ESDTs that require offsite backup.

* Thetyped entry appearsin the Volume Group Path: field.

In the Volume Group Type: radio box, click on the OFFSITE button.
» The button depressed appearance indicates selection of OFFSITE, signifying that the
volume group being created is for creation and initial storage for offsite backup use.
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19 Click on the Save and Exit button at the bottom of the Add Volume Group window.
* Thevolume group is created for display in the Volume Group I nformation field on
the Vol Grp Config. tab of the Storage Management GUI.
» Datastored in the volume group for OFFSITE backup can be safeguarded by
removing tapes that have data stored on them (see Section 17.2.4) and transporting
the tapes to a secure offsite storage location.

Table 17.6-2. Creating Offsite Backups

Step What to Do Action to Take
1 Launch the DSS Storage Management GUI Use procedure in Section 17.3.1
2 Select Vol Grp Config. tab single-click

3 Click Add . . . button single-click

4 Data Type.Version field single-click

5 Enter ESDT ShortName and Version enter text

6 Display HWCI: pull-down menu single-click

7 Select HWCI: single-click

8 Volume Group Path: field single-click

9 Identify active archive path enter text

10 Select PRIMARY volume group type single-click

11 Activate Save and Add Next VG button single-click

12 Volume Group Path: field single-click

13 Identify local backup path enter text

14 Select BACKUP volume group type single-click

15 Activate Save and Add Next VG button single-click

16 Volume Group Path: field single-click

17 Identify offsite backup path enter text

18 Select OFFSITE volume group type single-click

19 Activate Save and Exit button single-click

17.6.1.2 Creating Replacement Backups Manually from Existing Archives

If loss of data necessitates obtaining and inserting backup data from local or offsite storage, it is
necessary to create replacement data to be returned to backup storage. Table 17.6-3 presents the
steps required to create replacement backups manually from existing archives. If you are already
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed
procedure:

1 Log into the FSMS host (e0drg11, g0drgO1, 10drg01, or n0drg01) as amass or r oot.
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2 Type /usr/amass/bin/volcopy -c <source> < destination > (where <destination> is the
volume number of the destination volume and <source> is the volume number of the
source volume), and then press the Retur n/Enter key.

» The-c option specifies copy of the source to the destination.

» A hit for bit copy of the source (the cartridge to be copied) is made at the destination
(an available, unused cartridge). Because the copy procedure depends on the amount
of data on the source cartridge, the process can take as long as an hour to complete.

* Note: After starting avolcopy procedure, do not attempt to kill the process with the
Kill -9 command.

3 A hardcopy/softcopy list of the files backed up should be created and kept for future file
restoration operations.

4 Remove the backup volume(s) and send to offsite storage area, as appropriate.

Table 17.6-3. Creating Replacement Backups Manually from Existing Archives

Step What to Do Action to Take

1 Log in as amass or root enter text; press Return/Enter
2 volcopy -c <source> <destination> enter text; press Return/Enter
3 Add to list of backed up files for future reference print list

4 Send backup to secure offsite storage

17.6.2 Restoring Archive Data

Although the Archive hardware is highly reliable, errors due to tape or drive failure must be
expected to occur, though at an extremely low rate, as a function of the archived data volume.
Where errors have occurred and data has been lost from the archive and cannot be restored from
backup there may exist the potential to recover and re-archive equivalent data by one of the
following means:

» copying from backup onto the original or anew primary.

* replacing damaged or corrupted volumes with vendor restored or backup volumes.
e re-generation by reprocessing.

» obtaining replacement data from the original external provider.

If a backup volume is available and contains the data that were lost or corrupted on the primary
copy, the data can be copied using standard UNIX commands. If the backup volume must be
obtained from offsite storage, it must then be inserted into the archive and brought on line. The
procedures for loading archive media were addressed under a preceding topic. The requirements
then entail:

» using the Storage Config. tab of the Storage Management GUIs to view the volume
groups of the appropriate archive server and to find the filesin the primary and
backup volume groups.
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» using the UNIX copy command (cp or dd) to copy the lost or corrupted file from the
backup version to the primary version.

» asappropriate (i.e., if the recovery isone of aset of filesto be restored, for example,
because they were lost from a damaged tape), removing the names of the files
recovered from the list of files to be recovered by other means.

If an entire volume is to be copied, perform the procedure to create replacement backups (see
Section 17.6.1.2); if recovery isfrom offsite, send the backup back to secure offsite storage.

17.6.2.1 Manual Data Recovery from Local Backup Tapes

The procedure for manual data recovery from local backup tapes assumes that the tape is on-line
and in the Powderhorn Library Storage Module. Volume groups and tapes are transparent to the
automated file and storage management system. As long as the AMASS database is aware of the
files, the operator moves data using standard UNIX commands.

Table 17.6-4 presents the steps required for manua data recovery from local backup tapes. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DSS Storage Management GUI using UNIX commands (see Section 17.3.1).
* The DSS Storage Management GUI is displayed.

2 Click onthe Vol Grp Config. tab to display volume group information.
* TheVol Grp Config. tab is displayed.

3 Click in the Find Next field under the Volume Group Information field.
» The cursor movesto the Find Next field.

4 Typethefirst three letters of the ESDT short name for the data type with missing or
corrupted/damaged files on its primary storage tape.
* Thetyped entry isdisplayed in the field.

5 Click on the Find Next button.
e IntheVolume Group Information field, the volume group information for the first
volume group containing the three letters specified in Step 4 is highlighted.

6 As necessary, scroll further through the list of entriesin the Volume Group Information
field to locate the Current Volume Group Path for the primary and backup storage for
the data type with missing or corrupted/damaged files on its primary storage tape; note or
record the paths.
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In aUNIX window, at the command line prompt, type cp <backuppath/filename>
<primarypath/filename> and press the Retur n/Enter key.
» Thebackup fileis copied to the primary tape.
Repeat Step 7 as needed until all missing or corrupted/damaged files are restored from the
backup tape to the primary tape.
Remove the file(s) restored in Steps 7 and 8 from any list of files to be recovered.
Table 17.6-4. Manual Data Recovery from Local Backup Tapes
Step What to Do Action to Take
1 Launch the DSS Storage Management GUI Use procedure in Section 17.3.1
2 Select Vol Grp Config. tab single-click
3 Find Next field single-click
4 Specify search token enter text
5 Activate Find Next button to start search single-click
6 Locate and record primary and backup paths click and drag to scroll; read
text
7 cp <backuppath/filename> <primarypath/filename> | enter text; press Return/Enter
8 Repeat Step 7 (as necessary)
9 Remove restored files from list of files to be recovered

17.6.2.2 Manual Data Recovery from Offsite Backup Tapes

Each site has its own arrangements for managing data requiring secure offsite backup storage. In
the event of loss of data on primary and local backup tapes, recovery may be possible using
offsite backup tapes. Table 17.6-5 presents the steps required for manual data recovery from
local backup tapes. If you are aready familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1

Launch the DSS Storage Management GUI using UNIX commands (see Section 17.3.1).
* The DSS Storage Management GUI is displayed.

Click onthe Vol Grp Config. tab to display volume group information.
* TheVol Grp Config. tab is displayed.

Click in the Find Next field under the Volume Group Information field.
» The cursor movesto the Find Next field.
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Typethefirst three letters of the ESDT short name for the data type with missing or
corrupted/damaged files on its primary and local backup storage tapes.
» Thetyped entry isdisplayed in the field.

Click on the Find Next button.
e IntheVolume Group Information field, the volume group information for the first
volume group containing the three letters specified in Step 4 is highlighted.

As necessary, scroll further through the list of entriesin the Volume Group Information
field to locate the Current Volume Group Path for the primary and offsite storage for
the data type with missing or corrupted/damaged files on its primary and local backup
storage tapes; note or record the paths.

Login at the FSMS SGI host (workstation xOdr g##).

» Thex inthe workstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n =NSIDC, 0 = ORNL, a=ASF, ] = JPL; the ## will be
an identifying two-digit number (e.g., nOdrgO1 indicates an FSMS SGI server at
NSIDC).

To identify the offsite volume ID where a known file to be recovered is stored, on the

FSMS host, at the command line prompt in a UNIX window, type

lusr famass/utils/fileprint <filepathname/filename>, where filepathname/filenameis

the path and name of thefile, and press the Return/Enter key.

*  AMASS returns database information for each location where the fileis stored. For
example, if the input filepathname and filename for alost or damaged file is
/dss_stk1/aster/:Science:AST_L1BT:2137:1.EOSHDF, the output returned by

AMASS should look similar to the following:
FI LE : Sci ence: AST_L1BT: 2137: 1. ECSHDF :

rid = 5993

prid = 4749

si ze = 5410105 (0x528d39)
start blk = 37750397

vol = 18

| tvol = 18

node = 81la4

i nks = 1

ncrc = 4195

flags = 0

* Thisindicates that the file should be on volume 18. Similar output should be returned
for each volume involved in storage of the file.
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To determine if the offsite volume isin the archive, on the FSM S host, at the command
line prompt in a UNIX window, type /usr/amass/bin/vollist <volumenumber>, where
volumenumber isthe volume ID returned in Step 8, and press the Retur n/Enter key.

* AMASS returnsinformation about the requested volume. This step can be repeated

for each volume ID returned in Step 8. If the return is similar to the following:
VOL VOL JUKE PCS VOL FLAGS USED AVAIL DEAD ERRS

NUM GRP NUM LABEL (MB) (MB) (9
18 700 1 NET SD2102 O 35589 0 35 0

e thelO inthe FL AGS column indicates that the volume isinactive and offline-- i.e.,
the volumeis not in the Library Storage Module. The offsite backup volume will
have this statusiif it is not in the archive and needs to be retrieved from offsite storage.

Retrieve the volume from offsite storage and insert it in the Library Storage Module (see
Section 17.2.1), using the command /usr/amass/bin/bulkinlet <volgrp>, where volgrp is
the identifier in the VOL GRP column of the returnin Step 9.

* The CAP door unlocks (audible unlatching sound).

Open the recessed latch on the CAP door and insert the tape(s), solid black side up, with

the bar code label facing you, and close the door

* Therobot scans the volume(s) and makes the insertion into the volume group
specified in Step 10.

To recover afile from the newly inserted offsite backup volume, in a UNIX window, at
the command line prompt, type cp <offsitepath/filename> <primarypath/filename> and
press the Return/Enter key.

* Thebackup fileis copied to the primary tape.

Repeat Step 12 as needed until all missing or corrupted/damaged files are restored from
the offsite tape to the primary tape.

Remove the file(s) restored in Steps 12 and 13 from any list of files to be recovered.

Table 17.6-5. Manual Data Recovery from Offsite Backup Tapes (1 of 2)

Step What to Do Action to Take

Launch the DSS Storage Management GUI Use procedure in Section 17.3.1

Select Vol Grp Config. tab single-click

Find Next field single-click

Specify search token enter text

Activate Find Next button to start search single-click

|| |W[IN|F

Locate and record primary and offsite backup paths click and drag to scroll; read
text

Log in at FSMS host enter text; press Return/Enter
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Table 17.6-5. Manual Data Recovery from Offsite Backup Tapes (2 of 2)

Step What to Do Action to Take

8 lusr/amass/utils/fileprint <filepathname/filename> enter text; press Return/Enter;
read text

9 Ivollist <volumenumber> enter text; press Return/Enter;
read text

10 bulkinlet <volgrp> volume retrieved from offsite enter text; press Return/Enter

11 Insert the tape in the CAP close door

12 cp <offsitepath/filename> <primarypath/filename> | enter text; press Return/Enter

13 Repeat Step 12 as needed

14 Remove restored files from list of files to be recovered

17.6.2.3 Manual Data Recovery from Damaged Cartridge

In the course of operationsit is possible for a tape to become physically damaged or accidentally
overwritten. Some indications of a damaged tape may be AMASS read/write errors, or AMASS
may determine that the volume is unreadable and mark it inactive. In that event that a tape
volume is damaged, a manual recovery of datafrom the cartridge must be attempted.

Because of the technica complexity of data recovery from a damaged cartridge, it will be
performed by STK personnel. However, the Archive Manager can support and prepare for the
process by listing all the files on the tape and their associated start block numbers and providing
the list to the recovery personnel. The list is generated by using a Per| utility script. The utility
will generate three ASCII files that must be provided to the STK recovery personnel along with
the damaged tape. The files are: filelist_<volnumber>, start_block_listing_volnumber>, and
README_<volnumber>, where volnumber is the volume number of the requested tape
volume.

The script utility, EcDsStFilesPer TapeUtility, is located in the directory
/usr/ecs/<MODE>/CUST OM/utilities. The script produces directory information followed by
threefiles.

The directory information output should be similar to the following example:

/ dat al/ dat a/ : BR: Browse. 001: 1170: 1. Bl NARY

/ dat al/ dat a/ : BR: Browse. 000: 1170: 1. Bl NARY

/ dat al/ dat a/ : SC: MOD00: 65001: 1. CCSDS

/ dat al/ dat a/ : SC: MOD00: 65002: 1. CCSDS

/ dat al/ dat a/ : SC: MOD0O: 20001: 1. CCSDS

/ dat al/ dat a/ : PH: PH. 001: 2000000076: 1. Bl NARY
/ dat al/ dat a/ : PH: PH. 000: 2000000076: 1. Bl NARY

/ dat al/ dat a/ : QA: QA. 001: 1003: 1. ASCI |
/ dat al/ dat a/ : QA: QA. 001: 1004: 1. ASCI |
/ dat al/ dat a/ : QA: QA. 001: 1005: 1. ASCI |
/ dat al/ data/: OR OR 001: 2100: 1. ASCI |
/ dat al/ data/: OR OR 001: 2101: 1. ASCI |
/ dat al/ data/: OR OR 001: 2102: 1. ASCI |

17-48 611-EMD-001



/ dat al/ dat a/ : OR; OR. 001: 2103: 1. ASCI |

/ dat al/ dat a/ : AN: AN. 001: 3100: 1. ASCI |

/ dat al/ dat a/ : AN: AN. 001: 3101: 1. ASCI |

/ dat al/ dat a/ : AN: AN. 001: 3102: 1. ASCI |

/ dat al/ dat a/ : AN: AN. 001: 3103: 1. ASCI |
The information in the file filelist_<volnumber> isin ASCII format with one file name per line,
asin the following example:

/dss_stk2/joel/Test StdSeq6_0_ 10. wrt

/dss_stk2/joel/ Test StdSeq6_0_ 10. wrt

/dss_stk2/joel/ Test StdSeq6_0_ 10. wrt

/dss_stk2/joel/Test StdSeq6_0_ 10. wrt

/dss_stk2/joel/ Test StdSeq6_0_ 10. wrt
Table 17.6-6 presents the steps required for manual data recovery from a damaged cartridge. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Loginasamassor root at the FSMS SGI host (workstation xOdr g##, xacg##, or
XWK g##).
» Thex inthe workstation name will be aletter designating your site: g = GSFC, m =
SMC, | =LaRC, e=EDC, n=NSIDC, 0 =0RNL, a=ASF, | = JPL; the ## will be
an identifying two-digit number (e.g., nOdrgO1 indicates an FSM S SGI server at
NSIDC).

2 To verify that AMASS is running, type /usr/amass/bin/amassstat -c and press the
Return/Enter key.
* Themessage FILESYSTEM ISACTIVE should be displayed. If itisnot, restart
AMASS using Section 17.1.1.

3 To identify the volume ID where aknown file to be recovered is stored, on the FSMS
host, at the command line prompt in a UNIX window, type /usr/amass/utils/fileprint
<filepathname/filename>, where filepathname/filename is the path and name of the file,
and press the Return/Enter key.

*  AMASS returns database information for each location where the fileis stored. For
example, if the input filepathname and filename for alost or damaged file is
/dss_stk1/aster/:Science:AST_L1BT:2137:1.EOSHDF, the output returned by

AMASS should look similar to the following:
FI LE : Sci ence: AST_L1BT: 2137: 1. ECSHDF :

rid = 5993

prid = 4749

si ze = 5410105 (0x528d39)
start blk = 37750397

vol = 18

| tvol = 18

node = 81la4

i nks = 1

ncrc = 4195

flags = 0
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» Thisindicates that the file should be on volume 18. Similar output should be returned
for each volume involved in storage of the file.

Remove the volume from the archive (see Section 17.2.4).

Inspect the physical cartridge and tape for damage. Any creasing, scratches, snapping, or
stretching of the tape may warrant keeping the volume offline and sending it to STK for
replacement.

If the cartridge is damaged and to be returned to STK for recovery of data, run the script
EcDsStFilesPer TapeUtility script; to start the utility script, type the command:
/usr/ecs)<MODE>/CUST OM/utilities’EcDsStFilesPer TapeUtility and press the
Return/Enter key.

* Thescript runs and prompts for input of the volume number, as follows:
You have invoked an ECS utility script.

This script supports file recovery froman AVMASS tape vol une
by generating two listings of the files located on that vol une.
The listings are ASCII files and can be viewed.

AMASS nust be running in order to generate one of the listings.
If a .fileprint. use error nmessages result, nake sure AVASS is
runni ng, and you have AMASS privil eges, before invoking this
utility again.

Pl ease enter the AMASS vol ume nunber,
for which you wish to generate |istings

-->

Type the volume ID determined in Step 3 and press the Return/Enter key.

» Thescript runs and a message is displayed to indicate generation of the information
and completion of the run. The two ASCII files arefilelist_<volnumber> and
start_block _listing_volnumber>. Thereisaso aREADME_<volnumber> file.

Send the volume to STK along with the files generated by the perl utility.

» STK copiesall uncorrupted datato a new tape and inserts filler data blocks to replace
the lost data.

» Thefiller dataisinserted using the origina block sequence so that the remaining data
can be accessed by AMASS.

» After copying of the datato a new cartridge, it is returned to the DAAC with the
origina volume label and areport indicating which data blocks were replaced with
filler data

17-50 611-EMD-001



10

11

12

13

14

After receiving the recovered tape back from STK, insert the tape into the library (see
Section 17.2.1), using the command /usr/amass/bin/bulkinlet <volgrp>, where volgrp is
the volume group number. (Note: If you do not know the volume group number, you
can determine it by using the vollist command with the volume ID obtained in the return
from Step 3).

*  AMASS reads the volume label and places the volumein its home slot.

To put the volume online, type volloc -n <volumenumber>, where volumenumber isthe
volume ID obtained in the return from Step 3, and press the Retur n/Enter key.
* Thevolumeis marked O (online) in the database.

To activate the volume, type the command /usr/amass/bin/volstat -a <volumenumber>,
where volumenumber is the volume ID obtained in the return from Step 3, and press the
Return/Enter key.

* Thevolumeismarked A (active) in the database.

Using the report provided by STK, determine which files have had data blocks replaced
with filler and delete those files from AMASS using standard UNIX commands. All such
files must be recorded on alist of non-recovered files. To delete afile, type the command
rm filepathname/filename where filepathname/filename is the path and name of thefile,
and press the Return/Enter key.

* Thefileisremoved.

To assess dead space on the tape, type /usr/amass/bin/vollist <volumenumber>, where
volumenumber isthe volume ID, and press the Return/Enter key.
* AMASS returns information about the requested volume similar to the following

example:

VOL VOL JUKE PCS VOL FLAGS USED AVAIL DEAD ERRS
NUM GRP NUM LABEL (MB) (MB) (%

18 700 1 NET SD2102 A 35589 0 85 0

» If theamount of dead space created on the tape exceeds the allowed threshold, the
files can be copied to another volume within the volume group and the tape can be
reformatted (see "Recycle aVolume' in the AMASS System Administrator’s Guide).

Retrieve the file location metadata to recover the Archivel D and any checksum for each

file (see Section 17.6.2.5.1).

» The system design incorporates cal culation of a checksum when agranuleisinserted
into the archive. However, calculation of checksums can be time consuming, and
therefore to improve system performance checksums are only calculated for a small
percentage of granules on arandom basis.

17-51 611-EMD-001



15

16

17

For files with a non-zero checksum returned by SDSRV (Step 14), to validate the
checksum of the recovered file type cksum <filepathname/filename>, where
filepathname/filename is the path and name of the recovered file.

The system returns one line with three parameters per input file, similar to the

following example:
cksum : Sci ence: MOD29: 2498: 1. ECSHDF
1295913534 10892630

: Sci ence: MOD29: 2498: 1. ECSHDF
Thefirst parameter is the checksum (the second is the number of octets, and the third

isthe filename). If this returned checksum does not match the SDSRV-generated
checksum (from Step 14), repeat Step 12 to delete thefile.

For files with a checksum of zero returned by SDSRV (Step 14), it may be possible to
have a Science Data Specialist use aviewing tool (e.g., EOSView) to exercise some
validation on thefiles. It may also be possible to use information supplied be STK
identifying corrupt blocks on the tape, in conjunction with the datain the
start_block_listing_volnumber file, to determine specific files that are corrupt and
recover the remaining files. The conservative approach isto assume that all zero-
checksum files are corrupt and repeat Step 12 to delete them.

Add non-recovered filesto the list of filesto be recovered by other means (see Section
17.6.2.4).

Table 17.6-6. Manual Data Recovery from Damaged Cartridge (1 of 2)

Step

What to Do

Action to Take

Log in at FSMS host as amass or root

enter text; press Return/Enter

amassstat -c

enter text; press Return/Enter

/usrlamass/utils/fileprint <filepathname/filename>

enter text; press Return/Enter

Remove the volume from the archive

Use procedure in Section 17.2.4

Inspect the cartridge and tape for damage

observe

EcDsStFilesPerTapeUtility

enter text; press Return/Enter

Volume ID (from Step 3)

enter text; press Return/Enter

Send volume and file information to STK

OO [([N|O|O|_W[IN|F

bulkinlet <volgrp> volume returned from STK

enter text; press Return/Enter

(=Y
o

volloc -n <volumenumber>

enter text; press Return/Enter

=
=

volstat -a <volumenumber>

enter text; press Return/Enter

[y
N

rm filepathname/filename

enter text; press Return/Enter

[EnY
w

vollist <volumenumber>

enter text; press Return/Enter

H
o

Retrieve file location metadata

Use procedure in Section
17.6.25.1

iy
a1

cksum <filepathname/filename> (files with non-zero
checksum from SDSRV); delete files with non-match)

enter text; press Return/Enter

[EnY
[ep)

Other validation for files with zero checksum (e.g.,
EOSVIEW, recover non-corrupt files), or delete
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Table 17.6-6. Manual Data Recovery from Damaged Cartridge (2 of 2)
Step What to Do Action to Take

17 Add non-recovered files to list of files to be recovered See procedure in Section
by other means 17.6.2.4

17.6.2.4 Data Recovery for Known Files Not Backed Up in ECS

For any set of known files to be recovered (e.g., alist of files that were on a damaged tape and
could not be recovered by Section 17.6.2.3, and were not available in local or offsite backups),
data recovery can be attempted through procedures such as re-ingest, obtaining the data from
another DAAC that was the original source, or regeneration. Each of these potential recovery
approaches is addressed in a separate procedure.

The results of file or granule recovery are dlightly different depending on whether the lost files
are recovered from backup, or the corresponding lost granule had to be re-archived after re-ingest
or re-generation by PDPS. Files which are recovered within the Archive/STMGT procedures are
re-archived under the same name, so that the affected granule(s) are restored as they were before
thefailure.

Where file recovery within STMGT control is not possible, granule recovery through re-ingest or
re-generation results in the insertion of a new granule. This new granule has a new Universal
Reference (UR) and a new 'Production Date and Time'. Particularly where granule re-generation
isrequired, exact re-production of the original granule (data byte-for-byte) is not guaranteed.

17.6.2.4.1 Re-Ingest of Lost Data

Table 17.6-7 presents the steps required for re-ingest of lost data. If you are aready familiar with
the procedure, you may prefer to use this quick-step table. If you are new to the system, or have
not performed thistask recently, you should use the following detailed procedure:

1 Identify the source for each of the lost granules that were ingested.

2 If you have not already done so, retrieve the file |ocation metadata for each file (see
Section 17.6.2.5.1).

3 With reference to the applicable Interface Control Document (1CD) and using the granule

metadata retrieved in Step 2, initiate the required data re-supply requests as defined in the

ICD for those data suppliers able to re-supply data.

* Tore-order Level O production data sets (PDSs) from EDOS, the DAACS use the
ESDIS-sponsored EOS Data Reorder Web Tool. Steps 4 through 26 address use of
the tool to submit are-order request.
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» EDOS furnishes LO replacement data to the GSFC Earth Sciences (GES) DAAC on
DTF-2 tapes. A tape may contain multiple granules and files, a subset of which are
needed to replace the lost granule(s). Steps 27 through 54 address recovery of the lost
data.

» EDOS furnishes LO replacement data to other DAACs that do not have DTF-2 tape
drives. Inthis case, EDOS transfers the necessary PDS(s) to ECS in the automated
Ingest process for polling with delivery record, monitored by the Ingest Technician
using the M onitor/Control Ingest Requests procedure (see Chapter 16). The
re-order is accomplished as specified in Steps 4 through 26; the only other necessary
stepsin this procedure are Steps 45, 48, and 49.

NOTE: Some data suppliers (e.g., Landsat-7) do not support re-supply of data.

NOTE: Steps 4 through 8 are to access and launch browser software.

4 At the UNIX command shell prompt, type setenv DISPLAY clienthame: 0.0 and then
press the Return/Enter key.
* For clientname, use either the local terminal/workstation | P address or its machine
name.

5 Start the log-in to a Netscape host by typing /tools/bin/ssh hostname (e.g., g0ins02,
e0ins02, 10ins02, n0ins02) at the UNIX command shell prompt, and press the
Return/Enter key.

* If you receive the message, Host key not found from thelist of known hosts. Are
you sure you want to continue connecting (yes/no)? typeyes (“y” aone does not
work).

» If you have previously set up a secure shell passphrase and executed sshremote, a
prompt to Enter passphrase for RSA key '<user @ ocalhost>" appears; continue
with Step 6.

* If you have not previously set up a secure shell passphrase; go to Step 7.

6 If aprompt to Enter passphrase for RSA key '<user @ ocalhost>" appears, type your
Passphrase and then press the Return/Enter key. Go to Step 8.

7 At the <user @remotehost>'s password: prompt, type your Password and then press the
Return/Enter key.
* Youarelogged inand aUNIX command shell prompt is displayed.

8 Type netscape & and then press the Return/Enter key.
» The Netscape web browser is displayed.
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Click in the Netsite: or Location: field.
» Thefield ishighlighted.

Type the Universal Resource Locator (URL) for the End-to-End Data Tracking System

(http://edtsl.gsfc.nasa.gov:8080/index.html) and then press the Return/Enter key.

* TheEnd-to-End Data Tracking System index page is displayed, offering access to
various reports and related links.

Under Related Links, click on the appropriate Data Reorder link.
* Therearelinksfor various satellite platforms (e.g., Terra, Aqua).
» Theappropriate Data Reorder Request page for the selected Data Reorder link is

displayed.

On the Data Reorder Request page, click on the Add New Request link.
* The Add New Request pageis displayed.

On the Add New Request page, click in the Requestor’s Name field.
» Thecursor isdisplayed in thefield.

Type the name of the person making the request.
* Thetyped entry isdisplayed in the field.

Single-click on the pull-down arrow at the end of the Requestor’s Organization field

and then single-click on the name of the requesting organization to select it, or, if the

requesting organization is not displayed in the pull-down menu, select Other.

* ThechoicesareLaRD DAAC, LaTlS, GSFC DAAC, EDC, EDOS, FOT, ESDIS,
ASTER GDS, and Other.

» Theselected choiceisdisplayed in thefield.

In the Requested Data (UTC) block of the page, single-click on the pull-down arrow at
the end of the Year field and then single-click on the year for the missing data to select it.
* Theselected choiceisdisplayed in thefield.

In the Requested Data (UTC) block of the page, single-click on the pull-down arrow at
the end of the DOY (Day of Year) field and then single-click on the day of the year for
the missing data, first scrolling with the scroll bar if necessary to display the desired day.
» Theselected choiceisdisplayed in thefield.

In the Requested Data (UTC) block of the page, single-click on the pull-down arrow at

the end of the Start time field and then single-click on the hour representing the start of a

two-hour time window for the missing data.

* Thechoices arein even two-hour time intervals beginning with 0000 and proceeding
to 2200.
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» Theselected choiceisdisplayed in thefield.

In the Requested Data (UTC) block of the page, single-click on the pull-down arrow at

the end of the Stop time field and then single-click on the hour representing the end of a

two-hour time window for the missing data.

* Thechoices arein even two-hour time intervals beginning with 0200 and proceeding
to 2400.

* Theselected choiceisdisplayed in thefield.

In the Request Reason block of the page, click on the appropriate radio button to indicate
the reason for the request, specifying that the dataset isMissing or Partial.
» The selected button isfilled to indicate its selection.

For any data priority other than 3, click on the pull-down arrow at the end of the Priority

field and then click on the appropriate priority for the request.

* Thechoicesare 1 (critical data needed within 24-48 hours), 2 (important data
observation or activity, such as atarget of opportunity), and 3 (all other data needs).
The default is 3, and this step may be skipped if that is the priority for the request.

* Theselected choiceisdisplayed in thefield.

Click in the applicable check boxes in the Data type(s) block of the page to specify the
desired FDS or Flight Dynamics System information (Carry-out and APID1 or satellite
housekeeping data, Attitude, and Replacement Ephemeris), L ow Rate information, and
instrument (e.g., MODIS, ASTER, CERES, MOPITT, and MISR) application process
identifiers (APIDS).

» The selected check boxes each display a checkmark to indicate selection.

If it is desirable to enter any comments concerning the request, click in the Comments
field; otherwise, go to Step 25.
e Thecursor isdisplayed in thefield.

Type any comments to be submitted with the request.
» Thetyped entry isdisplayed in the field.

In the Actionee Org block of the page, click on the appropriate radio button to identify
the actionee for the request, specifying EDOS or FOT.
» Theselected button isfilled to indicate the selection (in this case, EDOYS).

Click on the Submit button at the bottom of the form.
» Following confirmation, the request submittal is acknowledged with arequest ID.
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If the replacement data are on a DTF-2 tape from EDOS, load the tape into a DTF-2
drive, using the Perform DTF-2 Drive L oading procedure (see Chapter 16).
* Thetapeisloaded.

Access aterminal window logged in to the appropriate host (e.g., Distribution Server).
» Examples of Distribution Server host names include e0dis02, g0dis02, 10dis02, and
nOdis02.

Type cd path and then press the Return/Enter key.

» path represents the directory path to the location where the data from the EDOS
archive tape should be copied.

» Using an empty directory would help identify the data from the tape.

Typetar xvf device and then press the Return/Enter key.
* deviceisthe DTF-2 drive device name (e.g., /dev/rmt/2n) asit is known to the shell.
* For example:

tar xvf /dev/rmt/2n

» Asfilesareread from the tape the file names, file sizes (in bytes), and number of
blocks are listed on the screen.
- For example:

x DZ9ZA49.M DR, 17393 bytes, 34 tape blocks

Type pg PPMUDR_name and then press the Retur n/Enter key.

PPMUDR_name represents the file name of the PDS Physical Media Unit Delivery
Record (PPMUDR).
- The PPMUDR file name hasa.MDR extension.
— The PPMUDR isthefirst item on the EDOS archive tape.

* For example:

pg DZ9ZA49.MDR

» Although this procedure has been written for the pg command, any UNIX editor or
visualizing command (e.g., Vi, view, mor e) can be used to review the log file.

Observe the contents of the PPMUDR to identify the PDS(s) to be archived.
» Packet date/time rangesin the PPMUDR can be used to determine which PDS(s) is
(are) to be archived.
- Inthe PPMUDR the PDSs on the tape are listed in file groups, which represent
data sets[i.e., science datafile(s) and corresponding metadata file].
— Eachfile group (data set) includes the date/time range of the data specified as
FIRST_PACKET_TIME and LAST_PACKET_TIME.
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For example (extract from a PPMUDR):

OBJECT =FILE_GROUP
DATA_SET_ID = P0420064AAAAAAAAAAAAAA03101231459600
DATA_TYPE = MODO00O

FIRST_PACKET_TIME = 2003-04-10T 00:00:00.000000Z
LAST_PACKET_TIME = 2003-04-10T 01:59:59.999999Z
PACKET_COUNT = NOT USED

OCTET_COUNT = NOT USED

TEST FLAG=F

APID_COUNT =1

OBJECT = APID_SPEC

APID_IN_PDS= 64

END_OBJECT = APID_SPEC

FILE_COUNT =2

OBJECT =FILE_SPEC

DIRECTORY_ID = NOT USED

FILE_ID = PO420064AAAAAAAAAAAAAA03101231459600.PDS
FILE_TYPE = METADATA

FILE SIZE =384

END_OBJECT =FILE_SPEC

OBJECT =FILE_SPEC

DIRECTORY_ID = NOT USED

FILE_ID = PO420064AAAAAAAAAAAAAA03101231459601.PDS
FILE_TYPE = DATA

FILE_SIZE = 108000

END_OBJECT =FILE_SPEC

END_OBJECT =FILE_GROUP

In the preceding example one data set is defined (asa“FILE_GROUP”).

— The datatype for the set is MODOQO.

— The data were collected on April 10, 2003 between midnight GMT
(00:00:00.0000002) (FIRST_PACKET_TIME) and just before 2:.00 A.M. GMT
(01:59:59.9999997) (LAST_PACKET_TIME).

— Therearetwo filesin the dataset (FILE_COUNT = 2).

— Onefile (PO420064AAAAAAAAAAAAAA03101231459600.PDYS) is a metadata
file (in EDOS terminology, a“construction record”).

— The other file (PO420064AAAAAAAAAAAAAA03101231459601.PDS) isa
datafile.

— Based on information embedded in the file names, the data set was created on
April 11, 2003 at 11:14:59 P.M. (as described under the next bullet).

The EDOS archive tape may contain both nominal and reprocessed PDSs but creation

timesin file names differentiate between the versions.

— Ingest the latest (most recent) version if there is more than one version.
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— PDSfile names consist of 40 bytes (characters) and Bytes 23 through 33 specify
the creation time of thefile.
— For example, 03101231459 is the creation time in the following file name:

PO420064AAAAAAAAAAAAAAD3101231459601.PDS
03 indicates the year (2003).
101 specifies the Julian day (April 11, the 101° day of the year).

231459 isthe time of file creation (11:14:59 P.M.).

It isthe Archive Manager’ s responsibility to resolve any questions concerning which
PDSs should be archived (see Step 2).

33 Type cp filenamel filename2 [ ... filenameN] path and then press the Return/Enter key.

NOTE:

filenamel filename2 [ ... filenameN represent the file names of the PDS files to be

ingested.

— Copy both the data and metadata files (as identified in the PPMUDR) for each
data set.

path is the directory path to the Ingest pol|EDOS directory; i.e., the directory in

which the ECS software for EDOS ingest routinely looks for EDOS delivery records

and data.

- The EDOS polling directory is specified as a parameter in the Registry database
or in the configuration file for EDOS polling (e.g., EcInPolling.EDOS.CFG).

For example:

cp PO420064AAAAAAAAAAAAAA03101231459600.PDS
PO420064AAAAAAAAAAAAAAD3101231459601.PDS
/usr [ecss OPS/ICUST OM/icl/x0icg0l/data/polIEDOS

If aDAAC-unique script is available for creating delivery records and signal files
and placing the filesin the polling directory, use the script and skip Steps 34
through 44 (go to Step 45 after running the script). Otherwise, manually generate
delivery records and signal files as described in Steps 34 through 44.

34 Type cd path and then press the Return/Enter key.

NOTE:

path is the directory path to the Ingest pol|EDOS directory.
For example:

cd /usr/ecsOPS/ICUST OM/icl/x0icg0l/data/pollEDOS

Steps 35 through 39 describe how to use an old delivery record (PDR) asa
template for generating anew PDR.

17-59 611-EMD-001



35 Typecp old PDR_filename new PDR filename and then press the Retur n/Enter key.

old_PDR_filename represents the file name of an old PDR that is being used as a

template for creating aPDR for PDS files to be ingested.

new_PDR_filename represents the file name of the new PDR that is being created

for PDSfilesto be ingested.

— Usethe EDOS file-naming convention for PDRs (refer to the EDOS ICD,
423-1CD-EDOSEGYS):

PDR file names consist of 38 bytes (characters).

Byte 1 identifies the file as either a PDS Delivery Record (“X”) or EDS Delivery

Record (“Y™").

Bytes2 through 8 identify the spacecraft ID (SCID) (three bytes) and first
Applications Process Identifier (APID) (four bytes) in the data set (right-justified

and, if necessary, zero-filled on the left).

Bytes 9 through 15 identify the SCID and second APID in the data set (right-
justified and, if necessary, zero-filled on the left), if applicable. If no second

APID is present in the data set, thisitem has avalue of “AAAAAAA”.

Bytes 16 through 22 identify the SCID and third APID in the data set (right-
justified and, if necessary, zero-filled on the left), if applicable. If no second

APID is present in the data set, thisitem has avalue of “AAAAAAA”.

Bytes 23 through 33 identify the GMT/ZULU time when the data set was created.

Byte34 is a numeric identification in the range of “0” to “9” to ad in
distinguishing the order of data set creation during the day and to provide

uniqueness to the file name.

Bytes 35 through 38 are the file name extension (i.e., “.PDR” or “.EDR")
For example:

X0420064AAAAAAAAAAAAAAD31012314596.PDR

X identifiesthe file asa PDS Delivery Record.

0420064 identifies the SCID (042 = Terra) and first APID (0064 = MODO0OO data

type) in the data set.
AAAAAAA indicates that thereis no second APID in the data set.
AAAAAAA indicates that thereis no third APID in the data set.

03101231459 isthe GMT/ZULU time when the data set was created [03 indicates
the year (2003); 101 specifies the Julian day (April 11, the 101° day of the year);

231459 is the time of data set creation (11:14:59 P.M.)].
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6 isanumeric identifier (sixth data set of the day).

.PDR isthefile-name extension for aPDS Delivery Record.

Typevi new_PDR_filename and then press the Retur n/Enter key.

* ThePDR templatefileis opened (displayed by the vi text editor).

* Although this procedure has been written for the vi editor, any UNIX editor can be
used to create the PDR.

Using vi editor commands modify the PDR file to specify ingest of one of the data sets to
be ingested.
» Create aseparate PDR for each data set [science datafile(s) and corresponding
metadata file — refer to the PPUDR “file group” examplein Step 32].
» Thefollowing vi editor commands are useful:
— h (move cursor |eft).
— j (move cursor down).
-k (move cursor up).
— | (move cursor right).
- a(append text).
— i (insert text).
— 1 (replace single character).
— X (delete acharacter).
- dw (delete aword).
— dd (deletealine).
— ndd (delete n lines).
— U (undo previous change).
— Esc (switch to command mode).

Press the Esc key.

TypeZZ.
* New PDRfileissaved.
*  UNIX prompt is displayed.

Typevi XFR_filename and then press the Return/Enter key.
* A new filewith the specified XFR_filename is opened.
- Usethe EDOS file-naming convention for signal files (refer to the EDOSICD,
423-1CD-EDOS/EGS):

Signal file name is the corresponding PDR file name plus the signal file name
extension (i.e., “.XFR").
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For example:

X0420064AAAAAAAAAAAAAA031012314596.PDR.XFR

» Thesigna fileindicates that the relevant data files and PDR have been put in the
polling directory and are ready to be ingested.

* Although this procedure has been written for the vi editor, any UNIX editor can be
used to create the signal file.

Using vi editor commands create afile that contains the name of the relevant PDR.
» A signd file contains the name of the relevant PDR only.

* For example:

*  XO0420064AAAAAAAAAAAAAA031012314596.PDR.

Press the Esc key.

TypeZZ.

* New signdl fileis saved.

e UNIX prompt is displayed.

» At the next polling occasion, the EDOS polling client should detect the signal file and
initiate ingest of the data specified in the corresponding PDR.

Repeat Steps 34 through 43 as required to create delivery records and signal files for all
remaining data sets (from the EDOS archive tape) to be ingested.

To monitor Ingest request processing (polling with delivery record), perform the
Monitor/Control Ingest Requests procedure (see Chapter 16).

Remove the EDOS-provided tape from the DTF-2 drive, using the Perform DTF-2
Drive Unloading procedure (see Chapter 16).

Verify that the data have been inserted into the archive as described in the Verify the
Archiving of Ingested Data procedure (see Chapter 16).

When insertion into the archive has been verified, the Archive Manager specifies "set
delete” for the replaced data/metadata by using procedures for granule deletion to mark
the data/metadata for deletion from the archive (see Section 17.4.2, Selecting Granules
for Deletion and Section 17.4.2.3, Selection Using a Separ ate | nput File).

When insertion into the archive has been verified, ensure that the EDOS archive tapeis
returned to the EDOS Level 0 Processing Facility (LZPF).

17-62 611-EMD-001



NOTE: Clean up (as described in Steps 50 through 54) the directory into which data were

originally copied from the EDOS archive tape. If preferred, skip Steps 50 through
54 and use the script described in the Clean the Polling Directories procedure

(see Chapter 16).
50 Type cd path and then press the Return/Enter key.
* path represents the directory path to the location where the data from the EDOS
archive tape were first copied.
51 Type Is and then press the Return/Enter key.
* Alisting of thefilesin the current directory is displayed.
52 Typerm filenamel filename2 [ ... filenameN] and then press the Return/Enter key.
« filenamel filename2 [ ... filenameN] represent the names of the filesto be removed
from the directory.
* A wildcard may be used if some of the files have common characteristics.
— For example:
rm *.PDS
* A prompt is displayed requesting whether or not a particular file should be removed.
— For example:
rm: remove DZ9ZA49.MDR (yes/no)?
53 Typey and then press the Return/Enter key.
» The specified fileis deleted and (if applicable) a prompt is displayed requesting
whether or not another particular file should be removed.
54 Repeat Step 53 as necessary.
Table 17.6-7. Re-Ingest of Lost Data (1 of 3)
Step What to Do Action to Take
1 Identify the source for each lost granule
2 Retrieve file location metadata Use procedure in Section
17.6.2.5.1
3 Initiate data re-supply with data provider read ICD
4 setenv DISPLAY clientname:0.0 enter text; press Return/Enter
5 /tools/bin/ssh hostname enter text; press Return/Enter
6 Passphrase (or Step 7) enter text; press Return/Enter
I Password enter text; press Return/Enter
8 netscape & enter text; press Return/Enter
9 Move cursor to Netsite: or Location: field single-click
10 http://[<URL> enter text; press Return/Enter
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Table 17.6-7. Re-Ingest of Lost Data (2 of 3)

Step What to Do Action to Take
11 Select data reorder link from Related Links single-click
12 On Data Reorder Request page, select Add New single-click
Request
13 Move cursor to Requestor’s Name field single-click
14 Type name of person making request enter text
15 Pull down list and select Requestor’s Organization clicks
16 In Requested Data (UTC) block, pull down list and clicks
select Year
17 In Requested Data (UTC) block, pull down list and clicks
select DOY
18 In Requested Data (UTC) block, pull down list and clicks
select Start Time
19 In Requested Data (UTC) block, pull down list and clicks
select Stop Time
20 Select Request Reason single-click
21 Pull down list and select Priority clicks
22 In Data type(s) block, check-select appropriate APIDs | click(s)
23 Optional: Move cursor to Comments field single-click
24 Optional: Enter comments enter text
25 In Actionee Org block, select actionee single-click
26 Activate Submit button single-click
27 For tape from EDOS, load tape into DTF-2 drive Use procedure in Section
16.3.34
28 Access terminal window logged in to appropriate host
29 cd path (to location for copy of data) enter text; press Return/Enter
30 tar xvf device (the DTF-2 drive device hame) enter text; press Return/Enter
31 pg PPMUDR_name (file name of PPMUDR) enter text; press Return/Enter
32 Identify the PDS(s) to be archived read text
33 cp filenamel filename2 [ ... filenameN] path (copy enter text; press Return/Enter
files to Ingest pollIEDOS directory)
34 cd path (path to Ingest pollEDOS directory) enter text; press Return/Enter
35 cp old_PDR_filename new PDR filename enter text; press Return/Enter
36 vi new_PDR _filename enter text; press Return/Enter
37 Use vi editor commands to modify PDR file to specify
ingest of a data set to be ingested
38 Place vi editor in command mode press Esc key
39 Type ZZ enter text
40 vi XFR_filename enter text; press Return/Enter
41 Use vi editor commands to create a signal file (file
containing the name of the created PDR file
42 Place vi editor in command mode press Esc key
43 Type ZZ enter text
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Table 17.6-7. Re-Ingest of Lost Data (3 of 3)

Step What to Do Action to Take
44 Repeat Steps 34 through 43 as needed to create any
additional delivery records and signal files for other
data sets from the EDOS tape to be ingested
45 Monitor Ingest request processing Use procedure in Section 16.2.5
46 Remove EDOS tape from DTF-2 drive Use procedure in Section
16.3.3.5
47 Verify that the data are inserted in the archive Use procedure in Section 16.2.10
48 Mark the replaced data/metadata for deletion Use procedure in Section
17.4.2.3
49 Return the EDOS tape to the LZPF
50 cd path (location where the data from the EDOS tape | enter text; press Return/Enter
were first copied)
51 Is enter text; press Return/Enter
52 rm filenamel filename2 [ ... filenameN] enter text; press Return/Enter
53 y enter text; press Return/Enter
54 Repeat Step 53 as necessary

17.6.2.4.2 Recovery of Lost Data by Reprocessing

Table 17.6-8 presents the steps required for recovery of lost data by reprocessing. If you are
already familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:

1 If you have not already done so, retrieve the granule Production History (PH) metadata
for each file for the lost granules (see Section 17.6.2.5.2).

2 Pass the output of Step 1 to the procedure to Re-Gener ate Granules Affected by L oss of
Filesfrom the Archive (see Chapter 13).

Table 17.6-8. Recovery of Lost Data by Reprocessing

Step What to Do Action to Take
1 Retrieve granule Production History metadata Use procedure in Section
17.6.2.5.2
2 Execute procedure to re-generate granules affected by | See Chapter 13
loss of files from the archive
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17.6.2.4.3 Recovering Granules from Another Producing Site

A specia case for data recovery involves granules archived at a DAAC other than the producing
DAAC or site and (generally) not archived at the producing DAAC or site. Ultimately, the
recovery involves a re-ingest (see Chapter 16), but because the granules are not archived at the
producing DAAC or site, they must first be generated through reprocessing. Table 17.6-9
presents the steps required for recovering granules from another producing site. If you are
already familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:

1 If you have not already done so, retrieve the file |ocation metadata for each file for the
lost granules (see Section 17.6.2.5.1).

2 Identify which of the lost granules were ingested from DAACs or other sites where the
granules were produced but not archived.
* Theselost granules are known to the local SDSRV, but do not have an associated
Production History (PH) granule (the PH granuleis at the producing site).

3 Forward the granule metadata lists to the source DAAC or other site, where the metadata
are used asinput to the procedure to Re-Gener ate Granules Affected by L oss of Files
from the Archive (see Chapter 13).

4 Once the granule is re-generated, it may be inserted at the DAAC where it was lost, either
through an order or through cross-DAAC ingest (see Chapter 16).

Table 17.6-9. Recovering Granules from Another Producing Site

Step What to Do Action to Take

1 Retrieve file location metadata Use procedure in Section
17.6.25.1

2 Identify lost granule(s) produced at another site

3 Forward granule metadata to producing site

4 Execute ingest procedure See Chapter 16

17.6.2.4.4 Restoration of LO Data to the EDOS Archive from the ECS

If EDOS discovers missing or corrupt LO datafilesin its archive, the lost data may be recovered
by obtaining LO filesfrom ECS. In the event of such loss, the EDOS Level 0 Processing Facility
notifies the DAAC that archives the appropriate LO data, either by telephone or, preferably, by
e-mail. In the notification, EDOS identifies each requested Production Data Set by Application
Process Identification (APID) and Start and Stop time. The notification also provides a host and
directory path and any related information necessary for the DAAC operator to write the data, as
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well as the priority of the request (high, medium, or low). The following procedure, referencing
standard data ordering procedures (see Chapter 19), may be used to achieve the transfer.

1 Review the request notification from EDOS to obtain appropriate criteria to search the
archive for the requested data and to specify the host and directory to which the data are
to be pushed.

2 Use the Search and Order Data using the EDG Search and Order Tool procedure
(see Chapter 19) to conduct a search for the data requested by EDOS, constraining the
search with the criteria provided by EDOS in the request notification, and to order the
data to be distributed by FTP Push to the provided host and directory path.

» Theorder is confirmed.

NOTE: If the request is for one or two files, it may be preferable to use atool and method
other than the EDG (e.g., the test tool EcTsDsClientDriver) to achieve the
distribution.

17.6.2.5 SDSRV Procedures in Support of Data Recovery

There are two procedures described here that may be used to extract information from the
SDSRV database to support the recovery of lost archive data. The first returns file metadata
including file checksums for use with file recovery from backup tapes. The second generates
granule metadata for use by the Planning subsystem (PLS) in re-creating granules from which
files have been irrecoverably lost. The output “lists” from these procedures should be exchanged
as electronic files (e.g., as email attachments) to facilitate subsequent use (e.g., to permit copying
into input screens of GUIs for other procedures).

17.6.2.5.1 SDSRYV Retrieval of File Location Metadata

The input to this procedure is a list of the unique file names of files in the archive affected by a
tape failure (e.g., procedure 17.6.2.3 shows how the script EcDsStFilesPer TapeUtility may be
used to generate file names for the list). The list may be called the Affected File List (AFL). The
file names in the AFL will match the inter nalFileName column of the DsM dFileStorage table
within the SDSRV metadata database.

The output of this procedure is a list of file metadata (archivel Ds and checksums) for each file
named in the input. It may be called the Affected File Metadata (AFM) list. It is used to
determine the backup locations, if any, of lost files and to verify the checksum of files restored
through support of the tape drive vendor (StorageTek).

This procedure has the following dependencies:

» The operator isworking on a machine from which SQL connections can be made to
the SDSRV SQL server (e.g., elacgll, gOacg0l, 10acg02, n0acg0l) and that server
recognizes the Sybase account sdsrv_role.
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* The UNIX account in use has execute permission on the required scripts, the * path’
shell variable set to include a directory where the command ‘isgl’ islocated and the
SYBASE (Sybase ‘home’) environment variable set appropriately (e.g. setenv
SYBASE /tools/sybOCv11.1.0).

» The operator knows the password for the SDSRV Sybase user sdsrv_role

Table 17.6-10 presents the steps required for SDSRYV retrieval of file location metadata. 1f you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are
new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1

2

Login at the SDSRV host (e.g., e0acs05, g0acs03, 10acs03, n0acs04).

Receive the Affected File List (AFL) (e.g., file list from output of script
EcDsStFilesPer TapeUtility) as an electronic file; save alocal copy of the file with an
identifiable name (e.g., aflfile.txt).

To change directory to the location of the database scripts, type cd /usr/ec§<MODE>/
CUSTOM/dbms/DSS and press the Retur n/Enter key.
The<MODE> will most likely be one of the following operating modes:
— OPS (for normal operation).
— TSl or TS2 (for testing).
» Theworking directory is changed to /usr/ecs/’<MODE>/CUSTOM/dbms/DSS.

To execute the script for retrieval of file location metadata, type

DsDbSrFilel ocM etadata aflfile.txt aflmetadata.txt, where aflfile.txt is the name of the

input file with the list of affected files and aflmetadata.txt is the desired name of the

output file, and then press the Return/Enter key.

* The script requires that certain environmental variables be set prior to execution. |If
you have not set them, the script returns an error message listing the variables that
must be set and giving examples. To make the script execute properly, you may need
to set environmental variables using the following commands and appropriate
variable entries:

setenv DSQUERY x0acgOn_srvr (e.g., e0acgll, g0acg01, 10acg02, n0acg0l)
setenv DBNAME EcDsScienceDataServer1 <MODE>

setenv DBUSERNAME sdsrv_role

setenv DBPASSWD <password>

setenv SYBASE /tools/sypOCv11.1.1
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» If thevariables are set appropriately, the script uses the datain the input file to
generate the named output file; during the execution it provides feedback similar to

the following:

Usi ng Login : sdsrv_role

Using Server : tlacg04_srvr

usi ng Dat abase: EcDsSci enceDat aServer1l TS2

Recovering the Effected Lost Files....

**** No errors found in DBoutfile_ FilelLocMetadata ***

To check that the output file is not empty (i.e., of zero length), type the command
Is-I aflmetadata.txt, where aflmetadata.txt is the name of the output file, and press the
Return/Enter key.

* UNIX displaysthe file information in the following form:
STWr--1-- 1 cnshared 293 Sep 25 15:25 afl netadat a. t xt

» If thefileisof zero length, either the input file was of zero length or an unexplained
error occurred. Check theinput file.

To visualy inspect the file to verify the success of the command, type the command

view aflmetadata.txt, where aflmetadata.txt is the name of the output file, and press the

Return/Enter key.

» The contents of the output file are in two sections: 1) the affected file metadata found
within SDSRV inventory database; and 2) files not found within SDSRV database
(this section is usually empty). UNIX displays the contents of the filein the

following form (for this sample data, the input file contained only one filename):
Internal Fil eNane_found_ i n_SDSRV_| nvent ory_ Mt adat a_Dat abase
Tue Sep 25 15:25:49 EDT 2001

: SC: MODO00. 001: 19862: 1. CCSDS
"Aug 21 2001 3:34:17:000PM O 1670000364 SCMODO00.00119862

Internal Fil eName_not _found_i n_SDSRV_I| nvent ory_Met adat a_Dat abase
Tue Sep 25 15:25:50 EDT 2001

» To exit the view process, type :q! and press the Return/Enter key. (Note: This step
specifies use of the view command to view the file, but the content can be viewed
using other commands as well [e.g., Vi, pg, mor€]).

* Itisadvisable, especialy if there are large numbers of affected files, to check for
errors in the output of the script, searching for occurrences of the strings 'msg’ and
‘error.” To execute a check for ‘msg,’ type the command grep -i msg aflmetadata.txt |
wc -l, where aflmetadata.txt is the name of the output file, and press the
Return/Enter key. To execute a check for ‘error,’ type the command grep -i error
aflmetadata.txt | wc - and press the Return/Enter key.

» If no errors occurred, UNIX returns an output of 'O’ (zero).
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* Any other output means that there were errorsin the process. If errors are found, they
must be diagnosed based on the error message(s) and the procedure must be repeated
after correction of theinput file.

7 When the output file passes the tests of Step 7, it can be passed to the calling procedure.

Table 17.6-10. SDSRV Retrieval of File Location Metadata

Step What to Do Action to Take

1 Log in at SDSRV host enter text; press Return/Enter

2 Save a local copy of the Affected File List name file, e.g., aflfile.txt

3 cd /usr/ecs/<MODE>/CUSTOM/dbms/DSS enter text; press Return/Enter

4 DsDbSrFileLocMetadata aflfile.txt aflmetadata.txt enter text; press Return/Enter

5 Is —I aflmetadata.txt enter text; press Return/Enter;
read text

6 view aflmetadata.txt enter text; press Return/Enter:
read text

7 grep -i msg aflmetadata.txt | wc - enter text; press Return/Enter;

grep -i error aflmetadata.txt | wc -I read text
8 Pass output file to calling procedure

17.6.2.5.2 SDSRV Retrieval of Granule Production History Metadata

The input to this procedure is a list of files remaining to be recovered after as many files as
possible are recovered from backup (see Sections 17.6.2.1 and 17.6.2.2) and/or from a damaged
cartridge (see Section 17.6.2.3). The list may be referred to as the Affected File List (AFL). The
output of this procedure serves asinput to the PDPS/PL S procedure for granule regeneration, Re-
Generate Granules Affected by L oss of Filesfrom the Archive, in Chapter 13.

The goal of this procedure is to list PLS-required granule metadata for use by the local PDPS in
re-generating lost granules. The procedure extracts valid Production History URs for the ‘lost’
granules from the local SDSRV database. It assumes that the Delivered Algorithm Package
information has been inserted into the SDSRV for all associate datatypes in the process of
Science Software Integration and Test (SSI&T), which is addressed in Chapter 26. There may be
aperiod in the lifetime of a granule when this information is not populated, during which granule
attributes PGEName and PGEV ersion are not available to this procedure.

Output from this procedure is afile containing:

* “Granulesfor PDPS Re-generation” -- those found within SDSRV. These are passed
to the PL S operators for re-generation using the procedure to Re-Gener ate Granules
Affected by L oss of Filesfrom the Archive (see Chapter 13).
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* “Residua Granulesto Recover” -- those not found within SDSRV inventory. This
list may include granules that have been removed by the process for physical deletion
from the archive and SDSRV inventory (see Section 17.4.3).

Table 17.6-11 presents the steps required for SDSRV retrieval of granule production history
metadata. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1

2

Login at the SDSRV host (e.g., e0acs05, g0acs03, 10acs03, nOacs04).

Receive the Affected FileList (AFL) (e.g., filelist from output of script
EcDsStFilesPer TapeUtility) as an electronic file; save alocal copy of the file with an
identifiable name (e.g., aflfile.txt).

To change directory to the location of the database scripts, type cd /usr/ec§<MODE>/
CUSTOM/dbms/DSS and press the Retur n/Enter key.
The<MODE> will most likely be one of the following operating modes:
— OPS (for normal operation).
— TSl or TS2 (for testing).
» Theworking directory is changed to /usr/ecs/<MODE>/CUSTOM/dbms/DSS.

To execute the script for retrieval of file location metadata, type

DsDbSrGranPHM etadata aflfile.txt agrmetadata.txt, where aflfile.txt is the name of

the input file with the list of affected files and agrmetadata.txt is the desired name of the

output file, and then press the Return/Enter key.

» The script requires that certain environmental variables be set prior to execution. |If
you have not set them, the script returns an error message listing the variables that
must be set and giving examples. To make the script execute properly, you may need
to set environmental variables using the following commands and appropriate
variable entries:

setenv DSQUERY x0Oacgnn_srvr (e.g., e0acgll, g0acg01, 10acg02, nOacg01)
setenv DBNAME EcDsScienceDataServer1 <MODE>

setenv DBUSERNAME sdsrv_role

setenv DBPASSWD <password>

setenv SYBASE /tools/sypOCv11.1.1

» If the variables are set appropriately, the script uses the datain the input file to
generate the named output file; during the execution it provides feedback similar to

the following:
Using Login . sdsrv_role
Using Server : tlacg04_srvr
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usi ng Dat abase: EcDsSci enceDat aServer1l TS2

Recovering the Lost Files....

**** No errors found in DBoutfile G anPHWetadata ***

To check that the output file is not empty (i.e., of zero length), type the command
Is -I agrmetadata.txt, where agrmetadata.txt is the name of the output file, and press the
Return/Enter key.

* UNIX displaysthe file information in the following form:
STWT--T-- 1 cnshared 293 Sep 25 15:25 agrnetadata.txt

» If thefileisof zero length, either the input file was of zero length or an unexplained
error occurred. Check the input file.

To visualy inspect the file to verify the success of the command, type the command
view agrmetadata.txt, where agrmetadata.txt is the name of the output file, and press the
Return/Enter key.

* The contents of the output file are in two sections: 1) the granule metadata found
within SDSRV inventory database; and 2) granule metadata not found within SDSRV
database (residual granulesto recover). For each of thefileslisted in the input file for
which related granule metadata are found in the SDSRV, the script output should
include the Geol D (partial UR), the UR of any available associated Production
History granule, the ESDT shortname and versionl D, the granule beginning date and
time and ending date and time. UNIX displays the contents of thefilein the

following form:
Granul e_net adata_found_wi t hi n_SDSRV_| nvent ory_dat abase Wed Sep 26
11:11: 51 EDT 2001

: BR Browse. 001: 1170: 1. BI NARY

0 1000 BRBrowse.0011170 PCENane 1 "None" "None" " NONE"
" NORMAL"

PH Does_Not Apply

: SC; MOD00: 65001: 1. CCSDS

0 1000 SCAST 04.00120001 PGEName 1

"Jan 1 1997 12:00: 00: 000AM' "Jan 1 1997 12:00:00: 000AM' "Oct 10
1996 12:02:00: 000AM'  "NORMAL" 2

NO_PH

: PH: PH. 001: 2000000076: 1. Bl NARY

0 65536 PHPH. 0012000000076 PGENane 1 "None" " None"
"None" " NORMAL"

PH Does_Not Apply

: QA QA . 001:1003: 1. AsCl |

0 0O QAQA 0011003 PCENanme 1 "None" "None" "None"
" NORMAL"

PH Does_Not Apply
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:OR OR 001:2102: 1. AsCl |

0 0O OROR 0012102 PCENanme 1 "None" "None" "None"
" NORMAL"

PH Does_Not Apply

: AN AN. 001: 3100: 1. AsCl |

0 0O ANAN 0013100 PCENanme 1 "None" "None" "None"
" NORMAL"

PH Does_Not Apply

Granul e_netadata_not _found wi thin_SDSRV_ I nventory_ database Wed Sep 26
11:11:51 EDT 2001

» To exit the view process, type :q! and press the Return/Enter key. (Note: This step
specifies use of the view command to view the file, but the content can be viewed
using other commands as well [e.g., Vi, pg, mor€]).

It isadvisable, especidly if there are large numbers of affected files, to check for errorsin

the output of the script, searching for occurrences of the strings 'msg’ and ‘error.” To

execute a check for ‘'msg,’ type the command grep -i msg agrmetadata.txt | wc -1, where

agrmetadata.txt is the name of the output file, and press the Return/Enter key. To

execute a check for 'error,’ type the command grep -i error aflmetadata.txt | wc -l and

press the Return/Enter key.

» If no errors occurred, UNIX returns an output of ‘0’ (zero).

* Any other output means that there were errorsin the process. If errors are found, they
must be diagnosed based on the error message(s) and the procedure must be repeated
after correction of theinput file.

When the output file passes the tests of Step 7, it can be passed to the calling procedure

(e.g., procedure to Re-Gener ate Granules Affected by L oss of Filesfrom the Archive

in Chapter 13).

* Note: Granulesfor recovered fileswill, by definition, have a different granuleURs
(dblDs) than the files that were lost.

Table 17.6-11. SDSRYV Retrieval of Granule Production History Metadata

(1 of 2)
Step What to Do Action to Take
1 Log in at SDSRV host enter text; press Return/Enter
2 Save a local copy of the Affected File List name file, e.g., aflfile.txt
3 cd /usr/ecs/<MODE>/CUSTOM/dbms/DSS enter text; press Return/Enter
4 DsDbSrGranPHMetadata aflfile.txt agrmetadata.txt | enter text; press Return/Enter
5 Is —I agrmetadata.txt enter text; press Return/Enter;
read text
6 view agrmetadata.txt enter text; press Return/Enter:
read text
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Table 17.6-11. SDSRYV Retrieval of Granule Production History Metadata

(2 of 2)

Step What to Do Action to Take

7 grep -i msg agrmetadata.txt | wc -l enter text; press Return/Enter;
grep -i error agrmetadata.txt | wc -l read text

8 Pass output file to calling procedure

17.7 Archive Troubleshooting

There are several troubleshooting tools provided with AMASS that can assist you in monitoring
archive activity and in responding to fault notifications. The AMASS System Administrator’s
Guide (available electronically on drg servers [e.g., g0drg01, eOdrgll, 10drg01, nOdrgOl] in
directory /usr/amass/books) includes instructions on using these tools. Some of the most useful
ones are addressed in this section. Table 17.7-1 provides an Activity Checklist for archive
troubl eshooting.

Table 17.7-1. Activity Checklist for Archive Troubleshooting

Order Role Task Section Complete?

1 Archive Manager Checking daemons and using healthcheck | (P) 17.7.1.1

2 Archive Manager Using sysperf to Display the Status of (P)17.7.1.2
AMASS /O Activity

3 Archive Manager Using vollist to Display Volume Data (P)17.7.1.3

4 Archive Manager Using the amass_log Script to Display (P)17.7.14
AMASS Errors

5 Archive Manager Using quedisplay to View What is in the (P)17.7.1.5
AMASS Queue

6 Archive Manager Using mediamove to Establish Synchrony | (P) 17.7.1.6
Between quedisplay and medialist

7 Archive Manager Checking Server Log Files (P)17.7.21

8 Archive Manager A Special Case: Checking the Request (P)17.7.2.2
Manager Server Debug Log

9 Archive Manager Checking the tac Log File (P) 17.7.2.3

10 Archive Manager/ Handling a Data Insertion Failure (P)17.7.2.4

Database
Administrator

11 Archive Manager Handling a Data Acquire Failure (P)17.7.25

12 Archive Manager Diagnosing/Investigating Write Errors (P)17.7.3

13 Archive Manager Diagnosing/Investigating Read Errors (P)17.7.4
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17.7.1 Using AMASS Commands, Utilities, and Scripts for Monitoring and Fault
Response

The AMASS file system needs to have the following daemons running at all times:

e amassmain.

» daemong/Im_ip -afdock.

+  (Qset.

* Kklogd.

* amass_iocomp.

» libsched (oneinstance for each virtua library).

» libio_tape (at least one instance for each drive in each jukebox).

The UNIX process search provides an easy check for these daemons. If they are up, the AMASS
healthcheck command provides a useful check on the health of AMASS while it is running.

A command provided to display the status of the AMASS 1/O activity is sysperf. Thiscommand
returns severa items:

» the number of reads and writes that are outstanding.

» the number of volumes (for reads) or volume groups (for writes) that are going to be
used by those reads and writes.

» thecurrent volumesin the drives.

» thel/Oratein Kb per second since the last update. This value first appears as a zero.
Then AMASS continues to update the information at intervals based on avalue for
updateinterval entered by the operator.

Sysperf can often show the first sign of trouble. For example, if there are reads and writes in
process but throughput is aways 0, a problem is indicated. The most common problems are
volumes and drives that go off line and/or inactive.

Volumes are monitored using the vollist command. It returns information on the status of a
specified volume or list of volumes in the archive. If the output of vollist indicates that the
volume is inactivated (i.e., | appears in the FLAGS column), the amass log script can help to
determine the nature of the problem. The amass log script displays AMASS messages from the
system log file. This script can provide helpful information under several circumstances, such as
when a command gives unexpected results or when AMASS appears not to be functioning
properly in other ways.

Unless use of the amass_log script shows that there are many errors on a volume that has been
inactivated, you can reactivate the volume using the command:

/usr/amass/bin/volstat -a <volumenumber>
where <volumenumber> is the volume ID for the volume to be activated.

Just as vollist provides information on the status of volumes, the command drivelist displays the
status of drives available to AMASS. Active drives are noted by an A, and inactive drives are
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noted by an I. The command is/usr/amassbin/drivelist. If AMASS inactivates adrive, use the
amass_log script as described previously. Unless there is a hardware problem and severd
attempts have been made to ready the drive, it is usually appropriate to reactivate the drive using
the drivestat command. For example, to reactivate drive 1 in jukebox 1, type the command
/usr/famass/bin/drivestat -a 1 1.

A useful library utility included with AMASS is quedisplay. This utility permits the operator to
see what isin the queue, and to diagnose problems such as the following:

* During an attempt to write to afile, the drive light does not illuminate.
* Thesystem is slowing down.
*  An AMASS command does not complete.

The output of the quedisplay utility shows the queue, which consists of read and write requests,
AMASS administration commands, and a list of libraries, drives, and what volumes they
manage. An example of output from this utility might take the following form:

READQ ri d=52696, fptr=0xf0227c5c, vol =3, fnode flags=0x110

VWRI TEQ ri d=79, fptr=0xc00eff54, vol=5, fnode flags=0x8048844

ADM NQ cnd=1, flags=0x6, vol =32, juke=1, pid=1047, ftype=0, err=0

JUKEBOX 1 DRIVE 1, vid=32, vflag=0x100, status=0

JUKEBOX 1 DRIVE 2, no volune in drive
If there are READQ or WRITEQ entries, the name(s) of the file(s) being processed can be
determined by using the filepath command and the first number in the entry. For example, enter

lusrlamasg/utilg/filepath 52696 for the first file number in the sample outpui.

Occasionally, a robot may lose synchrony with AMASS concerning the location of media. The
best way to verify this is to compare quedisplay and medialist. The medialist utility is a
standalone program that communicates with the robot controller in the Library Storage Module
to determine the robot’s view of media and their slot locations. If the two programs disagree,
you can bring the two programs into synchrony using mediamove. The following paragraphs
provide step-by-step procedures for use of some of these commands and utilities.

17.7.1.1 Checking Daemons and Using healthcheck

If there is an indication or question of a potential problem with AMASS, an appropriate initial
step is to check the status of the required daemons. If the check indicates that the daemons are
up, then it is a reasonable next step to run the healthcheck command. Table 17.7-2 presents the
steps required for checking daemons and using healtcheck to verify the status of AMASS. If you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are
new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Log in asamass at the FSM S host.
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2

Type ps-€f | grep amass and press the Return/Enter key.
UNIX returns running AMASS processes in aformat similar to the following:

7214464 7208385 0 Sep 19 ?
10 Sep19?

amass
amass

0
amass
amass
amass
amass
amass
amass
amass
amass
amass

amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass
amass

7208385

1214747
7282853
7282868
6949087
7214915
7214972
5539722
7301726
7215313

7357656
7215637
7215638
7277545
7215870
7215964
7216363
6950984
8175053
7340525
7278745
7216941
7340710
7217134
7359550
7217388
7285477
7285537
7217884
7279821
6878049
7279907
7335573

7208385 0
7215637 0
7215637 0
7215637 0
7208385 0
7208385 0
7217884 0
7215964 0

Sep 19 ?
Sep 20 ?
Sep 20 ?
Sep 20 ?
Sep 19 ?
Sep 19 ?
Sep 20 ?
Sep 20 ?

10 Sep19?
fslockl -u 128 -f 256 -q 128

7216363 0
7208385 0
7208385 0
7214972 0
7208385 0
7208385 0
7208385 0
7217884 0
7212410 O
7217134 0
7217884 0
7208385 0
7217134 O
7208385 0
7216363 0
7208385 0
7215637 0
7215637 0
7208385 0
7214972 0
7208385 0
7214972 0
7217134 O

Sep 20 ?
Sep 19 ?
Sep 19 ?
Sep 20 ?
Sep 19 ?
Sep 19 ?
Sep 19 ?
Sep 20 ?
Sep 26 ?
Sep 20 ?
Sep 20 ?
Sep 19 ?
Sep 20 ?
Sep 19 ?
Sep 20 ?
Sep 19 ?
Sep 20 ?
Sep 20 ?
Sep 19 ?
Sep 20 ?
Sep 19 ?
Sep 20 ?
Sep 20 ?
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0:00libio_tape21

10: 33 /usr/amass/daemons/amassmain

0:10 amass_iocomp
1:47 libio_tapel1l
0:00 libio_tapel1l
1:47 libio_tapel1l
0:00 klogd

50:54 libio_tape 12
0:23libio_tape 13
1:05libio_tape 31

9:34 /usr/amass/daemons/Im_ip -a

0:00 libio_tape 33
84:10 libio_tapel1
2:43 libsched 3
0:41libio_tapel2
2:52 libsched 1
109:25 libio_tape3 1
8416 libio_tape3 3
0:23libio_tape 13
0:00libio_tapel4
1:191libio_tape32
0:23libio_tapel3
0:32 gset
1:19libio_tape 32
138:26 libio_tape 3 2
0:52 libio_tape 33
0:00 libio_tape?2 2
1:47 libio_tapel1l
1:47 libio_tapel1
17:37 libio_tapel3
0:41libio_tapel2
2:36 libsched 2
0:41libio_tapel2
1:19libio_tape 32
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» If therunning processes do not include amassmain, daemons/Im_ip -afsock, qset,
klogd, amass_iocomp, libsched, and libio_tape, it may be necessary to restart
AMASS (refer to Section 17.1.3, Rebooting AMASS).

3 To check the AMASS database integrity, check the availability of write resources
FNODEs and cache blocks, and to verify cache partitions, type
/usr famass/bin/healthcheck -viwc and press the Return/Enter key.

*  AMASS eturns information on its health in format similar to the following:
- STARTI NG DATABASE | NTEGRI TY CHECK - - -

-api has been opened properly and AMASS i s running
-verifying pathnanes.

-got | ocks on database

-unl ocki ng dat abase tabl es and exiting

- CHECK COWVPLETED!

--- CHECKI NG AVAI LABI LITY OF WRI TE RESOURCES FNODEs AND CACHE
BLOCKS - - -

-api has been opened properly and AMASS i s running
-Initializing the passed argunents.

-Returning the passed argunents.

-Restoring signals.

-exiting.

- CHECK COWVPLETED!

- RUNNI NG CACHE TEST ---

-api has been opened properly and AMASS i s running
-Validating the raw cache.

-Restoring signals.

-exiting.

- TEST COMPLETED! !

» If an error message isreturned, it may be necessary to restart AMASS (refer to
Section 17.1.3, Rebooting AMASS).

4 To check library components, type /usr/amass/bin/healthcheck -vl 1 0 volumenumber
and press the Retur n/Enter key.

* Theargument -l (lower-case |) specifiesthe library components check, and requires
specification of ajukebox (1 in this case), adrive number (entering O asin this case
checks all active drives), and a volume number (volumenumber isthe volume ID of
an available volume in the specified jukebox; it may be helpful to use the vollist
command [refer to Section 17.7.1.3, Using vollist to Display Volume Data] to
identify a suitable volume, such as a volume in the Space Pool, to use for this test).
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*  AMASS returns information on the health of library componentsin the following

format:
- CHECKI NG LI BRARY COVPONENTS - - -

-api has been opened properly and AMASS i s running.

-mappi ng shared nenory.

-verifying the juke nunber.

-val idating vol une nunber.

-validating drive nunber and checking for active drive/s/.
-saving the volune's status before inactivating it.
-proceeding with physical test.

-restoring signals and exiting.

--- CHECK COWPLETED! !
» If an error message isreturned, it may be necessary to restart AMASS (refer to
Section 17.1.3, Rebooting AM ASS) and/or to check for possible hardware problems
with drives or other components.

Table 17.7-2. Checking Daemons and Using healthcheck

Step What to Do Action to Take

1 Log in at FSMS host enter text; press Return/Enter
2 ps -ef | grep amass enter text; press Return/Enter
3 /lusr/amass/bin/healthcheck -viwc enter text; press Return/Enter
4 /lusrlamass/bin/healthcheck -vl 1 0 volumenumber | enter text; press Return/Enter

17.7.1.2 Using sysperf to Display the Status of AMASS 1I/O Activity

Table 17.7-3 presents the steps required for using sysperf to display the status of AMASS I/O
activity. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Log into the FSMS host (e0drgl11, g0drg01, |0drg01, or n0Odrg01).

2 Type /usr/amass/bin/sysperf -k 5 and press the Return/Enter key.
* The screen updates every 5 seconds and display information on the amass kernel (-k)
inaform similar to the following example (Note: A different number of seconds may
be entered to specify adifferent refresh rate.):

SYSTEM STATI STICS - Thu Sep 27 08:17:33
UPDATE | NTERVAL - 10 SEC
AVERACE THROUGHPUT - 0 KBYTES/ SEC
READ REQUESTS # OF VOLUMES
0 0
VWRI TE REQUESTS # OF VOL GROUPS
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0 0

CACHE BLOCKS 2957 Tot al 2957 Free O Drty
FNCDES 800 Tot al 796 Free 4 Used

JUKE DRIVE VOLFLAGS VOLUME VOLCGRP KBYTES/ SEC

3 To break out of the command, use ctrl-c (while holding down the Control Key, pressc).
* The screen stops updating and displays a UNIX prompt.
Table 17.7-3. Using sysperf to Display the Status of AMASS I/O Activity
Step What to Do Action to Take
1 Log in at FSMS host enter text; press Return/Enter
2 sysperf -k 5 enter text; press Return/Enter
3 ctrl-c hold Control key and press ¢

17.7.1.3 Using vollist to Display Volume Data

Table 17.7-4 presents the steps required for using vollist to display volume data. If you are
aready familiar with the procedure, you may prefer to use this quick-step table. If you are new

to the system, or have not performed this task recently, you should use the following detailed
procedure:

1

2

Log into the FSMS host (e0drgl1, g0drg01, |0drg01, or n0Odrg01).

Type /usr/amass/bin/vollist volumenumber (where volumenumber isthe ID for one of
the volumes) and press the Return/Enter key.

*  AMASSdisplays volume data in the following form:

VOL VOL JUKE POS VOL FLAGS USED AVAIL DEAD ERRS
NUM GRP NUM LABEL (MB) (MB) (%
100 500 3 NET SD0060 O 99213 3167 0 0

* Note: Inthisexample for volume 100, the O in the FLAGS column indicates that the
volumeisoffline. Other often-used flagsare: A for Active, | for Inactive, R for
Read-only, U for Unformatted.

e If volumenumber is omitted from the command, AMASS displays volume data for
al volumes.

» If theargument -g is used with the command and a volume group identifier is
specified (i.e., vollist -g volumegroupnumber), AMASS displays volume data for
each volume in the specified volume group.
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3

To put an offline volume back on line, type /usr/amass/bin/volloc -n volumenumber and

press the Return/Enter key.

» The specified volumeis put online, and in output from execution of an appropriate
vollist command, AMASS displays A in the FLAGS column.

Table 17.7-4. Using vollist to Display Volume Data

Step What to Do Action to Take

1 Log in at FSMS host enter text; press Return/Enter
2 vollist [-g] [volumenumber] enter text; press Return/Enter
3 volloc -n volumenumber (to put offline volume online) | enter text; press Return/Enter

17.7.1.4 Using the amass_log Script to Display AMASS Errors

Table 17.7-5 presents the steps required for using the amass_log script to display AMASS errors.
If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1

2

Log into the FSMS host (e0drgl11, g0drg01, |0drg01, or n0Odrg01).

To change to the AMASS tools directory, type cd /usr/amass/tools, and then press the
Return/Enter key.
» Theworking directory is changed to /usr/amass/tools.

Type ./Jamass_log logfilepath, where logfilepath is the full pathname of the system log

fileto scan for AMASS messages, and then press the Return/Enter key.

* Onasun, thelogfilepath islikely to be /var/adm/messages; on an SGlI, the
logfilepath islikely to be /var/adm/SYSLOG. Any AMASS error messages in the
scanned log file are displayed.

Perform the action recommended for the error message in the log.

*  The AMASS System Administrator’s Guide (available electronically on drg servers
[e.g., g0drg01, eOdrgll, 10drg01, n0drg0l] in directory /usr/amass/books) provides
detailed information concerning error messages. An error message informs of critical
problems that prevent AMASS from functioning. An error message is usually
followed by a correction message, which providesinstructions for correcting the
situation. Sometimes, there is a previous warning message that may provide an
accompanying correction message. Other messages may be identified by number
only; the System Administrator’s Guide provides a reference list, with accompanying
corrective actions.
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Table 17.7-5. Using the amass_log Script to Display AMASS Errors

Step What to Do Action to Take
1 Log in at FSMS host enter text; press Return/Enter
2 cd /usr/amass/tools enter text; press Return/Enter
3 Jamass_log logfilepath enter text; press Return/Enter
4 Perform recommended action (see System read text

Administrator’'s Guide)

17.7.1.5 Using quedisplay to View What is in the AMASS Queue

Table 17.7-6 presents the steps required for using quedisplay to view what is in the AMASS
gueue. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Log into the FSMS host (e0drg11, g0drg01, |0drg01, or nOdrg01).

2 To changeto the utilities directory, type cd /usr/amass/utils, and then press the
Return/Enter key.
» Theworking directory is changed to /usr/amass/utils.

3 Type quedisplay, and then press the Retur n/Enter key.

*  The AMASS queue is displayed in the following form:
READQ ri d=52696, fptr=0xf0227c5c, vol =3, fnode_flags=0x110
VWRI TEQ ri d=79, fptr=0xc00eff54, vol=5, fnode_ flags=0x8048844
ADM NQ cnd=1, flags=0x6, vol =32, juke=1, pid=1047, ftype=0, err=0
JUKEBOX 1 DRIVE 1, vid=32, vflag=0x100, status=0
JUKEBOX 1 DRIVE 2, no volune in drive

* Note: Intheoutput, "rid" = Record ID, "pid" = Process ID

Table 17.7-6. Using quedisplay to View What is in the AMASS Queue

Step What to Do Action to Take

1 Log in at FSMS host enter text; press Return/Enter
2 cd /usr/amass/utils enter text; press Return/Enter
3 guedisplay enter text; press Return/Enter
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17.7.1.6 Using mediamove to Establish Synchrony between quedisplay and
medialist

Table 17.7-7 presents the steps required for using mediamove to establish synchrony between
quedisplay and medialist. If you are already familiar with the procedure, you may prefer to use
this quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1

2

Log in asamass at the FSM S host (e0drgl11, gOdrg01, 10drg01, or nOdrg01).

Type /usr/amass/utils/quedisplay and then press the Retur n/Enter key.

AMASS displays the following information (for example of incorrect status).

:JU.KEBOX 1 DRIVE 1, no volune in drive
JUKEBOX 1 DRI VE 2, vid=50, vflags-0x4, status=0

Type /usr/amass/utils/medialist and then press the Retur n/Enter key.

AMASS displays the following information (for example of actual status).

SLOT VSD0098 FULL
DRI VE 1 FULL FROM VSDO096
DRI VE 2 FULL FROM VSD0097

Note that the medialist result shows that drive 1 actually is occupied, although
quedisplay registersthat drive 1 is empty.

Type /usr/amass/utilsmediamove 1 VSD0096 1 and then press the Return/Enter key.

AMASS moves the volume from the source (drive 1 in this example) to the
destination (slot VSD0096 in this example) in the specified jukeboxnumber (jukebox
1inthisexample), thereby bringing the actual status of drive 1 (as known by
medialist) to the status reflected by quedisplay.

Table 17.7-7. Using mediamove

to Establish Synchrony Between quedisplay and medialist
Step What to Do Action to Take
1 Log in as amass at FSMS host enter text; press Return/Enter
2 Quedisplay enter text; press Return/Enter
3 Medialist enter text; press Return/Enter
4 mediamove source destination [jukeboxnumber] enter text; press Return/Enter
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17.7.2 Recovering from Failure to Store or Retrieve Data

Successful data storage and retrieval functions are the heart of ECS. Successful ingest of data or
processing of data to produce new science data granules require that Storage Management
(STMGT) is inserting the product into the archive and that Science Data Server (SDSRV) is
inserting the associated metadata into the inventory. Staging disks and cache managers for the
Archive server and the FTP server are also involved in this process. To check the functioning of
these elements, it is necessary that the ESDTs for the data to be inserted are installed and
available, and that subscriptions have been registered.

Troubleshooting failures to store or retrieve data (as well as other failures) often requires review
of server or application log files. This section contains a general procedure for reviewing log
files to check for proper start-up and communications. It also has a procedure for a specia case
of reviewing log files for the Storage Management Request Manager server, and a procedure for
reviewing the current tac log file of interactions between AMASS and ACSLS. Separate
procedures then address recovery from failure to insert (store) data and recovery from failure to
acquire (retrieve) data.

17.7.2.1 Checking Server Log Files

Table 17.7-8 presents the general steps required for checking server log files. If you are already
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed
procedure:

1 Log in to the host for the server and log(s) to be examined.

2 Typecd /usr/ec§<MODE>/CUSTOM/logs and then press the Return/Enter key.
» Theworking directory is changed to /usr/ecs<MODE>/CUST OM/logs.

3 Toview aserver log, type pg filename and then press the Return/Enter key.

» filenamerefersto the log file to be reviewed (e.g., EcDsScienceDataServer AL OG,
EcDsScienceDataSer ver Debug.log).

» Thefirst page of thelog fileis displayed; additional sequentia pages can be displayed
by pressing the Retur n/Enter key at the : prompt.

» Although this procedure has been written for the pg command, any UNIX editor or
visualizing command (e.g., Vi, view, more, tail) can be used to review the log file.

» Typically, the <server>Debug.log captures more detailed information than the
<server>.ALOG. However, for some servers (e.g., SDSRV), there may be
significant detail in the <server> ALOG. It isalso important to note that the
DebugL evel parameter setting in the Configuration Registry determines the level of
detail captured in the <server>Debug.log (0 is off, a setting of 1 captures status and
errors, a setting of 2 captures major events, and a setting of 3 isafull trace recording
of all activity). If the DebugL evel has been set to one of the lower levels during
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operations, the System Administrator may set it to 3 during troubleshooting.
Similarly, the AppL ogL evel parameter setting determines the level of detail captured
in the <server>.AL OG (0 provides afull trace recording of all events, 1 provides
messages related to all major events, 2 yields just records of errors, and 3 turns
recording off). (Note: There are additional debug levels available for some logs,
Storage Management (STMGT) offers "enhanced" debugging based on bitmasks.
Level 7 provides afour-bit level for detailed database debugging. Level 15 provides
an eight-bit level that repeatedly dumps the in-memory request queue in the STMGT
Request Manager.

4 Review the log file(s) to determine if there are any indications of connection problems or
errors at start up.

Thelog file for the called server may contain an error message indicating a problem at
start-up. The debug log should indicate atypical start sequence, including (sample
log entries in the following material were taken from a debug log showing start-up for
EcDsStFtpSer ver):

— Get parameters from registry (log entries similar to the following).
DSS EcDsSt Ft pServer Server Debug 1og on f2acg0l1 starting at Mn
Jun 4 07:57:45 EDT 2001
EcAgl nst ancel D Sequence Number is 3870
Setting up environnent variables needed for DCE:
RPC_UNSUPPORTED_NETIFS = ""
/ usr/ ecs/ DEVO7/ CUSTOM bi n/ DSS/ EcDs St Ft pServer ConfigFil e
[ usr/ ecs/ DEVO7/ CUSTOM cf g/ EcDsSt Ft pSer ver. CFG ecs_node DEVO7
Start Tenperature cold
Started process EcDsStFt pServer in node DEVO7 with PI D 2709893
EcRgRegi stry_1 0::ctor this = 0x104eef 38
EcRgRegi stry_1 0::ctor this = 0x104eef 88
Fol pPt ToPt Port al | np: : Send sent 20/ 20
Fol pPt ToPt Portal | np: : Send sent 219/219
Fol pPt ToPt Port al | np: : Recei ve got 20
Fol pPt ToPt Port al | np: : Recei ve got 1024
Fol pPt ToPt Port al | np: : Recei ve got 246
*rxxxxx After Retrieving of RGY: Name = EcDsStFt pServer NONE
Program D = 4645102
Applicationl D = 4600000
Rel ease = B
DeltaTine = 0
Site = RBD
SubSysNarne
Maj or Versi o
M nor Ver si o
DebugLevel
AppLogLevel =0
AppLogSi ze = 3000000
DBServer = f2acgO0l_srvr
DBLogi nNanme = EcDsSt Ft pServer
DBNanme = stngtdbl
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L oad resource catalogs (log entries indicate the loading, or that the loading did not

complete, similar to the following).

06/04/01 07:57:47: Thread ID: 65536 : |oading resource catal og
file from

[ usr/ ecs/ DEVO7/ CUSTOM dat a/ DSS/ Resour ceCat al ogs/ DsMiResour ce. dat . r
cat

06/ 04/ 01 07:57:48: Thread ID: 65536 : |oading resource catal og
file from

/ usr/ ecs/ DEVO7/ CUSTOM dat a/ DSS/ Resour ceCat al ogs/ EcDsSdHr . dat . r cat
06/ 04/ 01 07:57:48: Thread ID : 65536 : |oading resource catal og
file from

[ usr/ ecs/ DEVO7/ CUSTOM dat a/ DSS/ Resour ceCat al ogs/ DsSr Resource. dat . r
cat

06/ 04/ 01 07:57:48: Thread ID: 65536 : |oading resource catal og
file from

[ usr/ ecs/ DEVO7/ CUSTOM dat a/ DSS/ Resour ceCat al ogs/ Ds@ Resource. dat . r
cat

06/ 04/ 01 07:57:48: Thread ID: 65536 : |oading resource catal og
file from

[ usr/ ecs/ DEVO7/ CUSTOM dat a/ DSS/ Resour ceCat al ogs/ DsShResource. dat . r
cat

06/ 04/ 01 07:57:48: Thread ID: 65536 : |oading resource catal og
file from

/ usr/ ecs/ DEVO7/ CUSTOM dat a/ DSS/ Resour ceCat al ogs/ EcDsSdHc. dat . r cat

Pre-cache errors associated with database connectivity (log entries similar to the

following).

06/ 04/ 01 07:57:48: Thread ID : 65536 : User Nane

EcDsSt Ft pServer | Thread 65536

06/ 04/ 01 07:57:48: Thread ID : 65536 : Database Name

stngt db1l_DEVO7 | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : Server Nane

f2acg0l srvr | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : DsShTSStorage: creating
the MutexVec for this thread

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30141 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30141) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30143 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30143) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCH NG FOR. 30139 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30139) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30142 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30142) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30148 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30148) | Thread 65536
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06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30144 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30144) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30145 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30145) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCH NG FOR. 30147 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30147) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30146 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30146) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30211 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30211) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : SEARCHI NG FOR. 30140 ( Not
found) | Thread 65536

06/ 04/ 01 07:57:49: Thread ID : 65536 : CACH NG DsESt UnknownErr or
(30140) | Thread 65536

Get server configuration parameters from the database (log entries similar to the

following).

06/ 04/ 01 07:57:49: Thread ID: 65536 : BaseReal ::Ctor: Server
Name is - EcDsStFtpServer NONE | Thread 65536

06/ 04/ 01 07:57:50: Thread ID: 65536 : User Nane

EcDsSt Ft pServer | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : Database Name
stngt dbl _DEVO7 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : Server Nane

f2acg0l srvr | Thread 65536

06/04/01 07:57:50: Thread ID: 65536 : nyTransactionList[0]: use
stngt dbl_DEVO7 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : DBIF: Execute: Utinmate
SQL: use stngtdbl DEVO7 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : nyTransactionList[1]: exec
DsSt CPSel ect ByNane "EcDsSt Ft pServer NONE" | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : DBIF: Execute: Utimte
SQL: exec DsSt CPSel ect ByNane "EcDsSt Ft pServer NONE' | Thread 65536
06/ 04/ 01 07:57:50: Thread ID : 65536

DBI F: Fet ched: [ 8. 000000] [ EcDsSt Ft pServer NONE] [ 1] [ 10] [ FTP][][ O] [ FTPA
] [ NONE] [ 4194304] | Thread 65536

Spawn receptionist thread and register server in the database (log entries similar to

the following).

06/ 04/01 07:57:50: Thread ID : 65536

DsSt Recepti oni st: Bi ndSocket Get I nfo: Port assigned is 13441

Thread 65536

06/ 04/ 01 07:57:50: Thread ID: 65536 : nyTransactionList[0]: use
stngt dbl_DEVO7 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : DBIF: Execute: Utimte
SQL: use stngtdbl DEVO7 | Thread 65536
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06/ 04/ 01 07:57:50: Thread ID : 65536 : nyTransactionList[1]: exec
DsSt CPRegi st er Server 8, 13441, "f2acg01" | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : DBIF: Execute: Utinmate
SQL: exec DsStCPRegi sterServer 8, 13441, "f2acg0l1" | Thread 65536
06/ 04/ 01 07:57:50: Thread ID: 65536 : Ftp:Ctor:
EcDsSt Ft pServer NONE | Thread 65536

06/04/01 07:57:50: Thread ID: 65536 : nyTransactionList[0]: use
stngt dbl_DEVO7 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : DBIF: Execute: Utimte
SQL: use stngtdbl DEVO7 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : nyTransactionList[1]: exec
DsSt CPSel ectByld 8 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536 : DBIF: Execute: Utinmte
SQL: exec DsStCPSel ectByld 8 | Thread 65536

06/ 04/ 01 07:57:50: Thread ID : 65536

DBI F: Fet ched: [ 8. 000000] [ EcDsSt Ft pServer NONE] [ 1] [ 10] [ FTP] [ f 2acg01] [
13441] [ FTPA] [ NONE] [ 4194304] | Thread 65536

06/ 04/ 01 07:57:50: Thread ID: 65536 : Ftp:Cor: Leaving | Thread
65536

Spawn service threads (log entries similar to the following).

06/04/01 07:57:50: Thread ID: 65536 : Ftp:Startup: tenperature =
cold | Thread 65536

06/ 04/ 01 07:57:50: Perfornming startup processing | Thread 65536
06/04/01 07:57:50: Thread ID: 65536 : Spawni ng service threads
Thread 65536

06/04/01 07:57:50: Thread ID: 65536

BR Cet Thr eadPool Configuration | Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : nyTransactionList[0]: use
st ngt db1_DEVO7 | Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : DBIF: Execute: Utimte
SQL: use stngtdbl DEVO7 | Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : mnyTransactionList[1]: exec

DsSt STCSel ect For Server 8, "ThreadPool" | Thread 65536
06/04/01 07:57:51: Thread ID: 65536 : DBIF: Execute: Utimte
SQL: exec DsSt STCSel ect For Server 8, "ThreadPool" | Thread 65536

06/04/01 07:57:51: Thread ID : 65536 : DBIF: Fet ched: [ Thr eadPoo
J[10]1[O][0O][0][0][20] | Thread 65536

06/ 04/01 07:57:51: Thread ID : 65536 : 3_2709893_0757-
1125858625 _155062001_f 2acg01: FTPA: BR: Get Thr eadPool Confi gurati on
Ret urn

ing | Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : Ftp: Spawning a service
thread | Thread 65536

06/04/01 07:57:51: Starting a new service thread | Thread 65536
06/04/01 07:57:51: Thread ID: 65536 : Ftp: Spawning a service
thread | Thread 65536

06/04/01 07:57:51: 06/04/01 07:57:51: Thread ID : 65554 : WAiting
for work | Thread 65554

06/04/01 07:57:51: Thread ID: 65554 : DsShTSStorage: creating
the MutexVec for this thread

06/04/01 07:57:51: Thread ID: 65554 : Waking up manager thread
Thread 65554

17-88 611-EMD-001



06/04/01 07:57:51: Starting a new service thread | Thread 65536
06/04/01 07:57:51: Thread ID: 65536 : Ftp: Spawning a service
thread | Thread 65536

06/04/01 07:57:51: Starting a new service thread | Thread 65536
06/04/01 07:57:51: Thread ID: 65559 : Waiting for work | Thread
65559

06/04/01 07:57:51: Thread ID: 65560 : Waiting for work | Thread
65560

06/04/01 07:57:51: Thread ID: 65561 : Waiting for work | Thread
65561

Process Restart Notification for server restart ("Ready to accept requests’) (log

entries similar to the following).

06/04/01 07:57:51: Thread ID: 65536 : nyTransactionList[0]: use
stngt dbl_DEVO7 | Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : DBIF: Execute: Utinate
SQL: use stngtdbl DEVO7 | Thread 65536

06/04/01 07:57:51: Thread ID : 65536 : nyTransactionList[1]:
BEG N TRANSACTI ON OUTER 278888352 | Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : DBIF: Execute: Utinate
SQL: BEG N TRANSACTI ON OUTER 278888352 | Thread 65536

06/ 04/ 01 07:57:51: Thread ID : 65536 : nyTransactionList[2]: exec
DsSt GRRestart Noti fication "10_2709893_0757-1125858625_15506
2001_f2acg01l: FTPA: Server restart", "EcDsStFtpServer NONE', "col d"
Thread 65536

06/04/01 07:57:51: Thread ID: 65536 : DBIF: Execute: Utinate
SQL: exec DsStGRRestartNotification "10_2709893_0757- 1125858625
_155062001_f 2acg0l: FTPA: Server restart”, "EcDsStFtpServer NONE"
"cold" | Thread 65536

06/04/01 07:57:52: Thread ID: 65536 : DBIF: Fetched:[] | Thread
65536

06/04/01 07:57:52: Thread ID: 65536 : DBIF: Fetched:[8.000000]
Thread 65536

06/04/01 07:57:52: Thread ID: 65536 : DBIF: Execute: Utinate
SQL: COWM T TRANSACTI ON OUTER_ 278888352 | Thread 65536

06/04/01 07:57:52: Thread ID: O : No servers to awaken -- get
status | Thread 0

06/04/01 07:57:52: Thread ID: 65536 : Spawni ng manager thread
Thread 65536

06/ 04/ 01 07:57:52: Ready to accept requests | Thread 65564

Check queue for requests ("Waiting for an event” means there is nothing elsein

the queue.) (log entries similar to the following).

06/ 04/ 01 07:57:52: Thread ID : 65564 :

BR: ProcessCancel | edRequests | Thread 65564

06/ 04/ 01 07:57:52: Thread ID: 65564 : DsShTSStorage: creating
the MutexVec for this thread

06/ 04/ 01 07:57:52: Thread ID: 65564 : nyTransactionList[0]: use
stngt dbl_DEVO7 | Thread 65564

06/ 04/01 07:57:52: Thread ID : 65564 : DBIF: Execute: Utinmte
SQL: use stngtdbl DEVO7 | Thread 65564

06/ 04/ 01 07:57:52: Thread ID : 65564 : nyTransactionList[1]: exec
DsSt GRSel ect Cancell ed 8 | Thread 65564

06/ 04/ 01 07:57:52: Thread ID : 65564 : DBIF: Execute: Utinmate
SQL: exec DsSt GRSel ect Cancelled 8 | Thread 65564
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06/ 04/ 01 07:57:52: Thread ID: 65564 :

BR: ProcessCancel | edRequests: Nothing cancelled | Thread 65564

06/ 04/ 01 07:57:52: Thread ID: 65564 :

BR: ProcessCancel | edRequests Returning | Thread 65564

06/ 04/ 01 07:57:52: Thread ID: 65564 : Ftp: Getting next request
| Thread 65564

06/04/01 07:57:52: Thread ID: 65564 : nyTransactionList[0]: use
stngt dbl _DEVO7 | Thread 65564

06/ 04/ 01 07:57:52: Thread ID : 65564 : DBIF: Execute: Utinmte
SQL: use stngtdbl DEVO7 | Thread 65564

06/ 04/ 01 07:57:52: Thread ID : 65564 : nyTransactionList[1]: exec
DsSt FRGet Next Request 8 | Thread 65564

06/ 04/ 01 07:57:52: Thread ID : 65564 : DBIF: Execute: Utimte
SQL: exec DsSt FRGet Next Request 8 | Thread 65564

06/ 04/ 01 07:57:52: Thread ID : 65564 : GetNext Request: No
requests available | Thread 65564

06/04/01 07:57:52: Thread ID: 65564 : Waiting for an event
Thread 65564

* Thelog filefor the server from which the call originated may indicate a problem
completing a connection. The log should indicate successful awakening of aremote

host, with entries similar to the following:
06/04/01 07:57:52: Thread ID: 65536
DsSt Pat ron: AwakenRenot eServer: Hostnane - f2acg0l | Thread 65536
06/04/01 07:57:52: Thread ID: 65536
DsSt Pat ron: AwakenRenot eServer: Port Nunmber - 13441 | Thread 65536
06/04/01 07:57:52: Thread ID: 65536 : Patron: Creating new entry
for EcDsStFtpServer NONE | Thread 65536
06/04/01 07:57:52: Thread ID: 65536 : Trying gethostbyname r() O
of 5 attenpts | Thread 65536
06/ 04/ 01 07:57:52: Thread ID : 65536 : Waking up
EcDsSt Ft pServer NONE | Thread 65536

» and should indicate completion of aconnection to the called server, with entries

similar to the following:
06/04/01 07:57:52: Thread ID: 65553
DsSt Recept i oni st: Wai t For Connecti ons: A connecti on has been
accepted | Thread 65553
06/04/01 07:57:52: Thread ID: 65564 :
BR: ProcessCancel | edRequests | Thread 65564
06/ 04/ 01 07:57:52:
06/04/01 07:57:52: Thread ID: 65553 : Waking up manager thread
Thread 65553
06/04/01 07:57:52: Thread ID: 65564 : : 06/04/01 07:57:52: read
ID: 7:57:52: DsShTSSt orageDsShTSSt orage: creating the MitexVec
for this thread: creating the MuitexVec for this thread665553: 53
DsShTSSt or age: creating the MiuitexVec for this thread
06/04/01 07:57:52: Thread ID: 65564 : nyTransactionList[0]: use
st ngt db1l_DEVO7 | Thread 65564
06/04/01 07:57:52: Thread ID: 65564 : DBIF: Execute: Utimte
SQL: use stngtdbl DEVO7 | Thread 65564
06/04/01 07:57:52: Thread ID: 65564 : nyTransactionList[1]: exec
DsSt GRSel ect Cancell ed 8 | Thread 65564
06/04/01 07:57:52: Thread ID: 65564 : DBIF: Execute: Utimte
SQL: exec DsSt GRSel ect Cancelled 8 | Thread 65564
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06/ 04/ 01 07:57:52: Thread ID: 65564 :

BR: ProcessCancel | edRequests: Nothing cancelled | Thread 65564
06/ 04/ 01 07:57:52: Thread ID: 65564 :

BR: ProcessCancel | edRequests Returning | Thread 65564.

» Thisprocedureis applicable for reviewing logs for different types of errors and events
on ECS servers.

5 Exit thelog file (e.g., from pg, type q and then press the Retur n/Enter key).

Table 17.7-8. Checking Server Log Files

Step What to Do Action to Take

1 Log in at host for server and log(s) to be examined enter text; press Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/logs enter text; press Return/Enter
3 pg (or other viewing command) filename enter text; press Return/Enter
4 Review the entries in the file read text

5 Exit the log file (e.g., g for exit from pg) enter text; press Return/Enter

17.7.2.2 A Special Case: Checking the Request Manager Server Debug Log

The Request Manager server in the Storage Management computer software configuration item
of the Data Server Subsystem processes requests from external clients (processes outside of
Storage Management). Requests between Storage Management servers are passed directly from
one server to another.

* Requeststhat require one of the Storage Management servers to perform processing
are checkpointed (except requests that can be serviced solely through SQL).
— Checkpointing involves recording the request’s state (e.g., " checkpointed,”
"failed,” "completed") in the database to assist in error recovery.
* Requeststhat can be serviced solely through SQL are considered “trivial" requests.
— Trivia requests are not checkpointed.
— Examplesinclude attaching to a staging disk, getting capacity, and getting block
size.
— Trivia requests submitted from outside Storage Management are serviced by the
Request Manager server.
— Trivia requests originating within Storage Management are passed directly from
the client to the database server.

The Request Manager server (like other Storage Management servers) can manage several
concurrent activities. This is accomplished through the use of threads. There are severa
different kinds of threads:

* Manager thread.
— One per Storage Management server.
— Responsible for degqueuing requests and assigning them to service threads.
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— Checksfor cancelled requests.

Service thread.

— Multiple threads per Storage Management server.

— Responsible for the actual servicing of requests.

— Logsall progressincluding all changes of request state.

— Notifies submitter when request has been compl eted.

Receptionist thread.

— One per Storage Management server.

— Registersthe server as"up" in the database.

— Sitson a socket, waiting for connections from other Storage Management servers.

— Unregisters the server at shutdown.

Inbound RPC thread.

— Spawned by arequest from a Storage Management client.

— Hands off the request to the manager thread and waits for completion of the
request.

Housekeeper thread.

— Watches for completed requests which haven't previously been seen and
processed.

Information concerning Request Manager server processing of requests (identified by thread) is
recorded in the Request Manager server debug log (assuming some level of debug log recording
Is specified in the Registry database).

Trivial requests typically involve the following types of activities:

Inbound RPC thread appears with a request.

Manager thread dequeues the request and assignsiit to a service thread.

Service thread recognizes the thread as "trivia."

— A "No checkpointing required -- going straight to responded" message is recorded
in the Request Manager server debug log.

Service thread executes the database transaction for results.

— When the request is completed, a"Done servicing" message is recorded in the
Request Manager server debug log.

— If the request fails, an "Unable to service" message is recorded in the Request
Manager server debug log.

Service thread hands the results to the inbound RPC thread.

— A "Notifying the client" message is recorded in the Request Manager server
debug log.

Inbound RPC thread silently returnsto the client with the results.
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Non-trivial requests are forwarded to the appropriate Storage Management server (eqg.,
EcDsStFtpServer, EcDsStStagingDiskServer, ECDsSStArchiveServer) for processing.

» Some of the same types of entries are made in the Request Manager server debug log
for non-trivial requests as for trivial requests.

For example:
"Waking up service thread" (Request Manager is preparing to process the
request).

"Done servicing" (request processing has been compl eted).

"Unable to service" (the request has failed).

» Although some trivial requests include "token™" statements, tokens are characteristic of
non-trivial requests.

A token includes request information that varies with the type of operation to be
performed.
For example, atoken for an ftp request might include the following types of data:

Stored procedure (e.g., DsStFRInsert) [other types of stored procedures include
DsStSDRInsert and DsStGRMapL ogical Archiveld].

RPC ID (e.g., RPCld=1821 535 1109-
1124464729 171062001 _x0ins01.xdc.ecs.nasa.gov:SBSV SDSV1DSDD1DSDD4

).

Username.
Encrypted password.
Host.

Source path.
Destination path.
Externa request ID.

Server name (e.g., ECDsStFtpServerNONE) [other types of operations might
involve the EcDsStStagingDiskServerDRPL for example].

Type of operation (e.g., FtpPush) [other types of operations include ArRetrieve,
SDAllocateDisk, SDLinkFileg].

Submitter (e.g., DSDD) [other types of operations might involve SDSV].
Priority.
The server to which the request was sent is identified by name (ServerName).

Transaction ID is embedded in the RPC ID (the portion before the first colon in
the RPC ID).
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A "transaction” may involve multiple operations on a host or several hosts. Consequently,
multiple threads may be used on each relevant host.

Table 17.7-9 presents the general steps required for checking the Storage Management Request
Manager server debug log file. If you are already familiar with the procedure, you may prefer to
use this quick-step table. If you are new to the system, or have not performed this task recently,
you should use the following detailed procedure:

1

2

Log in to the Distribution Server host (e.g., €0dis02, g0dis02, 10dis02, n0dis02).

To changeto the logs directory, type cd /usr/ecs’<MODE>/CUST OM/logs then press
the Return/Enter key.

The working directory is changed to /usr/ecs<MODE>/CUST OM/logs.

Type pg filename then press the Return/Enter key.

filename refersto the appropriate Request Manager debug log.

For example: pg EcDsStRequestM anager Server Debug.log

The content of the first page of the specified file is displayed.

Although this procedure has been written for the pg command, any UNIX editor or
visualizing command (e.g., Vi, view, more) can be used to review the log file.

At the : prompt type /date time then press the Return/Enter key.

date time refers to the approximate date and time of the problem.
- For example:

/06/18/01 12:17:31

Thefileis searched for the specified text.

— If the specified text isin the log file, the following type of response is displayed.
...skipping forward
06/18/ 01 12:17:31: Thread ID: 105 : DsShTSStorage: creating the
Miut exVec for this thread

[-]

— If the specified text is not in the log file, the following type of responseis
displayed.

Pattern not found:

— If the specified text is not in the log file, verify the following aspects of Steps 3
and 4:

Date and time were entered correctly (Step 4).
Proper file was opened (Step 3).
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5

At the : prompt type /Unable to service then press the Return/Enter key.
* pg searchesthefilefor the specified text.

— |If the specified text isin the log file, the following type of responseis displayed.

... Skipping forward
2: 1 ngest RA09GRL Unable to service | Thread 52
[-]

— If the specified text is not in the log file, the following type of responseis

displayed.

Pattern not found:

» If the specified text isin thefile, go to Step 7.
» If the specified text isnot in the file, go to Step 6.

Examine the contents of the log file to determine which thread is associated with the

problem being investigated.
» Thefollowing pg commands (at the : prompt) are useful:
— nthen Return/Enter (go to Page n).

— Return/Enter or +1 then Return/Enter (go down to the next page).

— -1then Return/Enter (go back to the preceding page).
— +n then Return/Enter (go down n number of pages).
— -n then Return/Enter (go back n number of pages).

— +nl then Return/Enter (go down n number of lines).
— -nl then Return/Enter (go back n number of lines).

g then Return/Enter (exit from pg).

At the : prompt type the appropriate text (depending on the direction of the desired

search) then press the Return/Enter key:

To search back toward the beginning of the file, type ~“Waking up servicethread n®

and then press Return/Enter.

To search toward the end of the file, type /Waking up service thread n and then press

Return/Enter.
* For example:

AWaking up servicethread 52/

— Thefileis searched back toward the beginning of the file for the specified text.
» If the specified text isin the log file, the following type of response is displayed.

... ski ppi ng backward

06/18/01 12:17:31: Thread ID: 102 : Waking up service thread 52

| Thread 102
[-]
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NOTE:

NOTE:

If the specified text is not in the log file, the following type of responseis displayed.

Pattern not found:

The entries "Waki ng up service thread n" and"Unable to service
Thread n" bracket the thread servicing in which an error occurred.

Thread IDs are reused frequently. There are likely to be many processes with the
same thread ID in any particular log file. It isimportant to follow the correct
instance of the thread.

Itislikely that the Request Manager would try again to process afailed request.
Subsequent request processing may use the same thread 1D or a different thread
ID. However, it would involve the same transaction ID.

A "No checkpointing required -- going straight to responded” entry
associated with the thread ID indicates that the request is "trivial."

10 At the : prompt type /SEARCHING then press Return/Enter.

Thefileis searched for the specified text.

If the specified text isin the log file, the following type of response is displayed.

...skipping forward

06/18/01 12:17:31: Thread ID: 52 : SEARCH NG FOR 30148 (Found)

| Thread 52

06/18/01 12:17:31: Thread ID: 52 : SEARCH NG FOR 30148 (Found)

| Thread 52

06/18/01 12:17:31: Thread ID: 52 : DsStStoredProcedures:: Execute
- ERROR: Coul d not execute stored procedure | Thread 52

06/18/01 12:17:31: Thread ID: 52 : Error encountered in stored
procedure | Thread 52

06/18/01 12:17:31: Thread ID: 52 : DBIF: Execute: Utimte SQL:
ROLLBACK TRANSACTI ON QUTER 7077776 | Thread 52

06/18/01 12:17:32: Thread ID: 52 : 1 4501810_1217-
1124633447_169062001_p0i cg01. pvc. ecs. nasa. gov: | POBI POB1l NRMLI GSA15
;1 ngest RU09CR1L Done servicing | Thread 52

06/18/01 12:17:32: Thread ID: 52 : 1 4501810_1217-
1124633447_169062001_p0i cg01. pvc. ecs. nasa. gov: | POBI POB1l NRMLI GSA15
;1 ngest RUO9CRL Unable to service | Thread 52

06/18/01 12:17:32: Thread ID: 52 : 1 4501810_1217-
1124633447_169062001_p0i cg01. pvc. ecs. nasa. gov: | POBI POB1l NRMLI GSA15
;1 ngest RUO9CR1L Marked as unassigned | Thread 52

06/18/01 12:17:32: Thread ID: 52 : 1 4501810_1217-
1124633447_169062001_p0i cg01. pvc. ecs. nasa. gov: | POBI POB1l NRMLI GSA15
;1 ngest RUO9CRL Notifying the client | Thread 52

06/18/01 12:17:32: Thread ID: 52 : Waiting for work | Thread 52
06/18/01 12:17:32: Thread ID: 52 : Waking up nmanager thread
Thread 52

[-]
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In the preceding example the expression SEARCHING is associated with Thread
ID 52.

The context of the SEARCHING statement indicates the type and source of the
problem; in this case there appears to be a problem executing a stored procedure.

— If the specified text is not in the log file, the following type of responseis
displayed.

Pattern not found:

11 If the expression SEARCHING is not associated with the specified thread in the lines
displayed, repeat Step 8.

12 If necessary, at the : prompt type -2I [lower-case letter I] then press the Return/Enter
key.
* pg simulates scrolling the screen backward two lines (or any other number of lines
that istyped at the prompt).
— Thefileisredisplayed to include the two lines that preceded the page previously
displayed.
— For example:

... Ski ppi ng backward

06/18/01 12:17:31: Thread ID: 52 : DBIF: Execute: Utinmte SQ.:
exec DsSt SDAtt achDi sk

"/usr/ecs/ TS2/ CUSTOM pdps/ x0spg01/ dat a/ DpPr Rm x0Ospg01_di sk",
"SDSV', 0 | Thread 52

06/18/01 12:17:31: Thread ID: 52 : SEARCH NG FOR: 30148 (Found)
| Thread 52

06/18/01 12:17:31: Thread ID: 52 : SEARCH NG FOR: 30148 (Found)
| Thread 52

06/18/01 12:17:31: Thread ID: 52 : DsStStoredProcedures:: Execute
- ERROR: Coul d not execute stored procedure | Thread 52

06/18/ 01 12:17:31: Thread ID: 52 : Error encountered in stored
procedure | Thread 52

[.]

— The additional lines preceding "SEARCHING FOR" in the example indicate that
the stored procedure in which the error was encountered is DsStSDA ttachDisk.

13 At the: prompt type q then pressthe Return/Enter key.
* pg exits from the Request Manager server debug log file.

14 If therequest isatrivia request, go to Step 22.
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15

16

17

If the request isanon-trivial request, open a separate UNIX window.

The results of related operations on the server involved in performing copy or ftp
functions for the transaction are going to be checked in a separate UNIX window.

In the new UNIX window log in to the appropriate server host (e.g., e0drgll, gOdrg01,
10drg01, nOdrg01) for the server involved in performing copy or ftp functions for the
transaction.

At the shell prompt type grep 'Transactionld filename | grep 'LogProgress then
press the Return/Enter key.
For example:

grep 'af610628-" EcDsStArchiveServer Debug.log | grep 'LogProgress

filename refers to the name of the log file for the process involved in performing
copy or ftp functions for the transaction.

Transactionld refersto the Transaction ID associated with the applicable request.

In this example af610628-1dd1-11b2-a047-af 3a589fd88e is the relevant Transaction

ID.

However, usualy it is not necessary to use the entire Transaction ID in the
command; arepresentative sample (e.g., af610628- from the example) should be
sufficient.

Referencesto other Transaction IDs and entries that do not contain the string
"LogProgress” are filtered out so references to the specified Transaction ID that
contain the string "LogProgress’ are the only log entries displayed.

The string "LogProgress' is afilter for references to stored procedure
DsStGRL ogProgress.

Progressislogged for copy and ftp input/output at each block.
The following type of response is displayed:

06/ 26/ 01 12:46:00: Thread ID : 65674 : nyTransactionList[1]: exec
DsSt GRLogProgress "af 610628- 1dd1- 11b2- a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
C. MOD03. 001: 55732", 0, 1, "files" | Thread 65674

06/26/01 12:46:00: Thread ID : 65674 : DBIF: Execute: Utinmate

SQL: exec DsSt GRLogProgress "af 610628- 1dd1- 11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
C. MOD03. 001: 55732", 0, 1, "files" | Thread 65674

06/26/01 12:46:43: Thread ID: 65674 : : 06/26/01 12:46:43: read
ID: 2:46:43: nyTransactionmyTransactionList[1l]: exec

DsSt GRLogProgress "af 610628- 1dd1- 11b2- a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
C. MOD03. 001: 55732", 60, 60, "MB"List[1]: exec DsSt GRLogProgress
"af 610628- 1dd1- 11b2- a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
C. MOD03. 001: 55732", 60, 60, "MB"65714read 65674 : 74

06/26/01 12:46:43: Thread ID : 65674 : DBIF: Execute: Utimte

SQL: exec DsSt GRLogProgress "af 610628- 1dd1- 11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
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18

19

C. MOD03. 001: 55732", 60, 60, "MB"ODBIF: Execute: Utimte SQ: exec
DsSt GRLogProgress "af 610628- 1dd1- 11b2- a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
C. MOD03. 001: 55732", 60, 60, "MB"06/26/01 12:46:43: 6/26/01
12:46:43: | Thread : 65714read 65674 : 74

If no progressisindicated, go to Step 22.

Click inthe UNIX window for the Distribution Server host.

Type grep 'Transactionld filename | grep 'Done servicing' then press
Return/Enter.

filename refers to the appropriate Request Manager debug log.

For example:

grep 'af610628-" EcDsStRequestM anager Ser ver Debug.log | grep 'Done servicing’

If the operation has been completed, the following type of response is displayed:

06/ 26/ 01 12:46:00: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1 DSDD10DSDD1DSDD1: MoPGE02#sy14182000TS2S
C: MOD03. 001: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:44: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1 DSDD10DSDD1DSDD1: MoPGEQ2#sy14182000TS2S
C: MOD03. 001: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:45: Thread ID: 52 : af610628-1dd1l- 11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1 DSDD2 DSDD1 DSDD3: Mo PGE02#sy14182000TS2SC
: MOD03. 001: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:47: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1 DSDD2 DSDD1 DSDD3: MoPGE02#sy14182000TS2SC
: MOD03. 001: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:47: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1 DSDD2 DSDD1 DSDD7: MoPGE02#sy14182000TS2SC
: MOD03. 001: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:50: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1 DSDD2 DSDD1 DSDD7: MoPGE02#sy14182000TS2SC
: MOD03. 001: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:51: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD4: MoPGE02#sy14182000TS2SC: MOD03. 001
: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:56: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD4: MoPGE02#sy14182000TS2SC: MOD03. 001
: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:56: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD8: MoPGE02#sy14182000TS2SC: MOD03. 001
: 55732 Done servicing | Thread 52

06/ 26/ 01 12:46:59: Thread ID: 52 : af610628-1dd1l-11b2-a047-

af 3a589f d88e: PDPSSDSV1DSDD1DSDD8: MoPGE02#sy14182000TS2SC: MOD03. 001
: 55732 Done servicing | Thread 52

The statement "Done servicing" shows that the operation has been completed;
however, it provides no indication as to whether the operation succeeded or failed.
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20

21

22

— If "Done servicing" isfollowed by "Unable to service,” (as described in Step 19)
the operation failed.
» If the operation has not been completed, no file entries are displayed (the UNIX
prompt is displayed).
— It may just be slow to complete.
» If the operation has been completed, go to Step 19.
» If the operation has not been completed, go to Step 20.

Type grep 'Transactionld filename | grep 'Unableto service' then pressthe
Return/Enter key.

» filenamerefers to the appropriate Request Manager debug log.

* For example:

grep '2a7d4168-’ EcDsStRequestM anager Server Debug.log | grep "Unableto
service

» If therequest has failed, the following type of response is displayed:

06/ 26/ 01 12:56:22: Thread ID: 52 : 2a7d4168-1dd2- 11b2- 8c52-
99d0f 708dce5: PDPSSDSV1: MoPCGE02#sy14182000TS2MOD020BC Unabl e to
service | Thread 52

06/ 26/ 01 12:56:22: Thread ID: 52 : 2a7d4168-1dd2- 11b2- 8c52-
99d0f 708dce5: PDPSSDSV4: MoPCGE02#sy14182000TS2MOD020BC Unabl e to
service | Thread 52

— |If the operation hasfailed, return to Step 7.
» If the operation has not failed, no file entries are displayed (the UNIX prompt is
displayed).

If the operation has not failed, at the shell prompt type tail -f filename | grep
'Transactionld’ and then press the Return/Enter key.

» filenamerefers to the appropriate Request Manager debug log.

» Transactionld refersto the Transaction ID associated with the applicable request.
* For example:

tail -f EcDsStRequestM anager Server Debug.log | grep 'af610628-’

» If new entries are being posted to the log, the operation has not finished yet.
— I the same entries continue to be repeated over and over, it may be necessary to
restart the server.
» Ifitisnecessary to exit from atailed log, type ctrl-c (while holding down the
Control Key, pressc).

If the operation has not finished yet, monitor the tailed log for awhile.

» If the operation does not seem to finish (i.e., if entries continue to be made to the
tailed log) after a reasonable period of time (e.g., 30 minutes), it may be necessary to
restart the Request Manager server.
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« Ifitisnecessary to exit from atailed log, type ctrl-c (while holding down the
Control Key, pressc).

23 If problems were detected in the Request Manager server debug log and/or the log file for
the process involved in performing copy or ftp functions for the transaction, it may be
necessary to restart the server(s) performing those functions.

» If server restart does not resolve the problem, it is appropriate to notify the Help Desk
and prepare a Trouble Ticket.

24 If no problems were detected in the Request Manager server debug log or the log file for
the process involved in performing copy or ftp functions for the transaction, check the
Science Data Server log files; use Section 17.7.2.1, Checking Server Log Files.
Table 17.7-9. A Special Case: Checking the Request Manager Server

Debug Log (1 of 2)
Step What to Do Action to Take
1 Log in at host for Distribution Server enter text; press Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/logs enter text; press Return/Enter
3 pg (or other viewing command) enter text; press Return/Enter
EcDsStRequestManagerServerDebug.Log (or
filename of other Request Manager debug log)
4 /date time (of problem) enter text; press Return/Enter
5 /Unable to service enter text; press Return/Enter
6 Identify thread ID associated with problem read text
7 AWaking up service thread n”™ or /Waking up enter text; press Return/Enter
service thread n
8 /SEARCHING enter text; press Return/Enter
9 As necessary, repeat Step 8
10 As necessary, -2| enter text; press Return/Enter
11 g (to exit pg) enter text; press Return/Enter
12 If request is trivial, go to Step 22
13 If request is non-trivial, open a separate UNIX window | enter text; press Return/Enter
14 (In new window), log in at host for server for transaction | enter text; press Return/Enter
15 grep 'Transactionld’ filename | grep enter text; press Return/Enter
'‘LogProgress’
16 Go to window for Distribution Server host single-click
17 (In logs directory) grep 'Transactionld’ filename | enter text; press Return/Enter
grep 'Done servicing’
18 grep 'Transactionld’ filename | grep 'Unable to enter text; press Return/Enter
service’
19 If operation has not failed, tail -f filename | grep enter text; press Return/Enter
'"Transactionld’
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Table 17.7-9. A Special Case: Checking the Request Manager Server

Debug Log (2 of 2)

Step What to Do Action to Take

20 If operation not finished, monitor tailed log read text

21 If problem(s) detected, restart associated server

22 If no problem detected, check Science Data Server Use procedure in Section
logs 17.7.2.1

17.7.2.3 Checking the tac Log

Each day a current tac 00 log on the FSMS host records interactions between AMASS and
ACSLS. This log can provide helpful information in troubleshooting problems manifested in
those interactions. Table 17.7-10 presents the steps required for recovering from a failure to
store data. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the

following detailed procedure:

1 Log in asamass at the FSM S host.

2 Type cd /usr/amass/logs/tac and then press the Return/Enter key.
» Theworking directory is changed to /usr/amass/logs/tac.

3 Use the current tac log to investigate possible problems in communication between
AMASS and ACSLS. To view the current tac log, type pg tac_00 and then press the

Return/Enter key.

» Thefirst page of thelog fileis displayed; additional sequential pages can be displayed
by pressing the Return/Enter key at the : prompt.

» Although this procedure has been written for the pg command, any UNIX editor or
visualizing command (e.g., vi, view, more, tail) can be used to review thelog file.

* Thelog contains entries related to activities and communications associated with
actions by AMASS to direct ACSL S robotic activities; the entries should appear in
format similar to the following sample:

Sep 24 09:49: 42 p0drg0l1 anass
E7003(16) <00000>: xdi St k2749:
Sep 24 09:49: 42 p0drg0l1 anass
E7003(16) <00000>: xdi St k2797:
Sep 24 09:49: 42 p0drg01 anass
E7003(16) <00000>: xdi St k2742:
Sep 24 09:49:51 p0drg0l1 anass
E7003(16) <00000>: xdi St k2749:
Sep 24 09:49:51 p0drg0l1 anass
E7003(16) <00000>: xdi St k2873:
Sep 24 09:49:51 p0drg0l1 anass
E7003(16) <00000>: xdi St k2876:

17-102

LI BSCHED3[ 7215638] :

STK Response received; Status: O
LI BSCHED3[ 7215638] :

ACSLS ACK response received

LI BSCHED3[ 7215638] :

Waiting for ACSLS response

LI BSCHED3[ 7215638] :

STK Response received; Status: O
LI BSCHED3[ 7215638] :

ACSLS final response received

LI BSCHED3[ 7215638] :

1 network packets transfered
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Sep 24 10:18:52 p0drg0l amass LI BSCHEDL[ 7215870] :
E7003( 16) <00000>: xdi Arch39:  Archive index : 0
Sep 24 10:18:52 p0Odrg0l amass LI BSCHEDL[ 7215870] :

E7003(16) <00000>: xdi St k486: Media Id = P10011, Drive index = 0
Sep 24 10:18:52 p0drg0l1 amass LI BSCHEDL[ 7215870] :

E7003( 16) <00000>: xdi St k533: Sendi ng a nount conmand

Sep 24 10:19: 32 p0drg0l1 anmass LI BSCHED1[ 7215870] :

E7003(16) <00000>: xdi Arch39: Archive index : 0

Sep 24 10:19: 32 p0drg0l1 anmass LI BSCHED1[ 7215870] :

E7003(16) <00000>: xdi St k486: Media Id = P20676, Drive index = 1

Sep 24 10:19: 32 p0drg0l1 amass LI BSCHED1[ 7215870] :

E7003( 16) <00000>: xdi St k533: Sendi ng a nount conmand

Sep 24 10: 34:56 p0drg0l amass LI BSCHEDL[ 7215870] :

E1043(7) <00000>: | i bsched3165: Idle Eject tiner expired on volune 188
in drive 2.

Sep 24 10:35: 07 p0drg0l1 anmass LI BSCHEDL[ 7215870] :

E7003(16) <00000>: xdi Arch39: Archive index : 0

Sep 24 10:35: 07 p0drg0l1 amass LI BSCHED1[ 7215870] :

E7003(16) <00000>: xdi St k686: Media Id = P20676, Drive index = 1

Sep 24 10: 35: 07 p0drg0l1 amass LI BSCHED1[ 7215870] :

E7003(16) <00000>: xdi Stk719: Sendi ng a di snbunt conmand

Sep 24 10:35: 07 p0drg0l1 amass LI BSCHED1[ 7215870] :

E7003(16) <00000>: xdi St k2742: Waiting for ACSLS response

Sep 24 10:35: 07 p0drg0l1 amass LI BSCHEDL[ 7215870] :

E7003( 16) <00000>: xdi St k2749: STK Response received; Status: 0

Sep 24 10:35: 07 p0drg0l1 anmass LI BSCHED1[ 7215870] :

E7003( 16) <00000>: xdi St k2758: Error unexpected sequence nunber: 101 -
expect ed sequence nunber: 109

Examine the sections of the log with entries near the time of any problem being
investigated, looking for messages that indicate whether there was successful
communication between AMASS and ACSL S regarding mounting of atape and
transfer of information. It may be useful to search the log for occurrences of the word
fail (while viewing the log with pg, view, vi, or other viewing/editing tool, type /fail
and press the Return/Enter key).

If the log indicates problems in communication between AMASS and ACSLS, it may
be useful to use the quedisplay command to obtain the AMASS view of the queue
and the medialist command to obtain the robot view. If these commands show
discrepancies indicating alack of synchrony between AMASS and ACSLS, it may be
possible to re-establish that synchrony using the mediamove command (refer to
Section 17.7.1.6, Using mediamove to Establish Synchrony Between quedisplay
and medialist).

Note: The message "Error unexpected sequence number: 101 -expected sequence
number: 109" isan artifact likely to be removed in releases of AMASS subsequent to
Version 5.0.0 Revision 17 and does not reflect areal error.
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Table 17.7-10. Checking the tac Log

Step What to Do Action to Take
Log in at FSMS host enter text; press Return/Enter
cd /usr/famass/logs/tac enter text; press Return/Enter
pg tac_00 (or vi, view, tail, or other viewing tool) enter text; press Return/Enter

17.7.2.4 Handling a Data Insertion Failure

Successful data insertion requires interactions among numerous servers, and the interactions are
reflected in entries in the debug logs for those servers. Detection and initia isolation of a
problem that prevents successful insertion may require tracing events across multiple log files on
different hosts. Table 17.7-11 presents the steps required for recovering from a failure to store
data. If you are aready familiar with the procedure, you may prefer to use this quick-step table.
If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1

At the host for SDSRV (e.g., €0acs05, g0acs03, |0acs03, n0acsD4), review the debug log

EcDsScienceDataSer ver Debug.log (use Section 17.7.2.1, Checking Server Log Files).

» Examine the section of the log with entries near the time of the problem, looking for
error messages that indicate communication failure.

» If thelog file entries indicate a communication problem, note the server(s) with which
there isimpairment or disruption of communication.

At the host for Archive Server (e.g., €0drgl1, gOdrg01, 10drg01, nOdrg01), review the

debug log EcDsStAr chiveSer ver Debug.log (use Section 17.7.2.1, Checking Server Log

Files).

» Examine the section of the log with entries near the time of the problem, looking for
error messages that indicate communication failure.

» If thelog file entries indicate a communication problem, note the server(s) with which
there isimpairment or disruption of communication.

If Step 1 and/or Step 2 resulted in detection of a problem in the interaction of SDSRV

and/or Archive Server with other servers, at the host(s) for those servers, review the

server debug log(s). These logs may include:

» EcDsStStagingDisk Server Debug.log (on Archive Server host).

» EcDsStCacheM anager Server Debug.log (on Archive Server host).

* EcDsStRequestM anager Server Debug.log (e.g., on e0dis02, g0dis02, 10dis02,
n0dis02; use procedure in Section 17.7.2.2).

* EcloAdServer Debug.log (e.g., on e0ins02, g0ins02, 10ins02, n0ins02).

* EcSbSubServerDebug.log (e.g., on e0ins01, g0ins01, 10ins01, n0ins01).
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If there is evidence of requests not succeeding or other communication failure, it may
be necessary to have System Administrators or Engineering Support personnel
resolve the problem (e.g., restart affected servers, execute EcCsl dPingServers,
ensure that the Name Server is up in the mode being used and that its debug log
reflects appropriate look-up activity by the application servers, mount points are
intact, and database access is not impaired).

Note: The next three steps address running the Check Archive script,
EcDsCheckArchive. To run this script, it is necessary to enter eight database-specific
parameters when prompted during the running of the script: STMGT SQL server
name, STMGT database name, STMGT SQL server userlD, STMGT SQL server
database password, SDSRV SQL server name, SDSRV database name, SDSRV SQL
server userlD, and SDSRV database password. To facilitate the smooth execution of
the script, the parameters may be set as environmental variables instead. The
parameters are not readily available to most operators; therefore, you will need to
obtain them from the Database Administrator or have the Database Administrator run
the script for you, using Steps 4 through 6.

On the host for the Archive Server, type cd /usr/ec§<MODE>/CUSTOM

/utilities and then press the Return/Enter key.

The prompt reflects the directory change to /usr/ecss<MODE>/CUST OM/utilities.

Type EcDsCheck Archive <MODE>.

The Check Archive script runs; the initially displayed information should be similar
to the following:

This script is designed to validate the Inventory
agai nst the Archive.

The user nust select the nenu option associated with the
Vol ume Group to be validated

Pl ease press [RETURN] to continue

6 Follow the on-screen prompts for the script, entering the necessary parameters.

The script provides indication of any discrepancies between the presence of granules
in the Archive and entriesin the inventory (metadata). Note that the appearance of a
discrepancy is not necessarily indication of afailure (e.g., if agranule has been
deleted but the inventory database has not been cleaned up, there may be inventory
entries for which there are no granules in the archive), but a problem may be indicated
If adiscrepancy is apparent for agranule that you just inserted. Note also that this
script would not reveal a problem if you attempted to insert a granule which failed to
get inserted and also had its metadata fail to be inserted into the inventory (i.e., no
granule and no inventory entry = no discrepancy). Therefore, if the script reveals no
discrepancies, it may still be useful to conduct a direct examination to determine if the
granule has been inserted.
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10

11

12

On the host for the Archive Server, type the directory change command cd
/dss_stk1/<MODE>/<data_type directory> and then press the Return/Enter key.
» Theworking directory is changed to /dss_stk1/<MODE>/<data_type directory>.

Typels-al | grep " <date>" where" <date>" is athree-letter abbreviation for the month

followed by a number indicating the day (e.g., " Apr 21") for the granule being inserted,

and then press the Retur n/Enter key.

» If theinserted fileis displayed, with date and time of entry, go to Step 9.

» If theinserted file is not displayed, have the Ingest/Distribution Technician insert the
fileagain. If thissucceeds (i.e., thefileisnow listed), go to Step 9; otherwise,
conduct the procedure for Diagnosing/I nvestigating Write Errors, Section 17.7.3).

Determine if the inserted file is reflected in the Inventory Database (Database

Administrator function) by logging into Sybase on the host for SDSRV and then selecting

the data type for the granule being inserted.

» If theinserted fileisreflected in the Inventory Database, go to Step 10.

» If theinserted fileis not reflected in the Inventory Database, ensure that database
accessis not impaired (Database Administrator function).

Determine if the directory from/to which the copy is being made is visible on the machine

being used; have the System Administrators or Engineering Support personnel check the

mount points on the Archive host and the SDSRV host.

* If the mount points are OK, go to Step 11.

» If necessary, have the System Administrators or Engineering Support personnel re-
establish the mount point(s).

If you inserted the file with the DSS Driver, go to Step 13. If you used Ingest to insert
thefile, on the Ingest host (e.g., e0icgl1, g0icg01, 10acg02, n0acg01) examine the drp- or
icl-mounted staging directory to determineif a staging disk was created. To do this, first
type cd /usr/ecs/<MODE>/CUST OM/dr p/<host>/data/staging/cache (or type cd
/usr/ecs’<MODE>/CUST OM/icl/<host>/data/StagingAr ea/cache), then press the
Return/Enter key.

» The prompt reflects a change to the specified directory. [Note: Be sure that you are
checking the correct mount/host. Most ingests use Ingest subsystem staging areas
(i.e, icl), but others may not. Mediaingest (e.g., from tape) typically involves
staging in adip area. For apolling ingest for data from EDQOS, the polling directory
may serve as the staging area. Some data are staged directly to working storage in the
Data Server subsystem. If in doubt, consult Ingest/Archive personnel.]

Typels-al | more and then press the Return/Enter key.

* Any staging areas are listed in output similar to the following sample:
STW-FWAT - - 1 cnshared cnshared 10375 Jan 30 14: 46
: SC: L70RF2. 002: 16015: 6. HDF- EOS
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13

14

STW WY - - 1 cnshared cnshared 535563 Jan 30 14: 46
: SC: L70RF2. 002: 16015: 7. HDF- ECS

STW WY - - 1 cnshared cnshared 154399 Jan 25 12:34

: SC: L7CPF. 002: 13835: 1. ASCl |

STW WY - - 1 cnshared cnshared 154399 Jan 25 14:17

: SC: L7CPF. 002: 16644: 1. ASCI |

STW WY - - 1 cnshared cnshared 154399 Jan 25 17:31

: SC: L7CPF. 002: 16769: 1. ASCI |

STW WY - - 1 cnshared cnshared 67466 Jan 25 18:11
:SC: L71 GS. 001: 16789: 1. ASCI |

STWTWAT - - 1 cnshared cnshared 43570 Jan 25 18: 04
:SC: L71 GS. 001: 16790: 1. ASCI |

STW WY - - 1 cnshared cnshared 499804704 Feb 6 11:49
: SC: MOD0O0O0. 001: 11856: 1. CCSDS

STW WY - - 1 cnshared cnshared 320663592 Feb 6 11:51
: SC: MOD0O0O0. 001: 11856: 2. CCSDS

STWTWAT - - 1 cnshared cnshared 540 Feb 6 11:51

: SC: MOD000. 001: 11856: 3. CCSDS.

» If astaging areafor the inserted file appears at the end of thelist, go to Step 13.

* If no staging area appears for the inserted file, it is possible that the ingest failed and
that the staging area was immediately removed as part of clean-up. Check the Ingest
logs (e.g., EclnRegM gr Debug.log, Ecl nAutoDebug.log, EclnGranDebug.log, or
EclnGranDebug.log, depending on the type of Ingest) (refer to procedures for
troubleshooting Ingest problems, Chapter 16) to determine if a staging disk was
created. If no staging disk was created, it may be necessary to resolve a
communications failure as described in Step 7.

Ensure that the Archive volume groups are set up correctly (refer to Section 17.3.2, Using
Storage Management GUIsto Display Archive Path Information).

Ensure that the volume groups are on line (refer to Section 17.7.1.3, Using vollist to

Display Volume Data).

» If the volume groups are set up correctly and their volumes are on line, and insertion
still fails, it is appropriate to contact the Help Desk and prepare atrouble ticket (see
Chapter 8).
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Table 17.7-11. Handling a Data Insertion Failure

Step What to Do Action to Take

1 Review Science Data Server Debug Log Use procedure in Section
17.7.2.1

2 Review Archive Server Debug Log Use procedure in Section
17.7.2.1

3 Review debug logs for any implicated servers: Use the following procedures:

a. EcDsStStagingDiskServerDebug.log

b. EcDsStCacheManagerServerDebug.log
c. EcDsStRequestManagerServerDebug.log
d. EcloAdServerDebug.log

e. EcSbSubServerDebug.log

a. Section 17.7.2.1
b. Section 17.7.2.1
c. Section 17.7.2.2
d. Section 17.7.2.1
e. Section 17.7.2.1

4 (On Archive Server host) enter text; press Return/Enter
cd /usr/ecs/<MODE>/CUSTOM/utilities
5 EcDsCheckArchive <MODE> enter text; press Return/Enter
6 Respond to prompts to complete Check Archive Script | read text; enter text; press
Return/Enter
7 (On Archive Server host) enter text; press Return/Enter
cd /dss_stk1l/<MODE>/<data_type directory>
8 Is -al | grep "<date>" enter text; press Return/Enter
9 Check for file in SDSRV Inventory database (Database Administrator task)
10 Check mount points on Archive host and SDSRV host | (System Administrator task)
11 (For Ingested file, on Ingest host) enter text; press Return/Enter
cd /usr/ecs/<MODE>/CUSTOM/drp/<host>/data/
staging/cache
OR
cd /usr/ecs/<MODE>/CUSTOM/icl/<host>/data/
StagingAreal/cache)
12 Is -al | more enter text; press Return/Enter
13 Check Archive path information to ensure volume Use procedure in Section 17.3.2
groups are set up correctly
14 Use vollist to ensure that volume groups are online Use procedure in Section

17.7.1.3
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17.7.2.5 Handling a Data Acquire Failure

As afirst check, it is appropriate to determine if the acquire request appears in the list of System
Requests on the Science Data Server GUI. If the acquire request does not appear on the Science
Data Server GUI, you will need to determine where the breakdown occurred. Diagnosing an
acquire failure requires detailed examination of the following system log files and directories
associated with the process:

» Science Data Server log file (EcDsScienceDataServerDebug.log).
» Archive Server log file (EcDsStArchiveServerDebug.log).
*  STMGT Request Manager Server log file (EcDsStRequestM anagerDebug.log)
» Staging Area.
- Presence of the relevant file.
— Staging Disk log files (EcDsStStagingDiskServerDebug.log or
EcDsStCacheManager
ServerDebug.0g).
— Space available in the staging area.

In addition, note that a number of servers, clients, or other software running on various hosts, as
reflected in Table 17.7-12, may be involved at various times in processing an acquire request.
More information useful in troubleshooting may appear in related logs on these hosts.

Table 17.7-12. Hosts, Servers, Clients and Other Software Relevant to Acquires

HOST SERVER/CLIENT/OTHER SOFTWARE
Distribution Server (e.g., e0dis02, Distribution Server (EcDsDistribution Server)
g0dis02, 10dis02, n0dis02) Request Manager Server (EcDsStRequestManagerServer)
Working Storage (e.g., eOwkg01) Archive Server (EcDsStArchiveServer)

Cache Manager Server (EcDsStCacheManagerServer)
Staging Disk Server (EcDsStStagingDiskServer)

SDSRYV Server (e.g., e0acs05, Science Data Server (EcDsScienceDataServer)
g0acs03, 10acs03, n0acs04) HDF EOS Server (EcDsHdfEosServer)
Access/Process Coordinators (APC) Archive Server (EcDsStArchiveServer)

Server (e.g., edacgll, gOacg01, FTP Server (EcDsStFtpServer)

I0acg02, n0acg01) Cache Manager Server (EcDsStCacheManagerServer)

Staging Disk Server (EcDsStStagingDiskServer)
Pull Monitor Server (EcDsStPullMonitorServer)

FSMS Server (e.g., e0drgl1, g0drg01, | Archive Server (EcDsStArchiveServer)

|0drg01, n0drg01) Cache Manager Server (EcDsStCacheManagerServer)
Staging Disk Server (EcDsStStagingDiskServer)

Interface Server 02 (e.g., e0ins01, Subscription Server (EcSbSubServer)

g0ins01, 0ins01, nOins01) Event Server (EcSbEventServer)
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Table 17.7-13 presents the steps required for recovering from a failure to retrieve data. The
procedure is used to:

* maketheinitial check on the Science Data Server GUI.
» follow up with checks of the Science Data Server log file, Archive Server log file, and

Request Manager log file.

* determineif afailure occurred during copying of thefilesto a staging area (and if so,

whether there is sufficient staging space available).

If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1

2

Launch the Science Data Server GUI (see Section 17.3.1 Launching DSS GUI s).

Click on the System Requests tab.
* The System Requests window is displayed.

Examine the requests displayed in the System M anagement Requests field to determine

if SDSRV received the acquire request.

» If the number of request islarge, the Find button and field below the System
Management Requests field may be used to enter and search for information in the
reguest, such as the Requester, or the Filter . . . button ca be used to launch a System
Management Filter Requests window to limit the number of entries that appear in
the System Management Requestsfield.

On the SDSRV Server host (e.g., €0acs05, g0acs03, 10acs03, n0acs04), review the server
logs EcDsScienceDataSer ver AL OG and EcDsScienceDataSer ver Debug.log (refer to
Section 17.7.2.1, Checking Server Log Files).

» Examine the section of the log with entries near the time of the problem, looking for
messages that indicate whether the relevant file was successfully acquired.

» The EcDsScienceDataServer AL OG file should contain entries identifying the file
to be acquired by the ShortName of the corresponding ESDT; entries should be
similar to the following:

PID : 29168: MsgLi nk : 0 neani ngf ul name
: DsSr Sessi onExecut eRequest Start0

Msg: Request |D b5156038-03d3-11d3-8d16-c676e82eaa77: ?2???:
executing:
DsSrRequest (1): DsShSci Requestlnp: [ svr: ScienceDS, pri: NORVAL
domai n: ]: (DsShSci Commandl np: service: |NSERT num paraneters: 3
category: Paraneters are:

- UnnamedPL[ SHORTNAVE( AST_L1BT) VERSI ONI D( 001)
- - MAI NGROUP[ SHORTNAVE( AST_L1BT) VERSI ONI D( 001)

METAFI LEGROUP] METADATAFI LE(/ hone/ cnops/ dat a/ SCAST_L1BT. 0011279. net) ]
- - - DATAFI LEGROUP[ DATAFI LE(/ hone/ cnops/ dat a/ t ahoe- nort h- ni ddl e. MTA) ]

- - - DATAFI LEGROUP[ DATAFI LE(/ horre/ cnops/ dat a/ t ahoe-nort h-mi ddl e. hdf)]]]
WC)
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The EcDsScienceDataSer ver Debug.log file should contain entries regarding the

acquire activity. The following types of messages should be included in the log file:
05/06/99 12:52:01:

About to execute Statenent: exec ProclnsertReqDonai n 2205,

"UR: 10: DsShESDT

UR: UR: 15: DsShSci Server UR: 13: [ VTC. DSSDSRV] : 20: SC: AST_L1BT. 001: 2201"
05/06/99 12:52:01:

About to execute Statenent: ProclnsertAcquireCnd 2206, 2205, 3, null,

null, "tester", "FtpPush", "MAIL", "FILEFORMAT", null, "jrattiga",
"abc123", "tl1ldps04", "/hone/jrattiga
/push”, null, null

If the ShortName does not appear in the file, with a timestamp corresponding to the
time of the attempted acquire, SDSRV may not be running, or may not be
communicating with other servers. Have the System Administrator or Operations
Controller check to be sure the server isup and, if appropriate, resolve the problem
(e.g., restart affected servers, execute EcCsl dPingSer ver s, ensure that the Name
Server isup in the mode being used and that its debug log reflects appropriate ook-
up activity by the application servers, mount points are intact, and database accessis
not impaired).

If the log file does contain entries for the relevant ShortName, and indicates that two
files (the file and its associated metadata file) are being distributed, SDSRV has
completed its role in the acquire. Go to the next step.

If the ALOG contains the ShortName, and also contains an error showing that the
data file time stamp does not match the time stamp required by the acquire, the data
file needs to be removed from the Science Data Server and reinserted.

— Thisisusualy done using a script called DsDbCleanGranules.

To inspect the Archive Server log and Request Manager Server log for error messages
associated with the acquire, on the Archive host (e.g., e0drgl1, gOdrg01, 10drg01,
n0drg01), review the respective server logs (EcDsStAr chiveSer ver Debug.log,
EcDsStRequestM anager Server Debug.log); refer to Section 17.7.2.1, Checking Server
Log Filesand Section 17.7.2.2, A Special Case: Checking the Request M anager
Server Debug L og.

Examine the sections of the logs with entries near the time of the problem, looking for
messages that indicate whether the Request Manager handled the request and whether
the Archive Server log shows that the relevant file was successfully acquired.

If the logs indicate that the relevant file was successfully acquired, go to the next step.
If the file was not successfully acquired, it may be necessary to reboot AMASS (see
Section 17.1.3 Rebooting AMASS) and investigate the possibility of read errors (see
Section 17.7.4 Diagnosing/I nvestigating Read Errors).
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10

To determine whether the file being acquired (or alink to it) and its associated metadata
file arrived in the Data Distribution staging area, on the Distribution Server (e.g.,
e0dis02, g0dis02, 10dis02, n0dis02) type cd /usr/ecs/<MODE>/CUST OM/drp/
<archivehost>/data/staging/cache and then press the Return/Enter key.

» Theworking directory is changed to the specified directory.

Typels-Irt and then press the Return/Enter key.
* The contents of the directory are displayed.

Review the listing to determine whether the relevant file and its metadata file arrived in
the staging area.
* Thedisplay should contain entries similar to the following:
I rwxrwxr-x 1 cnshared cnshared 75 Apr 26 12:52
L7CPF19980518_19980518. 01 ->
[ usr/ ecs/ TS1/ CUSTOM dr p/ r aven/ dat a/ st agi ng/ cache/ : SC. L7CPF. 001: 1427: 1
. ASCl |
ST W T W T W 1 cnshared cnshared 14802 Apr 26 12:52
SCL7CPF. 0011427. et

STWTWT-- 1 cnshared cnshared 111 Apr 26 13:01
stagi ng. disk.filenane.|list
STWTWT-- 1 cnshared cnshared 2044 Apr 26 13:01

PACKI NG. LST. 115124935248431

« If therelevant files were not successfully staged, the staging log files may reveal the
cause; go to Step 9.

» If therelevant files were successfully staged, an acquire failure could be aresult of
problems with related servers or software (see Table 17.7-12). Have the System
Administrator or Operations Controller ensure that the necessary hosts and servers are

up.

To inspect the Staging Disk log for error messages associated with the acquire, on the

APC Server host (e.g., e0acgll, gOacg01, 10acg02, nOacg0l), review the server logs

(e.g., EcDsStStagingDisk Server Debug.log; EcDsStCacheM anager Server Debug.log);

refer to Section 17.7.2.1, Checking Server Log Files.

» Examine the section of each log with entries near the time of the problem, looking for
messages that indicate whether the relevant files were successfully staged.

» If therelevant files were not successfully staged, the cause may be alack of spacein
the staging area; go to Step 10.

» If therelevant files were successfully staged, an acquire failure could be aresult of
problems with related servers or software (see Table 17.7-12). Have the System
Administrator or Operations Controller ensure that the necessary hosts and servers are

up.

To check the space available in the staging area, on the Distribution Server (e.g., e0dis02,
g0dis02, 10dis02, n0dis02) type cd /usr/ecs'<mode>/CUSTOM/
drp/<archivehost>/data and then press the Return/Enter key.

* Theworking directory is changed to the specified directory.
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11 Ty

pedf -k . (besuretoincludethe™.") and then pressthe Return/Enter key.
The filesystem, staging disk space capacity in kbytes, amount used, amount available,

and percent of capacity are displayed, asin the following example:
Fi | esystem kbyt es used avail capacity Mounted on
t 1drg01: /usr/ ecs/ TS1/ CUSTOM dr p/ t 1dr g01/ dat a
225209856 173253056 51956800 7%
/ dat al/ ecs/ TS1/ CUSTOM dr p/ t 1dr g01/ dat a
If there is not adequate space for staging the relevant files, it will be necessary to free

up additional space (e.g., by purging expired files from cache).

Table 17.7-13. Handling a Data Acquire Failure

Step What to Do Action to Take
1 Launch the Science Data Server GUI Use procedure in Section 17.3.1
2 Select the System Requests tab single-click
3 Review list of System Management Requests to read text
determine if SDSRYV receive the acquire request
4 Review SDSRYV logs for evidence of acquire or errors: | Use the following procedures:
a. EcDsScienceDataServer.ALOG a. Section 17.7.2.1
b. EcDsScienceDataServerDebug.log b. Section 17.7.2.1
5 Review server logs for acquire error messages: Use the following procedures:
a. EcDsStArchiveServerDebug.log a. Section 17.7.2.1
b. EcDsStRequestManagerServerDebug.log b. Section 17.7.2.2
6 (On the Distribution Server host) enter text; press Return/Enter
cd /usr/ecs/<MODE>/CUSTOM/drp/<archivehost>/
data/staging/cache
7 Is —Irt enter text; press Return/Enter
8 Review listing for relevant file and metadata read text
9 (On APC Server host)
Review staging disk logs for acquire error messages: Use the following procedures:
a. EcDsStStagingDiskServerDebug.log a. Section 17.7.2.1
b. EcDsStCacheManagerServerDebug.log b. Section 17.7.2.1
10 (On the Distribution Server host) enter text; press Return/Enter
cd /usr/ecs/<mode>/CUSTOM/drp/<archivehost>/
data
11 dr -k . enter text; press Return/Enter
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17.7.3 Diagnosing/Investigating Write Errors

Although write errors to the archive should be infrequent, there are some circumstances under
which they may occur. Associated error messages should appear in arelevant log file (e.g., on a
Sun, in /var/adm/messages; on an SGlI, in /var/adm/SYSLOG). Causes of write errors may
include the following:

AMASS off line -- software captures and logs the error because the directory that is
being written to does not exist. However, the nature of the write error is not detected.
Directory does not exist -- if thereis an attempt to write to a directory that does not
exist, even if AMASS ison line, theresult isawrite error.

All drives off line -- write requests are accepted until cache space fills up, which stops
further data transfer.

Volume off line or no media associated with the directory - causes awrite error that is
detectable by the software. An 1/O error isrecorded in the relevant log file.

AMASS media write failure -- causes the drive to go off-line and the media volume
to go off-line aswell. The error iswritten to the relevant log file. No error is detected
by the application software. The operator can execute the command
/usr/famass/bin/drivelist to see which drive has been put off-line.

Table 17.7-14 presents the general steps required for diagnosing/investigating write errors. |If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1

2

Log in to the FSMS host (e0drg11, g0drg01, 10drg01, or n0drg01) as amass.

To verify that AMASS is running and active, type /usr/amass/bin/amassstat -c and then
press the Return/Enter key.

The message FILESYSTEM ISACTIVE isdisplayed.

If the message FILESYSTEM ISINACTIVE isdisplayed, AMASS isinactive (off
line); to put AMASS back on line, type /usr/amass/bin/amassstat -a and press the
Return/Enter key, entering y in answer to the displayed confirmation question Do
you want to change the status? [y - n]. If thisdoes not activate AMASS, it may be
necessary to reboot it (refer to Section 17.1.3, Rebooting AMASS).

Display AMASS I/0O activity (refer to Section 17.7.1.2, Using sysperf to Display the
Status of AMASS /0 Activity).

If the returned output indicates no free cache blocks, this may indicate that all drives
are off line and that as aresult all available cache space isfilled, stopping write
actions. Inthat case, it may be necessary to use ctrl-c to cancel pending 1/0 requests.
If there are no free cache blocks, go to Step 4; otherwise, go to Step 5.
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4 Type /usr/amasg/bin/drivelist and press the Return/Enter key.
AMASS returns the status of drivesin format similar to the following:

DRI VE JUKE STATUS ERRORS

1 1 A 0
2 1 A 0
3 1 [ 0
4 1 A 0
1 2 [ 0
2 2 A 0
1 3 A 0
2 3 A 0
3 3 A 0
[usr/amass/ bi n/driveli st

: 9 drives configured in this system

5 Use the amass_log script to display and examine AMASS errors (refer to Section
17.7.1.4, Using the amass |og Script to Display AMASSErrors).

If the returned error message(s) identify critical problems that prevent AMASS from

functioning correctly, follow the corrective guidance specified in the System

Administrator’s Guide for the specific error(s).

If there are no hardware problems and there have not been repeated attempts to
activate the drive(s) that are off line, reactivate the drive(s) (see Step 6).

6 For each off-line drive, type /usr/amass/bin/drivestat -a drivenumber [jukeboxnumber]
and press the Return/Enter key.
AMASS places on line the drive specified by drivenumber in the jukebox specified

by jukeboxnumber.

7 Check the tac log for evidence of problemsin communication between AMASS and
ACSLS (refer to Section 17.7.2.3, Checking thetac L og).

If there is evidence of communication problems, investigate and correct any lack of

synchrony between AMASS and ACSLS (refer to Section 17.7.1.6, Using

mediamove to Establish Synchrony Between quedisplay and medialist).

Table 17.7-14. Diagnosing/Investigating Write Errors (1 of 2)

Step What to Do Action to Take
1 Log in to the FSMS host as amass enter text; press Return/Enter
2 /lusr/amass/bin/amassstat —c enter text; press Return/Enter
3 Display status of AMASS 1/O activity Use procedure in Section
17.7.1.2
4 (If no free cache blocks) enter text; press Return/Enter
/usr/famass/bin/drivelist
5 Run amass_log script Use procedure in Section
17.7.14
6 /lusrlamass/bin/drivestat -a drivenumber enter text; press Return/Enter
[jJukeboxnumber]
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Table 17.7-14. Diagnosing/Investigating Write Errors (2 of 2)
Step What to Do Action to Take

7 Check tac log Use procedure in Section
17.7.2.3

17.7.4 Diagnosing/Investigating Read Errors

When aread error is encountered by AMASS, both the drive and the volume (tape) are taken off
line. The application is notified of the read failure. The Archive Server logs an error message
when the read failure is returned. The log message includes the name of the file, the secondary
path for the file, the checksum for the file, and a reason for the failure. If the reason for failureis
a checksum mismatch on retrieval, then the file must be restored. If the reason for failure
indicates the media was off line, then further investigation is warranted to determine why the
tape was off line. Off-line status can be the result of a write error, a read error on the file, or a
read error on another file that caused AMASS to take the tape off line, thus making other reads
fail. For atape that is off line, or for atape and drive that are off line together, one possibility is
that the tape is damaged. Damage may be confirmed by visual inspection or, more likely, the
need to have vendor maintenance remove the media from the drive. Any requests for files on that
tape fail or are served from backup. It isimportant that the list of filesthat is created for restoring
a tape from backup be kept and searched when new files are reported missing. This should
reduce the number of times that certain recovery procedures have to be performed (see Section
17.6.2.3 Manual Data Recovery from Damaged Cartridge).

Table 17.7-15 presents the steps required for diagnosing/investigating read errors observed
during operations (e.g., appearing in the Archive Server debug log, or appearing as an /O error
message at the command line during an attempt to copy a file from an archive volume). If you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are
new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Log in to the FSMS host (e0drgl1, g0drg01, 10drg01, or n0drg01) as amass.

2 Examine the Archive Server debug log EcDsStAr chiveSer ver Debug.log (refer to
Section 17.7.2.1, Checking Server Log Files) for error messages associated with the
read failure.

» Examine the sections of the log with entries near the time of the failure, looking for
messages that indicate read failure. 1t may be useful to search the log for occurrences
of the word fail (while viewing the log with pg, view, vi, or other viewing/editing
tool, type /fail and pressthe Return/Enter key).

* From the failure information in the log, note the name of the file, the secondary path
for the file, the checksum for the file, and the reason for the failure.

» |f thereason for the failure is specified as a checksum mismatch on retrieval, go to
Step 3. If the reason indicates media being off line, go to Step 4.
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Restore the corrupted file (refer to Sections 17.6.2.1, Manual Data Recovery from
Local Backup Tapes; 17.6.2.2, Manual Data Recovery from Offsite Backup Tapes;
and 17.6.2.3, Manual Data Recovery from Damaged Cartridge as appropriate).

Typedirfilelist path, where path is the full path name of the directory location of thefile

on which the read error occurred (e.g., /dss_stk1/OPS/modI|0), and then press the

Return/Enter key.

«  AMASS returnsalisting of the filesin the directory, listing for each one the volume
onwhich it isstored and its logical block address. Note the volume number for the
file on which the read error occurred.

Use the vollist command to display datafor the volume identified in Step 4 (refer to

Section 17.7.1.3, Using vollist to Display Volume Data).

*  AMASSdisplays datafor the specified volume; if the volumeis off line (has O
displayed in the FL AGS column of the output), placeit on line using the command
volstat -a and pressing the Return/Enter key.

Use the amass_log script to display and examine AMASS errors (refer to Section

17.7.1.4, Using the amass |og Script to Display AMASSErrors).

» If thereturned error message(s) identify critical problems that prevent AMASS from
functioning correctly, follow the corrective guidance specified in the System
Administrator’s Guide for the specific error(s).

» If there are no hardware problems and there have not been repeated attempts to
activate the drive(s) that are off line, reactivate the drive(s) (see Step 7).

For each off-line drive, type /usr/amass/bin/drivestat -a drivenumber [jukeboxnumber]

and press the Return/Enter key.

* AMASS places on line the drive specified by drivenumber in the jukebox specified
by jukeboxnumber.

Check the tac log for evidence of problemsin communication between AMASS and

ACSLS (refer to Section 17.7.2.3, Checking thetac L 0g).

» If thereisevidence of communication problems, investigate and correct any lack of
synchrony between AMASS and ACSLS (refer to Section 17.7.1.6, Using
mediamove to Establish Synchrony Between quedisplay and medialist).
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Table 17.7-15. Diagnosing/Investigating Read Errors

Step What to Do Action to Take

1 Log in to the FSMS host as amass enter text; press Return/Enter

2 Examine the Archive Server debug log Use procedure in Section
17.7.2.1

3 Restore any corrupted file Use procedure in Section
17.6.2.1,17.6.2.2, 0or 17.6.2.3 (as
appropriate)

4 dirfilelist path enter text; press Return/Enter

5 vollist nnn Use procedure in Section
17.7.1.3

6 Run amass_log script Use procedure in Section
17.7.14

7 /lusrlamass/bin/drivestat -a drivenumber enter text; press Return/Enter

[jJukeboxnumber]

8 Check tac log Use procedure in Section

17.7.2.3

17.8 ACSLS Procedures

For the StorageTek Powderhorn, direct control of the tape storage and handling operations is
managed by the Automated Cartridge System Library Software (ACSLS). Full guidance for
using ACSLS is provided in the Automated Cartridge System Library Software System
Administrator’s Guide. Table 17.8-1 lists the commands covered in that Guide.

Table 17.8-1. ACSLS Command Reference (1 of 2)

Command Function
audit Creates or updates the database inventory of the volumes in a library component.
cancel Cancels a current or pending request.

clear lock Removes all active and pending locks on transports or volumes.
define pool | Creates or modifies scratch pools.

delete pool | Deletes empty scratch pools.

dismount Dismounts a volume.

eject Ejects one or more volumes from the Automated Cartridge System (ACS).
enter Sets a Cartridge Access Port (CAP) to enter mode.

idle Stops ACSLS from processing new requests.

lock Locks (dedicates) a volume or transport to a user.

logoff Exits the command processor.

mount Mounts a data or scratch volume.
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Table 17.8-1. ACSLS Command Reference (2 of 2)

Command Function

query Displays the status of a library component.

set Sets various attributes of different library components.

show Displays your lock ID or user ID.

start Starts ACSLS request processing.

unlock Removes active locks on volumes or transports.

vary Changes the state of an ACS, LSM, CAP, transport, or port.

venter Enters one or more volumes with missing or unreadable labels into the ACS.

ACSL S commands use the following general syntax:
command type identifier state [options]

where type identifier is the ACS component and its identifier (these are listed in the System
Administrator’s Guide), state is a device state for the vary command only, and options are
command options (these are specified for each command in the System Administrator’s Guide.
The two most useful commands in ACSLS are query and vary. Other frequently used
commands are enter and gject, for inserting and removing cartridges, respectively. ACSLS does
not have an online help facility, but if you enter a command (e.g., vary), it will prompt you for
the parameters.

There are also severa utilities provided with ACSLS. These are listed with their functions in
Table 17.8-2.

Table 17.8-2. ACSLS Utilities

Utility Function
bdb.acsss Backs up the ACSLS database.
kill.Lacsss Terminates ACSLS.
rc.acsss Starts and recovers ACSLS.
rdb.acsss Restores the ACSLS database.
Volrpt Creates a volume report.
db_command | Starts or stops the Oracle database.

To control and interact with ACSLS, you use the following user IDs:

» acssaletsyou enter ACSLS commands from a command processor window.
* acsssletsyou run ACSLS utilities from the UNIX command line prompt.

It is typical to log in as both user IDs to permit entering both ACSLS utilities and commands.
You can, however, open a command processor window from the acsss user ID if you prefer to
work from asingle user ID. The System Administrator’s Guide provides full details.
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Table 17.8-3 provides an Activity Checklist for major ACSLS procedures addressed in this
section.

Table 17.8-3. Activity Checklist for ACSLS Procedures

Order Role Task Section Complete?
1 Archive Manager Entering the Archive after AMASS is (P)17.8.1
Started
2 Archive Manager Backing up the ACSLS Database (P) 17.8.2
3 Archive Manager Restoring the ACSLS Database (P) 17.8.3
4 Archive Manager Checking Cleaning Cartridges (P) 17.8.4

17.8.1 Entering the Archive After AMASS is Started

There are circumstances in which it may be necessary to enter the archive after AMASS is
started. For example, there may be a requirement for maintenance that necessitates access to the
robot or other areainside the Powderhorn. Another exampleisthat it may sometime be desirable
to bypass the Cartridge Access Port (CAP) when inserting tape cartridges, if there is a need to
perform bulk loading of alarge number of tapes, although usually this would be limited to initial
loading of the volumes. Table 17.8-4 presents the steps required for entering the archive after
AMASS has started. If you are already familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1 At the host for ACSLS (e.g., €0dr s03, g0dr s03, 10dr s02, n0dr s03), log in using the
acssa user 1D and password.
* The acssa command-process window is displayed with the ACSSA> prompt.

2 Typevary Ism 0,0 offline and then press the Return/Enter key.
* The access port is unlocked (audible unlatching sound).

3 Use the key to unlatch and open the access door.
* Ared DO NOT ENTER warning isvisible inside the enclosure.

Warning

If it is necessary to enter the STK Powderhorn after
AMASS is started, it is necessary to perform the following
step to avoid hazard and ensure safety of personnel and
equipment.
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Remove the key from the door to ensure that no one inadvertently locks the enclosure
with someoneinside.

* Thered DO NOT ENTER warning is extinguished and a green ENTER message is
displayed inside the enclosure.

Upon leaving the enclosed area, insert the key in the access door and latch the door.
* TheLED display indicates that the door is locked.

At the ACSLS host, type vary Ism 0,0 online and then press the Retur n/Enter key.

After afew seconds, the archive robots execute an initialization sequence and the LSM is
back online.

Table 17.8-4. Entering the Archive after AMASS is Started

Step What to Do Action to Take
Log in to the ACSLS host as acssa enter text; press Return/Enter
vary Ism 0,0 offline enter text; press Return/Enter
Unlock and open access door operate lock to unlatch with
key

Remove key from unlatched door remove key

Insert key and latch door operate lock to latch with key
vary Ism 0,0 online enter text; press Return/Enter

17.8.2 Backing Up the ACSLS Database

ACSLS provides the bdb.acsss utility to back up the database. It is advisable to run this utility
when there has been a change in the archive volume structure (e.g., upon addition or removal of
volumes). In the event of database loss, it is possible to re-create the database even if thereisno
backup available, by using the audit command to inventory the archive. However, for a large
storage facility, creating the database this way may take several hours. If there is a backup
available, the database can be restored easily and quickly (refer to Section 17.8.3). Table 17.8-5
presents the steps required for backing up the ACSLS database. If you are already familiar with
the procedure, you may prefer to use this quick-step table. If you are new to the system, or have
not performed this task recently, you should use the following detailed procedure:

1

At the host for ACSLS (e.g., €0dr s03, g0dr s03, 10dr s02, n0dr s03), log in using the acsss
user ID and password.
* The acsss command-process window is displayed with the ACSSS> prompt.

Ensure that there is atape in the backup drive (device dev/rmt/0), a streaming tape drive
attached to each ACSL S workstation.
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3 Type bdb.acsss, and then press the Retur n/Enter key.
» If you enter bdb.acsss with no options, the backup utility defaults to the default tape
device attached and configured to the ACSL S server.

* The system displays the following message.
Check tape device (/dev/rnt/0) to nake sure you have a tape in the
tape drive.
[ Ht RETURN to continue or Ctrl-Cto exit ]

4 Pressthe Return/Enter key.
» The bdb.acsss utility backs up the ACSL S database and miscellaneous library
resource files.

Table 17.8-5. Backing Up the ACSLS Database

Step What to Do Action to Take

1 Log in to the ACSLS host as acsss enter text; press Return/Enter
2 Ensure there is a tape in the backup drive mount tape

3 bdb.acsss enter text; press Return/Enter
4 Return/Enter press Return/Enter

17.8.3 Restoring the ACSLS Database

ACSLS provides the rdb.acsss utility to restore the database in case of severe disk or data
problems. If you have made regular backups, it should be possible to restore the database with
little or no loss of data. Restoring the database is likely to be necessary if there has been a
system crash, or if the database cannot be started or has a physical or logical error. Table 17.8-6
presents the steps required for restoring the ACSL S database. If you are already familiar with the
procedure, you may prefer to use this quick-step table. If you are new to the system, or have not
performed this task recently, you should use the following detailed procedure:

1 At the host for ACSLS (e.g., €0dr s03, g0dr s03, 10dr s02, n0dr s03), log in using the acsss
user ID and password.
» The acsss command-process window is displayed with the ACSSS> prompt.

2 L oad the restore tape into the backup drive.

3 Type rdb.acsss, and then press the Return/Enter key.
» If you enter bdb.acsss with no options, the backup utility defaults to the default tape
device attached and configured to the ACSL S server.
* The system displays the following message.

Check tape device (/dev/rnt/0) to nake sure you have a tape in the
tape drive.
[ Ht RETURN to continue or Ctrl-Cto exit ]
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4 Pressthe Return/Enter key.
* Therdb.acsss utility restores the ACSL S database and miscellaneous library resource

files.
Table 17.8-6. Restoring the ACSLS Database
Step What to Do Action to Take
1 Log in to the ACSLS host as acsss enter text; press Return/Enter
2 Load the restore tape into the backup drive mount tape
3 rdb.acsss enter text; press Return/Enter
4 Return/Enter press Return/Enter

17.8.4 Checking Cleaning Cartridges

The Automated Cartridge System Library Software (ACSLS) schedules and implements routine
cleaning of the system tape drives after a set usage time tracked by the software, using cleaning
volumes from a cleaning volume group designated for that purpose. The ACSLS software also
tracks the number of times a cleaning tape is used, and will not use a cleaning tape that has been
used the maximum set number of times (usually set at 100 for the 9940 drives). It is the
responsibility of the Archive Manager to monitor cleaning tape usage periodically, to ensure that
usable cleaning tapes remain available to the system.

Table 17.8-7 presents the steps required to check cleaning cartridges for usage status. If you are
aready familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:

1 At the host for ACSLS (e.g., €0dr 03, g0drs03, 10drs02, n0dr s03), log in using the
acssa user 1D and password.
* The acssa command-process window is displayed with the ACSSA> prompt.

2 Type query clean all, and press the Return/Enter key.
* Note: The command may be abbreviated to qu cl a.
* ACSLSdisplaysinformation on the status of the cleaning volumesin format similar
to the following:

2001-10-04 08:50: 54 Cl eaning Cartridge Status
Identifier Hone Location Max Usage Current Usage Status Type
9840C1 0, 0, 3 2, 2 100 38 hone STK1U
9840C2 0, 0,13, 1, 3 100 0 hone STK1U
9940C1 0, 0, 1, 4,19 100 7 hone STK2W
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* Note: If itisdesirable or necessary to change the maximum number of uses permitted
for a cleaning volume, the change can be accomplished with the command
set clean <max_usage> <vol_id> where max_usage (e.g. 100) is the maximum
number of uses for that volume and vol_id is the volume id of that cleaning cartridge.

Table 17.8-7. Checking Cleaning Cartridges

Step What to Do Action to Take
1 Log in as acssa enter text; press Return/Enter
2 qguery clean all (or qu cl a) press Return/Enter

17.9 Using the AMASS Graphical User Interface (GUI)

AMASS offers a Graphical User Interface (GUI) called the AMASS Administration Window
(AAWInN) through which operators can administer volumes and volume groups that are managed
by AMASS. AAWin provides a point-and-click interface for identifying volumes their groups,
and their configurable parameters. The AAWin main window is composed of a menu bar, alarge
middle section called the workroom, a utility bar at the right with icons for a trash can, avolume
group, and a volume, and a status bar at the bottom with indicator “lights’ that represent the
current status of AMASS. Selecting the volume icon on the utility bar populates the workroom
with icons for volumes. Moving the cursor over one of the icons results in the appearance of
volume-related information in a pop-up display.

For large storage facilities, command-line interactions are likely to be faster and more responsive
than interactions with the AMASS GUI. Therefore it is unlikely that extensive use of the GUI
will be applied for most archive operations. However, it may be useful to have the GUI open for
monitoring and easy access to volume information (refer to Section 17.9.1, Launching the
AMASS GUI and Viewing Volume Group and Volume Information). Table 17.9-1 provides
an activity checklist for some procedures that may be accomplished using the AMASS GUI.

Table 17.9-1. Activity Checklist for Using the AMASS GUI

Order Role Task Section Complete?
1 Archive Manager Launching the AMASS GUI and Viewing (P)17.9.1
Volume Group and Volume Information
2 Archive Manager Using the AMASS GUI to Modify a Volume | (P) 17.9.2
Group
3 Archive Manager Using the AMASS GUI to Modify a Volume | (P) 17.9.3
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17.9.1 Launching the AMASS GUI and Viewing Volume Group and Volume
Information

Table 17.9-2 presents the steps required to launch the AMASS GUI and view information about
volume groups and volumes in the archive. If you are already familiar with the procedure, you
may prefer to use this quick-step table. If you are new to the system, or have not performed this
task recently, you should use the following detailed procedure:

1

2

Log in asamass at the FSM S host (e0drgl11, gOdrg01, 10drg01, or nOdrg01).

Type /usr/amass/bin/aawin and then press the Return/Enter key.
 The AMASS GUI main window is displayed.

Click on the View by Volume Groups button (middle button at the right of the

wor kroom).

» Theworkroomis populated by icons for volume groups.

» TheBlock List window isdisplayed; itisavertically scrolled list of blocks of items
(in this case, volume groups). The workroom can display up to 256 icons; the Block
List window provides access to additional itemsin blocks of 256.

Move the cursor over one of theicons for a volume group.
* A pop-up display shows data for the volume group (Volume Group, Volumesin
Group, Free Space, Dead Space, Error Count).

Click on the View by Volumes button (at the bottom right side of the workroom).

* Theworkroomis populated by icons for volumes.

» TheBlock List window isalso displayed; it isavertically scrolled list of blocks of
items (in this case, volumes).

Move the cursor over one of the icons for avolume.
* A pop-up display shows data for the volume group (Volume, Library, Slot, Volume
Group, Volume Status, Volume L abdl).

Table 17.9-2. Launching the AMASS GUI and Viewing
Volume Group and Volume Information (1 of 2)

Step What to Do Action to Take

1 Log in as amass at FSMS host enter text; press Return/Enter

2 aawin enter text; press Return/Enter

3 Select View by Volume Groups button single-click

4 Move cursor over icon for a volume group hold left mouse button and
drag
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Table 17.9-2. Launching the AMASS GUI and Viewing
Volume Group and Volume Information (2 of 2)

Step What to Do Action to Take

5 Select View by Volumes button single-click

6 Move cursor over icon for a volume hold left mouse button and
drag

17.9.2 Using the AMASS GUI to Modify a Volume Group

The Modify a VG window is opened by selecting Modify a Volume Group from the Tasks
menu. The window is used to modify the characteristics of a volume group. The top portion of
the window (not modifiable) lists root directories already configured for a volume group. The
middle portion of the window permits adding directories to the list of root directories for the
specified volume group. The third major portion of the window, near the bottom, contains
indicators of the status of the volume group and buttons for selecting a volume group, as well as
buttons across the very bottom of the window for accepting or canceling the modifications.
(Note: The Modify a VG window also is opened if you have the workroom populated with
volume group icons and you click on one of them. However, in this case you may only modify
the volume group on which you clicked; the bottom of the window will not display buttons for
selecting a volume group.)

As an example of using the GUI to modify a volume group, it is possible to assign a new root
directory in the AMASS file system to a volume group. This requires first creating the directory
and then using the GUI to assign it to a volume group. Table 17.9-3 presents the steps required
for using the AMASS GUI to modify a volume group, in this example to assign a new root
directory in the AMASS file system to a volume group. If you are already familiar with the
procedure, you may prefer to use this quick-step table. If you are new to the system, or have not
performed this task recently, you should use the following detailed procedure:

1 Launch the AMASS GUI (refer to Section 17.9.1, Launchingthe AMASS GUI and
Viewing Volume Group and Volume I nformation).

2 Open a second terminal window (other than the one used to launch the AMASS GUI).

3 In the second terminal window, log in as amass at the FSM S host (e0drg11, gOdrg01,
10drg01, or n0Odrg01).

4 To changeto the dss_amass directory, type cd /dss_amass, and then press the
Return/Enter key.
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11

12

13

To create an empty directory with path /dss_amass/newdir/, where newdir is the name of
the new directory to be created and assigned to the volume group, type mkdir newdir,
and then press the Return/Enter key.

On the AMASS GUI main window, click on the View by Volume Groups button

(middle button at the right of the workroom).

» Theworkroomis populated by icons for volume groups.

» TheBlock List window isalso displayed; it isavertically scrolled list of blocks of
items (in this case, volume groups).

Follow menu path Tasks—>M odify a Volume Group.
* TheModify a VG window is displayed, showing data for VVolume Group 0001.

In the area for choosing a volume group, near the bottom of the window, use the buttons

to set the number displayed in the Volume Group field to the desired volume group.

» A click on the right-pointing arrow button or the left-pointing arrow button
respectively increases or decreases the number by one. Buttons below the arrow
buttons may be used to increase or decrease the number in multiples of 100 or 1000,
asindicated on the buttons.

When the Volume Group field displays the number of the desired volume group, click
on the Fetch button.

» Thelist of root directories already configured for the selected volume group is
displayed in the Existing Root Directoriesfield.
» The statusindicators show the status of the selected volume group.

Click onthe File/Directory Selection button (leftmost button after the label Root
Directoriesto Add, with folder icon).
* A File Selection filter window is displayed.

In the File Selection filter window, click on the Filter button.
» TheFilter field displays/usr/amass/*, and directories and files are displayed in the
Directories and Files windows, respectively.

Use the Filter button and selection of directoriesin the Directories window to display
/dss_amass/newdir/ in the Selection field.
* The Selection field displays/dss_ amass/newdir/.

In the File Salection filter window, click the OK button.

* TheRoot Directoriesto Add field of the Modify a VG window displays
/dss_amass/newdir/.
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14 To examine the capability to edit the list of Directoriesto Add, click on the entry
/dss_amass/newdir/ to highlight it in the Root Directoriesto Add, then click on the
Remove a File/Directory from List button (middle button after the label Root
Directoriesto Add, with folder icon crossed out with ared line).

* Theentry /dss_amass/newdir/ is removed from the Root Directoriesto Add field.

15 Repeat Steps 11 through 13 to restore the entry /dss_amass/newdir/ to the Root
Directoriesto Add field.
* TheRoot Directoriesto Add field of the Modify a VG window displays
/dss_amass/newdir/.

16 In the M odify a VG window, click on the Accept button at the bottom of the window.
» Theentry /dss amass/newdir/ is removed from the Root Directoriesto Add field
and appearsin the Existing Root Directoriesfield.
* TheModify aVG window is closed.

Table 17.9-3. Using the AMASS GUI to Modify a Volume Group

Step What to Do Action to Take

1 Launch the AMASS GUI Use procedure in Section 17.9.1
2 Open a second terminal window UNIX command

3 Log in as amass at FSMS host enter text; press Return/Enter
4 cd /dss_amass enter text; press Return/Enter
5 mkdir newdir enter text; press Return/Enter
6 Select View by Volume Groups button single-click

7 Follow menu path Tasks—>Modify a Volume Group menu selection

8 Set Volume Group click on right or left arrow

9 Select Fetch button single-click

10 Select File/Directory Selection button single-click

11 Select Filter button single-click

12 Display /dss_amass/newdir/ in Selection field use Filter button and selection
13 In File Selection filter window, select OK button single-click

14 Remove /dss_amass/newdir/ from list highlight and click

15 Restore /dss_amass/newdir/ to list highlight and click

16 Select Accept button single-click

17.9.3 Modify a Volume

The Modify a Volume window is opened by selecting M odify a Volume from the Tasks menu.
The window is used to modify the characteristics of a volume. The right side of the window
shows the current set of statistics and configuration information (not modifiable) for the volume
listed in the Volume field on the left side of the window (the Volume field looks like a button,
but if you click on it, a “spinbox” is displayed, with arrow buttons permitting increases or
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decreases to the volume number, and buttons at the bottom to Accept or Cance the change;
accepting the change closes the spinbox, displays the new number in the Volume field, and
displays data for that volume). The left side of the M odify a Volume window provides access to
modifiable characteristics of the volume. Changes made to the buttons and fields in the window
do not take effect until the Accept button at the bottom of the window is clicked. (Note: The
Modify a Volume window also is opened if you have the workroom populated with volume
icons and you click on one of them. However, in this case you may only modify the volume on
which you clicked; the Volume field does not look like a button and may not be changed.)

There are six fields that can be edited for a given volume:

» Thefirst isabutton for setting the Volume Group. Clicking the button opens a
spinbox for selecting the volume group to which the volume isto be assigned.
* Below the Volume Group button is an Online/Offline indicator light with label.
Clicking on the indicator toggles its state and updates the text field (label) next to it.
» Below the Onling/Offline indicator is an Active/l nactive indicator light with label.
Clicking on the indicator toggles its state and updates the text field (label) next to it.
* NextisaFormat Request option button permitting selection of aformatting option
for the volume.
» NextistheBlock Sizefield, applicable only to tape libraries when aformat is
requested to be done on the volume. Thisfield requires a numeric value, which
should be a multiple of 16384.
» Thelast modifiable field isatext field for specifying the volume label.
Table 17.9-4 presents the steps required for using the AMASS GUI to modify a volume. If you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are

new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the AMASS GUI (refer to Section 17.9.1, Launchingthe AMASS GUI and
Viewing Volume Group and Volume I nformation).

2 On the AMASS GUI main window, click on the View by Volume Groups button
(middle button at the right of the workroom).

* Theworkroomis populated by icons for volume groups.
» TheBlock List window isalso displayed; it isavertically scrolled list of blocks of
items (in this case, volume groups).

3 Click on theicon for a desired volume group.
» Theworkroomis populated with icons for the volumes in the selected volume group,
and the M odify a VG window is displayed, showing data for the selected volume
group.
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10

11

12

13

Click on the icon for the volume to be modified.
* TheModify a VG window is closed and the M odify a Volume window is displayed,
showing data for the selected volume.

If it is desired to change the volume group to which the volume is assigned, note the

Volume Group number indicated on the Volume Group button, and then click on the

button.

* A spinbox is displayed showing the Volume Group number, with right-pointing and
left-pointing arrow buttons respectively to increase or decrease the number.

Use the arrow buttons to change the Volume Group number, and then click on the

Accept button in the spinbox.

* The spinbox is closed and the new number appears in the M odify a VVolume window
asthe Volume Group number.

To change the status of a volume indicated to be Onlineg, click on the Active/l nactive
indicator.
* Thecolor and label of the Active/l nactive indicator toggle.

To change the status of a volume indicated to be I nactive, click on the Online/Offline
indicator.
* Thecolor and label of the Online/Offline indicator toggle.

Click on the Format Request option button.
* A pop-up option menu is displayed for selection of Y esor No, and when one of those
options s clicked, the indicated choice is displayed on the option button.

Use the mouse to move the cursor to the Block Size field.
* A blinking cursor appearsin the Block Sizefield.

Use the keyboard to enter or change the value in the Block Size field.
» Theentered data appear in the Block Size field.

Use the mouse to move the cursor to the Volume Labe field.
* A blinking cursor appearsin the Volume L abel field.

Use the keyboard to enter or change the value in the Volume L abél field.
» Theentered data appear in the Volume L abel field.
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14 If you wish to cancel any request for changes to the volume, click on the Cancel button at
the bottom of the window. If you wish to accept the changes, click on the Accept button
at the bottom of the window.

* When you click the Accept button, AAWin attempts to make the requested changes.
For most changes, specifically changesto Online/Offline and Active/l nactive status,
the requested Volume Group for the volume, and the Volume L abel, the changes are
made immediately. But if aformat has been requested, then the Online/Offline and
Active/l nactive status changes are not applied immediately. Instead, the requests for
these status changes and the format changes are passed to the AAWin Scheduler
daemon for processing. Changes made by the Scheduler occur when the job is
processed, which depends on how many other jobs are currently schedul ed.

Table 17.9-4. Using the AMASS GUI to Modify a Volume

Step What to Do Action to Take
1 Launch the AMASS GUI Use procedure in Section 17.9.1
2 Select View by Volume Groups button single-click
3 Select desired volume group single-click
4 Select volume to be modified single-click
5 To change volume group assignment, select Volume single-click

Group button

6 Set Volume Group number click arrows on "spinbox"
7 Toggle Active/lnactive status of online volume single-click
8 Toggle Online/Offline status of inactive volume single-click
9 Select Format Request button single-click
10 Move cursor to Block Size field single-click
11 Enter Block Size enter text
12 Move cursor to Volume Label field single-click
13 Enter Volume Lable enter text
14 Select Cancel button or Accept button single-click

17.10 Data Pool Maintenance Tasks

Archive and/or engineering support personnel are directly involved in Data Pool monitoring and
maintenance, and support User Services and/or Science Data Specialists in managing the content
and retention of data in the Data Pool. A major tool used for these functions is the Data Pool
Maintenance (DPM) GUI. There are aso scripts and utilities for specific maintenance and
monitoring functions, and the Spatial Subscription Server GUI can be used for some maintenance
and monitoring functions. Table 17.10-1 provides an activity checklist for Data Pool procedures
that are accomplished using the DPM GUI and Data Pool utility scripts. See Chapter 19 for
procedures using the Spatial Subscription Server GUI (Launching the Spatial Subscription Server
GUI; Use the Spatial Subscription Server GUI to List and View Subscriptions in the NSBRV
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Database; Use the Spatial Subscription Server GUI to Extend the Period of Retention in a Data
Pool Insert Subscription; Use the Spatial Subscription Server GUI to View the Acquire and
Notification Actions Being Processed: Use the Spatial Subscription Server GUI to View
Statistics on NSBRV Processing of Events and Actions).

Table 17.10-1. Activity Checklist for Data Pool Maintenance Tasks (1 of 4)

Order Role Task Section Complete?

1 Archive Manager/ Launch the DPM GUI (P) 17.10.1
Support Engineer
[full-capability or
limited-capability]

2 Archive Manager/ Shut Down the DPM GUI (End a DPM GUI | (P) 17.10.2
Support Engineer Session)
[full-capability or
limited-capability]

3 Archive Manager/ Use the DPM GUI to Monitor Data Pool (P) 17.10.3
Support Engineer Active Insert Processes
[full-capability or
limited-capability]

4 Archive Manager/ Use the DPM GUI to View a List of Data (P) 17.10.4
Support Engineer Pool File Systems
[full-capability or
limited-capability]

5 Archive Manager/ Use the DPM GUI to Modify a Data Pool (P) 17.10.5
Support Engineer File System
[full-capability only]

6 Archive Manager/ Use the DPM GUI to Add a Data Pool File | (P) 17.10.6
Support Engineer System
[full-capability only]

7 Archive Manager/ Use the DPM GUI to Enable/Disable Data | (P) 17.10.7
Support Engineer Compression
[full-capability only]

8 Archive Manager/ Use the DPM GUI to View a List of (P) 17.10.8
Support Engineer Compression Algorithms
[full-capability or
limited-capability]

9 Archive Manager/ Use the DPM GUI to Modify Compression | (P) 17.10.9
Support Engineer Algorithms
[full-capability only]

10 Archive Manager/ Use the DPM GUI to Add a Compression (P) 17.10.10
Support Engineer Algorithm
[full-capability only]

11 Archive Manager/ Use the DPM GUI to Deactivate a (P) 17.10.11

Support Engineer
[full-capability only]

Compression Algorithm
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Table 17.10-1. Activity Checklist for Data Pool Maintenance Tasks (2 of 4)

Order Role Task Section Complete?

12 Archive Manager/ Use the DPM GUI to View Cloud Cover (P) 17.10.12
Support Engineer Information
[full-capability or
limited-capability]

13 Archive Manager/ Use the DPM GUI to Add New Cloud (P) 17.10.13
Support Engineer Cover Information
[full-capability only]

14 Archive Manager/ Use the DPM GUI to Modify Cloud Cover (P) 17.10.14
Support Engineer Source Descriptions
[full-capability only]

15 Archive Manager/ Use the DPM GUI to Delete Cloud Cover (P) 17.10.15
Support Engineer Information
[full-capability only]

16 Archive Manager/ Check the Status of Batch Inserts (P) 17.10.16
Support Engineer
[full-capability or
limited-capability]

17 Archive Manager/ Check the Data Pool Insert Queue and (P) 17.10.17
Support Engineer Cancel a Data Pool Insert Action
[full-capability
(limited-capability
check only)]

18 Archive Manager/ View DPM Configuration Parameter (P) 17.10.18
Support Engineer Values
[full-capability or
limited-capability]

19 Archive Manager/ Modify DPM Configuration Parameter (P) 17.10.19
Support Engineer Values
[full-capability only]

20 Archive Manager/ Use the DPM GUI to View Collection (P) 17.10.20
Support Engineer Group and Collection Information
[full-capability or
limited-capability]

21 Archive Manager/ Use the DPM GUI to Modify Collection (P) 17.10.21
Support Engineer Groups
[full-capability only]

22 Archive Manager/ Use the DPM GUI to Add a Collection (P) 17.10.22
Support Engineer Group
[full-capability only]

23 Archive Manager/ Use the DPM GUI to Add an ECS (P) 17.10.23

Support Engineer
[full-capability only]

Collection to a Collection Group
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Table 17.10-1. Activity Checklist for Data Pool Maintenance Tasks (3 of 4)

Order Role Task Section Complete?

24 Archive Manager/ Use the DPM GUI to Add a NON-ECS (P) 17.10.24
Support Engineer Collection to a Collection Group
[full-capability only]

25 Archive Manager/ Use the DPM GUI to Modify an ECS (P) 17.10.25
Support Engineer Collection
[full-capability only]

26 Archive Manager/ Use the DPM GUI to Modify a NON-ECS (P) 17.10.26
Support Engineer Collection
[full-capability only]

27 Archive Manager/ Use the DPM GUI to View a List of (P) 17.10.27
Support Engineer Themes
[full-capability or
limited-capability]

28 Archive Manager/ Filter a List of Themes (P)17.10.27.1
Support Engineer
[full-capability or
limited-capability]

29 Archive Manager/ Use the DPM GUI to Modify a Theme (P) 17.10.28
Support Engineer
[full-capability only]

30 Archive Manager/ Use the DPM GUI to Add a Theme (P) 17.10.29
Support Engineer
[full-capability only]

31 Archive Manager/ Use the DPM GUI to Delete a Theme (P) 17.10.30
Support Engineer
[full-capability only]

32 Archive Manager/ Use the Update Granule Utility to Extend (P) 17.10.31
Support Engineer the Retention for Selected Science

Granules

33 Archive Manager/ Invoke the Data Pool Cleanup Utility (P) 17.10.32
Support Engineer Manually

34 Archive Manager/ Establish Data Pool Cleanup to Run with (P) 17.10.33
Support Engineer cron

35 Archive Manager/ Specify Data Pool Access Statistics Rollup | (P) 17.10.34
Support Engineer Start Time and DPASU Execution with

cron

36 Archive Manager/ Specify Data Pool Access Statistics Utility (P) 17.10.35
Support Engineer Execution from the Command Line

37 Archive Manager/ Archive Access Statistics using the Data (P) 17.10.36
Support Engineer Pool Archive Access Statistics Data Utility

38 Archive Manager/ Delete Access Statistics using the Data (P) 17.10.37
Support Engineer Pool Delete Access Statistics Data Utility
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Table 17.10-1. Activity Checklist for Data Pool Maintenance Tasks (4 of 4)

Order Role Task Section Complete?

39 Archive Manager/ Restore Access Statistics using the Data (P) 17.10.38
Support Engineer Pool Restore Access Statistics Data Utility

40 Archive Manager/ Use the Batch Insert Utility for Batch Insert | (P) 17.10.39
Support Engineer of Data into the Data Pool

41 Archive Manager/ Launch the DataPool Order Status & (P) 17.10.40
Support Engineer Control GUI

42 Archive Manager/ Use the DataPool Order Status & Control (P) 17.10.41
Support Engineer GUI to Review Orders and Order Items

43 Archive Manager/ Intervene in a Failed Data Pool Order (P) 17.10.42
Support Engineer Susceptible to Operator Intervention

44 Archive Manager/ Use DataPool Order Status & Control GUI | (P) 17.10.43

Support Engineer

to Manage HEG Converter Front End
Server

17.10.1 Launch the DPM GUI
The procedure for launching the DPM GUI is provided separately here and referenced in other

procedures. Table 17.10-2 presents the steps required to launch the DPM GUI.

If you are

already familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:

1

At the UNIX command shell prompt, type setenv DISPLAY clientname: 0.0 and then
press the Return/Enter key.
» For clientname, use either the local terminal/workstation |P address or its machine

name.

Start the log-in to a Netscape host by typing /tools/bin/ssh hostname (e.g., g0ins02,
e0ins02, 10ins02, n0ins02) at the UNIX command shell prompt, and press the

Return/Enter key.

» If you receive the message, Host key not found from the list of known hosts. Are
you sur e you want to continue connecting (yes/no)? typeyes (“y” aone does not

work).

» If you have previously set up a secure shell passphrase and executed sshremote, a
prompt to Enter passphrase for RSA key '<user @ ocalhost>" appears; continue

with Step 3.

» If you have not previously set up a secure shell passphrase; go to Step 4.
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If aprompt to Enter passphrase for RSA key '<user @ ocalhost>" appears, type your
Passphrase and then press the Return/Enter key. Go to Step 5.

At the <user @remotehost>'s password: prompt, type your Password and then press the
Return/Enter key.
* Youarelogged inand aUNIX command shell prompt is displayed.

Type netscape & then press Return/Enter.

* It may be necessary to type the path as well as the netscape command (e.g.,
/tools/bin/netscape & ).

* It may be necessary to respond to dialogue boxes, especialy if the browser is already
being used by someone else who has logged in with the same user ID.

* The Netscape web browser is displayed.

If abookmark has been created for the DPM GUI, select the appropriate bookmark from
those listed on the browser’ s Bookmar ks button (or the Communicator — Bookmarks
pull-down menu).

» Thesecurity login Prompt is displayed.

If no bookmark has been created for the DPM GUI, type http://host:port/path inthe
browser’s L ocation (Go To) field then press Return/Enter.
* For example:

http://x0dps01.daac.ecs.nasa.gov:54321/DataPool.html
» The security login Prompt is displayed.

Type the appropriate username in the User Name box of the security login Prompt.

Type the appropriate password in the Passwor d box of the security login Prompt.

NOTE: If the security login prompt reappears after the first time the user name and

password have been entered (and the OK button has been clicked), it may not be
due to adataentry problem. Try again to log in using the same user name and
password. Sometimes it is necessary to enter the user name and password for the
GUI more than once.

Click on the appropriate button from the following selections:
* OK - to complete the log-in and dismiss the dialogue box.
— The dialogue box is dismissed.
— The DPM GUI Home Pageis displayed.
* Cancd - to dismiss the dialogue box without logging in.
— The dialogue box is dismissed.
— The Netscape web browser is displayed.
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Table 17.10-2. Launch the DPM GUI

Step What to Do Action to Take

1 setenv DISPLAY clientname:0.0 Enter text; press Return/Enter
2 ftools/bin/ssh hostname Enter text; press Return/Enter
3 Passphrase (or Step 4) Enter text; press Return/Enter
4 Password Enter text; press Return/Enter
5 netscape & Enter text; press Return/Enter
6 bookmark (for DPM GUI) Single-click

7 http://host:port/path (if no bookmark is available) Enter text; press Return/Enter
8 username Enter text

9 password Enter text

10 OK button Single-click

17.10.2 Shut Down the DPM GUI (End a DPM GUI Session)

At some point it becomes necessary to shut down the DPM GUI (end a DPM GUI session).
Table 17.10-3 presents the steps required to shut down the DPM GUI. If you are aready familiar
with the procedure, you may prefer to use this quick-step table. If you are new to the system, or
have not performed this task recently, you should use the following detailed procedure:

1 Click on the Home Page link at the top of the DPM GUI.
 The DPM GUI Home Page is displayed.

2 Click onthe End Session link at the top of the Home Page.

* A log-out page containing the message “Click on Button Below to End Session:
NOTE: THISWOULD ALSO SHUT DOWN THE BROWSER :” is displayed.

NOTE: To abort the log-out and return to the Home Page, click on the browser Back
button.

3 Click on the ShutDown button.
» The Netscape browser is dismissed.

Table 17.10-3. Shut Down the DPM GUI (End a DPM GUI Session)

Step What to Do Action to Take
1 Home Page link single-click
2 End Session link single-click
3 ShutDown button single-click
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17.10.3 Use the DPM GUI to Monitor Data Pool Active Insert Processes

Y ou may wish to keep an instance of the DPM GUI displayed to monitor Data Pool Active Insert
Processes. The procedure for using the DPM GUI to monitor Data Pool active insert processesis
applicable to both full-capability and limited-capability operators. Table 17.10-4 presents the
steps required to use the DPM GUI to monitor Data Pool active insert processes. If you are
aready familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed

procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).
The Home Pageis displayed.

2 Observe information displayed on the DPM GUI Home Page.
The Home Page has the following links for access to Data Pool maintenance function

pages:

Data Pool File Systems.
Compression Algorithms.
Cloud Cover.

List Insert Queue.

Batch Summary.
Collection Groups.
Themes.

Configuration Parameters.
End Session.

The Home Page has a summary of Data Pool file systems with the following
columns:

File System L abel (Iabel representing an existing Data Pool file system).

Free Space Flag (if setto “Y,” free space is available for inserts; “N” means free
space isnot available).

Availability (if set to “Y,” thefile systemis currently available for Data Pool
insert; “N” means the file system is not available for Data Pool insert).

Min Freed Spacein MB (value that represents the minimum amount of freed
space in the file system in megabytes; it is an amount of space must remain freein
order to make the file system available for insert).

The Home Page has a summary of active processes with the following rows:

Maximum allowed processes.

Maximum allowed processes from AMASS cache.
Maximum allowed processes from AMASS tape.

Total number of activeinsert processes running.
Number of activeinsert processes using AMASS cache.
Number of activeinsert processes using AMASS tape.
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» TheHome Page has atable of active insert processes showing the following columns

of detailed information for each process:

— Unix Processld (UNIX processidentifier).

— EcsID (ECSidentifier or Granule ID for the granule being processed).

— Caollection (to which the granule belongs).

— Version (for the collection to which the granule belongs).

- StartTime (time at which the insert processing started).

— StatusTime (time at which the status listed in the Status column was achieved).

— Status (current state of the insert process).

— AMASS Cache [availability (Y or N) of the granule being processed].

— Retries[number of attempts by the process to recover from retriable errors (e.g.,
Data Pool disk temporarily unavailable, Data Pool directory does not exist, or
Data Pool database temporarily unavailable)].

NOTE: The system is designed for rapid insertion of datainto the Data Pool by quickly

processing data that are available in cache, such as data that are staged for
archiving. If theinsert processing is delayed and the data are removed from
cache, the Data Pool insert is likely to fail.

To obtain an immediate screen refresh, click on the Refresh Home Page link near the
upper right corner of the display.
* Thedisplayed data are updated.

NOTE: The screen refreshes automatically at intervals determined by the number of

seconds specified in the Screen Refresh Rate field.

To change the automatic screen refresh rate first type the desired number of seconds
between refreshes in the Screen Refresh Rate text entry box.

To complete changing the automatic screen refresh rate click on the Apply button
adjacent to the Screen Refresh Ratetext entry box.
* The Screen Refresh Rateis changed to the new value.

To change the number of active insert processes displayed at atimeinthe List of Active
Insert Processes table on the Home Page first type the desired number of rows to be
displayed in the Active I nsert Processes text entry box.

To complete changing the number of active insert processes displayed at atimein the

List of Activelnsert Processes table on the Home Page click on the Apply button

adjacent to the Active I nsert Processes text entry box.

* The number of active insert processes displayed at atimeintheList of Active Insert
Processes table is changed to the new value.
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Table 17.10-4. Use the DPM GUI to Monitor Data Pool Active Insert

Processes
Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Observe Data Pool information read text
3 Refresh Home Page link (as necessary) single-click
4 seconds (in the Screen Refresh Rate text entry box) (if | enter text

applicable)
5 Apply button (if applicable) single-click
6 rows (in the Active Insert Processes text entry box) (if | enter text

applicable)
7 Apply button (if applicable) single-click

17.10.4 Use the DPM GUI to View a List of Data Pool File Systems

The Synergy IV DPM GUI File System Information page permits both full-capability and
limited-capability operators usersto view alist of Data Pool file systems and obtain information
on the status of the free space flag, availability for insert, and minimum freed space for each file
system. In addition it has links that allow full-capability operators to add new Data Pool file
systems or modify existing file system information.

Table 17.10-5 presents the steps required to use the DPM GUI to view a list of Data Pool file
systems. If you are aready familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Data Pool File Systems|link.
* TheFile System Information page is displayed.

3 Observe data displayed on the File System I nfor mation page.
* Thetable on the File System Infor mation page has columns containing the
following types of Data Pool file system information:
— File System Labdl.
- Absolute Path.
— Free Space Flag.
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Table 17.10-5. Use the DPM GUI to View a List of Data Pool File Systems

— Availability.

— Min Free Space (in Megabytes).

The following links are available on the File System I nfor mation page:
— Add New File System.
— Modify File System.

Step What to Do Action to Take

1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Data Pool File Systems link single-click

3 Observe file system information read text

17.10.5 Use the DPM GUI to Modify a Data Pool File System

The DPM GUI may be used to modify a Data Pool file system. Thisis useful if the Absolute
Path, Free Space Flag, Availability (for Insert), and/or Min. Freed Space for a particular Data
Pool file system need to be corrected or updated. Full-capability operators (only) can use the
following procedure to modify a Data Pool file system:

Table 17.10-6 presents the steps required to use the DPM GUI to modify a Data Pool file system.
If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following

detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Data Pool File Systems|link.
The File System Information page is displayed.

3 Click on the M odify File System link at the bottom of the list of file systems (scrolling

down if necessary).

The M odify File System Infor mation page is displayed, providing atable of Data
Pool file system information showing six columns: File System L abel, Absolute
Path, Free Space Flag, Availability, Min Free Space (in Megabytes), and Click on

box to modify (containing a check box to mark the file system for change).

Thereisan Apply Change button at the bottom of the page to implement changes.
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To change the absolute path for afile system type the desired path in the Absolute Path

field for the file system.

» Thebasic ftp root directory path is shown above the text entry box; data entered in the
box will be appended to the base path shown.

To change afile system’ s free space flag setting click on the appropriate button in the
Free Space Flag column.
» Thefollowing choices are available:

- ON.

- OFF.

To change the setting for afile system’ s availability for datainsert click on the
appropriate button in the Availability column.
» Thefollowing choices are available:

- YES

- NO.

To change the minimum freed space for afile system type the desired value (in
megabytes) in the appropriate Min Free Space (in M egabytes) field.

Click in the check box at the end of the row containing file system information to be
modified.
» The selected file system information is marked for subsequent modification.

Repeat Steps 4 through 8 for any additional file systems to be modified.
Click on the Apply Change button.
* Therevised file system information is entered in the Data Pool database.

» TheFile System Information page is displayed with the modified file system
information.

Table 17.10-6. Use the DPM GUI to Modify a Data Pool File System(1 of 2)

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Data Pool File Systems link single-click
3 Modify File System link single-click(s)
4 path (in the Absolute Path field for the file system) (if enter text
applicable)
5 Free Space Flag option (i.e., ON button or OFF button | single-click
in the Free Space Flag column) (if applicable)
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Table 17.10-6. Use the DPM GUI to Modify a Data Pool File System (2 of 2)

Step What to Do Action to Take

6 Availability option (i.e., YES button or NO button in the | single-click
Availability column) (if applicable)

7 value (in the appropriate Min Free Space (in enter text
Megabytes) field) (if applicable)

8 check box at the end of the appropriate row single-click

9 Repeat Steps 4 through 8 (as necessary)

10 Apply Change button single-click

17.10.6 Use the DPM GUI to Add a Data Pool File System

Full-capability operators (only) can use the procedure that follows to add a Data Pool file system.
Table 17.10-7 presents the steps required to use the DPM GUI to add a Data Pool file system. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Data Pool File Systems|link.
* TheFile System Information page is displayed.

3 Click onthe Add New File System link at the bottom of the list of file systems (scrolling
down if necessary).
* TheAdd New File System Information pageis displayed, providing atable of Data
Pool file system information showing five rows: Label, Absolute Path, Free Space
Flag, Availability, and Min Freed Space (in M egabytes).
* Thereisan Apply Change button at the bottom of the page to implement the new file
system.

4 Type the desired file system label in the L abel field.
» Enter aunique name with no more than 25 characters.
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10

11

Type the desired path in the Absolute Path field.
» Thebasic ftp root directory path is shown adjacent to the text entry box; data entered
in the box will be appended to the base path shown.

To display free space flag options click on the Free Space Flag option button.
* Free Space Flag options are displayed (i.e., ON and OFF).

To select afree space flag option click on the appropriate choice from the option list.
* ON should be selected if there is enough free space in the file system for inserts.
* OFF should be selected if there is not enough free space in the file system for inserts.

To display availability options click on the Availability option button.
* Availability options are displayed (i.e., YES and NO).

To select an availability option click on the appropriate choice from the option list.
* YESshould be selected if the file system is currently available for inserts.
* NO should be selected if the file system is not currently available for inserts.

Type the desired value for minimum freed space (in megabytes) in the Min Freed Space

(in Megabytes) field.

* Min Freed Space indicates how much space needs to be available to keep thefile
system available for insert.

Click on the Apply Change button.

» Thefile system information is entered in the Data Pool database.

* TheFile System Information pageis displayed with the new file system
information.

Table 17.10-7. Use the DPM GUI to Add a Data Pool File System

Step What to Do Action to Take

Launch the DPM GUI Use procedure in Section
17.10.1

Data Pool File Systems link single-click

Add New File System link single-click

label (in the Label field) enter text

path (in the Absolute Path field) enter text

(| [wW|N

Free Space Flag option (i.e., ON or OFF on the Free single-click
Space Flag option button)

Availability option (i.e., YES or NO on the Availability | single-click
option button)

value (in the Min Freed Space (in Megabytes) field) enter text

Apply Change button single-click
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17.10.7 Use the DPM GUI to Enable/Disable Data Compression

The Synergy IV release provides the data compression capability for Data Pool. This feature is
accomplished using DAAC-provided compression algorithms. When compression is turned on
a the Data Pool subsystem level, all science granules will be compressed at the time of Data
Pool insert, if there is a compression algorithm associated with the granule's collection.  For
each compressed granule, the name and size of the granule’s compressed file(s), the size of the
origina uncompressed file(s), and the compression type will be stored in the file table in the Data
Pool database. If checksumming isturned on, the checksum of the compressed file(s) is stored in
the Data Pool database. Metadata and browse files are not compressed on insert.

The procedure for using the DPM GUI to enable or disable data compression can be performed
by full-capability operators only. It involves changing the value for the CompressOnlnsert
configuration parameter in the Data Pool database. Changing the value from OFF to ON enables
data compression. Changing the value from ON to OFF disables data compression. Limited-
capability operators are not alowed to change the values assigned to configuration parameters.

Table 17.10-8 presents the steps required to use the DPM GUI to enable/disable data
compression. |If you are already familiar with the procedure, you may prefer to use this quick-
step table. If you are new to the system, or have not performed this task recently, you should use
the following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Configuration Parameterslink.

» ThelList of Configuration Parameters pageis displayed, providing atable of
parameters showing three columns. Parameter Name, Parameter Value (including
an entry field with current value, followed by a brief description of the parameter),
and Click on Box to M odify Parm (containing a check box to mark the parameter
for change).

» Thereisan Apply Change button at the bottom of the page to implement any
selected change(s).

3 To display CompressOnlnsert options click on the option button in Parameter Value
column of the row for the CompressOnlnsert parameter.
» Thefollowing choices are available:
- ON.
- OFF.
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4 To select aCompressOnlnsert option click on the appropriate choice from the option
list.
» Selected option is displayed in the field.

5 In the row for the CompressOnlnsert parameter click in the check box in the Click on
Box to Modify Parm column.
» Thebox isfilled to indicate selection.

6 Click on the Apply Change button.

» Thescreenisrefreshed, the check box is unfilled, and the displayed Parameter
Value for CompressOnlnsert reflects the change.

Table 17.10-8. Use the DPM GUI to Enable/Disable Data Compression

Step What to Do Action to Take

1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Configuration Parameters link single-click

3 CompressOnlinsert option (i.e., ON or OFF in the single-click

Parameter Value column of the row for the
CompressOnlinsert parameter)

4 check box (in the Click on Box to Modify Parm column | single-click
of the row for the CompressOnlinsert parameter)
5 Apply Change button single-click

17.10.8 Use the DPM GUI to View a List of Compression Algorithms

The DPM GUI Manage Compression Algorithms link permits both full-capability operators
and limited-capability operators to view the current compression algorithms. The full-capability
operator only may add, modify, or deactivate compression algorithms.

Table 17.10-9 presents the steps required to use the DPM GUI to view a list of compression
algorithms. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).
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2 Click on the Compression Algorithmslink.

The Compression Algorithms page is displayed.

3 Observe data displayed on the Compression Algorithms page.

The table on the Compression Algorithms page has columns containing the
following types of compression algorithm information:

— Compression Label.

- FileExtension.

— Compression Command.

— Decompression Command.

The following links are available on the Compression Algorithms page:

— Add Compression Algorithm.

— Modify Compression Algorithm.

— Deactivate Compression Algorithm.

Table 17.10-9. Use the DPM GUI to View a List of Compression Algorithms

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Compression Algorithms link single-click
3 Observe compression algorithms data read text
17.10.9 Use the DPM GUI to Modify Compression Algorithms

The DPM GUI may be used to modify compression algorithms. This can be useful if the file
extension, compression command, or decompression command needs to be modified or updated.
A full-capability operator may use the procedure that follows to modify compression algorithms.

Table 17.10-10 presents the steps required to use the DPM GUI to modify compression
algorithms. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the

following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).
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Click on the Compression Algorithmslink.

» The Compression Algorithms pageis displayed, providing atable listing all
compression algorithms and showing algorithm-related information in four columns:
Compression Label, File Extension, Compression Command, and Decompr ession
Command. Therearelinks (i.e., Add Compression Algorithm, M odify
Compression Algorithm and Deactivate Compression Algorithm) that can be
selected.

Click on the M odify Compression Algorithm link at the bottom of thelist of
Compression Algorithms (scrolling down if necessary).
* TheModify Compression Algorithm page is displayed.

To modify the default file extension for a compression algorithm type the desired file
extension in the appropriate File Extension field.

» Thefile extension may have no more than ten characters.

» Thetyped entry isdisplayed in the field.

To modify the compression command for a compression algorithm type the desired
compression command in the appropriate Compression Command field.
* The compression command may have no more than 255 characters.
* Includethe full path and parameters.
*  Use“%infile” to represent the file to be compressed.
— For example:

/usr/bin/gzip -1 %infile
» Thetyped entry isdisplayed in the field.

To modify the decompression command for a compression algorithm type the desired
decompression command in the appropriate Decompression Command field.
»  The decompression command may have no more than 255 characters.
* Includethe full path and parameters.
»  Use“%infile” to represent the file to be compressed.
- For example:

lusr/bin/gunzip -1 %infile
* Thetyped entry isdisplayed in the field.
Click in the check box at the end of the row containing modified compression algorithm
information.
* The compression algorithm is marked for subsequent modification. (A check mark is
displayed in the selected check box.)

Repeat Steps 4 through 7 as necessary to modify additional compression agorithms.
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9 Click on the Apply Change button.
* Themodified compression algorithm information is added to the Data Pool Database.
* TheCompression Algorithms page is displayed with the revised compression
algorithm information.

Table 17.10-10. Use the DPM GUI to Modify Compression Algorithms

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Compression Algorithms link single-click
3 Modify Compression Algorithm link single-click
4 extension (in the appropriate File Extension field) (if enter text
applicable)
5 command (in the appropriate Compression Command | enter text
field) (if applicable)
6 command (in the appropriate Decompression enter text
Command field) (if applicable)
7 check box (at the end of the row containing modified single-click
compression algorithm information)
8 Repeat Steps 4 through 7 (as necessary)
9 Apply Change button single-click

17.10.10 Use the DPM GUI to Add a Compression Algorithm

A full-capability operator may use the procedure that follows to add a compression agorithm.
Table 17.10-11 presents the steps required to use the DPM GUI to add a compression algorithm.
If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

» TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Compression Algorithmslink.

» TheCompression Algorithms pageis displayed, providing atable listing all
compression algorithms and showing algorithm-related information in four columns:
Compression Label, File Extension, Compression Command, and Decompr ession
Command. Therearelinks (i.e.,, Add Compression Algorithm, M odify
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Compression Algorithm and Deactivate Compression Algorithm) that can be
selected.

Click on the Add Compression Algorithm link at the bottom of the list of compression

algorithms (scrolling down if necessary).

* The Add Compression Algorithm page is displayed, providing atable of
compression algorithms showing four columns: Compression Label, File
Extension, Compression Command, and Decompression Command.

* Thereisan Add Algorithm button at the bottom of the page to implement the new
algorithm.

Type the desired compression label in the Compression Label field.
» Thelabel may have no more than ten characters.
» Thetyped entry isdisplayed in the field.

If applicable, type the desired default file extension in the File Extension field.
» Thefile extension may have no more than ten characters.
» Thetyped entry isdisplayed in the field.

Type the compression command in the Compression Command field.
» The compression command may have no more than 255 characters.
* Includethe full path and parameters.
*  Use“%infile” to represent the file to be compressed.

— For example:

/usr/bin/gzip -1 %infile
» Thetyped entry isdisplayed in the field.

If applicable, type the decompression command in the Decompression Command field.
*  The decompression command may have no more than 255 characters.
* Includethe full path and parameters.
*  Use“%infile” to represent the file to be compressed.
— For example:

/usr/bin/gunzip -1 %infile
» Thetyped entry isdisplayed in the field.

Click onthe Add Algorithm button.

* The compression algorithm is added to the Data Pool Database.

» The Compression Algorithms page is displayed with the new compression
algorithm.
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Table 17.10-11. Use the DPM GUI to Add a Compression Algorithm

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Compression Algorithms link single-click
3 Add Compression Algorithm link single-click
4 label (in the Compression Label field) enter text
5 extension (in the File Extension field) (if applicable) enter text
6 command (in the Compression Command field) enter text
7 command (in the Decompression Command field) (if | enter text
applicable)
8 Add Algorithm button single-click

17.10.11 Use the DPM GUI to Deactivate a Compression Algorithm

A full-capability operator may use the procedure that follows to deactivate a compression
algorithm. Table 17.10-12 presents the steps required to use the DPM GUI to deactivate a
compression algorithm. If you are already familiar with the procedure, you may prefer to use
this quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

NOTE: Deactivating a compression agorithm removes the algorithm from the list of
compression algorithms and dissociates it from all collections. However, it will
still be possible to decompress any granules compressed with the algorithm.

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Compression Algorithmslink.

» The Compression Algorithms pageis displayed, providing atable listing all
compression algorithms and showing algorithm-related information in four columns:
Compression Label, File Extension, Compression Command, and Decompr ession
Command. Therearelinks (i.e., Add Compression Algorithm, M odify
Compression Algorithm and Deactivate Compression Algorithm) that can be
selected.
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3 Click on the Deactivate Compression Algorithm link at the bottom of the list of

Compression Algorithms (scrolling down if necessary).

» The Deactivate Compression Algorithm page is displayed, providing atable of
compression algorithms showing five columns: Compression Label, File
Extension, Compression Command, Decompression Command, and Check Box
to Deactivate (containing check boxes to mark algorithms for deactivation).

* ThereisaDeactivate Selected button at the bottom of the page to implement the
deactivation(s).

4 To select compression algorithms to be marked for deactivation click in the appropriate
check box(es) in the column on the far right of the Deactivate Compression Algorithm

page.
» The compression algorithm(s) is (are) marked for subsequent deactivation. (A check

mark is displayed in each selected check box.)

5 Click on the Deactivate Selected button.
» The selected compression algorithms are deactivated.

Table 17.10-12. Use the DPM GUI to Deactivate a Compression Algorithm

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Compression Algorithms link single-click
3 Deactivate Compression Algorithm link single-click
4 check box(es) (in the column on the far right of the single-click
Deactivate Compression Algorithm page) (as
applicable)
5 Deactivate Selected button single-click

17.10.12 Use the DPM GUI to View Cloud Cover Information

The Synergy IV release provides the capability for users to view al cloud cover information in
the Data Pool database. The DPM GUI Manage Cloud Cover link permits both full-capability
and limited-capability operators to view al cloud cover information in the Data Pool database.
In addition it allows full-capability operators to add new cloud cover information, modify cloud
cover source descriptions, or delete cloud cover information.

Table 17.10-13 presents the steps required to use the DPM GUI to view cloud cover information.
If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:
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1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Cloud Cover link.
* TheCloud Cover Information pageis displayed.

3 Observe data displayed on the Cloud Cover Information page.

* Thetable on the Cloud Cover Information page has columns containing the
following types of cloud cover information:
- SourceType.
— Source Name.
— Source Description.

» Thefollowing links are available on the Cloud Cover Information page:
- Add New Cloud Cover.
— Modify Source Description.

* AnApply Change button is available for deleting cloud cover information from the
Data Pool database.

Table 17.10-13. Use the DPM GUI to View Cloud Cover Information

Step What to Do Action to Take

1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Cloud Cover link single-click

3 Observe data displayed on the Cloud Cover Information | read text

17.10.13 Use the DPM GUI to Add New Cloud Cover Information

A full-capability operator may use the procedure that follows to add new cloud cover
information. Table 17.10-14 presents the steps required to use the DPM GUI to add new cloud
cover information. If you are already familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).
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Click on the Cloud Cover link.

» TheCloud Cover Information pageis displayed, providing atable listing al cloud
cover information; i.e., Sour ce Type, Sour ce Name, and Sour ce Description.

» Thefollowing links are available: Add New Cloud Cover and M odify Sour ce
Description.

* AnApply Change button is available for deleting cloud cover information from the
Data Pool database.

Click on the Add New Cloud Cover link at the bottom of the Cloud Cover Information

page (scrolling down if necessary).

* The Add New Cloud Cover pageisdisplayed, providing atable of cloud cover
information showing three rows. Sour ce Type, Sour ce Name, and Sour ce
Description.

* Thereisan Apply Change button at the bottom of the page to implement changes.

To display source type options click on the Sour ce Type option button.
» Source type options are displayed (e.g., Core M etadata and PSA).

To select a source type click on the appropriate source type from the option list.
* If Core Metadata was selected, the Sour ce Name field is automatically filled in.

To specify a source name type the desired name in the Sour ce Name field.
» If Core Metadata was selected as the source type, the Sour ce Namefield is
automatically filled in and cannot be edited.

Type adescription of the cloud cover information in the Sour ce Description field.
* Thedescription may be up to 255 charactersin length.

Click on the Apply Changes button.

* Thesource nameis validated against the Science Data Server database.

* Thenew cloud cover information is entered in the Data Pool database.

* TheCloud Cover Information pageis displayed with the new cloud cover
information.
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Table 17.10-14. Use the DPM GUI to Add New Cloud Cover Information

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Cloud Cover link single-click
3 Add New Cloud Cover link single-click
4 Source Type option (e.g., Core Metadata or PSA from single-click
the Source Type option list)
5 name (in the Source Name field) enter text
6 description (in the Source Description field) enter text
7 Apply Changes button single-click

17.10.14 Use the DPM GUI to Modify Cloud Cover Source Descriptions

Full-capability operators may use the procedure that follows to modify cloud cover source
descriptions. Table 17.10-15 presents the steps required to use the DPM GUI to modify cloud
cover source descriptions. If you are already familiar with the procedure, you may prefer to use
this quick-step table. If you are new to the system, or have not performed this task recently, you

should use the following detailed procedure:

1

Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

» TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

Click on the Cloud Cover link.

» TheCloud Cover Information pageis displayed, providing atable listing al cloud

cover information; i.e., Sour ce Type, Sour ce Name, and Sour ce Description.
» Thefollowing links are available: Add New Cloud Cover and M odify Sour ce

Description.

* AnApply Change button is available for deleting cloud cover information from the

Data Pool database.

Click on the M odify Sour ce Description link at the bottom of the Cloud Cover

Information page (scrolling down if necessary).

» TheModify Source Description page is displayed, providing atable of cloud cover

information showing four columns: Sour ce Type, Sour ce Name, Sour ce

Description, and Click on box to modify (containing a check box to mark the source

description for change).
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* Thereisan Apply Change button at the bottom of the page to implement changes.

4 To start the process of changing a source description type the desired description in the
appropriate Sour ce Description field.

5 To continue the process of changing a source description click in the check box at the end
of the row containing modified source description information.
» The source description is marked for subsequent modification. (A check mark is
displayed in the selected check box.)

6 Repeat Steps 4 and 5 for any additional source descriptions to be modified.
7 Click on the Apply Change button.
» Therevised source description information is entered in the Data Pool database.

» TheCloud Cover Information page is displayed with the modified cloud cover
information.

Table 17.10-15. Use the DPM GUI to Modify Cloud Cover Source Descriptions

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Cloud Cover link single-click
3 Modify Source Description link single-click
4 description (in the appropriate Source Description enter text
field)
5 check box (at the end of the row containing modified single-click
source description information)
6 Repeat Steps 4 and 5 (as necessary)
7 Apply Change button single-click

17.10.15 Use the DPM GUI to Delete Cloud Cover Information

A full-capability operator may use the procedure that follows to delete cloud cover information.
Table 17.10-16 presents the steps required to use the DPM GUI to delete cloud cover
information. If you are aready familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:
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1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Cloud Cover link.
» TheCloud Cover Information pageis displayed, providing atable listing al cloud
cover information; i.e., Sour ce Type, Sour ce Name, and Sour ce Description.
» Thefollowing links are available: Add New Cloud Cover and M odify Source
Description.
* AnApply Change button is available for deleting cloud cover information from the
Data Pool database.

3 Click in the check box(es) at the end of the row(s) containing cloud cover information to
be deleted.
» The selected source(s) is (are) marked for subsequent deletion.

4 Click on the Apply Change button.
* The selected source(s) is (are) deleted from the Data Pool database.
» If any cloud cover information is associated with any collection, it will not be deleted.
* TheCloud Cover Information pageis displayed with the modified cloud cover
information.

Table 17.10-16. Use the DPM GUI to Delete Cloud Cover Information

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Cloud Cover link single-click
3 check box(es) (at the end of the row(s) containing cloud single-click
cover information to be deleted)
4 Apply Change button single-click

17.10.16 Check the Status of Batch Inserts

The DPM GUI provides a page to display a summary of the status of batch Data Pool inserts
made using the Synergy batch insert utility. The procedure that follows is applicable to both full-
capability and limited-capability operators.

Table 17.10-17 presents the steps required to use the DPM GUI to check the status of batch
inserts. If you are already familiar with the procedure, you may prefer to use this quick-step
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table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1

Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

Click onthe Batch Summary link.

The Batch Summary pageis displayed.

The GUI displays the Batch Summary page, providing for each batch label the
numbers of inserts for that label that are New, Completed, Failed, in Retry, and
Canceled.

The page a so shows the screen refresh rate in minutes; the rate may be changed by
clicking in the Screen Refresh Rate field, replacing the displayed value with the
desired value, and clicking on the Apply Refresh Rate button.

Observe data displayed on the Batch Summary page.

The table on the Batch Summary page has columns containing the following types
of information:

- Batch Label.

— New (number of insertsfor thelabel that are new).

— Completed (number of insertsfor the label that have been completed).

— Failed (number of insertsfor thelabel that have failed).

— Retry (number of insertsfor thelabel that have been retried).

— Canceled (number of insertsfor the label that have been canceled).

To change the automatic screen refresh rate first type the desired number of minutes
between refreshes in the Screen Refresh Rate text entry box.

To compl ete changing the automatic screen refresh rate click on the ApplyRefreshRate
button adjacent to the Screen Refresh Rate text entry box.

The Screen Refresh Rateis changed to the new value.

Return to Step 3.
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Table 17.10-17. Check the Status of Batch Inserts

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Batch Summary link single-click
3 Observe batch summary data read text
4 minutes (in the Screen Refresh Rate text entry box) (if | enter text
applicable)
5 ApplyRefreshRate button (if applicable) single-click
6 Return to Step 3

17.10.17 Check the Data Pool Insert Queue and Cancel a Data Pool Insert Action

The List Insert Queue page of the DPM GUI provides alist of Data Pool inserts |eft to process
that both full-capability and limited-capability operators can view. It also provides for each
listed insert a check box permitting a full-capability operator to mark queued inserts for
cancellation, and an Apply Change button to implement the cancellation.

Table 17.10-18 presents the steps required to use the DPM GUI to check the Data Pool insert
gueue and cancel a Data Pool insert action. If you are already familiar with the procedure, you
may prefer to use this quick-step table. If you are new to the system, or have not performed this
task recently, you should use the following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click onthe List Insert Queuelink.
* Thelist Insert Queue pageis displayed.

3 Observe data displayed on the List Insert Queue page.
* Thelist Insert Queue page shows how many inserts are left to process as of the
current date.
* ThetableontheList Insert Queue page has columns containing the following types
of insert queue information:
— Data Source.
— Batch Label.
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NOTE:

Dispatch Priority.

Request|D.

Subl D (subscription identifier of the subscription selected by the softwar e for
processing).

ECSID (ECSidentifier or GranulelD for the granuleto be processed).
Collection (to which the granule belongs).

Version (for the collection to which the granule belongs).

Science Granules and/or Metadata (indication of whether theinsert isto
include science granules and metadata or just the metadata).
Enqueue Time (timewhen the insert was placed in theinsert queue).
Retries[number of attempts by the processto recover from retriableerrors
(e.g., Data Pool disk temporarily unavailable, Data Pool directory does not
exist, Data Pool database temporarily unavailable)].

Status.

Click on Box to Cancel (containing a check box to mark theinsert for
cancellation).

There may be multiple subscriptions specifying insertion of specific datainto the
Data Pool, but only one insert is needed; therefore, only one of the subscriptions
serves as the basis for the insert action. The SubID is of no particular
significance to an operator and may safely be ignored.

Thereis an Apply Change button at the bottom of the page for implementing
cancellations.

ThereisaContinuelink at the bottom of the page; if there are more inserts than can
be displayed in the space of one page, the Continue link displays the next page of the

To cancel an insert first click on the check box at the end of the row of information for

the insert to be canceled.

Theinsert is marked for subsequent cancellation.
The check box for the selected insert is filled to indicate selection.

Repeat Step 4 for any additional insert to be cancel ed.

6 To implement the cancellation of insert(s) click on the Apply Change button.

A confirmation message is displayed; it asks "Are you ready to cancel theinsert for . .
" and there are links displayed for Yes, cancel insert and No, return to previous

page.
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7 To confirm cancellation, click on the Yes, cancel insert link.
* Thelist Insert Queue page is displayed with the canceled insert(s) removed and the
count of inserts | eft to process reduced by the number of inserts canceled.
Table 17.10-18. Check the Data Pool Insert Queue and Cancel a Data Pool
Insert Action
Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 List Insert Queue link single-click
3 Observe list insert queue data read text
4 check box (at the end of the row of information for the single-click
insert to be canceled)
5 Repeat Step 4 (as necessary) enter text
6 Apply Change button single-click
7 Yes, cancel insert link single-click

17.10.18 View DPM Configuration Parameter Values

The List of Configuration Parameters page on the DPM GUI allows a full-capability operator
to set or change values assigned to Data Pool Management configuration parameters. Limited-
capability operators have read-only access to the page.

The following parameters are examples of the types of parametersin the Data Pool database that
the full-capability operator can modify:

ActionQueueCleanupFrequency - frequency in seconds when the action queueis
checked for completed actions and those older than the configured retention period
are removed.

BatchSummar yAutoRefr esh — autorefresh rate for the Batch Summary page.
CompressOnlnsert - turns compression ON or OFF.

DefaultRetentionPeriod - default retention period in days for al Data Pool Insert
Actions.

DefaultRetentionPriority - default retention priority for all Data Pool Inserts actions.
Therange of valid valuesis 1 — 255.

DeleteCompletedActionsAfter - timein minutes that operators let completed actions
stay in the insert action queue before making them eligible for removal. The delay is
intended to provide the operator with some ability to check on past actions. The time
period should not be too long.

DisplayAl PChunkSize - number of rows to return per chunk for the AIP list.
HEGCleanupAge— HDF-EOS to GeoTIF Converter (HEG) cleanup age in

days.
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» IdleSleep - number of secondsto sleep when there is nothing to do.

* InCacheTimeLimit - maximum time in minutes that operators are willing to wait for
aData Pool Insert Utility (DPIU) process to complete when itsfiles are in cache.
When the time limit is reached, the Data Pool Action Driver (DPAD) kills the process
and retries the action.

* InsertRetryWait - number of seconds to wait before an insert that failed should be
resubmitted (if it can be retried).

*  MFSOnInsert — specifies whether or not (YES or NO) DPAD should use the
Multiple File System table.

* MaxInsertRetries- maximum number of times an insert should be tried again (-1
means forever).

* MaxReadDrivesPer Archive - maximum number of tape drivesin use
simultaneously.

* MaxTapeM ountPer Request - maximum number of tape mounts allowed per
request.

* NewActionCheckFrequency — number of seconds before checking for new actions.
DPAD always checks to determine whether we are out of actions that can be
dispatched, so unless getting things queued up in memory is urgent, this could be a
time interval of minutes.

*  NumOfAllowedCacheProcesses - maximum number of insert processes that require
access to cache.

*  NumOfAllowedl nsertProcesses - maximum number of insert processes running at
any time.

*  NumOfAllowedNonCacheProcesses - maximum number of insert processes that
reguire access to tape.

*  OnTapeTimelLimit - maximum time in hours operators are willing to wait for a
DPIU process to complete when itsfiles are not in cache. After the timelimit, DPAD
kills the process and retries the action.

* RefreshRate - DPM Home Page refresh rate in seconds.

* RunAwayCheckFregquency — number of seconds before checking again for runaway
processes. It isrecommended that RunAwayCheck Frequency not be much less than
InCacheTimeLimit.

e SizeOflnsertQueuel ist - number of Data Pool Insert Queue entries that the DPM
GUI can display on apage at any one time.

« StartUpWait - number of seconds to delay start-up while trying to clean out |eft-over
DPIU processes.

Section 17.10.3, Use the DPM GUI to Monitor Data Pool Active Insert Processes, addresses
changing the Screen Refresh Rate parameter using an entry field on the Home Page. The
parameter may also be changed using an entry field on the Manage Configuration Parameters
page. Section 17.10.7, Use the DPM GUI to Enable/Disable Data Compression, describes the
procedure for changing the CompressOnlnsert parameter was described.
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Although most of the parameters managed on the Manage Configuration Parameters page are
not likely to be changed frequently, the operator may want to change some of them for tuning the
Data Pool. Data Pool tuning parameters can be used to help meter the flow of datainto the Data
Pool and to adjust retention priority and duration to maintain optimum usage of Data Pool
storage. To determine the best settings, it is necessary to monitor Data Pool inserts and disk
space and adjust the parameters based on experience and projected functioning.

Both full-capability operators and limited-capability operators can view DPM configuration
parameter values. Table 17.10-19 presents the steps required to use the DPM GUI to view DPM
configuration parameter values. If you are already familiar with the procedure, you may prefer to
use this quick-step table. If you are new to the system, or have not performed this task recently,
you should use the following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Configuration Parameterslink.
» ThelList of Configuration Parameters pageis displayed.

3 Observe data displayed on the List of Configuration Parameter s page.
» ThetableontheList of Configuration Parameter s page has columns containing the
following types of Data Pool file system information:
— Parameter Name.
— Parameter Value (including an entry field with current value, followed by a brief
description of the parameter).
— Click on Box to M odify Parm (containing a check box to mark the parameter for
change).
* Therowsin the table indicate the current values and descriptions of the parameters.
» Thereisan Apply Change button at the bottom of the page for implementing
changes.

Table 17.10-19. View DPM Configuration Parameter Values

Step What to Do Action to Take

1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Configuration Parameters link single-click

3 Observe configuration parameters data read text
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17.10.19 Modify DPM Configuration Parameter Values

Full-capability operators (only) can modify DPM configuration parameter values. Table
17.10-20 presents the steps required to use the DPM GUI to modify DPM configuration
parameter values. If you are aready familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Configuration Parameterslink.

» ThelList of Configuration Parameter s page is displayed, providing atable of DPM
configuration parameters showing three columns. Parameter Name, Parameter
Value (including an entry field with current value, followed by a brief description of
the parameter), and Click on Box to M odify Parm (containing a check box to mark
the parameter for change).

» Thereisan Apply Change button at the bottom of the page for implementing
changes.

3 If thereisan option list for the parameter value to be changed, first click on the
corresponding option button.
* Options are displayed (e.g., ON and OFF).

4 If thereisan option list for the parameter value to be changed, click on the appropriate
choice (e.g., ON).

5 If thereisno option list for the parameter value to be changed, type the desired valuein
the corresponding text entry box.

6 Click in the check box at the end of the row containing the parameter value to be
modified.
» Theselected file system information is marked for modification.

7 Repeat Steps 3 through 6 for any additional parameter values to be modified.

8 To implement the modification of parameter value(s) click on the Apply Change button.

* ThelList of Configuration Parameter s page is refreshed, the check box(e) is (are)
unfilled, and the displayed Parameter Value(s) reflect(s) the change(s) implemented.
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Table 17.10-20. Modify DPM Configuration Parameter Values

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Configuration Parameters link single-click
3 option (from the appropriate option list) (if applicable) single-click
4 value (in the appropriate text entry box) (if applicable) enter text
5 check box (at the end of the row containing the parameter | single-click
value to be modified)
6 Repeat Steps 3 through 5 (as necessary)
7 Apply Change button single-click

17.10.20 Use the DPM GUI to View Collection Group and Collection Information

The conceptual structure of the data pool is set up for each DAAC based on the collections and
granules archived at the DAAC. Related collections are grouped in Collection Groups (e.g.,
ASTER collections and granules from the Terra mission, MODIS Oceans collections and
granules from the TerraMission, MISR collections and granules from the Terramission, MODIS
Snow and Ice collections and granules from the Terra mission). Each collection group initialy
consists of a number of collections that have been specified as valid for Data Pool insertion (i.e.,
granules of the data types in the collection may be inserted into the Data Pool).

The Collection Groups page of the DPM GUI alows both full-capability operators and limited-
capability operators to view collection groups. It also provides access to pages for viewing
collections within a collection group. In addition, the page has links that allow a full-capability
operator to modify or add a collection group or collection in the Data Pool database.

Both full-capability operators and limited-capability operators can use the procedure that follows
to display the list of collection groups that have collections specified as valid for Data Pool
insertion and to view information about those collections. Table 17.10-21 presents the steps
required to use the DPM GUI to view collection group and collection information. If you are
aready familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).
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Click on the Collection Groups link.

The Collection Groups page is displayed.

Observe data displayed on the Collection Groups page.

The table on the Collection Groups page has columns containing the following types

of collection group information:

— Data Source (i.e., ECS or NON-ECS).

— Group ID.

— Display Name.

— Description.

The following links are available on the Collection Groups page:

— Each collection listed in the Group 1D column links to a Collection Group
Detail page.

— Add Collection Group.

- Modify Collection Group.

To obtain more information about the collections in one of the groups, click onitslink in
the Group 1D column.

The Collection Group Detail pageis displayed.

Observe data displayed on the Collection Group Detail page.

Near the top of the Collection Group Detail pageisthe following basic collection
group information:

— Data Source (i.e., ECS or NON-ECS).

- Group ID.

— Display Name.

— Description.

Thereisafile system filter (and associated Apply Filter button) for displaying data
on the Collection Group Detail page for al file systems or by individual file system.
The table on the Collection Group Detail page has columns containing the following
types of collection group information:

- Collection.

- Version.

— Compression Command L abel.

- Science Granules and/or M etadata.

- Data Pool Insertion.

- HEG Processing.

- Export Urlsto ECHO.

- Quality Summary Url.

— Spatial Search Type.
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11

— Global Coverage.
— Day/Night Coverage.
— 24 Hour Coverage.
— Cloud Coverage.
» Thefollowing links are available on the Collection Group Detail page:
— Each collection listed in the Collection column links to a Collection Detail page.
- Add New Collection.
— Return to previous page.

To filter data displayed on the Collection Group Detail page first click on the File
System filter option button.
* Options are displayed.

To select afile system filter option click on the appropriate choice from the option list.

To implement the filtering of data displayed on the Collection Group Detail page click

on the Apply Filter button.

* TheCollection Group Detail pageis displayed with the filtered collection group
information.

If data displayed on the Collection Group Detail page were filtered, observe data
displayed on the Collection Group Detail page.
* Referto Step 5.

To obtain more information about one of the collectionsin the collection group, click on
itslink in the Collection column.
» TheCoallection Detail pageisdisplayed.

Observe data displayed on the Collection Detail page.
* Near the top of the Collection Detail pageis the following basic collection group
information:
— Data Source (i.e., ECS or NON-ECS).
— Group ID.
— Display Name.
— Description.
» Thetable on the Collection Detail page has rows containing the following types of
collection information:
- Collection.
- Verson.
— Description.
- File System.
— Compression Command L abel.
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14

- Science Granules and/or M etadata.
— Data Pool Insertion.
- HEG Processing.
- Export Urlsto ECHO.
— Quality Summary Url.
— Spatial Search Type.
— Global Coverage.
— Day/Night Coverage.
— 24 Hour Coverage.
— Cloud Cover Type.
- Cloud Cover Source.
— Cloud Cover Description.
» Thefollowing links are available on the Collection Detail page:
- Modify Collection.
— Return to previous page.

To view adescription for another collection in the same group first click on the Return
to previous page link.
* TheCoallection Group Detail pageis displayed again.

To view adescription for another collection in the same group return to Step 10.

To view adescription for another collection in another group return to Step 2.
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Table 17.10-21. Use the DPM GUI to View Collection Group and Collection

Information
Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Collection Groups link single-click
3 Collection Groups page single-click
4 group link (in the Group ID column) single-click
5 Observe collection group detail information read text
6 File system filter option (from the the option list) (if single-click
applicable)
7 Apply Filter button (if applicable) single-click
8 Observe collection group detail information read text
9 collection link in the Collection column single-click
10 Observe collection detail information read text
11 Return to previous page link (if applicable) single-click
12 Return to Step 9 (if applicable)
13 Return to Step 2 (if applicable)
17.10.21 Use the DPM GUI to Modify Collection Groups

Rarely, it may be desirable to modify the description of one or more of the collection groups

listed on the Collection Groups page.

If there is a need to modify a collection group

description, there is a link at the bottom of the list on that page providing access to a page that
permits the descriptions to be modified. Full-capability operators (only) can use the procedure
that follows to modify collection groups.

Table 17.10-22 presents the steps required to use the DPM GUI to modify collection groups. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Pageis the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Collection Groups link.
The Collection Groups page is displayed, providing atable listing collection group
information; i.e., Source Type, Group I D, Display Name, and Description.
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» Thefollowing links are available: Add Collection Group, Modify Collection
Group, and each collection listed in the Group ID column links to a Collection
Group Detail page.

Click onthe M odify Collection Group link at the bottom of the page.

» TheModify Collection Group pageis displayed, providing atable of collection
group information showing five columns. Data Source, Group ID, Display Name,
Description, and Check box to modify (containing a check box to mark the
collection group for change).

» Thereisan Apply Change button at the bottom of the page for implementing
changes.

To change the display name for the collection group type the desired name in the Display
Name field for the group ID.
» The Display Name may have no more than 12 characters.

— Valid charactersinclude A-Z, 0-9, underscore and space.

To change the description of the collection group type the desired description in the
Description field for the group ID.
» The Description may have no more than 255 characters.

Click in the check box at the end of the row containing collection group information to be
modified.
» Theselected collection group information is marked for modification.

Repeat Steps 4 through 6 for any additional collection groups to be modified.
Click on the Apply Change button.
» Therevised collection group information is entered in the Data Pool database.

* TheCoallection Groups page is displayed with the modified collection group
information.
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Table 17.10-22. Use the DPM GUI to Modify Collection Groups

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Collection Groups link single-click
3 Modify Collection Group link single-click
4 name (in the Display Name field for the group ID) (if enter text
applicable)
5 description (in the Description field for the group ID) (if | single-click
applicable)
6 check box (at the end of the row containing collection single-click
group information to be modified)
7 Repeat Steps 4 through 6 (as necessary)
8 Apply Change button single-click

archiving data from a new instrument).

17.10.22 Use the DPM GUI to Add a Collection Group

Although the following procedure is applicable, most of the time new collection
groups will be added only during releases of new software versions and you will

not use this procedure often.

Caution

From time to time, it may be necessary to add a collection group (e.g., if a DAAC begins
If a collection group is to be added to the list of
collection groups, it is necessary to use the Add Collection Group link at the bottom of the
Manage Collection Groups page. Full-capability operators (only) can use the procedure that
follows to modify collection groups.

NOTE:

The Add Collection Group function is to be exercised
judiciously because the DPM GUI does not provide any

means of deleting collection groups.
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Table 17.10-23 presents the steps required to use the DPM GUI to add a collection group. If you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are
new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Collection Groups link.
» TheCoallection Groups page is displayed, providing atable listing collection group
information; i.e., Source Type, Group I1D, Display Name, and Description.
» Thefollowing links are available: Add Collection Group, Modify Collection
Group, and each collection listed in the Group ID column links to a Collection
Group Detail page.

3 Click onthe Add Collection Group link at the bottom of the page.
» The screen displays a page with four columns of text-entry fields: Data Sour ce,
Group ID, Display Name, and Description.

4 To display data source options click on the Data Sour ce option button.
» Data Source options are displayed (i.e., ECS and NON-ECS).

5 To select adata source option click on the appropriate choice from the option list.

6 Type aunique identifier for the new collection group in the Group 1D field.
e TheGroup ID may have no more than 12 characters.
- Valid charactersinclude A-Z, 0-9, and underscore.
e TheGroup ID will be compared with the existing Group | Ds to ensure that it is not
aduplicate of another ID.

7 To provide adisplay name that is different from the Group I D type anamein the
Display Namefield.
» TheDisplay Name is the name for the collection as displayed on the Data Pool Web
Access GUI.
* If no Display Nameis entered, the Group I D will be used as the Display Name.
» The Display Name may have no more than 12 characters.
— Valid charactersinclude A-Z, 0-9, underscore and space.
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8 Type the description for the new collection group in the Description field.
» The Description may have no more than 255 characters.

9 Click on the Apply Change button.

* The new collection group information is entered in the Data Pool database.
» The Coallection Groups page is displayed with the new collection group information.

Table 17.10-23. Use the DPM GUI to Add a Collection Group

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Collection Groups link single-click
3 Add Collection Group link single-click
4 Data Source option (i.e., ECS or NON-ECS from the single-click
Data Source option list)
5 identifier (in the Group ID field) enter text
6 name in the Display Name field) (if applicable) enter text
7 description (in the Description field) enter text
8 Apply Change button single-click

17.10.23 Use the DPM GUI to Add an ECS Collection to a Collection Group

Although an initial Data Pool structure is provided, not al collections are necessarily specified as
eligible for Data Pool insertion. Based on experience, or on changes in demand, a DAAC may
wish to add one or more collections to a data group. The procedure for adding ECS collections
to a collection group is somewhat different from the procedure for adding a non-ECS collection
to a collection group. Full-capability operators (only) can use the procedure that follows to add
an ECS collection to an existing collection group.

Table 17.10-24 presents the steps required to use the DPM GUI to add an ECS collection to a
collection group. If you are aready familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).
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Click on the Collection Groupslink.

The Collection Groups page is displayed, providing atable listing collection group
information; i.e., Source Type, Group I D, Display Name, and Description.
Thefollowing links are available: Add Collection Group, Modify Collection
Group, and each collection listed in the Group I D column linksto a Collection
Group Detail page.

Click onthe Group ID link for the ECS collection group to which the collection isto be
added.

The Collection Group Detail (List of Collections) pageis displayed with the
following basic collection group information near the top of the page: Data Sour ce
(i.e.,, ECS), Group ID, Display Name, and Description.

Thereisafile system filter (and associated Apply Filter button) for displaying data on
the Collection Group Detail page for al file systems or by individual file system.

The table on the Collection Group Detail page has 13 columns containing the
following types of collection group information: Collection, Version, Compression
Command Label, Science Granules and/or Metadata, Data Pool Insertion, HEG
Processing, Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, and Cloud Coverage.

The following links are available: Add New Collection, Return to previous page, and
each collection listed in the Collection column links to a Collection Detail page.

Click on the Add New Collection link at the bottom of the Collection Group Detail
(List of Collections) page.

The Collections Not in Data Pool page is displayed with the following basic
collection group information near the top of the page: Data Sour ce (i.e., ECS),
Group ID, Display Name, and Description.

The table on the Collections Not in Data Pool page has three columns containing the
following types of collection group information: Collection, Version, and
Description.

Thefollowing links are available: Return to previous page and each collection listed
in the Collection column links to a Collection Detail page.

Click onthelink (in the Collection column) of the collection to be added to the collection
group.

The Add New Collection page is displayed with the following basic collection group
information near the top of the page: Data Source (i.e., ECS), Group ID, Display
Name, and Description.

The Add New Collection page has atable of collection information showing 13
rows. Collection, Version, Description, File System, Compression Command
Label, Science Granules and/or Metadata, Data Pool I nsertion, Quality
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Summary Url, Spatial Search Type, Global Coverage, Day/Night Coverage, 24
Hour Coverage, and Cloud Cover Type & Sour ce.

» Thereisan Apply Change button at the bottom of the page to implement the new
collection in the collection group.

NOTE: On the ECS collection version of the Add New Collection page the Collection,

10

11

12

13

Version, Description, and Spatial Search Typefields are aready filled in using
information from the Data Pool database.

To display file system options (if applicable) click on the File System option button.
» File System options are displayed (if there are multiple Data Pool file systems).

To select afile system option (if applicable) click on the appropriate choice from the File
System option list.

To display compression command label options (if applicable) click on the Compression
Command L abel option button.

» Compression Command L abel options are displayed.

» Selection of acompression command label is not required.

To select acompression command label option (if applicable) click on the appropriate
choice from the Compression Command L abel option list.

To display science granules and/or metadata options click on the Science Granules

and/or Metadata option button.

e Science Granules and/or M etadata options (i.e., Science and M etadata and
Metadata Only) are displayed.

To select a science granules and/or metadata option click on the appropriate choice from
the Science Granules and/or M etadata option list.
» Scienceand Metadata is the default option.

To display data pool insertion options click on the Data Pool | nsertion option button.
» DataPool Insertion options (i.e., Invalid for Data Pool and Valid for Data Pool)
are displayed.

To select adata pool insertion option click on the appropriate choice from the Data Pool

Insertion option list.

* Invalid for Data Pool isthe default option.

» Valid for Data Pool must be selected if the collection isto be eligible for insertion
into the Data Pool.
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If the collection isto be linked to a quality summary web site, enter the URL in the
Quality Summary text entry field.
* Ensurethat http:// isincluded in the Quality Summary text entry field.

To display global coverage options click on the Global Cover age option button.
* Global Coverage options are displayed.

To select aglobal coverage option click on the appropriate choice from the Global
Coverage option list.

* Yesindicates no spatia searches for the collection.

* Noindicatesthat spatial searches are allowed for the collection.

To display day/night coverage options click on the Day/Night Cover age option button.
» Day/Night Coverage options are displayed.

To select aday/night coverage option click on the appropriate choice from the Day/Night
Coverage option list.

* Yesindicates that day/night searches are allowed for the collection.

* Noindicatesthat the collection is excluded from day/night searches.

To display 24-hour coverage options click on the 24 Hour Cover age option button.
* 24 Hour Coverage options are displayed.

To select a 24-hour coverage option click on the appropriate choice from the 24 Hour
Coverage option list.

* Yesindicates that the collection is excluded from time of day searches.

* Noindicatesthat time of day searches are allowed for the collection.

To display cloud cover type and source options click on the Cloud Cover Type &
Sour ce option button.
e Cloud Cover Type & Source options are displayed.

To select acloud cover type and source option click on the appropriate choice from the

Cloud Cover Type & Source option list.

* All cloud cover information in the Data Pool database is listed.

» If thedesired cloud cover type/source is not listed, it can be entered using the Use the
DPM GUI to Add New Cloud Cover Information procedure (Section 17.10.13).

To view details of cloud cover type and source (if applicable) click on the View Details
link adjacent to the Cloud Cover Type & Source option list.
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24 Click on the Apply Change button.
» Thenew collection information is entered in the Data Pool database.
» TheCoallection Group Detail pageis displayed with the new collection information.

Table 17.10-24. Use the DPM GUI to Add an ECS Collection to a Collection

Group
Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Collection Groups link single-click

3 group link (in the Group ID column) single-click

4 Add New Collection link single-click

5 collection link (in the Collection column) single-click

6 File System option (from the File System option list) (if | single-click
applicable)

7 Compression Command Label option (from the single-click
Compression Command Label option list) (if applicable)

8 Science Granules and/or Metadata option (from the single-click
Science Granules and/or Metadata option list)

9 Data Pool Insertion option (from the Data Pool single-click
Insertion option list)

10 URL (in the Quality Summary text entry field) enter text

11 Global Coverage option (from the Global Coverage single-click
option list)

12 Day/Night Coverage option (from the Day/Night single-click
Coverage option list)

13 24 Hour Coverage option (from the 24 Hour Coverage | single-click
option list)

14 Cloud Cover Type & Source option (from the Cloud single-click
Cover Type & Source option list)

15 View Details link (if applicable) single-click

16 Apply Change button single-click

17.10.24 Use the DPM GUI to Add a NON-ECS Collection to a Collection Group

Full-capability operators (only) can use the procedure that follows to add a NON-ECS collection
to an existing collection group. Table 17.10-25 presents the steps required to use the DPM GUI
to add a NON-ECS caollection to a collection group. If you are aready familiar with the
procedure, you may prefer to use this quick-step table. If you are new to the system, or have not
performed this task recently, you should use the following detailed procedure:
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Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

Click on the Collection Groupslink.

The Collection Groups page is displayed, providing atable listing collection group
information; i.e., Source Type, Group I D, Display Name, and Description.
Thefollowing links are available: Add Collection Group, Modify Collection
Group, and each collection listed in the Group I D column linksto a Collection
Group Detail page.

Click onthe Group ID link for the non-ECS collection group to which the collection is
to be added.

The Collection Group Detail (List of Collections) pageis displayed with the
following basic collection group information near the top of the page: Data Sour ce
(i.e., NON-ECS), Group ID, Display Name, and Description.

Thereisafile system filter (and associated Apply Filter button) for displaying data on
the Collection Group Detail page for al file systems or by individual file system.

The table on the Collection Group Detail page has 13 columns containing the
following types of collection group information: Collection, Version, Compression
Command Label, Science Granules and/or Metadata, Data Pool Insertion, HEG
Processing, Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, and Cloud Coverage.

The following links are available: Add New Collection, Return to previous page, and
each collection listed in the Collection column links to a Collection Detail page.

Click onthe Add New Collection link at the bottom of the Collection Group Detail
(List of Collections) page.

The Add New Collection page is displayed with the following basic collection group
information near the top of the page: Data Sour ce (i.e., NON-ECS), Group ID,
Display Name, and Description.

The Add New Collection page has atable of collection information showing 13
rows. Collection, Version, Description, File System, Compression Command
Label, Science Granules and/or Metadata, Data Pool I nsertion, Quality
Summary Url, Spatial Search Type, Global Coverage, Day/Night Coverage, 24
Hour Coverage, and Cloud Cover Type & Sour ce.

Thereis an Apply Change button at the bottom of the page to implement the new
collection in the collection group.
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Type aname for the new collection in the Collection text entry field.

* The name for the new collection may have no more than eight characters.
- Valid charactersinclude A-Z, 0-9, and underscore.

* Thename must start with aletter.

* Thename will be compared with the existing collection names to ensure that it is not
aduplicate of another one.

Type aversion number for the new collection in the Version text entry field.

Type adescription for the new collection in the Description text entry field.
» Thedescription for the new collection may have no more than 255 characters.

To display file system options (if applicable) click on the File System option button.
» File System options are displayed (if there are multiple Data Pool file systems).

To select afile system option (if applicable) click on the appropriate choice from the File
System option list.

To display compression command label options click on the Compression Command
L abel option button.

» Compression Command L abel options are displayed.

» Selection of acompression command label is not required.

To select acompression command label option click on the appropriate choice from the
Compression Command L abel option list.

To display science granules and/or metadata options click on the Science Granules

and/or M etadata option button.

e Science Granules and/or M etadata options (i.e., Science and M etadata and
Metadata Only) are displayed.

To select a science granules and/or metadata option click on the appropriate choice from
the Science Granules and/or M etadata option list.
» Scienceand Metadata is the default option.

To display data pool insertion options click on the Data Pool | nsertion option button.

» Data Pool Insertion options (i.e., Invalid for Data Pool and Valid for Data Pool)
are displayed.

To select adata pool insertion option click on the appropriate choice from the Data Pool

Insertion option list.

* Invalid for Data Pool isthe default option.
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» Valid for Data Pool must be selected if the collection isto be eligible for insertion
into the Data Pool.

If the collection isto be linked to a quality summary web site, enter the URL in the
Quality Summary text entry field.
* Ensurethat http:// isincluded in the Quality Summary text entry field.

To display spatial search type options click on the Spatial Search Type option button.
» Spatial Search Type options (e.g., Not Supported, Orbit, Rectangle, and
GPolygon) are displayed.

To select aspatial search type option click on the appropriate choice from the Spatial
Search Type option list.
* Not Supported isthe default spatia search type.

To display global coverage options click on the Global Cover age option button.
» Global Coverage options are displayed.

To select aglobal coverage option click on the appropriate choice from the Global
Coverage option list.

* Yesindicates no spatial searchesfor the collection.

* Noindicatesthat spatial searches are allowed for the collection.

To display day/night coverage options click on the Day/Night Cover age option button.
» Day/Night Coverage options are displayed.

To select aday/night coverage option click on the appropriate choice from the Day/Night
Coverage option list.

* Yesindicates that day/night searches are allowed for the collection.

* Noindicates that the collection is excluded from day/night searches.

To display 24-hour coverage options click on the 24 Hour Cover age option button.
e 24 Hour Coverage options are displayed.

To select a 24-hour coverage option click on the appropriate choice from the 24 Hour
Coverage option list.

* Yesindicates that the collection is excluded from time of day searches.

* Noindicatesthat time of day searches are allowed for the collection.

To display cloud cover type and source options click on the Cloud Cover Type and

Sour ce option button.
* Cloud Cover Type & Source options are displayed.
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To select acloud cover type and source option click on the appropriate choice from the

Cloud Cover Type & Source option list.

* All cloud cover information in the Data Pool database is listed.

» If thedesired cloud cover type/source is not listed, it can be entered using the Use the
DPM GUI to Add New Cloud Cover Information procedure (Section 17.10.13).

To view details of cloud cover type and source (if applicable) click on the View Details
link adjacent to the Cloud Cover Type & Source option list.

Click on the Apply Change button.

* Thenew collection information is entered in the Data Pool database.
» TheCoallection Group Detail pageis displayed with the new collection information.
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Table 17.10-25. Use the DPM GUI to Add a NON-ECS Collection to a Collection

Group
Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1

2 Collection Groups link single-click

3 group link (in the Group ID column) single-click

4 Add New Collection link single-click

5 collection link (in the Collection column) single-click

6 version (in the Version text entry field) enter text

7 description (in the Description text entry field) enter text

8 File System option (from the File System option list) (if | single-click
applicable)

9 Compression Command Label option (from the single-click
Compression Command Label option list) (if applicable)

10 Science Granules and/or Metadata option (from the single-click
Science Granules and/or Metadata option list)

11 Data Pool Insertion option (from the Data Pool single-click
Insertion option list)

12 URL (in the Quality Summary text entry field) enter text

13 Spatial Search Type option (from the Spatial Search single-click
Type option list)

14 Global Coverage option (from the Global Coverage single-click
option list)

15 Day/Night Coverage option (from the Day/Night single-click
Coverage option list)

16 24 Hour Coverage option (from the 24 Hour Coverage | single-click
option list)

17 Cloud Cover Type & Source option (from the Cloud single-click
Cover Type & Source option list)

18 View Details link (if applicable) single-click

19 Apply Change button single-click

17.10.25 Use the DPM GUI to Modify an ECS Collection

As part of managing the Data Pool storage and retention of data, making adjustments based on
experience and/or changes in demand, it may be desirable to modify a collection. The
modification may mean specifying that metadata only may continue to be inserted and science
granules may no longer be inserted, or declaring the collection no longer valid for data pool
insertion at all.

The procedure for modifying an ECS collection is somewhat different from the procedure for
modifying a non-ECS collection. Full-capability operators (only) can use the procedure that
follows to modify an ECS collection.
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Table 17.10-26 presents the steps required to use the DPM GUI to modify an ECS collection. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Collection Groups|link.

The Collection Groups page is displayed, providing atable listing collection group
information; i.e., Source Type, Group I D, Display Name, and Description.
Thefollowing links are available: Add Collection Group, Modify Collection
Group, and each collection listed in the Group I D column linksto a Collection
Group Detail page.

3 Click onthe Group ID link for the collection group containing the collection to be
modified.

The Collection Group Detail (List of Collections) pageis displayed with the
following basic collection group information near the top of the page: Data Sour ce
(i.e,, ECS), Group ID, Display Name, and Description.

Thereisafile system filter (and associated Apply Filter button) for displaying data on
the Collection Group Detail page for al file systems or by individual file system.

The table on the Collection Group Detail page has 13 columns containing the
following types of collection group information: Collection, Version, Compression
Command Label, Science Granules and/or Metadata, Data Pool Insertion, HEG
Processing, Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, and Cloud Coverage.

The following links are available: Add New Collection, Return to previous page, and
each collection listed in the Collection column links to a Collection Detail page.

Click on thelink (in the Collection column) of the collection to be modified.

The Collection Detail page is displayed with the following basic collection group
information near the top of the page: Data Sour ce (i.e., ECS), Group 1D, Display
Name, and Description.
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» The Collection Detail page has atable of collection information showing 17 rows:
Collection, Version, Description, File System, Compression Command L abel,
Science Granules and/or M etadata, Data Pool I nsertion, HEG Processing,
Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, Cloud Cover Type, Cloud
Cover Source, and Cloud Cover Description.

* ThereisaModify Collection link and a Return to previous page link at the bottom
of the page.

5 Click on the M odify Collection link.

* TheModify Collection page is displayed with the following basic collection group
information near the top of the page: Data Source (i.e., ECS), Group 1D, Display
Name, and Description.

» TheModify Collection page has atable of collection information showing 15 rows:
Collection, Version, Description, File System, Compression Command L abel,
Science Granules and/or M etadata, Data Pool I nsertion, HEG Processing,
Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, and Cloud Cover Type &
Source.

» Thereisan Apply Change button at the bottom of the page to implement the new
collection in the collection group.

NOTE: On the ECS collection version of the M odify Collection page the Collection,
Version, Description, and Spatial Search Type fields cannot be edited.

6 To display file system options (if applicable) click on the File System option button.
» File System options are displayed (if there are multiple Data Pool file systems).

7 To select afile system option (if applicable) click on the appropriate choice from the File
System option list.

8 To display compression command label options (if applicable) click on the Compression
Command L abel option button.
» Compression Command L abel options are displayed.

9 To select acompression command label option (if applicable) click on the appropriate
choice from the Compression Command L abel option list.

10 To display science granules and/or metadata options (if applicable) click on the Science
Granules and/or M etadata option button.
» Science Granules and/or M etadata options (i.e., Science and M etadata and
Metadata Only) are displayed.
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To select a science granules and/or metadata option (if applicable) click on the
appropriate choice from the Science Granules and/or M etadata option list.
» Scienceand Metadata is the default option.

To display data pool insertion options (if applicable) click on the Data Pool I nsertion

option button.

» DataPool Insertion options (i.e., Invalid for Data Pool and Valid for Data Pool)
are displayed.

To select adata pool insertion option (if applicable) click on the appropriate choice from

the Data Pool Insertion option list.

» Valid for Data Pool must be selected if the collection isto be eligible for insertion
into the Data Pool.

If the collection isto be linked to a quality summary web site, enter the URL in the
Quality Summary text entry field.
* Ensurethat http:// isincluded in the Quality Summary text entry field.

To display global coverage options (if applicable) click on the Global Coverage option
button.

* Global Coverage options are displayed.

To select aglobal coverage option (if applicable) click on the appropriate choice from the
Global Coverage option list.

* Yesindicates no spatia searches for the collection.

* Noindicatesthat spatial searches are allowed for the collection.

To display day/night coverage options (if applicable) click on the Day/Night Coverage
option button.
» Day/Night Coverage options are displayed.

To select aday/night coverage option (if applicable) click on the appropriate choice from
the Day/Night Coverage option list.

* Yesindicates that day/night searches are allowed for the collection.

* Noindicatesthat the collection is excluded from day/night searches.

To display 24-hour coverage options (if applicable) click on the 24 Hour Coverage

option button.
* 24 Hour Coverage options are displayed.
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To select a 24-hour coverage option (if applicable) click on the appropriate choice from
the 24 Hour Coverage option list.

* Yesindicates that the collection is excluded from time of day searches.

* Noindicatesthat time of day searches are allowed for the collection.

To display cloud cover type and source options (if applicable) click on the Cloud Cover
Type & Sour ce option button.
* Cloud Cover Type & Source options are displayed.

To select acloud cover type and source option (if applicable) click on the appropriate

choice from the Cloud Cover Type & Source option list.

* All cloud cover information in the Data Pool database s listed.

» If thedesired cloud cover type/source is not listed, it can be entered using the Use the
DPM GUI to Add New Cloud Cover Information procedure (Section 17.10.13).

To view details of cloud cover type and source (if applicable) click on the View Details
link adjacent to the Cloud Cover Type & Source option list.

Click on the Apply Change button.

* Themodified collection information is entered in the Data Pool database.

» TheCoallection Group Detail pageis displayed with the modified collection
information.

Table 17.10-26. Use the DPM GUI to Modify an ECS Collection (1 of 2)

Step What to Do Action to Take

1

Launch the DPM GUI Use procedure in Section
17.10.1

Collection Groups link single-click

group link (in the Group ID column) single-click

collection link (in the Collection column) single-click

Modify Collection link single-click

(| [wW|N

File System option (from the File System option list) (if | single-click
applicable)

Compression Command Label option (from the single-click
Compression Command Label option list) (if applicable)

Science Granules and/or Metadata option (from the single-click
Science Granules and/or Metadata option list) (if
applicable)

Data Pool Insertion option (from the Data Pool single-click
Insertion option list) (if applicable)

10

URL (in the Quality Summary text entry field) (if enter text
applicable)
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Table 17.10-26. Use the DPM GUI to Modify an ECS Collection (2 of 2)

Step What to Do Action to Take

11 Global Coverage option (from the Global Coverage single-click
option list) (if applicable)

12 Day/Night Coverage option (from the Day/Night single-click
Coverage option list) (if applicable)

13 24 Hour Coverage option (from the 24 Hour Coverage | single-click
option list) (if applicable)

14 Cloud Cover Type & Source option (from the Cloud single-click
Cover Type & Source option list) (if applicable)

15 View Details link (if applicable) single-click

16 Apply Change button single-click

17.10.26 Use the DPM GUI to Modify a NON-ECS Collection

Full-capability operators (only) can use the procedure that follows to modify a non-ECS
collection.

Table 17.10-27 presents the steps required to use the DPM GUI to modify a NON-ECS
collection. If you are already familiar with the procedure, you may prefer to use this quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
following detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Collection Groupslink.
» The Coallection Groups page is displayed, providing atable listing collection group
information; i.e., Source Type, Group I D, Display Name, and Description.
* Thefollowing links are available: Add Collection Group, Modify Collection
Group, and each collection listed in the Group I D column linksto a Collection
Group Detail page.

3 Click onthe Group ID link for the collection group containing the collection to be
modified.
» TheCollection Group Detail (List of Collections) page is displayed with the
following basic collection group information near the top of the page: Data Sour ce
(i.e., NON-ECS), Group ID, Display Name, and Description.
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Thereisafile system filter (and associated Apply Filter button) for displaying data on
the Collection Group Detail page for al file systems or by individual file system.

The table on the Collection Group Detail page has 13 columns containing the
following types of collection group information: Collection, Version, Compression
Command Label, Science Granules and/or Metadata, Data Pool Insertion, HEG
Processing, Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, and Cloud Coverage.

The following links are available: Add New Collection, Return to previous page, and
each collection listed in the Collection column links to a Collection Detail page.

4 Click onthelink (in the Collection column) of the collection to be modified.

The Collection Detail pageis displayed with the following basic collection group
information near the top of the page: Data Sour ce (i.e., NON-ECS), Group ID,
Display Name, and Description.

The Collection Detail page has atable of collection information showing 17 rows.
Collection, Version, Description, File System, Compression Command L abel,
Science Granules and/or Metadata, Data Pool I nsertion, HEG Processing,
Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, Cloud Cover Type, Cloud
Cover Source, and Cloud Cover Description.

ThereisaModify Collection link and a Return to previous page link at the bottom
of the page.

5 Click on the M odify Collection link.

The M odify Collection page is displayed with the following basic collection group
information near the top of the page: Data Sour ce (i.e., NON-ECS), Group ID,
Display Name, and Description.

The M odify Collection page has atable of collection information showing 15 rows:
Collection, Version, Description, File System, Compression Command L abel,
Science Granules and/or M etadata, Data Pool I nsertion, HEG Processing,
Export Urlsto ECHO, Quality Summary Url, Spatial Search Type, Global
Coverage, Day/Night Coverage, 24 Hour Coverage, and Cloud Cover Type &
Source.

Thereis an Apply Change button at the bottom of the page to implement the new
collection in the collection group.

NOTE: On the NON-ECS collection version of the M odify Collection page the
Collection and Version fields cannot be edited.
6 If applicable, type a description for the collection in the Description text entry field.

The description for the collection may have no more than 255 characters.
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To display file system options (if applicable) click on the File System option button.
» File System options are displayed (if there are multiple Data Pool file systems).

To select afile system option (if applicable) click on the appropriate choice from the File
System option list.

To display compression command label options (if applicable) click on the Compression
Command L abel option button.
» Compression Command L abel options are displayed.

To select acompression command label option (if applicable) click on the appropriate
choice from the Compression Command L abel option list.

To display science granules and/or metadata options (if applicable) click on the Science

Granules and/or M etadata option button.

» Science Granules and/or M etadata options (i.e., Science and M etadata and
Metadata Only) are displayed.

To select a science granules and/or metadata option (if applicable) click on the
appropriate choice from the Science Granules and/or M etadata option list.
» Scienceand Metadata is the default option.

To display data pool insertion options (if applicable) click on the Data Pool I nsertion

option button.

» Data Pool Insertion options (i.e., Invalid for Data Pool and Valid for Data Pool)
are displayed.

To select adata pool insertion option (if applicable) click on the appropriate choice from

the Data Pool I nsertion option list.

» Valid for Data Pool must be selected if the collection isto be eligible for insertion
into the Data Pool.

If the collection isto be linked to a quality summary web site, enter the URL in the
Quality Summary text entry field.
* Ensurethat http:// isincluded in the Quality Summary text entry field.

To display spatial search type options (if applicable) click on the Spatial Search Type

option button.

» Spatial Search Type options (e.g., Not Supported, Orbit, Rectangle, and
GPolygon) are displayed.

» Spatial Search Type can be changed only when the collection is not currently
enabled for insert and the Data Pool contains no granules belonging to the collection.
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To select aspatial search type option (if applicable) click on the appropriate choice from
the Spatial Search Type option list.

To display global coverage options (if applicable) click on the Global Coverage option
button.

» Global Coverage options are displayed.

To select aglobal coverage option (if applicable) click on the appropriate choice from the
Global Coverage option list.

* Yesindicates no spatia searches for the collection.

* Noindicatesthat spatial searches are allowed for the collection.

To display day/night coverage options (if applicable) click on the Day/Night Coverage
option button.
» Day/Night Coverage options are displayed.

To select aday/night coverage option (if applicable) click on the appropriate choice from
the Day/Night Coverage option list.

* Yesindicates that day/night searches are allowed for the collection.

* Noindicatesthat the collection is excluded from day/night searches.

To display 24-hour coverage options (if applicable) click on the 24 Hour Coverage
option button.
* 24 Hour Coverage options are displayed.

To select a 24-hour coverage option (if applicable) click on the appropriate choice from
the 24 Hour Coverage option list.

* Yesindicates that the collection is excluded from time of day searches.

* Noindicatesthat time of day searches are allowed for the collection.

To display cloud cover type and source options (if applicable) click on the Cloud Cover
Type and Sour ce option button.
e Cloud Cover Type & Source options are displayed.

To select acloud cover type and source option (if applicable) click on the appropriate

choice from the Cloud Cover Type & Sour ce option list.

* All cloud cover information in the Data Pool database is listed.

» If thedesired cloud cover type/source is not listed, it can be entered using the Use the
DPM GUI to Add New Cloud Cover Information procedure (Section 17.10.13).
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26 To view details of cloud cover type and source (if applicable) click on the View Details
link adjacent to the Cloud Cover Type & Source option list.
27 Click on the Apply Change button.
» Themodified collection information is entered in the Data Pool database.
» TheCollection Group Detail pageis displayed with the modified collection
information.
Table 17.10-27. Use the DPM GUI to Modify a NON-ECS Collection
Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Collection Groups link single-click
3 group link (in the Group ID column) single-click
4 collection link (in the Collection column) single-click
5 Modify Collection link single-click
6 description (in the Description text entry field) (if enter text
applicable)
7 File System option (from the File System option list) (if | single-click
applicable)
8 Compression Command Label option (from the single-click
Compression Command Label option list) (if applicable)
9 Science Granules and/or Metadata option (from the single-click
Science Granules and/or Metadata option list) (if
applicable)
10 Data Pool Insertion option (from the Data Pool single-click
Insertion option list) (if applicable)
11 URL (in the Quality Summary text entry field) (if enter text
applicable)
12 Spatial Search Type option (from the Spatial Search single-click
Type option list) (if applicable)
13 Global Coverage option (from the Global Coverage single-click
option list) (if applicable)
14 Day/Night Coverage option (from the Day/Night single-click
Coverage option list) (if applicable)
15 24 Hour Coverage option (from the 24 Hour Coverage | single-click
option list) (if applicable)
16 Cloud Cover Type & Source option (from the Cloud single-click
Cover Type & Source option list) (if applicable)
17 View Details link (if applicable) single-click
18 Apply Change button single-click
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17.10.27 Use the DPM GUI to View a List of Themes

Users may search the Data Pool for data associated with themes. As data are inserted into the
Data Pool, it is possible to associate the data with themes. The DPM GUI Detailed List of Data
Pool Themes page permits both full-capability and limited-capability operators users to view a
list of Data Pool themes. In addition it has links that allow full-capability operators to add new
themes, modify existing themes, or delete themes.

Table 17.10-28 presents the steps required to use the DPM GUI to view alist of themes. If you
are already familiar with the procedure, you may prefer to use this quick-step table. If you are
new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Themeslink.

The Detailed List of Data Pool Themes page is displayed.

3 Observe data displayed on the Detailed List of Data Pool Themes page.

Thetable on the Detailed List of Data Pool Themes page has columns containing
the following types of Data Pool file system information:

— Theme Name/Description.

- Web Visible.

- Insert Enabled.

— Click on Box to Delete (containing a check box to mark the theme for deletion).
There are theme filters (and associated Apply Filter button) for displaying data on
the Detailed List of Data Pool Themes page depending on whether or not the
themes...

- Arewebvisible.

- Areinsert enabled.

— Have certain letters at the beginning of the theme name.

Filters can be applied individually or in any combination.

The following links are available on the Detailed List of Data Pool Themes page:
- Add New Theme.

- Modify Theme.

Thereisan Apply Change button at the bottom of the page to implement the deletion
of selected themes.
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To filter data displayed on the Detailed List of Data Pool Themes page use the Filter a
List of Themes procedure (Section 17.10.27.1).

If data displayed on the Detailed List of Data Pool Themes page were filtered, return to
Step 3.

Table 17.10-28. Use the DPM GUI to View a List of Themes

Step What to Do Action to Take

Launch the DPM GUI Use procedure in Section
17.10.1

Themes link single-click

Observe Data Pool themes data read text

Filter the list of themes (if applicable) Use procedure in Section
17.10.27.1

Return to Step 3 (if applicable) single-click

17.10.27.1 Filter a List of Themes

The procedure to Filter a List of Themes is subordinate to other theme-related procedures (i.e.,
Section 17.10.27, Use the DPM GUI to View a List of Themes, Section 17.10.28, Use the
DPM GUI to Modify a Theme, and Section 17.10.30, Use the DPM GUI to Delete a Theme).
Both full-capability and limited-capability operators users may filter data displayed on the
Themes pages to which they have access.

Table 17.10-29 presents the steps required to filter a list of themes. If you are aready familiar
with the procedure, you may prefer to use this quick-step table. If you are new to the system, or
have not performed this task recently, you should use the following detailed procedure:

1

To filter data displayed on one of the Themes pages on the basis of whether or not the
themes are enabled for web drill-down (if applicable) first click on the Web Visible
option button in the filter area of the page.

To select athemefilter option on the basis of whether or not the themes are enabled for
web drill-down (if applicable) click on the appropriate choice from the option list.

*  Yes(View al themes enabled for web drill-down).

* No (View all themes disabled for web drill-down).

* ALL (View al themes regardless of whether web drill-down is enabled or disabled).

To filter data displayed on one of the Themes pages on the basis of whether or not the

themes are enabled for insertion into the Data Pool (if applicable) first click on the I nsert
Enabled option button.
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4 To select athemefilter option on the basis of whether or not the themes are enabled for
web drill-down (if applicable) click on the appropriate choice from the option list.
* Yes(View al themes enabled for insertion into the Data Pool).
* No (View all themes disabled for insertion into the Data Pool).
 ALL (View al themes regardless of whether insertion into the Data Pool is enabled
or disabled).

5 To select athemefilter option on the basis of the beginning letters of the theme (if
applicable) type the beginning letter(s) of the theme in the Beginning L etter stext entry
field.

6 To implement the filtering of data displayed on one of the Themes pages click on the
Apply Filter button.

» The pageisdisplayed with the filtered theme information.

7 Return to the procedure that specified the Filter a List of Themes procedure.

Table 17.10-29. Filter a List of Themes

Step What to Do Action to Take
1 Web Visible option (from the Web Visible option list) (if | single-click
applicable)
2 Insert Enabled option (from the Insert Enabled option single-click
list) (if applicable)
3 letter(s) (in the Beginning Letters text entry field) enter text
4 Apply Filter button single-click
5 Return to the procedure that specified the Filter a List of
Themes procedure

17.10.28 Use the DPM GUI to Modify a Theme

Full-capability operators can use the DPM GUI to modify a theme. This can be useful if, for
example, it is noted that access frequency for granules referencing a theme has declined to the
point that the thematic collection should be removed from the Data Pool, but there are afew web
usersthat still useit. Inthat case, it may be appropriate to change the description of the themeto
alert users that the theme will be phased out soon.

Table 17.10-30 presents the steps required to use the DPM GUI to modify a theme. If you are
aready familiar with the procedure, you may prefer to use this quick-step table. If you are new
to the system, or have not performed this task recently, you should use the following detailed
procedure:
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Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

* TheHome Pageisthe default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

Click onthe Themeslink.
» TheDetailed List of Data Pool Themes page is displayed.

Click on the Modify Themelink.

» TheModify Theme page is displayed, providing atable of theme information
showing five columns. Theme Name, Description, Web Visible, Insert Enabled,
and Click on Box to M odify (containing a check box to mark the theme for change).

» There arethemefilters (and associated Apply Filter button) for displaying data on
the M odify Theme page.

» Thereisan Apply Change button at the bottom of the page for implementing
changes.

» Thefollowing links are available: Return to previous page and Return to Main
Theme Page.

To filter data displayed on the M odify Theme page use the Filter a List of Themes
procedure (Section 17.10.27.1).

To change the description of atheme (if applicable) type the desired description in the
Description field for the theme name.
* The Description may have no more than 255 characters.

To change the theme from enabled for web drill-down to disabled (or vice versa) (if

applicable) click on the toggle button box in the Web Visible column in the row for the

theme.

* A check mark in the box indicates that the theme is enabled for web drill-down.

+ The absence of acheck mark in the box indicates that the theme is not enabled for
web drill-down.

To change the theme from enabled for insert into the Data Pool to disabled (or vice versa)

(if applicable) click on the toggle button box in the Insert Enabled column in the row

for the theme.

* A check mark in the box indicates that the theme is enabled for insert into the Data
Pool.

* The absence of acheck mark in the box indicates that the theme is not enabled for
insert into the Data Pool.
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8 Click in the check box at the end of the row containing the theme to be modified.

The selected theme is marked for modification.

9 Repeat Steps 5 through 8 as necessary for any additional themes to be modified.

10 To implement the modification of theme(s) click on the Apply Change button.
The theme information is entered in the Data Pool database.
The Detailed List of Data Pool Themes page is displayed with the modified theme

information.

Table 17.10-30. Use the DPM GUI to Modify a Theme

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Themes link single-click
3 Modify Theme link. single-click
4 Filter the list of themes (if applicable) Use procedure in Section
17.10.27.1
5 description (in the appropriate Description field) (if enter text
applicable)
6 Web Visible check box (in the Web Visible column for single-click
the appropriate theme) (if applicable)
7 Insert Enabled check box (in the Insert Enabled column | single-click
for the appropriate theme) (if applicable)
8 check box (at the end of the row containing the theme to | single-click
be modified)
9 Repeat Steps 5 through 8 (as necessary)
10 Apply Change button single-click

17.10.29 Use the DPM GUI to Add a Theme

Full-capability operators (only) can use the procedure that follows to add a theme. Table
17.10-31 presents the steps required to use the DPM GUI to add a theme. If you are already
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed

procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Page is the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).
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Click on the Themes|link.
* TheDetailed List of Data Pool Themes page is displayed.

Click on the Add New Themelink.

» The Add New Theme page is displayed, providing atable of theme information
showing four columns. Theme Name, Description, Web Visible, and Insert
Enabled.

» Therearethemefilters (and associated Apply Filter button) for displaying data on
the M odify Theme page.

— Thefilters serve no real function on this page (there is nothing to filter).

» Thereisan Apply Change button at the bottom of the page for implementing
changes.

» Thefollowing link is available: Return to themelist.

Type aunique name for the theme in the Theme Name text entry field.

* The Theme Name may have no more than 40 characters.

* The Theme Name may not start with a number.

* The Theme Name may not duplicate the name of a collection, an ESDT, or another
theme,.

To enter adescription of the theme type the desired description in the Description text
entry field.
» The Description may have no more than 255 characters.

To enable the theme for web drill-down click on the toggle button box in the Web

Visible column.

* A check mark in the box indicates that the theme is enabled for web drill-down.

* The absence of acheck mark in the box indicates that the theme is not enabled for
web drill-down.

To enable the theme for insert into the Data Pool click on the toggle button box in the

Insert Enabled column.

* A check mark in the box indicates that the theme is enabled for insert into the Data
Pool.

* The absence of acheck mark in the box indicates that the theme is not enabled for
insert into the Data Pool.

Click on the Apply Change button.

* The new themeinformation is entered in the Data Pool database.

» TheDetailed List of Data Pool Themes page is displayed with the new theme
information.
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Table 17.10-31. Use the DPM GUI to Add a Theme

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Themes link single-click
3 Add New Theme link single-click
4 name (in the Theme Name text entry field) enter text
5 description (in the Description text entry field) enter text
6 Web Visible check box (in the Web Visible column for single-click
the appropriate theme) (if applicable)
7 Insert Enabled check box (in the Insert Enabled column | single-click
for the appropriate theme) (if applicable)
8 Apply Change button single-click

17.10.30 Use the DPM GUI to Delete a Theme

Full-capability operators (only) can use the procedure that follows to delete a theme. Table
17.10-32 presents the steps required to use the DPM GUI to delete a theme. If you are already
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed

procedure:

1 Launch the DPM GUI (refer to Section 17.10.1, Launch the DPM GUI).

The Home Pageis the default display, offering links for access to Data Pool
mai ntenance function pages (i.e., Data Pool File Systems, Compression
Algorithms, Cloud Cover, List Insert Queue, Batch Summary, Collection
Groups, Themes, Configuration Parameters, and End Session).

2 Click on the Themeslink.

The Detailed List of Data Pool Themes page is displayed, with columns containing
the following types of Data Pool file system information:

— Theme Name/Description.

- Web Visible.

- Insert Enabled.

— Click on Box to Delete (containing a check box to mark the theme for deletion).
There are theme filters (and associated Apply Filter button) for displaying data on
the Detailed List of Data Pool Themes page depending on whether or not the
themes...

- Arewebvisible.

- Areinsert enabled.
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— Have certain letters at the beginning of the theme name.
» Filters can be applied individually or in any combination.
» Thefollowing links are available on the Detailed List of Data Pool Themes page:
- Add New Theme.
- Modify Theme.
» Thereisan Apply Change button at the bottom of the page to implement the deletion
of selected themes.

3 To filter data displayed on the Detailed List of Data Pool Themes page use the Filter a
List of Themes procedure (Section 17.10.27.1).

4 Click in the check box at the end of the row containing the theme to be deleted.
» The selected theme is marked for deletion.

5 Repeat Step 4 as necessary for any additional themes to be deleted.
6 To implement the deletion of theme(s) click on the Apply Change button.
» Thetheme deletion information is entered in the Data Pool database.

» TheDetailed List of Data Pool Themes page is displayed with the modified theme
information.

Table 17.10-32. Use the DPM GUI to Delete a Theme

Step What to Do Action to Take
1 Launch the DPM GUI Use procedure in Section
17.10.1
2 Themes link. single-click
3 Filter the list of themes (if applicable) Use procedure in Section
17.10.27.1
4 check box (at the end of the row containing the theme to | single-click
be deleted)
5 Repeat Step 4 (as necessary)
6 Fill the toggle button box in the Click on Box to Delete single-click
column
6 Apply Change button single-click

17.10.31 Use the Update Granule Utility to Extend the Retention for Selected
Science Granules

A changein user interest in data from a particular location may make it desirable to retain certain
data aready in the Data Pool for a longer period of time than originally specified. Data Pool
maintenance personnel can run the Update Granule Utility to update the expiration date for
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selected science granules. This utility also permits modifying a granule’s retention priority,
which can affect how soon the Data Pool Cleanup Utility removes the granule from the Data
Pool.

When updating the granules associated with a theme, the utility updates the expiration date of a
granule associated with that theme if and only if the new expiration date specified is later than
the current expiration date of the granule. It updates the retention priority of a granule associated
with that theme if and only if the new expiration priority specified is higher than the current
retention priority of the granule.

The Update Granule Utility permits updating granule information using a command-line
interface. The following options may be used:

e -noprompt: suppressing prompts and detailed information display.
» -theme: specifiesavalid theme name (i.e., a character string that matches an existing
theme name in the Data Pool inventory).

A single granule may be updated using manual input. Multiple granule updates can be handled
using an input file containing a list of granules to be updated, or by specifying a theme. The
input file must be structured as alist of granules to be processed, one per line. Each line contains
a granule 1D (reflecting the Sybase entry in the Data Pool database), an expiration date, and
(optionally) a new retention priority, the value of which may be null (i.e., left blank). The fields
are separated by a single space. There should be no blank lines before the first or after the last
granuleinthelist. The file contents should be similar to the following example.

GRANULE_| D_4832 EXP_DATE=2002/ 2/ 28 RETENTI ON=255

GRANULE_| D_4876 EXP_DATE=2002/2/ 28 RETENTI ON=200

GRANULE_| D_4883 EXP_DATE=2002/ 2/ 28 RETENTI ON=

GRANULE_| D_4937 EXP_DATE=2002/ 2/ 28

GRANULE_| D_4966 EXP_DATE=2002/2/ 28 RETENTI ON=255
The Update Granule Utility connects to the Data Pool database and calls Sybase stored
procedures to perform the requested updates. Therefore, the utility runs only if the Data Pool
database server is running and if the database is available. It also assumes the stored procedures
are present. The Granule Update Utility may be run as a background process, with suppression
of all warning/error messages and confirmation prompts if desired. When the utility is run, it
writes information, any warnings, any errors, and messages to a log file about granules as they
are updated.

Table 17.10-33 presents the steps required to use the Update Granule Utility to extend the
retention for selected science granules. If you are already familiar with the procedure, you may
prefer to use this quick-step table. If you are new to the system, or have not performed this task
recently, you should use the following detailed procedure:

1 Log in at the machine on which the Update Granule Utility isinstalled (e.g., e0dps01,
g0dps01, 10dps01, n0dps01).
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To changeto the directory for starting the Update Granule Utility, type cd
/usr/lecs’<MODE>/CUST OM/utilities and then press the Return/Enter key.
» Theworking directory is changed to /usr/ecs’<MODE>/CUST OM/utilities.

At the UNIX prompt, enter the command to start the Update Granule Utility, in the form
EcDIUpdateGranule.pl <command line parameters>. (Note: The first command-line
parameter specified must be <MODE>, avalid, existing Data Pool mode [e.g., OPS, TS1,

TS2)).

» Thefollowing six permutations are valid command-line entries for initiating the
Update Granule utility:

EcDIUpdateGranule.pl <MODE> -file <filename> (to update granuleslisted in
an input file named <filename> while displaying all summary information to the
operator, and asking confirmation of the update).

EcDIlUpdateGranule.pl <MODE> -grnid <granulel D> -exp <expiration date>
[-ret <retention priority>] (to update a granule identified by its <granulel D>
with anew expiration date and, optionally, a new retention priority while
displaying all summary information to the operator, and asking confirmation of
the update).

EcDIUpdateGranule.pl <MODE> -noprompt -file <filename> (to update
granules listed in an input file named <filename> with no confirmation or
information displayed to the operator).

EcDIlUpdateGranule.pl <MODE> -noprompt -grnid <granulel D> -exp
<expiration date> [-ret <retention priority>] (to update a granule identified by its
<granulel D> with anew expiration date and, optionally, a new retention priority
with no confirmation or information displayed to the operator).
EcDIlUpdateGranule.pl <MODE> -theme <themename> -exp <expiration
date> [-ret <retention priority>] (to update a granule identified by its
<themename> with a new expiration date and, optionally, a new retention priority
while displaying all summary information to the operator, and asking
confirmation of the update).

EcDIUpdateGranule.pl <MODE> -noprompt -theme <themename> -exp
<expiration date> [-ret <retention priority>] (to update a granule identified by its
<themename> with a new expiration date and, optionally, a new retention priority
with no confirmation or information displayed to the operator.

» The utility executes and displays a confirmation prompt similar to the following:
You are about to start updating granul es.

Total number of granules: 11
Total size of granules: 8.61339673772454 MB

Do you wish to continue processing the update? [y/n]y
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Typey and then press the Return/Enter key.
The utility completes execution and displays output similar to the following:

Updat e conpl et ed.
Pl ease check the database to ensure proper conpletion.

Update took 2 seconds to conplete

Gracefully exiting...
To check the database, have the Database Administrator use isgl commands on the
Data Pool database host to query the DIGranuleExpirationPriority table. 1t may also
be useful to examine the Update Granule Utility log file to determine whether there
were any problems with the execution. To examine that log file, go to Steps 5 and 6.

To change to the directory containing the Update Granule Utility log file and other log
files, type cd /usr/ecss<MODE>/CUST OM/logs, and then press the Return/Enter key.
The working directory is changed to /usr/ecs<MODE>/CUST OM/logs.

To examine the Update Granule Utility log file, type pg EcDIUpdateGranule.log and

then press the Retur n/Enter key.

Thefirst page of the log file is displayed; additional sequential pages can be displayed
by pressing the Retur n/Enter key at the : prompt. It isalso possible to search
forward by typing /<search item>. For example, to search the log file for reference to
one of the granules updated, type /<granulel D> and then press the Retur n/Enter

key.

Although this procedure is written for the pg command, any UNIX editor or
visualizing command (e.g., Vi, view, more, tail) can be used to review the log.
The log entries have atime and date stamp; about the time that the update was

executed, the log should show entries similar to the following:
814:

2001/ 11/ 29

2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29
2001/ 11/ 29

2001/ 11/ 29

15:

15:
15:
15:
15:
15:
15:
15:
15:
15:
15:
15:
15:

15:

52:

52:
52:
52:
52:
52:
52:
52:
52:
52:
52:
52:
52:

52:

50.

50.
51.
51.
51.
51.
51.
51.
51.
52.
52.
52.
52.

52.

964:
083:
:Granul e 4955
346:
409:
688:
778:
998:
107:
394:
569:
590:

212

608:

Update started.

Granul e 4871
Granul e 4954

G anul e 4956
G anul e 4957
G anul e 4959
Granul e 4961
G anul e 4963
G anul e 4963
G anul e 4964
G anul e 4966

Updat e ended.

updat ed
updat ed
updat ed
updat ed
updat ed
updat ed
updat ed
updat ed
updat ed
updat ed
updat ed

Thi s update took approximately 2 seconds
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If the log indicates errors or warnings, it may be necessary to correct the condition
identified in the entry (e.g., edit the datain the granule list in the input file) and run
the utility again. Specific error entries depend on the error that occurred; examples of

error entriesin the log may be similar to the following:

4959 AST_04 1 0.03962299 Jul 30 2001 12: O0AM Feb 2 1998
11: 59PM 255 2

Warni ng: The new expiration date for the above granule is | ess than
or equal to today’s date.

DATABASE ERROR: Server nessage nunber=120001 severity=16 state=1
I i ne=33 server=f2acg01_srvr procedure=ProcSel ect G Expiration
text =ProcSel ect G Expi rati on: Requested granule id not in database.

2001/ 11/ 29 15:50: 36. 647: Sybase Lookup ==> ERRORS WERE FOUND W TH
GRANULE "4654". (It may not exist or contains the wong fornat).

2001/ 11/ 29 15: 50: 36. 663:

EcDl Updat eGranul e_1.pl aborted due to insufficient processing data:
Al'l the granule triplets had errors.

Table 17.10-33. Use the Update Granule Utility to
Extend the Retention for Selected Science Granules

Step What to Do Action to Take
1 Log in at host for Update Granule Utility enter text; press
Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press
Return/Enter
3 EcDIUpdateGranule.pl <command line parameters> enter text; press
Return/Enter
4 Enter y enter text; press
Return/Enter
5 cd /usr/ecs/<MODE>/CUSTOM/logs enter text; press
Return/Enter
6 pg EcDIUpdateGranule.log (or other editor or visualizing | enter text; press
command Return/Enter
17.10.32 Invoke the Data Pool Cleanup Utility Manually

The Data Pool Cleanup Utility permits ECS Operations Staff to remove expired granules from
the Data Pool disks and inventory. In addition, the Data Pool Cleanup Utility reports (via an
externa utility) to the EOS Clearing House (ECHO) the granules that are to be (or that have
been) deleted.
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The Cleanup Utility may be executed using a -noprompt argument to suppress all confirmations
and warnings normally displayed to standard output.

The Cleanup Utility must be executed on the machine where the granules are located.
Qualification for cleanup is based on two criteria: expiration date/time and retention priority.

To determine whether a granule qualifies for deletion, the utility first compares the granule’'s
expiration date (insert date plus retention period in days specified in the insert subscription) with
a cut-off date/time. If a granule’s expiration date is prior to the cut-off, the granule qualifies as
expired.
* Thedefault cut-off date/timeis set to midnight of the previous day.
» Theoperator is permitted to specify an offset (from the previous midnight) in hoursto
add or subtract hours to determine a cut-off date/time for deletion.
— For example, -offset -5 would delete all granules that had expired as of 7:00 P.M.
yesterday.
Next, the utility compares the granul€e's retention priority with any priority limit the operator has

specified to identify those granules that should be retained in the Data Pool even though their
expiration date has passed.

* Retention priority is an integer from 1 to 255.
— For example, -limit 150 would delete all granules with priority less than or equal
to 150.
* Retention priority for granules already in the Data Pool may be modified using the
granule expiration update script.

The Data Pool Cleanup Utility removes those granules with expiration date prior to the cut-off
date/time and with retention priority less than or equal to the specified limit. If apriority limitis
not specified in command-line input parameters at the time it is invoked, the Cleanup Utility
reads the parameter ‘DEFAULT _LIMIT’ from its configuration file to get a priority limit. If the
operator does not wish to use retention priority as a criterion for deletion, the default limit should
be set to 255. If the operator specifies a theme name, the utility applies the removal criteria only
to those granules associated with the theme.

The Cleanup Utility can alternatively take as input a file listing granuleld’'s for granules to be
deleted. The file can contain single or multiple granuleld’s per line separated by white space.
The —file option may not be used with any other options other than the -nopr ompt option.

Another file option is -geoidfile (e.g., -geoidfile geoid20040304). It specifies the name of afile
containing geoids, which are a combination of science type, ESDT short name and version ID,
and ECS Science Data Server database ID. Granules in the file whose ECS ID match those in
the Data Pool are candidates for Data Pool cleanup if specified by this option. The -geoidfile
option may not be used in conjunction with any other options other than the -noprompt option.
Note that the geoid file can contain science granules as well as non-science granules because the
science data server may delete these types of granules. The input value for this parameter is
logically defined to be the output of any Science Data Server Phase 1 (EcDsBulkDelete.pl)
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granule deletion run. This causes the Data Pool cleanup utility to clean up any Science Data
Server granules found in the geoid input file to be removed from the Data Pool database.

The Cleanup Utility cleans up non-ECS data just as it does ECS data. It can remove granule
cross references associated with a given theme, and aso remove the granules associated with the
theme. The option -themexref specifies a theme for which all cross-references are to be
removed from the Data Pool. The option -theme specifies atheme for which associated granules
areto beremoved. If agranuleisreferenced to more than one theme, the -theme option removes
only the cross-reference to the specified theme, without removing the granule. The theme name
must be enclosed in quotes (e.g., -theme “Ocean Temperatures’ or —themexref “Surface
Reflectance’). The -themexref option cannot be used with any options other than the
-noprompt option.

The -ecsgrandel option indicates that only granules removed in the ECS system from the
Science Data Server inventory are to be removed from the Data Pool if they exist. The option
may not be used in conjunction with any options other than the -noprompt option. No other
cleanup occurs when the -ecsgrandel option is specified.

The -echomode parameter specifies the method by which the Cleanup Utility reports deletion
candidates to ECHO. The -echomode parameter takes one of three values; i.e., predelete, delete
or deleteall.

When predelete is specified, the Cleanup Utility builds the list of items to clean up from the
Data Pool and reports them to ECHO through the ECBmBUIkURL utility. No data is actually
cleaned up from the disks or database inventory using predelete.

When delete is specified as the value for -echomode, the Cleanup Utility deletes al of the data
that was last found during a run with the predelete parameter. The difference is that the
EcBmBuUlkURL utility is not invoked because this run performs the actual cleanup of the
database inventory and disks of what was presumably reported to ECHO during the previous run.

When deleteall is specified as the value for -echomode, the Cleanup Utility builds its list of
items to clean up, actualy cleans them up, and notifies ECHO via the ECBmBUIkURL utility.
The deleteall value does not alow for a time lag between the Cleanup Utility deleting the
granules and ECHO performing its own clean up of URLSs.

The normal sequence for cleanup isto run the Cleanup Utility twice: specifying predelete for the
first run and delete for the second run. Note that an -echomode parameter with avalue of delete
can only be specified by itself because the list of items to delete will have already been
determined by the previous (predelete) run.

If a predelete run is performed, the subsequent run must specify delete in order to perform the
actual deletions. The Cleanup Utility enforces the requirement to avoid operator error. The
predelete/delete run sequence can be viewed as alogical run done in two parts. The values of
predelete and deleteall may be used with each of the other parameters specific to performing
Data Pool Cleanup except themexr ef.
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There are three types of runsthat can be performed with the Cleanup Utility:

* Cleanup only.
« Validation only.
* Cleanup followed by validation.

When involved in “ cleanup” processing, the Cleanup Utility performs the following actions:

* Removes from the Data Pool disks and inventory all Data Pool granules, associated
browse files, and browse links that meet the specified cleanup criteria (provided that
no other granules are cross-referenced to them —i.e., linked by atheme). This occurs
when the -echomode parameter has a value of delete or deleteall. (No actual deletion
occurs during predelete.)

* Removesall recent insert files (with names prefixed with DPRecentl nsert) that are
older than seven days. Therelevant files are found in /datapool/<mode>/user/<fs1>
and /datapool/<mode>/user/<fs1>/<group>/<esdt>.

* Exportsalist of deleted granules for ECHO accessibility by invoking an external
utility (i.e., ECBmBuUlkURL Start) when the Cleanup Utility -echomode parameter has
avalue of either delete or deleteall.

— If there are granules being deleted that qualify for ECHO export, the Cleanup
Utility generates an XML file containing alist of those granules and storesit in
the /datapool/<mode>/user/URL Export directory for files that are ftp pulled and
ftp pushes files when Bulk URL is configured to ftp push the datato ECHO.

— |If the Data Pool Cleanup Utility isrunin -echomode delete, the
EcBmBulkURL Start utility is not called.

* Removesal HEG conversion files associated with the HEG order IDs that have the
status of "DONE" or "FAILED" and atimestamp older than a certain cleanup age.

— TheHEG order IDs are provided in the DICartOrder table and the cleanup ageis
specified by the "HEGCleanupAge" parameter in the DIConfig table of the Data
Pool database.

— TheHEG conversion files for each order ID are stored in the
/datapool/<mode>/user/downloads/<orderl D> directory. (HEG orders and
conversion files are generated when end users request HEG-converted data using
the Data Pool Web Access tool.)

When involved in “validation” processing, the Data Pool Cleanup Utility performs the following
actions:

» Validates the Data Pool inventory and disk content by checking for the existence of
orphans and/or phantoms and either removing them or just logging them depending
on the command line options specified.

Vaidation requires either the —orphan parameter or the -phantom parameter or both. The
-orphan parameter finds'removes data in the Data Pool that is not represented by entries in the
Data Pool inventory. The -phantom parameter finds/removes entries in the Data Pool inventory
that have one or more science or metadata files, or associated browse files, missing from the Data
Pool. To specify just logging of the discrepancies, the operator uses the option -nofix.
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The -maxorphanage validation option specifies the maximum orphan age in days (eg.,
-maxor phanage 5). The value specified must be greater than or equal to three days. The Data
Pool inventory validation function will consider only those files on disk as orphans whose age is
equal to or larger than the maximum orphan age specified. If the parameter is omitted, the
default value specified in the configuration file is used.

The -collgroup validation option limits the Data Pool validation to the specified collection
group(s). Single or multiple collection groups can be specified on the command line. If multiple
collection groups are specified, they must be separated by commas, with the string enclosed in
double quotes (e.g., “MOAT, ASTT”). By default al collection groups in the Data Pool
inventory are included in the validation if the -collgroup option is not specified.

A validation run can be time-consuming and should not be run as often as the cleanup runs,
because it potentially involves the checking of al filesin the entire Data Pool inventory against
those on the Data Pool disk in order to find and remove the discrepancies. It is advised that the
validation function be run using the -collgroup option whenever possible to limit the validation
to alimited number of collection groups.

If the Cleanup Utility is interrupted during execution, upon restart it continues from the point of
interruption. Furthermore, in the interest of low database contention, the Cleanup Utility allows
only oneinstance of itself to execute concurrently.

Table 17.10-34 presents the steps required to invoke the Data Pool Cleanup Utility manually. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Log in at the machine where the Data Pool Cleanup Utility isinstalled (e.g., e0dps01,
g0dps01, 10dps01, n0dps01).
» Note: The operator who is executing the script must have privileges for removing
science, metadata, and browse files from the Data Pool disks.

2 To change to the directory for starting the Data Pool Cleanup Utility, type
cd /usr/ecs’<MODE>/CUST OM/utilities and then press the Retur n/Enter key.
» Theworking directory is changed to /usr/ecss<MODE>/CUST OM/utilities.

NOTE: There are three types of runs that can be performed with the Cleanup Utility; i.e.,
“cleanup only,” “validation only,” or “cleanup followed by validation.”

NOTE: The normal sequence for cleanup is to run the Cleanup Utility twice: specifying
predelete for the first run and delete for the second run. Note that an -echomode
parameter with avalue of delete can only be specified by itself because the list of
items to delete will have already been determined by the previous (predelete) run.

NOTE: If apredeleterunis performed, the subsequent run must specify delete in order to
perform the actual deletions. The Cleanup Utility enforces that requirement to
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avoid operator error. The predelete/delete run sequence can be viewed as a
logical run donein two parts.

To perform a*“cleanup only” run, at the UNIX prompt enter:

EcDICleanupDataPool.pl <MODE> -echomode <echomode> [-noprompt] [-offset
<hours>] [-limit <priority>] [-theme <themeName>]

OR

EcDICleanupDataPool.pl <MODE> -echomode <echomode> [-noprompt] -file
<fileName>

OR

EcDICleanupDataPool.pl <MODE> -echomode <echomode> [-noprompt]
-geoidfile <fileName>

OR

EcDICleanupDataPool.pl <MODE> -echomode <echomode> [-noprompt]
-ecsgrandel

OR

EcDICleanupDataPool.pl <MODE> [-noprompt] -themexref <themeName>

» <echomode> isthe value specified for the ECHO mode. The valueis either
predelete, delete, or deleteall (e.g., -echomode predelete).

* <hours> isthe value of the offset. It can be either a positive number (e.g., -offset 2)
or anegative number (e.g., -offset -5). If the—offset option is not specified, the
Cleanup Utility uses the default value of O (zero).

o <priority> isthe vaue of the priority limit. It isanumber from 1 through 255 (e.g.,
-limit 200). If the—imit option is not specified, the Cleanup Utility uses the default
value specified in the configuration file.

» <themeName> isthe name of atheme to be associated with either the —-theme option
or the -themexr ef option. The name of the theme must be in quotes (e.g., -theme
“Ocean Temperatures’ or —themexref “ Surface Reflectance”).

» <fileName> isthe name of afileto be associated with either the —file option or the
-geoidfile option (e.g., -file clean20040404 or -geoidfile geoid20040304). Thefile
will be read by the Cleanup Utility to determine what granulesto clean up.

» The-ecsgrandel option indicates that only granules removed in the ECS system from
the Science Data Server inventory will be removed from the Data Pool if they exist.
No other cleanup occurs.

* The Cleanup Utility runs and the Cleanup Utility log file EcDICleanup.log records
errors, warnings, and information about utility events.
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To perform a*“validation only” run, at the UNIX prompt enter:

EcDICleanupDataPool.pl <MODE> -orphan | -phantom [-noprompt] [-collgroup

<groupList>] [-maxorphanage <days>] [-nofix]

» For validation either the —or phan parameter or the -phantom parameter or both must
be specified.

* <groupList> isthe name of the collection group(s) to be validated (e.g., “MOAT,
ASTT”). The collection group(s) must be enclosed in quotes and if there are multiple
groups, they must be separated by commas. If the —collgroup option is not specified,
all collection groupsin the Data Pool inventory are included in the validation.

* <days> isthe number of days (at least 3) after which files on the Data Pool disks are
considered orphans if they do not have corresponding entries in the Data Pool
inventory. The default value in the configuration file (e.g., 3) isused if the
-maxor phanage option is not specified.

» The-nofix option prevents reconciling any discrepancies found during validation.
The validation results are logged.

To perform a*“ cleanup followed by validation” run, at the UNIX prompt enter a
command line with valid options from Steps 3 and 4 plus the —cleanvalidate parameter.
* For example:

EcDICleanupDataPool.pl OPS -echomode predelete -offset 5 -limit 200
-orphan -phantom -cleanvalidate

If predelete was specified as the value for the —.echomode parameter in Step 3 or Step 5,
after the Cleanup Utility has run to completion repeat Step 3 (or Step 5) to perform a
cleanup using delete as the value for the —.echomode parameter.

Table 17.10-34. Invoke the Data Pool Cleanup Utility Manually (1 of 2)

Step What to Do Action to Take
1 Log in at host for Data Pool Cleanup Utility enter text; press
Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press
Return/Enter
3 EcDICleanupDataPool.pl <MODE> -echomode enter text; press
<echomode> [ -optionl <valuel>. .. -optionN Return/Enter
<valueN>]

(Options: -noprompt, -limit, -offset, -file, -geoidfile,
-theme, -themexref) (for a “cleanup only” run)

EcDICleanupDataPool.pl <MODE> -echomode enter text; press
<echomode> [ -optionl <valuel>. .. -optionN Return/Enter
<valueN>]

(Options: -noprompt, -orphan, -phantom, -collgroup, -
nofix, -cleanvalidate) (for a “validation only” run)

17-209 611-EMD-001



Table 17.10-34. Invoke the Data Pool Cleanup Utility Manually (2 of 2)

Step What to Do Action to Take
5 EcDICleanupDataPool.pl <MODE> -echomode enter text; press
<echomode> [ -optionl <valuel>. .. -optionN Return/Enter

<valueN>] -cleanvalidate

(Options: -noprompt, -limit, -offset, -file, -geoidfile,
-theme, -themexref, -orphan, -phantom, -collgroup, -
nofix) (for a “cleanup followed by validation” run)

6 Repeat Step 3 (or Step 5) (as necessary)

17.10.33 Establish Data Pool Cleanup to Run with cron

In normal operations, the Cleanup Utility is run once aday as a cron job as a "cleanup only" run
executing in echo mode of predelete. This builds the list of cleanup candidates (based on the
expiration date and retention priority) that are reported to ECHO as those that will be deleted in
the next run of cleanup. Also, the granules that have been entered in the Science Data Server’s
deleted granules table will be reported. On a subsequent run within the same 24-hour period, the
cleanup utility is run in delete mode to perform the actual cleanup processing that was reported
to ECHO in the predelete mode.

Table 17.10-35 presents the steps required to establish Data Pool Cleanup to run with cron. If
you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 Login at an ECS platform using an account with privileges to remove science, metadata,
and browse files from Data Pool disks.

2 To ensure that the crontab command launches the vi editor, type setenv EDITOR vi and
then press the Return/Enter key.
* It may be desirable to include this command in the operator's .cshrc file to set the
crontab editor to vi as part of the environmental settings normally used routinely.

3 Type crontab -e and then press the Return/Enter key.
» The contents of the file are displayed, and the cursor is displayed on the first character
at the upper left corner of thefile. Note: If the operator has no crontab file on the
current platform, this command opens a new one for editing.

4 If necessary, use the down arrow key on the keyboard to move the cursor down to a blank

line.
» Thecursor isdisplayed at the beginning of the selected line.
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Typei to put the vi editor into the insert mode.

The vi editor isin the insert mode, but no feedback is provided.

Type the crontab entry, including the appropriate Cleanup Utility command (as described
in Section 17.10.32, Invoke the Data Pool Cleanup Utility Manually).

For example:

0 1 * * * Jusr/ecOPS/CUSTOM/utilitiedEcDIDataPoolCleanup.pl OPS
-echomode predelete -noprompt

The example would start a predelete cleanup run at 1:00 A.M. every day.

Repeat Step 6 as necessary to enter additional crontab entries, including the appropriate
Cleanup Utility command (e.g., to run adelete cleanup run at 4:00 A.M. every day).

Press the Esc key.

The cursor moves one character to the left and the vi editor isin the command mode.

Type :wq and then press the Return/Enter key.

UNIX displays a message identifying the number of lines and charactersin the
crontab file (stored in the directory /var/spool/cr on/cr ontabs) and then displays the
UNIX prompt.

Table 17.10-35. Establish Data Pool Cleanup to Run with cron

Step What to Do Action to Take
1 Log in at an ECS host using an account with privileges to | enter text; press
remove science, metadata, and browse files from Data Return/Enter
Pool disks
2 setenv EDITOR vi enter text; press
Return/Enter
3 crontab —e enter text; press
Return/Enter
4 If necessary, use down arrow key to move cursor to a press arrow key on keyboard
blank line
5 To put vi editor in insert mode, type | enter text command
6 crontab entry, including the appropriate Cleanup Utility enter text
command, for example:
0 1***/usr/ecs/OPS/CUSTOM/utilities/EcDIData
PoolCleanup.pl OPS -echomode predelete -noprompt
7 Repeat Step 6 (as necessary)
8 To put vi editor in command mode, press Esc key press Esc key on keyboard
9 Exit vi editor with :wq enter text; press
Return/Enter
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17.10.34 Specify Data Pool Access Statistics Rollup Start Time (at 1:00 am) and
DPASU Execution (at 2:00 am), OPS Mode, with cron

The Data Pool Access Statistics Utility (DPASU) parses logs of the Data Pool Web Access
service and the FTP access service and stores the results in tables in the Data Pool database. The
DPASU is a command-line utility that permits an option of entering input parameters. It is
intended to be run with cron to cover an arbitrary 24-hour period starting at a time specified as a
configuration parameter in a configuration file. However, an operator may run the utility from
the command line specifying a start date as an input parameter to cover a period other than the
normal 24-hour period addressed by cron or to cover that normal period if cron failed to process
the logs for that period.

There are two versions of the DPASU, one for each type of log processed. The script named
EcDIRollupWebL ogs.pl processes the Web Access log, its configuration file is
EcDIRollupWebL 0ogs.CFG. The script named EcDIRollupFtpL ogs.pl processes the SY SLOG
with FTP access entries; its configuration file is EcDIRollupFtpLogs.CFG. These scripts
capture data on downloads from the Data Pool, including date and time of access, path and file
name of the file, and size of the file. The captured data are written to a temporary "flat file" -- a
tab-delimited text file -- stored in the directory /I<SECS HOME>/<MODE>/CUSTOM/data/DPL/.
The flat file is then exported to Sybase and stored in atable. The DPASU calls Sybase stored
procedures to generate a separate rollup table, removes the flat file, and enters a record in a
separate table identifying which periods have been rolled up in order to prevent inadvertent
reprocessing of that period.

To prevent potentia table locking, cron runs of the DPASU scripts should be separated so that
they are not both running concurrently (e.g., separate their start times by at least 20 minutes).
Use the following procedure to specify a 1:00 am. start time for the rollup and add a line to the
crontab files to run the DPASU for the OPS mode beginning at 2:00 am. every day with a 20-
minute separation between the scripts.

Table 17.10-36 presents the steps required to specify Data Pool access statistics rollup start time
and DPASU execution with cron. If you are aready familiar with the procedure, you may prefer
to use this quick-step table. If you are new to the system, or have not performed this task
recently, you should use the following detailed procedure:

1 Log in at the host for the DPASU scripts and their configuration files (e.g., e0dps01,
g0dps01, 10dps01, n0dps01).

2 To change to the directory containing the configuration files, type the command
cd /usr/ecsOPS/CUST OM/cfg and then press the Return/Enter key.
» Theworking directory is changed to /usr/ecs OPS/CUST OM/cfg.
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10

To look at the Rollup Start Time specified in the configuration file for
EcDIRollupWebL ogs.pl, type vi EcDIRollupWebL 0ogs.CFG and then press the
Return/Enter key.

* The contents of the file are displayed, and the last line of the file indicates the start

timein format similar to the following:
ROLLUP_START_TI ME=3: 00

» and the cursor is displayed on the first character at the upper left corner of thefile.
» If thestart timeis correct, exit vi by typing :q! and pressing the Return/Enter key;
then go to Step 10. Otherwise, to change the time, execute Steps 4 through 9.

Use the arrow keys on the keyboard to move the cursor down to the line specifying the
ROLLUP_START_TIME and to moveit to the right until it islocated over the first
character in the time value.

* Thecursor is moved to the start time location; the line should ook similar to the

following:
ROLLUP_START_TI ME=R: 00

Type x to delete the number under the cursor.

*  The number is deleted; the line should look similar to the following.
ROLLUP_START_TI ME=JJ00

* Note: If more charactersin the time value are to be changed, you can type x

repeatedly to delete additional characters. For this exercise, you need only delete one
character.

Typei to put the vi editor into the insert mode.
* Thevi editor isin the insert mode, but no feedback is provided.

Type 1.
* Thetyped entry appears to the left of the cursor.

Press the Esc key.
* The cursor moves one character to the left and the vi editor isin the command mode.

Type ZZ (be sure to use upper case).
» Thefileissaved and the UNIX prompt is displayed.

To ensure that the crontab command launches the vi editor, type setenv EDITOR vi and

then press the Return/Enter key.

* It may be desirable to include this command in the operator’s .cshrc file to set the
crontab editor to vi as part of the environmental settings normally used routinely.
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11

12

13

14

15

16

17

18

19

Type crontab -e and then press the Return/Enter key.

» The contents of the file are displayed, and the cursor is displayed on the first character
at the upper left corner of thefile. Note: If the operator has no crontab file on the
current platform, this command opens a new one for editing.

If necessary, use the down arrow key on the keyboard to move the cursor down to a blank
line.

» Thecursor isdisplayed at the beginning of the selected line.

Typei to put the vi editor into the insert mode.
* Thevi editor isin the insert mode, but no feedback is provided.

Type02* * * Jusr/ecs OPS/ICUST OM/utilitiesEcDIRollupWebL ogs.pl OPS
-noprompt.
* Thetyped entry appears to the left of the cursor.

Press the Esc key.
* The cursor moves one character to the left and the vi editor isin the command mode.

Type :wq and then press the Return/Enter key.

* UNIX displays a message identifying the number of lines and charactersin the
crontab file (stored in the directory /var/spool/cr on/cr ontabs) and then displays the
UNIX prompt.

To look at the Rollup Start Time specified in the configuration file for
EcDIRollupFtpLogs.pl, type vi EcDIRollupFtpL ogs.CFG and then press the
Return/Enter key.

» The contents of the file are displayed, and the last line of the file indicates the start

timein format similar to the following:
ROLLUP_START_TI ME=3: 00

» and the cursor is displayed on the first character at the upper left corner of thefile.
» If thestart timeis correct, exit vi by typing :q! and pressing the Return/Enter key;
then go to Step 21. Otherwise, to change the time, execute Step 20.

Repeat Steps 4 through 9 to change the time in EcDIRollupFtpL ogs.CFG.

To ensure that the crontab command launches the vi editor, type setenv EDITOR vi and

then press the Return/Enter key.

* It may be desirable to include this command in the operator’s .cshrc file to set the
crontab editor to vi as part of the environmental settings normally used routinely.
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20

21

22

23

24

25

Type crontab -e and then press the Return/Enter key.

» The contents of the file are displayed, and the cursor is displayed on the first character
at the upper left corner of thefile. Note: If the operator has no crontab file on the
current platform, this command opens a new one for editing.

If necessary, use the down arrow key on the keyboard to move the cursor down to a blank
line.
» Thecursor isdisplayed at the beginning of the selected line.

Typei to put the vi editor into the insert mode.
* Thevi editor isin the insert mode, but no feedback is provided.

Type202* * * Jusr/ecOPS/CUST OM/utilitiesyEcDIRollupFtpL ogs.pl OPS
-noprompt.
* Thetyped entry appears to the left of the cursor.

Press the Esc key.
* The cursor moves one character to the left and the vi editor isin the command mode.

Type :wq and then press the Return/Enter key.

* UNIX displays a message identifying the number of lines and charactersin the
crontab file (stored in the directory /var/spool/cr on/cr ontabs) and then displays the
UNIX prompt.

Table 17.10-36. Specify Data Pool Access Statistics Rollup Start Time

(at 1:00 am) and DPASU Execution (at 2:00 am), OPS Mode, with cron (1 of 2)

Step What to Do Action to Take
1 Log in at the host for the DPASU scripts and their enter text; press
configuration files Return/Enter

2 cd /usr/ecs/OPS/CUSTOM/cfg enter text; press
Return/Enter

3 vi EcDIRollupWebLogs.CFG enter text; press
Return/Enter

4 Move cursor down to line for ROLLUP_START_TIME press keyboard arrow keys

and right until it is over first character in time value

5 To delete the number under the cursor, type x enter text command

6 To put vi editor ininsert mode, type i enter text command

7 1 (for ROLLUP_START_TIME of 1:00 am) enter text

8 To put vi editor in command mode, press Esc key press Esc key on keyboard
9 Y4 enter text command
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Table 17.10-36. Specify Data Pool Access Statistics Rollup Start Time
(at 1:00 am) and DPASU Execution (at 2:00 am), OPS Mode, with cron (2 of 2)

Step What to Do Action to Take
10 setenv EDITOR vi enter text; press
Return/Enter
11 crontab —e enter text; press
Return/Enter
12 If necessary, use down arrow key to move cursor to a press arrow key on keyboard
blank line
13 To put vi editor in insert mode, type i enter text command
14 0 2 *** Jusr/ecs/OPS/CUSTOM/utilities/EcDIRollup enter text
WebLogs.pl OPS —noprompt
15 To put vi editor in command mode, press Esc key press Esc key on keyboard
16 Exit vi editor with :wq enter text; press
Return/Enter
17 vi EcDIRollupFtpLogs.CFG enter text; press
Return/Enter
18 Repeat Steps 4 through 9 to change the time in
EcDIRollupFtpLogs.CFG
19 setenv EDITOR vi enter text; press
Return/Enter
20 crontab —e enter text; press
Return/Enter
21 If necessary, use down arrow key to move cursor to a press arrow key on keyboard
blank line
22 To put vi editor in insert mode, type i enter text command
23 02 *** Jusr/ecs/OPS/CUSTOM/utilities/EcDIRollup enter text
FtpLogs.pl OPS —noprompt
24 To put vi editor in command mode, press Esc key press Esc key on keyboard
25 Exit vi editor with :wq enter text; press
Return/Enter

17.10.35 Specify Data Pool Access Statistics Utility Execution from the

Command Line

Although the Data Pool Access Statistics Utility scripts are intended to be run with cron, if itis
necessary to run them from the command line, it is possible to do so. For example, if cron fails
to complete successfully for any reason, no entry is made into the record table to indicate that a
period was processed. In that event, the statistics can be captured for the missing interval by

running the utility manually.

There are seven command-line parameters for use with the utility scripts:
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*  The <MODE> parameter indicates the mode (must specify avalid directory path) in
which the script isto run; it is mandatory, unlabeled, and must be the first parameter
following the command.

» The-noprompt parameter optionally specifies suppression of output to the screen.

* The-nodelete parameter optionally prevents the flat file from being deleted upon
completion of the run.

» The-flatfile <path/file> parameter optionally provides an aternative path/file name
for the flat file produced by the parser (useful only with the -nodelete option).

» The-ftp <path/file> parameter optionally indicates an alternative ftp log path/file(s)
to be used instead of the configured default path/file (for the EcDIRollupFtpL ogs.pl
script only). Wildcards may be used, but must be escaped (i.e., preceded with a\).

* The-web <path/file> parameter optionally indicates an aternative web log
path/file(s) to be used instead of the configured default path/file (for the
EcDIRollupWebL ogs.pl script only). Wildcards may be used, but must be escaped
(i.e., preceded with a\).

* The-start <date> parameter optionally indicates an aternative start date for the
rollup period, using the format MM/DD, and may be used to process a previously
uncovered period.

With the exception of the mandatory <MODE> parameter, which must appear first after the
command, the other parameters may be used in various orders and combinations. For example,
to run without screen prompts or information, starting from December 22, and to retain the flat
file, the command for accumulating statistics on web access should be entered as follows:

EcDIRollupWebL ogs.pl OPS -noprompt -nodelete -start 12/22.

To run with normal screen information display, starting from February 15, but using an
alternative file with wildcards for the web log, the command should be similar to the following:

EcDIRollupWebL ogs.pl OPS - start 2/15 -web /usr/var/\* .|og.

Table 17.10-37 presents the steps required to specify Data Pool Access Statistics Utility
execution from the command line, with normal screen information display. If you are already
familiar with the procedure, you may prefer to use this quick-step table. If you are new to the
system, or have not performed this task recently, you should use the following detailed
procedure:

1 Log in at the host for the DPASU scripts and their configuration files (e.g., e0dps01,
g0dps01, 10dps01, n0dps01).

2 To change directory to the directory containing the scripts, type the command

cd /usr/ec<MODE>/CUST OM/utilities and then press the Return/Enter key.
» Theworking directory is changed to /usr/ecs’<MODE>/CUST OM/utilities.
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3 Type EcDIRollupWebL ogs.pl <MODE> and then press the Return/Enter key.

The utility runs and displays information to the screen as it executes, in form similar

to the following:
A Synergy |1/ Data Pool product

/

BYRRYE
| 7/
|
|

|

| O

| |
| ___/]_]
Dat a Poo

e

OV V| |||
I A
|l 1\
Access Statistics Uility

)
Connecting to database. ..

The DPASU wi || exanmine the logs for access entries between the
foll owi ng timnes:

Mont h Day Hour M nut e
START: 11 26 03 00
END: 11 27 02 59

Checking for already covered rollup periods...

File list:

[ usr/ ecs/ OPS/ COTS/ ww/ ns- hone/ ww/ | ogs/ access
Processing Wb | ogs. ..

No access entries found in any of the Wb | ogs

C eaning up table "D WebAccessLog"... K
Exporting flat file to Sybase... XK

No access data was available to roll up.
DPASU wi | I skip this step.

Rol I up successful!
Removing flat file... K
Gacefully exiting...

4 Type EcDIRollupFtpL ogs.pl <MODE> and then press the Retur n/Enter key.

The utility runs and displays information to the screen as it executes, in form similar

to the following:
A Synergy |1/ Data Pool product

|
0 |
| | _
| |_ \__/
Access Statistics Uility

v
oV
U
o
o ——

Connecting to database. ..
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The DPASU wi Il examne the logs for access entries between the
foll owi ng tines:

Mont h Day Hour M nut e
START: 11 26 03 00
END: 11 27 02 59

Checking for already covered rollup periods...

File list:

/var/ adm SYSLOG

Processing FTP | ogs. ..

No access entries found in any of the FTP | ogs

C eaning up table "D FtpAccessLog"... K
Exporting flat file to Sybase... X

No access data was available to roll up.
DPASU wi I | skip this step.

Rol | up successful!
Removing flat file... X
Gracefully exiting...

Table 17.10-37. Specify Data Pool Access Statistics Utility Execution
from the Command Line

Step What to Do Action to Take
1 Log in at the host for the DPASU scripts and their enter text; press
configuration file Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press
Return/Enter
3 EcDIRollupWebLogs.pl <MODE> enter text; press
(Results in normal information display; options include: Return/Enter

-noprompt, -nodelete, -flatfile <path/file>, -web
<path/file> -start <date>)

4 EcDIRollupFtpLogs.pl <MODE> enter text; press
(Results in normal information display; options include: Return/Enter
-noprompt, -nodelete, -flatfile <path/file>, -ftp
<path/file> -start <date>)

17.10.36 Archive Access Statistics Using the Data Pool Archive Access
Statistics Data Utility

The three remaining utilities are shell scripts for archiving, deleting, and restoring information in
database tables populated by the DPASU. The Data Pool Archive Access Statistics Data
Utility is run from the command line as needed or desirable to connect to the Data Pool database
and write granule access data for a specified time range from the DIGranuleAccess,
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DIGranuleSubscription, and DIAccessRollup tables to an ASCII file. Once this is done, the
operator can run the Data Pool Delete Access Statistics Data Utility from the command line to
delete the archived data from the Data Pool database. If it is desirable to restore deleted data to
the database, the Data Pool Restore Access Statistics Data Utility can be run from the
command line to restore the data.

Table 17.10-38 presents the steps required to archive access statistics using the Data Pool
Archive Access Statistics Data Utility. If you are already familiar with the procedure, you may
prefer to use this quick-step table. If you are new to the system, or have not performed this task
recently, you should use the following detailed procedure:

1

2

Log in at the host for the Data Pool database (e.g., e0acgl1, g0acg01, 10acg02, nOacg0l).

To change directory to the directory containing the Data Pool Archive Access Statistics
Data Utility, type cd /usr/ec<MODE>/CUSTOM/dbms/DPL and then press the
Return/Enter key.

» Theworking directory is changed to cd /usr/ec§<MODE>/CUSTOM/dbms/DPL .

Type DIDbAr chiveAccessStat <MODE> <STARTDATE> <STOPDATE>
<ARCHIVEDIR> <USERNAME> <SERVER> <DBNAME> and then press the
Return/Enter key.

* Note: <MODE> isthe modein which the utility is being executed (e.g., OPS, TS1,
TS2). <STARTDATE> isthe start date time range, in format yyyymmdd, for the data
to be archived. <STOPDATE> isthe stop date time range, in format yyyymmdd, for
the datato be archived. <ARCHIVEDIR> isthe absolute path where the generated
ASCII filesareto be stored. <USERNAME> isthe Sybase login name. <SERVER>
is the Sybase Server for the Data Pool database (e.g., €0acgll srvr, g0acg0l_srvr,
|0acg02_srvr, n0acg01_srvr). <DBNAME> isthe name of the Data Pool database
(e.g., DataPool_OPS).

* Thescript displays a prompt for entry of the password for the Sybase login.

Type <password> and then press the Return/Enter key (Note: This may require input
from the Database Administrator).
* Thescript runs and and the Archive Access Statistics Utility log file
DIDbAr chiveAccessStat.log records errors, warnings, and information about utility
events.
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Table 17.10-38. Archive Access Statistics Using the
Data Pool Archive Access Statistics Data Utility

Step What to Do Action to Take
1 Log in at the host for the Data Pool database enter text; press
Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/dbms/DPL enter text; press
Return/Enter
3 DIDbArchiveAccessStat <MODE> <STARTDATE> enter text; press
<STOPDATE> <ARCHIVEDIR> <USERNAME> Return/Enter
<SERVER> <DBNAME>
4 <password> (from Database Administrator) enter text; press
Return/Enter

17.10.37 Delete Access Statistics Using the Data Pool Delete Access Statistics
Data Utility

Table 17.10-39 presents the steps required to delete access statistics using the Data Pool Delete
Access Statistics Data Utility. If you are already familiar with the procedure, you may prefer to
use this quick-step table. If you are new to the system, or have not performed this task recently,
you should use the following detailed procedure:

1 Log in at the host for the Data Pool database (e.g., e0acgl1, g0acg01, 10acg02, nOacg0l).

2 To change directory to the directory containing the Data Pool Delete Access Statistics
Data Utility, type cd /usr/ec<MODE>/CUSTOM/dbms/DPL and then press the
Return/Enter key.

* Theworking directory is changed to /usr/ecs’<MODE>/CUSTOM/dbms/DPL.

3 Type DIDbDeleteAccessStat <MODE> <STARTDATE> <STOPDATE>

<USERNAME> <SERVER> <DBNAME> and then press the Return/Enter key.

* Note: <MODE> isthe mode in which the utility is being executed (e.g., OPS, TSI,
TS2). <STARTDATE> isthe start date time range, in format yyyymmdd, for the data
to be deleted. <STOPDATE> isthe stop date time range, in format yyyymmdd, for
the data to be deleted. <USERNAME> isthe Sybase login name. <SERVER> isthe
Sybase Server for the Data Pool database (e.g., €0acgll srvr, gO0acg0l srvr,
|0acg02_srvr, n0acg01_srvr). <DBNAME> isthe name of the Data Pool database
(e.g., DataPool_OPS).

* Thescript displays a prompt for entry of the password for the Sybase login.
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4 Type <password> and then press the Return/Enter key (Note: This may require input
from the Database Administrator).
* Thescript runs and the Delete Access Statistics Utility log file
DIDbDeleteAccessStat.log records errors, warnings, and information about utility
events.

Table 17.10-39. Delete Access Statistics Using the
Data Pool Delete Access Statistics Data Utility

Step What to Do Action to Take
1 Log in at the host for the Data Pool database enter text; press
Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/dbms/DPL enter text; press
Return/Enter
3 DIDbDeleteAccessStat <MODE> <STARTDATE> enter text; press
<STOPDATE> <ARCHIVEDIR> <USERNAME> Return/Enter
<SERVER> <DBNAME>
4 <password> (from Database Administrator) enter text; press
Return/Enter

17.10.38 Restore Access Statistics Using the Data Pool Restore Access
Statistics Data Utility

Table 17.10-40 presents the steps required to restore access statistics using the Data Pool Restore
Access Statistics Data Utility. If you are already familiar with the procedure, you may prefer to
use this quick-step table. If you are new to the system, or have not performed this task recently,
you should use the following detailed procedure:

1 Log in at the host for the Data Pool database (e.g., e0acgl1, g0acg01, 10acg02, nOacg0l).

2 To change directory to the directory containing the Data Pool Restore Access Statistics
Data Utility, type cd /usr/ec<MODE>/CUSTOM/dbms/DPL and then press the
Return/Enter key.

* Theworking directory is changed to /usr/ecs’<MODE>/CUSTOM/dbms/DPL.

3 Type DIDbRestor eAccessStat <MODE> <STARTDATE> <STOPDATE>
<ARCHIVEDIR> <USERNAME> <SERVER> <DBNAME> and then press the
Return/Enter key.

* Note: <MODE> isthe modein which the utility is being executed (e.g., OPS, TS1,
TS2). <STARTDATE> isthe start date time range, in format yyyymmdd, for the data
to berestored. <STOPDATE> isthe stop date time range, in format yyyymmdd, for
the datato be restored. <ARCHIVEDIR> isthe absolute path of the storage location
for the ASCII files containing the data to be restored. <USERNAME> isthe Sybase

17-222 611-EMD-001



login name. <SERVER> isthe Sybase Server for the Data Pool database (e.g.,
e0acgll_srvr, g0acgOl1_srvr, |I0acg02_srvr, nOacg0l_srvr). <DBNAME> isthe name
of the Data Pool database (e.g., DataPool _OPS).

* Thescript displays a prompt for entry of the password for the Sybase login.

4 Type <password> and then press the Return/Enter key (Note: This may require input
from the Database Administrator).
* The script runs and the Archive Access Statistics Utility log file
DIDbRestor eAccessStat.log records errors, warnings, and information about utility
events.

Table 17.10-40. Restore Access Statistics Using the
Data Pool Restore Access Statistics Data Utility

Step What to Do Action to Take
1 Log in at the host for the Data Pool database enter text; press
Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/dbms/DPL enter text; press
Return/Enter
3 DIDbRestoreAccessStat <MODE> <STARTDATE> enter text; press
<STOPDATE> <ARCHIVEDIR> <USERNAME> Return/Enter
<SERVER> <DBNAME>
4 <password> (from Database Administrator) enter text; press
Return/Enter

17.10.39 Use the Batch Insert Utility for Batch Insert of Data into the Data Pool

The Batch Insert Utility allows operators to specify Data Pool insert for granules residing in the
ECS archive, as well as data from outside ECS (non-ECS granules). The utility queues the
granules up for dispatch by the Data Pool Action Dispatcher (DPAD) for insertion by the Data
Pool Insert Utility (DPIU). It accepts either alist of ECS granule identifiers or alist of non-ECS
names, the list can be provided either as an input file or as standard input. A label identifying a
batch of granules is specified as a command-line parameter, using the option -label, so that
operators can monitor a batch with the DPM GUI.

Granules to be inserted can aso be linked to atheme, using the option -theme. In fact, the Batch
Insert Utility can also be used with that option to link granules aready present in the Data Pool
to atheme, or to additional themes. However, it is important to note that if the granules were
originally inserted into the Data Pool using the Batch Insert Utility, you must use a different
batch label when linking the granules to the theme than was used for the original insert. Thisis
necessary because the Batch Insert Utility is designed to regject inserts that are in a batch with a
label identical to one for which granules are already being processed. So, even if the batch has
been inserted, if the inserts are still in the queue (e.g., with a status of Completed), you cannot
run another batch with the same label to link them to a theme.
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Table 17.10-41 presents the steps required to use the Batch Insert Utility for Batch Insert of Data
into the Data Pool. If you are already familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:

1

Log in at the machine where the Data Pool Batch Insert Utility isinstalled (e.g., e0dps01,
g0dps01, 10dps01, n0dps0l).
Note: Thelogin must be as either cmshared or allmode to ensure correct permissions.

To changeto the directory for starting the Batch Insert Utility, type
cd /usr/ecss<MODE>/CUST OM/utilities and then press the Retur n/Enter key.

The working directory is changed to /usr/ecs<MODE>/CUST OM/utilities.

At the UNIX prompt, enter the command to start the Batch Insert Utility, in the form
EcDIBatchlnsert.pl <MODE> -ecs | -nonecs| -file <pathname> ] [options].

Note: The following are examples of valid command-line entries for initiating the
Batch Insert Utility:

EcDIBatchlnsert.pl <MODE> -ecs -file /home/cmshar ed/<filename> (to add
actionsto the action insert queue for all ECS granules specified by granule IDs in
the specified file. Because the command does not specify a-label parameter, the
label isformed from the first 16 characters of the input file name).
EcDIBatchlnsert.pl <MODE> -nonecs -file /home/cmshar ed/<filename> -
label Chig_volcano -theme “ Chiginagak Volcano 2002” (to add actions to the
insert action queue for all non-ECS granules specified by XML pathnamesin the
specified input file, with all granules linked with the theme name “ Chiginagak
Volcano 2002” in the Data Pool database). Note: The theme name must already
be in the Data Pool database in the DIThemes table; if necessary, use the DPM
GUI Manage Themes tab to define the theme before running the batch insert.
Note: You can use Batch Insert with the -theme option to link granules already
in the Data Pool to atheme, but if the granules were originally inserted using the
Batch Insert Utility, you must use a different batch label than was used for the
origina insert; otherwise, the insert of the theme links may be rejected.
EcDIBatchlnsert.pl <MODE> -ecs -file /home/cmshar ed/<filename> -mdonly
(to add actions to the action insert queue for all ECS granules specified by granule
IDsin the specified file, but insert metadata only. Because the command does not
specify a-label parameter, the label isformed from the first 16 characters of the
input file name).

EcDIBatchlnsert.pl <MODE> -ecs -file /home/cmshar ed/<filename>
-rpriority 255 (to add actions to the action insert queue for all ECS granules
specified by granule IDsin the specified file, and to set their retention priority to
255. Because the command does not specify a-label parameter, the label is
formed from the first 16 characters of the input file name).
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— EcDIBatchlnsert.pl <MODE> -ecs -file /home/cmshar ed/<filename>
-rpriority 255 -rperiod 10 -dpriority 5 to add actions to the action insert queue
for al ECS granules specified by granule IDs in the specified file, and to set their
retention priority to 255 and their retention period to 10 days, with dispatch
priority set to 5. Because the command does not specify a-label parameter, the
label isformed from the first 16 characters of the input file name).

» TheBatch Insert Utility runs and events and errors are recorded in the Batch Insert

Utility log file EcDIBatchl nsert.log.

Table 17.10-41. Use the Batch Insert Utility for Batch Insert of Data
into the Data Pool

Step What to Do Action to Take
1 Log in at the host for EcDIBatchinsert.pl enter text; press
Return/Enter
2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text; press
Return/Enter
3 EcDIBatchinsert.pl <MODE> -ecs | -nonecs [ -file enter text; press
<pathname>] [options] Return/Enter

17.10.40 Launch the DataPool Order Status & Control GUI

The DataPool Order Status & Control application is a set of HTML pages that alows the
operator to view the status of orders and order items for Data Pool orders (i.e., orders placed
using the Data Pool Web Access GUI Shopping Cart order capability or the single granule
converter dialog). It also allows the operator to control key aspects of the order process such as
the queue control. The application is split into four functional areas. Queue Control, Orders,
Order Items, and Help. Each page of the DataPool Order Status & Control application provides
access to these four functions through links at the top of the page. The help function is the
primary source of information in this section of the Archive Procedures and is therefore not
addressed separately.

Table 17.10-42 presents the steps required to launch the DataPool Order Status & Control GUI.
If you are already familiar with the procedure, you may prefer to use this quick-step table. If you
are new to the system, or have not performed this task recently, you should use the following
detailed procedure:

1 At the UNIX command shell prompt, type setenv DISPLAY clientname: 0.0 and then
press the Return/Enter key.

* For clientname, use either the local terminal/workstation | P address or its machine
name.
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Start the log-in to a Netscape host by typing /tools/bin/ssh hostname (e.g., g0ins02,
e0ins02, 10ins02, n0ins02) at the UNIX command shell prompt, and press the
Return/Enter key.

» If you receive the message, Host key not found from thelist of known hosts. Are
you sure you want to continue connecting (yes/no)? typeyes (“y” aone does not
work).

» If you have previously set up a secure shell passphrase and executed sshremote, a
prompt to Enter passphrase for RSA key '<user @ ocalhost>" appears; continue
with Step 3.

» If you have not previously set up a secure shell passphrase; go to Step 4.

If aprompt to Enter passphrase for RSA key '<user @ ocalhost>" appears, type your
Passphrase and then press the Return/Enter key. Goto Step 5.

At the <user @remotehost>'s password: prompt, type your Password and then press the
Return/Enter key.
* Youarelogged in and a UNIX command shell prompt is displayed.

Type netscape and then press the Return/Enter key.
* The Netscape web browser is displayed.

Click in the Netsite: field.
» Thefield is highlighted.

Type the Universal Resource Locator (URL) for the DataPool Order Status & Control

GUI and then press the Return/Enter key.

* The DataPool Order Status & Control GUI Orders pageis displayed, offering links
to access Data Pool order status and control functions (Queue Control, Orders,
Order Items, and Help) and atable of information on orders currently in the order
queue.

Table 17.10-42. Launch the DataPool Order Status & Control GUI

Step What to Do Action to Take

1 setenv DISPLAY clientname:0.0 enter text; press Return/Enter
2 ftools/bin/ssh hostname enter text; press Return/Enter
3 Passphrase (or Step 4) enter text; press Return/Enter
4 Password enter text; press Return/Enter
5 Netscape enter text; press Return/Enter
6 Move cursor to Netsite: field single-click

7 http://[<URL> enter text; press Return/Enter
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17.10.41 Use the DataPool Order Status & Control GUI to Review Orders and
Order Items

Table 17.10-43 presents the steps required to use the DataPool Order Status & Control GUI to
review orders and associated order items. |If you are aready familiar with the procedure, you
may prefer to use this quick-step table. If you are new to the system, or have not performed this
task recently, you should use the following detailed procedure:

1

Launch the DataPool Order Status & Control GUI (refer to Section 17.10.40, Launch the

DataPool Order Status& Control GUI).

* The DataPool Order Status & Control GUI Orders pageis displayed, offering links
to access Data Pool order status and control functions (Queue Control, Orders,
Order Items, and Help) as well as atable of information on orders currently in the
order queue.

* You can observe an order of interest by locating it in the Order 1D column, scrolling
If necessary.

» Filtering and sorting capabilities are available through controls in the table header and
footer.

It may be useful to filter thelist. For example, if you receive notice that an order failed
and you want to restrict the listed orders to display only those that have failed and for
which notice has been sent to you, click on the pull-down arrow at the end of the By
Statusfield, select FAILOPERN, and then click on the Do Filtering button.

» Thetabledisplaysonly failed orders for which a notice has been sent to the operator.

It may be helpful to sort the list, using the column-heading links. For example, if the

window displays many failed orders and you are looking for afailed order from a specific

user, click on the User_Name link at the top of the column listing user names.

» Thelisted orders are sorted by user name, permitting the operator to see all the failed
orders from the user of interest in a single contiguous block.

If desired, inthe Order_1D column click on the magnifier icon (=) for the order of
interest to obtain the Order Details Viewer.

* TheOrder Details Viewer is displayed with additional details concerning the order
of interest.

To closethe Order Details Viewer, click on thefolder icon ( & ) in the viewer.
* TheOrder Details Viewer is closed.

To check the status of itemsin the order of interest, click on theorder 1D link in the
Order ID column.

* Thesystem displaysthe Order Items page with the Items table listing the itemsin
the order for which the Order 1D was clicked.
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» For each listed item, the Itemstable showsthe Item_1D, Status, any Error Code,
the Granule_ID, the Input_File, and the Order_1D.

7 If desired, click on the magnifier icon (&) to obtain the Order Item Details Viewer.
* TheOrder Item Details Viewer is displayed with additional details concerning the
selected order item.

8 To closethe Order Item Details Viewer, click on the folder icon ( & ) in the viewer.

e TheOrder Item Details Viewer is closed.

Table 17.10-43. Use the DataPool Order Status & Control GUI to
Review Orders and Order Items

Step What to Do Action to Take
1 Launch the DataPool Order Status & Control GUI Use procedure in Section
17.10.40
2 To filter the list, use pull-down arrow to select filter category | clicks
and activate Do Filtering button
3 To sort the list, activate the link at top of column single-click
4 To view details of an order, activate its magnifier icon (&) single-click
5 To close order details viewer, activate folder icon ( &) single-click
6 To view items of an order, activate its order ID link single-click
7 To view the details of an item, activate its magnifier single-click
icon (%)
8 To close item details viewer, activate folder icon (&) single-click

17.10.42 Intervene in a Failed Data Pool Order Susceptible to Operator
Intervention

The DataPool Order Status & Control GUI provides icons permitting the operator to take action
on orders and/or order items that have failed in a way that may allow an operator intervention to
reprocessing of the items that failed. The system is designed to send the operator an e-mail
notification of the necessity for intervention. The operator may intervene to re-try the order or
order items, or may choose to mark the order in question as complete, which results in the order
being placed in one of the following states:

* DONE - some items are successfully completed and any failed items are |eft in the
failed state.
* FAILED —all itemswerefailed and are left in the failed state.

Table 17.10-44 presents the steps required to intervene in a failed data pool order susceptible to
operator intervention. If you are already familiar with the procedure, you may prefer to use this
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the following detailed procedure:
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Launch the DataPool Order Status & Control GUI (refer to Section 17.10.40, Launch the

DataPool Order Status& Control GUI).

* The DataPool Order Status & Control GUI Orders pageis displayed, offering links
to access Data Pool order status and control functions (Queue Control, Orders,
Order Items, and Help) as well as atable of information on orders currently in the
order queue.

* You can observer an order of interest by locating it in the Order ID column, scrolling
If necessary.

» Filtering and sorting capabilities are available through controls in the table header and
footer.

Locate the order of interest (e.g., an order for which you receive e-mail notification of

failure that may permit intervention to recover).

» See Section 17.10.41 Use the DataPool Order Status & Control GUI to Review
Ordersand Order Items, Steps 2 and 3).

* The Status column for afailed order of which the operator is notified indicates
FAILOPERN and also containstwo icon links: retry (€2 ) and "mark as complete"

(2).

If desirable, review detailed information on the order and its order items (see the Section
17.10.41, Use the DataPool Order Status & Control GUI to Review Ordersand
Order Items, Steps 4 through 8).

Toretry afalled order, click on theretry icon ().

* A retry confirmation message asks Y ou have opted toretry an order. Thiswill
automatically retry all of thefailed itemswithin the order if thereareany. Are
you sure you want to do this? and offers Yesand No buttons.

Click on the Yes button in the retry confirmation message.
» A confirmation message indicates Your request has been submitted. Pleasereload
the corresponding page. and offers a Reload button.

Click on the Reload button in the confirmation message.

* OntheOrders page, the Status of the order isshown asENTERED.

e OntheOrder Items page, the Status of the itemsin the order should be NUL L
(entered but not yet being processed) or PROCESSING.

To mark afailed order as complete, click on the “Mark as Complete”’ icon (& ).

* A “Mark as Complete’ confirmation message asks Y ou have opted to completethis
order despiteitsfailurestatus. Thismeansthat at least some granulesin this
order will not be delivered to the user asrequested. Marking thisorder for
completion meansthat it will never beableto beretried (at least from this user
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interface). Notethat the user e-mail notice will automatically be sent at this

point. If you wish to enter comments FOR THE USER regarding thisorder,
please enter them below. (A text entry box is provided for the entry.) Change

order status and send e-mail? The message then offers Yesand No buttons.

8 Click on the Yes button in the “Mark as Complete” confirmation message.
» A confirmation message indicates Your request has been submitted. Pleasereload
the corresponding page. and offers a Reload button.

9 Click on the Reload button in the confirmation message.
* Onthe Orders page, the Status of the order is shown as DONE.
*  OntheOrder Items page, the Status of the itemsin the order is shown as FAILED.

Table 17.10-44. Intervene in a Failed Data Pool Order Susceptible
to Operator Intervention

Step What to Do Action to Take
1 Launch the DataPool Order Status & Control GUI Use procedure in Section
17.10.40
2 Locate the order of interest Use Steps 2 and 3 of
procedure in Section
17.10.41
3 If desirable, review details of the order and its items Use Steps 4 through 8 of
procedure in Section
17.10.41
4 To retry a failed order order, activate its retry icon (€2 ) single-click
5 Activate the Yes button in the retry confirmation single-click
6 Activate the Reload button in the confirmation message single-click
7 To mark a failed order as complete, activate its “Mark as single-click
Complete” icon (&)
8 Activate the Yes button in the “Mark as Complete” single-click
confirmation
9 Activate the Reload button in the confirmation message single-click

17.10.43 Use DataPool Order Status & Control GUI to Manage HEG Converter
Front End Server

The DataPool Order Status & Control GUI Queue Control function provides a means for
starting and stopping the HEG Front End Server (there is also a script named
EcDIHEGFrontEndControl on the Data Pool host that provides an aternative method of
starting and stopping the HEG Front End). The Queue Control function of the GUI also permits
an operator to set the HEG Front End Processing State to process orders in the converter order
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gueue or not, and to set limits on the maximum number of HEG Converter processes and the
maximum number of ordersin the Order Queue.

Table 17.10-45 presents the steps required to use the DataPool Order Status & Control GUI to
Manage the HEG Converter Front End Server. If you are already familiar with the procedure,
you may prefer to use this quick-step table. If you are new to the system, or have not performed
this task recently, you should use the following detailed procedure:

1

Launch the DataPool Order Status & Control GUI (refer to Section 17.10.40, Launch the

DataPool Order Status& Control GUI).

* The DataPool Order Status & Control GUI Orders pageis displayed, offering links
to access Data Pool order status and control functions (Queue Control, Orders,
Order Items, and Help) as well as atable of information on orders currently in the
order queue.

Click on the Queue Control link near the top of the display.
* TheProcessing and Queue Status page is displayed.

To check the status of the HEG Front End Processing Server, observe the HEG Front
End Processing Server line on the display.
» The appearance of the line provides indication of the status, as follows:
- If the server is up, the line indicates UP and there are two control buttons one
labeled Exit Gracefully and one labeled Exit Immediately (No Cleanup).
— If the server isdown, the line indicates DOWN and there is one control button
labeled Start Up.
» If the server isdown and you wish to start it, go to Step 6.
» If theserver isup and you wish to stop it, go to Step 4 (graceful exit) or 5 (immediate
exit); otherwise continue with Step 7.

To stop the server gracefully, click on the Exit Gracefully button.

» The server does not begin any new processes and, after the server completes ongoing
converter processes and exits, the HEG Front End Processing Server line on the
display indicates DOWN and offers a Start Up button.

To stop the server immediately, click on the Exit Immediately (No Cleanup) button.

» All ongoing converter processes are killed and the server exits immediately; the HEG
Front End Processing Server line on the display indicates DOWN and offersa
Start Up button.

To start the server, click on the Start Up button.

* Theserver starts; the HEG Front End Processing Server line on the display
indicates Up and offers an Exit Gracefully button and an Exit |mmediately (No
Cleanup) button.
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If you wish to change the other parameters available on the Processing and Queue
Status page, enter the new value in the input field, using the appropriate editing method:
To changethe HEG Front End Processing State, click on the pull-down arrow at
the end of the field and select the desired state (Process ordersin the order queueor

STOP processing ordersin the order queue).

To change the value for the Maximum number of HEG Converter Processes or
Maximum Order Queue Size, click at the end of the field and either use the
Backspace key to delete the current value or use the mouse with the primary key held
down to drag the cursor and highlight the current value. Then type the desired new

value.
The field(s) display the desired new value(s).

Click on the Apply Changes button.
The screen is refreshed with the new value(s) implemented.

The Reset button may be used to clear the form values.

Table 17.10-45. Use DataPool Order Status & Control GUI to Manage the
HEG Converter Front End Server

Step What to Do Action to Take
1 Launch the DataPool Order Status & Control GUI Use procedure in Section
17.10.40

2 Activate the Queue Control link single-click

3 To check the status of the HEG Front End Processing read text; observe
Server, note the indications on the HEG Front End button(s)
Processing Server line on the display

4 To stop the server gracefully, activate the Exit Gracefully single-click
button

5 To stop the server immediately, activate the Exit single-click
Immediately (No Cleanup) button

6 To start the server, activate the Start Up button single-click

7 To change other parameter(s), enter new value(s) in the click(s); enter text
input field(s)

8 Activate the Apply Changes button single-click
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18. Data Distribution

18.1 Data Distribution Process

Data Distribution is a process of retrieving archived data and providing the data to requestersin
response to the orders they submit or subscriptions they have entered into the system. The
requesters may be classified in either of the following two categories:

» Externa to ECS.

— For example, scientists at Science Computing Facilities (SCFs) may have
standing orders for the data products that are processed using their science
software.

* Interna to ECS.

— For example, the Data Processing Subsystem depends on Data Distribution to
distribute copies of archived science software and input datain support of data
processing.

Data retrieved from the archives can be distributed to requesters using any of the following three
general methods:

e Electronic pull.
» Electronic push.
* Hard (physical) media distribution on disks or tape cartridges.

Hard (physical) media distribution is accomplished through the Product Distribution System
(PDS), which supports the distribution of data on the following types of media

e 8mm tape cartridges.

» Digital Linear Tape (DLT).

e Compact disk (CD).

* DVD (formerly “digital video disk” or “digital versatile disk” now referred to as just
"DVD").

The method of data distribution is dictated by the nature of the data distribution request. (The
requester specifies the distribution method when ordering or subscribing to the data.)

Data Distribution includes three genera types of activities; i.e.,, Data Distribution (DDIST)
operations, Product Distribution System (PDS) operations, and Order Manager (OM) operations.
The Distributed Active Archive Center (DAAC) Distribution Technicians use the Data
Distribution Operator graphical user interface (GUI) within the Data Server Subsystem to
perform DDIST operations (i.e., electronic push or pull). They use Product Distribution System
(PDS) tools to perform hard (physical) media operations (i.e., to distribute data on disks or tape
cartridges). They use the OM GUI in the Order Manager Subsystem (OMS) to manage orders.
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Subsequent sections related to Data Distribution address the following topics:

e Section 18.2 An overview of the process for processing distribution requests
through DDIST and step-by-step procedures for monitoring and controlling
distribution requests.

e Section 18.3 An overview of the process for performing storage management
server operations and step-by-step procedures for monitoring storage management
server operations.

» Section 18.4 An overview of the process and step-by-step procedures for tuning
DDIST system parameters related to DDIST operations.

e Section 18.5 An overview of the process and step-by-step procedures for
monitoring/controlling Order Manager operations.

e Section 18.6 An overview of the process and step-by-step procedures for
troubleshooting DDIST and Order Manager GUI problems.

» Section 18.7 An overview of the process and step-by-step procedures for
starting up PDS.

» Section 18.8 An overview of the process and step-by-step procedures for
shutting down PDS.

e Section 18.9 An overview of the process for product processing using PDS and
step-by-step procedures for monitoring and controlling product processing using
PDS.

e Section 18.10 An overview of the process for order processing using the Product
Distribution System Interface Server (PDSIS) Operator Interface (Ol) and step-by-
step procedures for monitoring and controlling order processing using the PDSIS Ol.

» Section 18.11 An overview of the process and step-by-step procedures for
troubleshooting PDS problems.

18.2 Processing Distribution Requests through DDIST

The Distribution Technicians use the Data Distribution Operator GUI and the Storage
Management Control GUI to monitor and control the retrieval of data from the archives and
distribution to requesters using either of the following methods:

» Electronic pull.
» Electronic push.

The method of data distribution is dictated by the nature of the data distribution request. (The
regquester specifies the distribution method when ordering or subscribing to the data.)

If the requester specifies distribution in the electronic “pull” mode, data are retrieved from the
archive and placed in the “pull area’” on the data server staging disk. The requester is notified
that the data are available for retrieval from that particular location for a set period of time. The
requester initiates a file transfer procedure (ftp “get”) to move the data electronically (over a
communications network) to the requester’ s own system.

In response to a request for distribution in the electronic “push” mode, data are retrieved from
the archive and placed on a data server staging disk. Then the retrieved data on the staging disk
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are transferred electronicaly (via ftp “put”) to the requester's designated storage location
(specified in the distribution request) under the control of the data server. The requester is
notified when the data push has been completed.

Each procedure outlined has an Activity Checklist table that provides an overview of the task to
be completed. The outline of the Activity Checklist isasfollows:

Column one - Order shows the order in which tasks could be accomplished.
Column two - Role lists the Role/Manager/Operator responsible for performing the task.
Column three -Task provides a brief explanation of the task.

Column four - Section provides the Procedure (P) section number or Instruction (I) section
number where details for performing the task can be found.

Column five - Complete? is used as a checklist to keep track of which task steps have been
compl eted.

Table 18.2-1, below, provides an Activity Checklist for monitoring/controlling distribution
requests.

Table 18.2-1. Monitoring/Controlling Distribution Requests - Activity Checklist

Order Role Task Section Complete?

1 Distribution Log in to ECS Hosts (P)18.2.1
Technician

2 Distribution Launch the Data Distribution Operator (P) 18.2.2
Technician and Storage Management Control GUls

3 Distribution Monitor/Control Data Distribution (P) 18.2.3
Technician Requests

4 Distribution Configure Data Distribution Polling (P)18.2.4
Technician

5 Distribution Filter Data Distribution Requests (P) 18.2.5
Technician

6 Distribution Change the Priority of Data Distribution | (P) 18.2.6
Technician Requests

7 Distribution Suspend/Resume Data Distribution (P) 18.2.7
Technician Requests

8 Distribution Cancel Data Distribution Requests (P) 18.2.8
Technician

9 Distribution Modify Preambles (P) 18.2.9
Technician
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18.2.1 Log into ECS Hosts

Logging in to ECS hosts is accomplished from a UNIX command line prompt. Table 18.2-2
presents (in a condensed format) the steps required to log in to ECS hosts. If you are aready
familiar with the procedures, you may prefer to use the quick-step table. If you are new to the
system, or have not performed this task recently, you should use the detailed procedures that

follow.
1 At the UNIX command line prompt enter:

setenv DISPLAY <client name>:0.0

* Useeither the X terminal/workstation |P address or the machine-name for the client
name.

*  When using secure shell, the DISPLAY variableis set just once, before logging in to
remote hosts. If it were to be reset after logging in to aremote host, the security
features would be compromised.

2 If logging in to the PDS Server host, in the terminal window (at the command line

prompt) start the log-in to the PDS Server by entering:
/tools/bin/ssh -| <PDSuser ID> <PDS host name>

Examples of PDS Server host names include e0dig06, g0dig06, 10dig06, and

n0dig06.

The -l option used with the ssh command allows logging in to the remote host (or the

local host for that matter) with adifferent user 1D (in this case the login ID is changed

to aPDSuser ID).

<PDSuser ID> refersthe PDS user ID or PDSIS user ID.

— ThePDS user IDs pds, pds_st, and pds it are used for PDS operationsin the
OPS, TS1, and TS2 modes respectively.

— ThePDSIS user IDs pdsis, pdsis tsl, and pdsis ts2 are used for PDSIS
operationsin the OPS, TS1, and TS2 modes respectively.

An alternative method isto enter:

/toolg/bin/ssh <PDSuser ID>@<PDS host name>
- For example:
/toolg/bin/ssh pds@x0dig06

Depending on the set-up it may or may not be necessary to include the path (i.e.,
/tools/bin/) with the ssh command. Using ssh aloneis often adequate. For example:

ssh -l pds x0dig06
- Or -

ssh pds@x0dig06
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* If you receive the message, “Host key not found from the list of known hosts. Are
you sure you want to continue connecting (yes/no)?’ enter yes (*y” alone will not
work).

* If you have previously set up a secure shell passphrase and executed sshremote, a
prompt to Enter passphrasefor RSA key '<user @ ocalhost>" appears; continue
with Step 3.

» If you have not previously set up a secure shell passphrase, go to Step 4.

If logging in to an ECS host other than the PDS Server host, in the terminal window (at
the command line prompt) start the log-in to the appropriate host by entering:

/toolg/bin/ssh <host name>
* The-l option can be used with the ssh command to alow logging in to the remote

host (or the local host for that matter) with adifferent user ID. For example, to login
to x0acs06 as user cmops enter:

/toolg/bin/ssh -I cmops x0acs06

» An alternative method of logging in with adifferent user ID isto enter:
/tools/bin/ssh <PDSuser | D>@<PDS host name>
- For example:

/toolg/bin/ssh cmops@x0acs06

* Depending on the set-up it may or may not be necessary to include the path (i.e.,
/toolg/bin/) with the ssh command. Using ssh alone is often adequate. For example:
ssh xOacs06

-or -
ssh -I cmops x0acs06
-or -

ssh cmops@x0acs06

» Examplesof Suninternal server host names include eOacs06, g0acs06, 10acs06, and
nOacs06.

» Examples of Sun external server host names include e0ins01, g0ins01, 10ins01, and
nOinsO1.

» Examples of Access/Process Coordinators (APC) Server host names include eDacgll,
gOacg01, 10acg02, and nOacgO1.

* Examplesof FSMS Server host names include eOdrgl11, gOdrg01, 10drg01, and
nOdrg01.

» Examples of Operations Workstation host names include e0acs03, g0acs02, 10acs01,
and nOacs03.

» Examplesof Ingest Server host names include €0icgl1, gOicg01, 10acg02, and
nOacgO1.
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* If you receive the message, “Host key not found from the list of known hosts. Are
you sure you want to continue connecting (yes/no)?’ enter yes (*y” alone will not
work).

* If you have previously set up a secure shell passphrase and executed sshremote, a
prompt to Enter passphrase for RSA key '<user @ ocalhost>" appears; continue
with Step 4.

» If you have not previously set up a secure shell passphrase, go to Step 5.

4 If aprompt to Enter passphrase for RSA key '<user @ ocalhost>" appears, enter:
<passphrase>

e If acommand line prompt is displayed, log-in is complete.

» If the passphrase is unknown, press Return/Enter, which should cause a
<user @remotehost>’s passwor d: prompt to appear (after the second or third try if
not after the first one), then go to Step 5.

» If the passphrase is entered improperly, a <user @r emotehost>’s passwor d: prompt
should appear (after the second or third try if not after the first one); go to Step 5.

5 If aprompt for <user @ emotehost>'s password: appears, enter:
<passwor d>

* A command line prompt is displayed.
e Log-iniscomplete.

Table 18.2-2. Log in to ECS Hosts - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 setenv DISPLAY <client name>:0.0 enter text, press Enter
2 ftools/bin/ssh -l <pds user id> <pds host enter text, press Enter
name> or /tools/bin/ssh <host name> (as
applicable)
3 <passphrase> (if applicable) enter text, press Enter
4 <password> (if applicable) enter text, press Enter

18.2.2 Launch the Data Distribution Operator and Storage Management Control
GUIs

The Data Distribution Operator GUI is intended to run continually to allow the monitoring
and management of data distribution requests. The Storage Management Control GUI is
intended to be run as it is needed; e.g., in support of Storage Management configuration
parameter modifications.

18-6 611-EMD-001




The Data Distribution Operator and Storage M anagement Control GUIs are invoked from a
UNIX command line prompt. Table 18.2-3 presents (in a condensed format) the steps required
to launch the Data Distribution Operator and Storage M anagement Control GUIs. If you are
already familiar with the procedures, you may prefer to use the quick-step table. If you are new
to the system, or have not performed this task recently, you should use the detailed procedures
that follow.

1

Access aterminal window logged in to the Operations Workstation.

Examples of Operations Workstation host names include e0acs03, g0acs02, 10acs01,
and nOacs03.
For detailed instructions refer to the Log in to ECS Hosts procedure (Section 18.2.1).

In the terminal window, at the command line prompt enter:
cd /usr/ecs/’<M ODE>/CUSTOM/utilities

<M ODE> is current mode of operation.

- TS1 - Science Software Integration and Test (SSI&T)

- TS2 - New Version Checkout

— OPS - Normal Operations

“utilities’ isthe directory containing the Data Distribution Operator GUI and
Storage Management Control GUI start-up scripts (e.g., EcDsDdistGui Start,
EcDsStmgtGui Start).

Start the Data Distribution Operator GUI by entering:
EcDsDdistGuiStart <MODE>

The Data Distribution Operator GUI islaunched.
The Data Distribution Operator GUI Distrib’'n Requests tab is displayed.

Start the Stor age M anagement Control GUI by entering:
EcDsStmgtGuiStart <MODE>

The Storage Management Control GUI islaunched.
The Storage M anagement Control GUI Storage Config. tab is displayed.

Table 18.2-3. Launch the Data Distribution Operator and Storage Management

Control GUIs - Quick-Step Procedures (1 of 2)

Step What to Enter or Select Action to Take
1 UNIX window (Operations Workstation) single-click or use procedure in
Section 18.2.1
2 cd /usr/ecs/<MODE>/CUSTOM/utilities enter text, press Enter
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Table 18.2-3. Launch the Data Distribution Operator and Storage Management

Control GUIs - Quick-Step Procedures (2 of 2)

Step What to Enter or Select Action to Take
3 EcDsDdistGuiStart <MODE> enter text, press Enter
4 EcDsStmgtGuiStart <MODE> enter text, press Enter

18.2.3 Monitor/Control Data Distribution Requests

The Distribution Technician monitors and manages data distribution requests primarily via the
Data Distribution - Track Activity window of the Distrib’n Requests tab on the Data
Distribution Operator GUI. From the Data Distribution - Track Activity window the DAAC
Distribution Technician can perform the following functions:

* View data distribution requests.
» Change the priority of aselected distribution request.
» Cancel or suspend arequest.
* Resume processing of a suspended request.
» Filter on al or specific requests by...
— Request ID.
— Requester.
- All Requests.
- MediaType.
— State (current status).

Table 18.2-4 presents (in a condensed format) the steps required to monitor/control data
distribution requests. If you are already familiar with the procedures, you may prefer to use the
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the detailed procedures that follow.

If it is not already being displayed, launch the Data Distribution Operator GUI (refer to
Section 18.2.2).
* TheData Distribution Operator GUI is displayed.

Configure Data Distribution polling (refer to Section 18.2.4).
» DDist Polling Rateis s&t.
» Error Retry Rateis set (if applicable).

Observe the distribution request information displayed on the Distrib’n Requests tab of
the Data Distribution Operator GUI.
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By default, all current distribution requests are shown in the Data Distribution

Requests list of the Data Distribution - Track Activity window (Distrib’n

Requests tab).

Note that Data Distribution controls much of the dataretrieval from the archive

(excluding retrieval for Data Pool insert); therefore, there may be alot of activity on

the Data Distribution - Track Activity screen, especialy if data processing is

operating at or near capacity.

— Consequently, it may be useful to restrict the number of distribution requests
displayed by filtering them as described in the next step of this procedure.

Horizontal and vertical scroll bars allow viewing data that are not readily visiblein

the window.

Single-click on any of the column headers of the Data Distribution - Track Activity

screen to sort the listed requests in order by the column selected.

— For example, single-click on the Submission Time column header to list requests
in the order in which the requests were submitted (i.e., oldest first).

The Refresh button provides a means of updating the data on the screen.

— Andternative isto execute the following menu path from the pull-down menu:

View —» Refresh

The Find button provides a means of performing a keyword search of the distribution
requests.

— To perform a keyword search, in the text entry box to the right of the Find
button enter: <text> then single-click on the Find button. Request(s) that have
the search text are highlighted.

The Operator Messages field at the bottom of the GUI displays messages concerning

events occurring in distribution operations.

— Error messages are described in Table 18.6-3, Data Distribution Operator GUI
User Messages and Table 18.6-4, Storage Management User M essages.

To select (highlight) all requests being displayed in the Data Distribution - Track

Activity window execute the following menu path from the pull-down menu:

Selected — Select All

To deselect all highlighted requests being displayed in the Data Distribution - Track
Activity window execute the following menu path from the pull-down menu:

Selected — Desdlect All

To access more detailed information concerning the status of a distribution request,
single-click on the distribution request in the Data Distribution - Track Activity
window then execute the following menu path from the pull-down menu:

View— Detailed

— Thedetailed information is displayed in the Operator M essages field at the
bottom of the GUI.
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10

11

If the list of data distribution requests shown in the Data Distribution - Track Activity

window needsto be filtered, filter data distribution requests (refer to Section 18.2.5).

* Only requests that meet the specified filter criteriaappear in the list in the Data
Distribution - Track Activity window.

Observe the distribution request information displayed on the Distrib’n Requests tab of
the Data Distribution Operator GUI.

If necessary, change the priority of a data distribution request (refer to Section 18.2.6).

» Priority of the request, as displayed in the Priority column of the Data Distribution
Requests list, changes from its original value to the newly selected priority.

* A check mark is displayed in the M od column of the Data Distribution Requests list
to indicate that the request has been changed.

If necessary, suspend data distribution request(s) (refer to Section 18.2.7).

» Statusof request(s), as displayed in the State column of the Data Distribution
Requests list, change(s) to the appropriate state(s).

*  Check mark(s) is (are) displayed in the M od column of the Data Distribution
Requests list to indicate that changes have been made to the request(s).

If necessary, resume processing of suspended request(s) (refer to Section 18.2.7).

e Statusof request(s), as displayed in the State column of the Data Distribution
Requests list, change(s) to the appropriate state(s).

»  Check mark(s) is (are) displayed in the Mod column of the Data Distribution
Requests list to indicate that changes have been made to the request(s).

If necessary, cancel a data distribution request (refer to Section 18.2.8).

» Statusof the request, as displayed in the State column of the Data Distribution
Requests list, changes from its original value to “Canceled.”

* A check mark isdisplayed in the M od column of the Data Distribution Requests list
to indicate that the request has been changed.

If the system creates an open intervention with respect to arequest (e.g., due to the failure

of arequest), respond to the intervention.

» For detaled instructions refer to the View Open I ntervention I nformation on the
OM GUI procedure (Section 18.5.2).

If it becomes necessary to reprocess or check on a data distribution request that has

failed, been cancelled, or been shipped, check/resubmit the request.

» For detailed instructions refer to the Monitor/Control Distribution Request
Information on the OM GUI procedure (Section 18.5.3).
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12 If it is necessary to update the data displayed in the Data Distribution - Track Activity
window, single-click on the Refresh button.
» Current data concerning data distribution requests is displayed in the Data
Distribution - Track Activity window.

13 If it is necessary to access more detailed information concerning the status of a particul ar
distribution request, first single-click on (highlight) the distribution request in the Data
Distribution - Track Activity window.

14 To compl ete accessing more detailed information concerning the status of a particular
distribution request execute the following menu path from the pull-down menu:

View— Detailed
* Information isdisplayed in the Operator M essages field at the bottom of the GUI.

15 If there is a data distribution failure, perform the applicable procedure(s) in the
Troubleshooting DDIST and Order Manager GUI Problems section (Section 18.6).

16 Repeat Steps 4 through 15 as necessary to monitor data distribution requests.

17 If necessary, exit from the Data Distribution Operator GUI by executing the following
menu path:

File - Exit
e TheData Distribution Operator GUI disappears.

Table 18.2-4. Monitor/Control Data Distribution Requests - Quick-Step
Procedures (1 of 2)

Step What to Enter or Select Action to Take

1 Launch the Data Distribution Operator GUI (if Use procedure in Section 18.2.2
necessary)

2 Configure Data Distribution polling Use procedure in Section 18.2.4

3 Observe distribution request information read text

4 Filter data distribution requests if necessary Use procedure in Section 18.2.5

5 Observe distribution request information read text

6 Change the priority of a data distribution request | Use procedure in Section 18.2.6
if necessary

7 Suspend data distribution request(s) if necessary | Use procedure in Section 18.2.7

8 Resume processing of suspended request(s) if Use procedure in Section 18.2.7
necessary

9 Cancel a data distribution request if necessary Use procedure in Section 18.2.8

10 | View open intervention information on the OM Use procedure in Section 18.5.2

GUI if necessary
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Table 18.2-4. Monitor/Control Data Distribution Requests - Quick-Step
Procedures (2 of 2)

Step What to Enter or Select Action to Take

11 | Check/resubmit a completed request if necessary | Use procedure in Section 18.5.3

12 | Refresh button (as necessary) single-click

13 | <distribution request> (in the Data Distribution | single-click
- Track Activity window) (as necessary to
access detailed information concerning request
status)

14 | View— Detailed (as necessary to access single-click
detailed information concerning request status)

15 | Repeat Steps 4 through 14 as necessary

16 | File — Exit (to exit from the Data Distribution single-click
Operator GUI)

18.2.4 Configure Data Distribution Polling

The procedure to Configure Data Distribution Polling is performed as part of the
Monitor/Control Data Distribution Requests procedure (Section 18.2.3). The Options menu
on the Data Distribution Operator GUI provides the Distribution Technician with a means of
switching the Data Distribution database polling function on or off. In addition, there are several
parameters that the technician can modify:

» DDigt Polling Rate
— How often (in seconds) the system updates the information displayed in the Data
Distribution - Track Activity window.
» Error Retry Rate
— Amount of time (in seconds) that the system waits before trying to poll the Data
Server after afailed attempt.
» Select Confirmation Min
— Number of records that triggers a confirmation dialogue box for a selected action.
* OverdueLimit
— Timelimit (in hours) for declaring requests “overdue.”

Table 18.2-5 presents (in a condensed format) the steps required to configure Data Distribution
polling. If you are aready familiar with the procedures, you may prefer to use the quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
detailed procedures that follow.

1 Execute the following menu path:
Options — System Settings
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* The Refresh Options dialogue box is displayed.

If the DDist Polling state is to be changed (from off to on or vice versa), single-click on
the DDist Polling On button.

» If the button does not have a check mark in it, clicking on it turns DDist Polling on.
» If the button already has a check mark init, clicking on it turns DDist Polling off.

If the polling rate value is to be changed, in the DDist Polling Rate field enter:
<polling rate>
» Thedefault value for polling rate is 30 seconds.

If an error retry rate value isto be specified, inthe Error Retry Rate field enter:
<error retry rate>
» Thevauefor error retry rate is specified as a number of seconds.

If it is necessary to specify a number of records that would trigger a confirmation
dialogue box if selected, in the Select Confirmation Min field enter:

<number of records>

*  When specifying acommon action for a multiple requests that have been highlighted
(e.g., when “resuming” alarge group of suspended requests), a dialogue box is
displayed to confirm that the action should be applied to al of the requestsin the
group.

* The Select Confirmation Min field specifies the minimum number of records for
displaying the confirmation dial ogue box.

— Thedefault value is 100. If 100 requests (or more) are selected for a particular
action, adialogue box is displayed to confirm the action. 1f 99 requests (or fewer)
are selected for a particular action, no confirmation dialogue box is displayed.

If it is necessary to specify atime limit for declaring requests “overdue,” in the Overdue

Limit field enter:

<hours>

* Requeststhat exceed the number of hours specified in the Overdue Limit field are
marked “Yes” in the Over due column on the Data Distribution - Track Activity
window.

When the appropriate data have been entered in the Refresh Options dialogue box fields,

single-click on the appropriate button from the following selections:

* Ok - to apply the selections and dismiss the Refresh Options dialogue box.

* Cancd - to dismiss the Refresh Options dialogue box without applying the
selections.
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8 Return to the M onitor/Control Data Distribution Requests procedure (Section 18.2.3).

Table 18.2-5. Configure Data Distribution Polling - Quick-Step Procedures

Step What to Enter or Select Action to Take

1 Options — System Settings single-click

2 DDist Polling On button (if applicable) single-click

3 <polling rate> (if applicable) enter text

4 <error retry rate> (if applicable) enter text

5 <number of records> (if applicable) enter text

6 <hours> (if applicable) enter text

7 Ok button single-click

8 Return to the procedure to Monitor/Control Data | Use procedure in Section 18.2.3

Distribution Requests

18.2.5 Filter Data Distribution Requests

The procedure to Filter Data Distribution Requests is performed as part of the
Monitor/Control Data Distribution Requests procedure (Section 18.2.3). The Data
Distribution Operator GUI provides the Distribution Technician with a means of filtering data
distribution requests.

The distribution requests to be displayed in the Data Distribution Requests list (Data
Distribution - Track Activity window) can be filtered using the Distribution Filter Requests
dialogue box. The filtering can be done on the basis of the following criteria, either individualy
or in combination:

* Request ID.
* Requester.
* MediaType.

» State[of the request].

Table 18.2-6 presents (in a condensed format) the steps required to filter data distribution
requests. If you are already familiar with the procedures, you may prefer to use the quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
detailed procedures that follow.

1 Execute the following menu path:
View — Filter

» TheDistribution Filter Requests dialogue box is displayed.
» If datadistribution requests are to be filtered on the basis of ....
- Request ID, perform Steps 2 and 3.
- Requester, perform Steps 4 and 5.
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- All Requests, perform Step 6.
- MediaType, perform Step 7.
- State, perform Step 8.

If a specific distribution request is desired and the request 1D is known, single-click on
the Request | D radio button.

If a specific distribution request is desired and the request 1D is known, in the text box
adjacent to the Request | D radio button enter:

<request |D>

If data distribution requests submitted by a particular requester are desired, single-click
on the Requester radio button.

If data distribution requests submitted by a particular requester are desired, in the text box
adjacent to the Requester radio button enter:

<reguester>

* Inthetext box the requester must be identified exactly as known to the Data Server
Subsystem.

If all data distribution requests are to be displayed in the Data Distribution Requests

list, single-click on the All Requests radio button.

» TheAll Requests button is particularly useful for restoring the Data Distribution
Requests list after reviewing a previoudly filtered set of requests.

e Goto Step 9.

If alist of data distribution requests filtered by mediatype(s) is needed, in the M edia
Type section of the Filter Requests dialogue box single-click on the type(s) of mediato
be displayed in the Data Distribution - Track Activity window.
* Optionsare: MM, CDROM, DLT, DVD, FtpPull, FtpPush, scp, All, None.
- 8MM (tape), CDROM (Compact Disk — Read-Only Memory), DL T (Digital
Linear Tape), and DVD are handled through PDS not DDIST.
— FtpPull, FtpPush and scp (secure copy distribution) are handled through DDIST.
* One mediatype or several mediatypes may be sel ected.
» If other filters (e.g., requester or state) are to be applied, it is possible to single-click
on the Apply button to implement the mediatype filter and leave the Filter Requests
dialogue box open.

If alist of data distribution requests filtered by state(s) is needed, single-click on the
applicable button(s) in the State section of the Filter Requests dialogue box.
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* Options are: Pending, Active, Staging, Transferring, Cancelled, Suspended,
Suspended with Errors, Waiting for Shipment, Shipped, Failed, All, None.

*  One button or several buttons may be selected.

» If other filters (e.g., requester or mediatype) areto be applied, it is possible to single-
click on the Apply button to implement the state filter and leave the Filter Requests
dialogue box open.

9 When all filter criteria have been selected, single-click on the appropriate button from the
following selections:
* OK - toimplement the selections and dismiss the Distribution Filter Requests
dialogue box.
— TheData Distribution - Track Activity window reappears, only requests that
meet the specified filter criteriaappear in the list.
* Apply - to implement the selections without dismissing the Distribution Filter
Requests dia ogue box.
— TheDistribution Filter Requests dialogue box remains open.
* Cancd - todismissthe Distribution Filter Requests dialogue box without
Implementing the selections.
— The previously available Data Distribution Requestslist is shown in the Data
Distribution - Track Activity window.

10 Return to the Monitor/Control Data Distribution Requests procedure (Section 18.2.3).

Table 18.2-6. Filter Data Distribution Requests - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 View — Filter single-click
2 Request ID radio button (if applicable) single-click
3 <request ID> (in Request ID text box) (if enter text
applicable)
4 Requester radio button (if applicable) single-click
5 <requester> (in Requester text box) (if enter text
applicable)
6 All Requests radio button (if applicable) single-click
7 <media types> (in Media Type section) (if single-click
applicable)
8 <state> button(s) (in State section) (if applicable) | single-click
9 OK button single-click
10 | Return to the procedure to Monitor/Control Data | Use procedure in Section 18.2.3
Distribution Requests
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18.2.6 Change the Priority of Data Distribution Requests

The procedure to Change the Priority of Data Distribution Requests is performed as part of
the Monitor/Control Data Distribution Requests procedure (Section 18.2.3). The Change
Priority area of the Data Distribution - Track Activity window on the Data Distribution
Operator GUI alows the Distribution Technician to change the priority of data distribution
requests.

Table 18.2-7 presents (in a condensed format) the steps required to change the priority of data
distribution requests. If you are already familiar with the procedures, you may prefer to use the
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the detailed procedures that follow.

1 If the list of data distribution requests shown in the Data Distribution - Track Activity
window of the Data Distribution Operator GUI needsto befiltered, filter data
distribution requests (refer to Section 18.2.5).

*  Only requests that meet the specified filter criteriaappear in the list in the Data
Distribution - Track Activity window.

2 In the Data Distribution Requests list single-click on (highlight) the row corresponding
to the distribution request to be assigned a different priority.
» The selected data distribution request is highlighted.

3 Single-click and hold the Change Priority option button to display a menu of priorities,
move the mouse cursor to the desired selection (highlighting it), then r elease the mouse
button.

* Optionsare: Xpress, Vhigh, High, Normal, L ow.
» Selected codeis displayed on the Change Priority option button when the mouse
button is released.

4 To implement the priority change single-click on the Apply button to the right of the
priority option button.

5 Single-click on the Refresh button to update the data displayed on the screen.
» Priority of therequest, as displayed in the Priority column of the Data Distribution
Requests list, changes from its original value to the newly selected priority.
* A check mark isdisplayed in the M od column of the Data Distribution Requests list
to indicate that the request has been changed.

6 Repeat the preceding steps as necessary to change the priority of additional data
distribution requests.

7 Return to the Monitor/Control Data Distribution Requests procedure (Section 18.2.3).
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Table 18.2-7. Change the Priority of Data Distribution Requests - Quick-Step

Procedures
Step What to Enter or Select Action to Take
1 Filter data distribution requests (if necessary) Use procedure in Section 18.2.5
2 <distribution request> (in Data Distribution single-click
Requests list)
3 <priority> (Change Priority option button) single-click
4 Apply button single-click
5 Refresh button (if applicable) single-click
6 Repeat the preceding steps as necessary
7 Return to the procedure to Monitor/Control Data | Use procedure in Section 18.2.3
Distribution Requests

18.2.7 Suspend/Resume Data Distribution Requests

Under certain circumstances it may be advisable to suspend the processing of a data distribution
request and resume it at a later time. For example, if there is a very large request that is taking
up resources and causing other requests to back up waiting (especially requests from data
processing that must be filled to allow processing to proceed), the request should be suspended.
Processing of the request might be resumed at a time when the demand on data distribution was
relatively light. Another example is that of arequest that has been suspended by the system due
to a system error. Processing of the request should be resumed after the conditions that caused
the error have been corrected.

The procedure to Suspend/Resume Data Distribution Requests is performed as part of the
Monitor/Control Data Distribution Requests procedure (Section 18.2.3). The Data
Distribution Operator GUI provides the Distribution Technician with a means of suspending or
resuming data distribution requests.

Table 18.2-8 presents (in a condensed format) the steps required to suspend/resume data
distribution requests. If you are already familiar with the procedures, you may prefer to use the
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the detailed procedures that follow.

1 If the list of data distribution requests shown in the Data Distribution - Track Activity
window of the Data Distribution Operator GUI needsto befiltered, filter data
distribution requests (refer to Section 18.2.5).

* Only requests that meet the specified filter criteriaappear in the list in the Data
Distribution - Track Activity window.
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» If datadistribution request areto be...
— Suspended, perform Steps 2 through 6.
— Resumed, perform Steps 7 through 11.

If all new requests displayed in the Data Distribution Requests list are to be suspended,
click on the Suspend New Requests button.

» Thedatadistribution requests are suspended.

* Goto Step 6.

If asingle request displayed in the Data Distribution Requests list isto be suspended, in
the Data Distribution Requests list single-click on (highlight) the row corresponding to
the request.

» The selected data distribution request is highlighted.

If asingle request displayed in the Data Distribution Requestslist is to be suspended,
single-click on the Suspend button.
* The selected data distribution request is suspended.

Single-click on the Refresh button to update the data displayed on the screen.

e Statusof request(s), as displayed in the State column of the Data Distribution
Requests list, change(s) from original value to “ Suspended.”

*  Check mark(s) is (are) displayed in the M od column of the Data Distribution
Requests list to indicate that changes have been made to the request(s).

If there are no suspended requests to be resumed at this time, return to the
Monitor/Control Data Distribution Requests procedure (Section 18.2.3).

If processing of al new requests displayed in the Data Distribution Requestslist isto
be resumed, single-click on the Resume New Requests button.

* The data distribution requests resume processing.

 Goto Step 10.

If processing of asingle request displayed in the Data Distribution Requestslist isto be
resumed, in the Data Distribution Requests list single-click on the row corresponding
to the request.

» The selected data distribution request is highlighted.

If processing of asingle request displayed in the Data Distribution Requestslist isto be

resumed, single-click on the Resume button.
* The selected data distribution request resumes processing.
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10 Single-click on the Refresh button to update the data displayed on the screen.

» Statusof request(s), as displayed in the State column of the Data Distribution
Requests list, changes from “ Suspended” to whatever state(s) is (are) appropriate for
the continuation of request processing (depending on each request’ s status when it
was suspended).

»  Check mark(s) is (are) displayed in the M od column of the Data Distribution
Requests list to indicate that changes have been made to the request(s).

11 Return to the Monitor/Control Data Distribution Requests procedure (Section 18.2.3).
Table 18.2-8. Suspend/Resume Data Distribution Requests - Quick-Step
Procedures
Step What to Enter or Select Action to Take
1 Filter data distribution requests (if necessary) Use procedure in Section 18.2.5
2 Suspend New Requests button (if applicable) single-click
3 <distribution request> (in Data Distribution single-click
Requests list) (if applicable)
4 Suspend button (if applicable) single-click
5 Refresh button (if applicable) single-click
6 Return to the procedure to Monitor/Control Data | Use procedure in Section 18.2.3
Distribution Requests (if applicable)
7 Resume New Requests button (if applicable) single-click
8 <distribution request> (in Data Distribution single-click
Requests list) (if applicable)
9 Resume button (if applicable) single-click
10 | Refresh button (if applicable) single-click
11 | Return to the procedure to Monitor/Control Data | Use procedure in Section 18.2.3

Distribution Requests

18.2.8 Cancel Data Distribution Requests

The procedure to Cance Data Distribution Requests is performed as part of the

Monitor/Control

Data Distribution Requests procedure (Section 18.2.3).

The Data

Distribution Operator GUI provides the Distribution Technician with a means of canceling
data distribution requests.

Table 18.2-9 presents (in a condensed format) the steps required to cancel data distribution
requests. If you are already familiar with the procedures, you may prefer to use the quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
detailed procedures that follow.
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1 If thelist of data distribution requests shown in the Data Distribution - Track Activity
window of the Data Distribution Operator GUI needsto befiltered, filter data
distribution requests (refer to Section 18.2.5).

»  Only requests that meet the specified filter criteriaappear in thelist in the Data
Distribution - Track Activity window.

2 In the Data Distribution Requestslist single-click on (highlight) the row corresponding
to the distribution request to be canceled.
» The selected data distribution request is highlighted.

3 Single-click on the Cancel button near the bottom of the Distrib’n Requests tab.
» The selected data distribution request is cancel ed.

4 Single-click on the Refresh button to update the data displayed on the screen.
» Statusof the request, as displayed in the State column of the Data Distribution
Requests list, changes from its original value to “Canceled.”
» A check mark is displayed in the M od column of the Data Distribution Requests list
to indicate that the request has been changed.

5 Return to the M onitor/Control Data Distribution Requests procedure (Section 18.2.3).

Table 18.2-9. Cancel Data Distribution Requests - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Filter data distribution requests (if necessary) Use procedure in Section 18.2.5
2 <distribution request> (in Data Distribution single-click
Requests list)

3 Cancel button single-click

4 Refresh button single-click

5 Return to the procedure to Monitor/Control Data | Use procedure in Section 18.2.3
Distribution Requests

18.2.9 Modify Preambles
The Preamble Editor tab on the Data Distribution Operator GUI alows the Distribution
Technician to review and/or modify the text of preambles to the following types of documents:

» Packing list.
¢ Successful e-mail.
* Faled emall.

The preambles are accessible in the /usr/ecs’<sM ODE>/CUSTOM/data/DSS directory on the
Distribution Server host (Sun internal server host). The directory contains preambles for the
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different types of distribution. For example, the file ECDsDdFtpPushEM SuccessPreamble.txt (in
the /usr/ecs/’<MODE>/CUSTOM/data/DSS directory) would be an “ftp push successful e-mail”
preamblefile.

The following three types of distribution only are currently relevant to DDIST distribution:

*  Ftppull.
* Ftp push.
» Securedistribution (scp).

Consequently, preambles for those types of distribution are the only preambles that are currently
applicable.

Table 18.2-10 presents (in a condensed format) the steps required to modify preambles. If you
are aready familiar with the procedures, you may prefer to use the quick-step table. If you are
new to the system, or have not performed this task recently, you should use the detailed
procedures that follow.

1 If necessary, launch the Data Distribution Operator GUI (refer to Section 18.2.2).
* TheData Distribution Operator GUI is displayed.

2 Single-click on the Data Distribution Operator GUI Preamble Editor tab.
* ThePreamble Editor screen isdisplayed.

3 Single-click on (highlight) the mediatype for which the preambleis to be modified in the
Media Type window.
e Optionsare: SMM, CDROM, DLT, DVD, FtpPull, FtpPush, and scp.
* The selected mediatype is highlighted.

4 Single-click and hold the Preamble Type option button to display a menu of types of
preambles, move the mouse cursor to the desired selection (highlighting it), then release
the mouse button.

* Optionsare: Packing List, Successful Email, and Failed Email.
» The selected preamble type is displayed on the Preamble Type option button.
* Theselected preamble is displayed in the Preamble Text window.
— |If the Preamble Text window is blank, either there is no current preamble of the
specified type or the preamble file is empty. Proceed to Step 5 and create a new
preamble.

5 In the Preamble Text window enter:
<text>

* Enter modifications to the preambl e text as necessary.
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» Thefollowing editing functions are available from the Edit pull-down menu or by
clicking on the right mouse button:
- Cut.
- Copy.
- Paste.

6 Single-click on the appropriate button from the following selections:
* Save- to save the preamble text as modified.
* Reset - to discard any changes and revert to the original (unmodified) preamble text.
» Clear - toremove al text from the Preamble Text window.
— When the Clear button has been selected, a Preamble Save Confirmation
Dialogue Box is displayed.

7 If the Preamble Save Confirmation Dialogue Box is displayed, single-click on the
appropriate button from the following selections:
* Yes- to save the preamble text as modified.
* No-torevert to the origina (unmodified) preamble text.

Table 18.2-10. Modify Preambles - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Data Distribution Operator GUI (if Use procedure in Section 18.2.2
necessary)

2 Preamble Editor tab single-click

3 <media type> (in Media Type window) single-click

4 <preamble type> (Preamble Type option button) | single-click

5 <text> (in Preamble Text window) enter text

6 Save button single-click

7 Yes button (if applicable) single-click

18.3 Monitoring Storage Management Server Operations

Distribution Technicians use the Storage Management Control GUI primarily to monitor Storage
Management server operations. Configuring Storage Management polling and deleting files
from cache are activities that are included in the overall process.

Table 18.3-1, below, provides an Activity Checklist for monitoring Storage Management server
operations.
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Table 18.3-1. Monitoring Storage Management Server Operations - Activity

Checklist

Order Role Task Section Complete?
1 Distribution Configure Storage Management Polling | (P) 18.3.1

Technician
2 Distribution Delete Files from Cache (P) 18.3.2

Technician
3 Distribution View Storage Management Event Log (P) 18.3.3

Technician Information
4 Distribution Monitor Storage Management Server (P) 18.3.4

Technician Operations

18.3.1 Configure Storage Management Polling

The Storage Management Control GUI Options menu provides the Distribution Technician
with a means of switching the Operator Notification Timer Polling on or off: In addition, the
technician can modify the following parameters:
» Database Polling Rate.
— How often (in seconds) the system updates the information displayed on the GUI.
* Error Retry Rate.
— Amount of time (in seconds) that the system waits before trying to poll the
database server after afailed attempt.
Table 18.3-2 presents (in a condensed format) the steps required to configure Storage
Management polling. If you are already familiar with the procedures, you may prefer to use the
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the detailed procedures that follow.

1 If necessary, launch the Storage M anagement Control GUI (refer to Section 18.2.2).
* The Storage Management Control GUI isdisplayed.

2 Execute the following menu path:
Options — System Settings
* The Session Settings dialogue box is displayed.

3 To change the Operator Notification Timer Polling state (from off to on or vice versa),
single-click on the Polling button.

» If OFF isdisplayed in the Polling field , single-clicking on the adjacent button turns
Polling on.
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* If ONisdisplayed in the Polling field , single-clicking on the adjacent button turns
Polling off.

To change the database polling rate for the Operator Notification Timer inthe
Database Polling Rate field enter:

<value>

» <value> isexpressed in seconds.
» Thedefault valueis 30 seconds.

To change the error retry rate for the Operator Notification Timer, inthe Error Retry
Ratefield enter:

<value>
» <value> isexpressed in seconds.

When the appropriate data have been entered in the Session Settings dialogue box fields,

single-click on the appropriate button from the following selections:

* Ok - to apply the selections and dismiss the Session Settings dial ogue box.

* Apply - to apply the selections without dismissing the Session Settings dialogue box.

» Cance - to dismissthe Session Settings dialogue box without applying the
selections.

Table 18.3-2. Configure Storage Management Polling - Quick-Step Procedures

Step What to Enter or Select Action to Take

1 Launch the Storage Management Control GUI | Use procedure in Section 18.2.2
(if necessary)

2 Options — System Settings single-click

3 Either <on> or <off> (Polling button) (as single-click
applicable)

4 <value> (in Database Polling Rate field) enter text

5 <value> (in Error Retry Rate field) enter text

6 Ok button single-click

18.3.2 Delete Files from Cache

The Storage Management Control GUI’'s Cache Stats. tab displays all of the files that are in
the cache areas, including the Pull Monitor and other staging areas. The data displayed on the
Cache Stats. tab reports genera statistics on the selected cache and allows the operator to
manually delete expired filesin cache areas.
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A just-enough-cache cleanup strategy is used in Storage Management. A principal effect of the
strategy is that caches (including the Pull Area) generally remain full because each cache
manager (including the cache manager that is configured as the Pull Monitor or Pull Area
Manager) automatically identifies and removes just enough old files to accommodate new ones.
Consequently, it is likely that manual cache cleanup will not be performed very often. The
procedure that follows is provided as a guide for those rare occasions when it is necessary to
manually delete files from cache.

Table 18.3-3 presents (in a condensed format) the steps required to delete files from cache. If
you are already familiar with the procedures, you may prefer to use the quick-step table. If you
are new to the system, or have not performed this task recently, you should use the detailed
procedures that follow.

1 If necessary, launch the Storage M anagement Control GUI (refer to Section 18.2.2).
* The Storage Management Control GUI isdisplayed.

2 Single-click on the Cache Stats. tab.
* The Cache Stats. tab is displayed.

3 To define the size of a“page” of data displayed in the Cache Information table on the
Cache Stats. tab type the number of rows per page in the Max Rows Returned text box.
* Max Rows Returned definesthe size of a“page’ of data displayed in the Cache
I nfor mation table on the Cache Stats. tab.
— For example, setting M ax Rows Returned to 50 would cause data to be displayed
in the Cache Information table in pages (groups) of 50 rows of data.
— If there were 500 files in the selected cache and M ax Rows Retur ned were set to
50, there would be 10 pages of data available for display, with the first 50 items
being displayed in the Cache I nfor mation table.
— ThePrev and Next buttons provide means of displaying additional pages of data.

4 To view the contents of a particular cache (e.g., FTP Pull Cache) single-click and hold
on the option button to the right of the Cache field, move the mouse cursor to the desired
selection (highlighting it), then r elease the mouse button.

» The selected cacheis displayed in the Cache field of the Cache Stats. tab.
* Thefollowing cache statistics are displayed in the Cache Statistics area:

— Current Utilization.

- Used Space (Blocks).

— Free Space (Blocks).

— Total Space (Blocks).

— Number of Resident Files.

— Maximum File Size (Blocks).

— Minimum File Size (Blocks).
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- Average File Size (Blocks).
» Thefollowing information concerning the filesin the selected cacheislisted in the
Cache Information table:
- Filename.
- FileSize
— Expiration [date/time].
- Last Accessed.
— Delete Flag [displays either N or Y].
- State.

NOTE: The only view currently accessible using the Text (view) option button is Text.

10

The Graphic view is not currently available.

Observe cache statisticg/information displayed on the Cache Stats. tab.

» Aspreviously mentioned, cache statistics are displayed in the Cache Statistics area
of the GUI and information concerning the filesin the selected cacheislisted in the
Cache Information table.

* The Refresh button can be used to update the data on (refresh) the screen.

* ThePrev and Next buttons provide means of displaying additional pages of data.

* TheOperator Messages field at the bottom of the GUI displays messages concerning
events (i.e., information, warnings, or errors) occurring in Stor age M anagement
Control GUI operations.

— Error messages are described in Table 18.6-4, Storage Management User
Messages.

If deleting files, single-click on the row(s) corresponding to the file(s) to be deleted in the
Cache Information table on the Cache Stats. tab.
* Multiple rows may be selected.

If deleting files, single-click on the Mark Delete button near the bottom of the Cache
Stats. tab.
* Y isdisplayedinthe Delete Flag field for the row in the Cache Infor mation table.

If any file that should be left in the cache has been inadvertently marked Delete, first
single-click on the row corresponding to thefile.

If any file that should be left in the cache has been inadvertently marked Delete, single-
click on the Unmark Delete button near the bottom of the Cache Stats. tab.
* Nisdisplayed in the Delete Flag field for the row in the Cache Information table.

If it becomes necessary to exit from the Storage M anagement Control GUI execute the
following menu path:
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File » Exit

Table 18.3-3. Delete Files from Cache - Quick-Step Procedures

Step What to Enter or Select Action to Take

1 Launch the Storage Management Control GUI | Use procedure in Section 18.2.2
(if necessary)

2 Cache Stats. tab single-click

3 <cache> (in Cache field) single-click

4 Observe cache statistics/information (Cache read text
Stats. tab)

5 <file> (to delete) (Cache Information table) single-click

6 Mark Delete button single-click

7 <file> (to preserve) (Cache Information table) single-click
(if applicable)

8 Unmark Delete button (if applicable) single-click

9 File — Exit (when applicable) single-click

18.3.3 View Storage Management Event Log Information

The Storage Events tab on the Storage Management Control GUI provides the Distribution
Technician with the ability to search the Event Log and obtain reports on events that have
occurred in Storage Management. It is possible to review the following information concerning
any particular Storage M anagement event:

*  Number.
* Date.

* Levd.

* Type.

* Message.

The following search criteria can be used individualy or in combination to view entries in the
Event Log:

Date Interval.
Event Type.
Event Level.

* Message.
Table 18.3-4 presents (in a condensed format) the steps required to view Storage Management
Event Log information. If you are already familiar with the procedures, you may prefer to use
the quick-step table. If you are new to the system, or have not performed this task recently, you
should use the detailed procedures that follow.
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If necessary, launch the Stor age M anagement Control GUI (refer to Section 18.2.2).
* The Storage Management Control GUI isdisplayed.

Single-click on the Stor age Events tab.
» The Storage Events screen is displayed.
» If Event Log entries are to be displayed on the basis of aparticular....
— Time period, perform Step 3. (If no time period is specified, log entries for the
current day will be displayed.)
- Event type, perform Step 4.
- Event level, perform Step 5.
— Message, perform Step 6.
» Any of the preceding criteria (time period, event type, event level, or message) may
be used individually or in combination to view entriesin the Event Log.

To view Event Log entries for a particular time period, enter the desired data start date in
the Date Interval: Begin field in the following format:

<MM/DD/YYYY>

» TheTab key may be pressed to move from field to field.

* Another method of changing date settings (other than typing the numbers) isto
single-click in the Date Interval: Begin field and single-click on the up/down
buttons adjacent to the Date I nterval: Begin field until the correct date is indicated.

To view Event Log entries for a particular time period, enter the desired data ending date
in the Date Interval: End field in the following format:

<MM/DD/YYYY>

» TheTab key may be pressed to move from field to field.

* Another method of changing date settings (other than typing the numbers) isto
single-click in the Date Interval: End field and single-click on the up/down buttons
adjacent to the Date Interval: End field until the correct date is indicated.

To view log entries for a particular event type, single-click and hold on the Event Type
option button, move the mouse cursor to the desired selection (highlighting it), then

r elease the mouse button.

* Optionsare: Any, Device, Cache, Software, COTS, Sybase, Pulldisk, Unknown.

* The selected event type is displayed on the Event Type option button.

To view log entries for a particular event level, single-click and hold on the Event L evel
option button, move the mouse cursor to the desired selection (highlighting it), then

r elease the mouse button.

* Optionsare: Any, Information, Warning, Error, Severe, Fatal, Unknown.

» Theselected event level is displayed on the Event L evel option button.
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To view log entries for a particular message in the M essage field enter:
<message>

Single-click on the Sear ch button to search the event log for events that meet the

specified criteria.

» Thesearch results are displayed in the Event L og table of the Storage M anagement
Control GUI Storage Eventstab.

Observe event information displayed in the Event L og table.

* Log entries are displayed in the Event L og table of the GUI.

» Single-click on any of the column headers of the Event L og table to sort the listed
eventsin order by the column selected.

— For example, single-click on the M essage column header to list the eventsin
alphabetical order by message text.

* TheOperator Messages field at the bottom of the GUI displays messages concerning
events (i.e., information, warnings, or errors) occurring in Storage M anagement
Control GUI operations.

— Error messages are described in Table 18.6-4, Storage Management User
Messages.

If it becomes necessary to clear entries in the Event Log Search Parameter fields, single-
click on the Clear Parameter s button.
» Entriesin the Event Log Search Parameter fields are cleared.

If it becomes necessary to purge entries from the Event Log, single-click on (highlight)
each row corresponding to an event to be deleted in the Event L og table.
* Multiple entries may be selected.

If it becomes necessary to purge entries from the Event Log, single-click on the Purge
Selected button.
» Selected entries are deleted from the Event Log.

If anew Event Log search isto be performed on the basis of aparticular....
» time period, returnto Step 3.

e event type, return to Step 5.

» event level, return to Step 6.

* message, returnto Step 7.

If it becomes necessary to exit from the Storage M anagement Control GUI execute the
following menu path:

File > Exit
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Table 18.3-4. View Storage Management Event Log Information - Quick-Step

Procedures
Step What to Enter or Select Action to Take
1 Launch the Storage Management Control GUI | Use procedure in Section 18.2.2
(if necessary)
2 Storage Events tab single-click
3 <MM/DD/YYYY> (in Date Interval: Begin field) |enter text
(if applicable)
4 <MM/DD/YYYY> (in Date Interval: End field) (if |enter text
applicable)
5 <event type> (Event Type option button) (if single-click
applicable)
6 <event level> (Event Level option button) (if single-click
applicable)
7 <message> (in Message field) enter text
8 Search button single-click
9 Observe event information (Event Log table) read text
10 | Clear Parameters button (if applicable) single-click
11 |<event> (in Event Log table) (if applicable) single-click
12 | Purge Selected button (if applicable) single-click
13 | Return to applicable step to perform a new Event
Log search
14 | File —» Exit (when applicable) single-click

18.3.4 Monitor Storage Management Server Operations

The Request Status tab on the Storage Management Control GUI provides the Distribution
Technician with the ability to monitor processing activity in al of the storage management
servers for a given mode. The Request Status Information table lists the requests that are
currently being serviced by storage management servers and those that have been completed

within the last 24 hours.

particular storage management request:
» Operation [type of operation represented by the request].

* Request ID.

It is possible to review the following information concerning any

» Progress[stage of processing on which the request is currently working (may include

anumeric progress indication)].
» Status.
* Priority.

*  When Submitted [time and date when the request was received by the Storage
Management server that is responsible for the request].
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Last Updated [time and date when the status was last updated for the request].

Using the Request Status tab the Distribution Technician can detect stalled requests or servers
that appear to beidle.

Table 18.3-5 presents (in a condensed format) the steps required to monitor storage management
server operations. If you are aready familiar with the procedures, you may prefer to use the
quick-step table. If you are new to the system, or have not performed this task recently, you
should use the detailed procedures that follow.

1 If necessary, launch the Stor age M anagement Control GUI (refer to Section 18.2.2).

The Storage M anagement Control GUI is displayed.

2 Single-click on the Storage Management Control GUI Request Status tab.

The Request Statustab is displayed.

3 Observe information displayed on the Request Status tab of the Stor age M anagement
Control GUI.

The Request Status I nfor mation table displays the following information:

— Operation.

- Request ID.

— Progress.

- Status.

— Priority.

-  When Submitted.

— Last Updated.

By default, all storage management server requests for the last 24 hours are shown in

the Request Status I nformation table of the Request Status tab.

Note that virtually all datainserted into or retrieved from the archive is controlled by

storage management servers, consequently there may be alot of activity on the

Request Statustab.

— Consequently, it may be useful to restrict the number of requests displayed by
filtering them as described in the next step of this procedure.

Single-clicking on any of the column headers of the Request Status I nfor mation

table causes the listed requests to be sorted in order by the column selected.

— For example, single-clicking on the Last Updated column header causes the
requests to be listed in order from the least recently updated to the most recently
updated.

The Operator Messages field at the bottom of the GUI displays messages concerning

events (i.e., information, warnings, or errors) occurring in Stor age M anagement

Control GUI operations.

— Error messages are described in Table 18.6-4, Storage Management User

Messages.
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If thelist of Storage Management requests shown in the Request Status I nfor mation
table needs to befiltered, single-click and hold the Filtering pull-down menu to display
amenu of filtering options, move the mouse cursor to the appropriate selection
(highlighting it), then r elease the mouse button.

The Filtering pull-down menu offers the following options for filtering Storage
Management requests:
Options are: Server, Operation, Processing State, and Submitter.

Server controls what activity is displayed by limiting the list to the requests
being/having been serviced by a specific server. Selecting All displays all
requests throughout the Storage Management CSCI. Other selections include the
individual archive servers, cache manager servers, ftp servers, request manager
server, and staging disk servers.

Operation alows the Distribution Technician to focus on a specific type of
operation. Thelist of operationsis dynamically generated to reflect those
operations for which requests are currently in queue, for example (among others):
All, scp, CMLink, ArStore, FtpPull, FtpPush.

Processing State allows the Distribution Technician to differentiate anong
regquests that are being actively processed; have been completed, either
successfully or to aretryable error state; or have been suspended and are awaiting
the outcome of another event. The following selections are available: All,
Processing, Suspended, Completed.

Submitter allows the Distribution Technician to see the status of requests
submitted by a specific client process. The list of possible clientsis dynamically
generated to reflect the list of clients with outstanding requests for example
(among others): All, DSDD, SDSV, this, individual ftp server, individual archive
server, individual staging disk server.

Observe the Storage Management requests displayed in the Request Status I nformation

table.

Repeat Steps 4 and 5 as necessary to monitor Storage Management requests.

If it becomes necessary to exit from the Storage M anagement Control GUI execute the
following menu path:

File > Exit
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Table 18.3-5. Monitor Storage Management Server Operations - Quick-Step
Procedures

Step What to Enter or Select Action to Take

1 Launch the Storage Management Control GUI | Use procedure in Section 18.2.2
(if necessary)

2 Request Status tab single-click

3 Observe request status information (Request read text
Status Information table)

4 <filtering option> (Filtering pull-down menu) (If single-click
applicable)

5 Observe request status information (Request read text
Status Information table)

6 Repeat Steps 4 and 5 (as necessary)

7 File —» Exit (when applicable) single-click

18.4 Tuning Data Server Subsystem Configuration Parameters

The values assigned to system parameters affect the functioning and performance of the system.
When certain parameters are modified, the system operates differently. Changes to some other
parameters may not appear to affect the system although there may in fact be subtle effects. In
any case before system parameters are modified it is essentia to understand what will happen to
system functioning and performance.

Many system parameters may be subject to control by Configuration Management (CM). When
making or requesting a change to system parameters, the CM process at the particular site must
be followed (if applicable).

Vaues are assigned to Storage Management and Data Distribution parameters in the following
databases:

» Configuration Registry database.
» Storage Management and Data Distribution database.

With respect to Storage Management servers the Registry contains database connectivity
information only. All other configuration information is in the Storage Management and Data
Distribution database and is typically entered or modified using the Storage Management
Control GUI.

Table 18.4-1, below, provides an Activity Checklist for tuning DDIST system parameters.
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Table 18.4-1. Tuning DDIST System Parameters - Activity Checklist

Order Role Task Section Complete?
1 Distribution Modify System Parameters in the (P)18.4.1
Technician Storage Management and Data

Distribution Database Using the
Storage Management Control GUI

2 Distribution Modify System Parameters in the (P) 18.4.2
Technician Storage Management and Data
Distribution Database Using ISQL
3 Distribution Modify Parameters in the (P) 18.4.3
Technician DsDdThreadPool Table Using ISQL

Modifying System Parameters in the Configuration Registry Database

The Configuration Registry Server provides a single interface (via a Sybase server) for retrieving
configuration attribute-value pairs for ECS servers from the Configuration Registry database.
When ECS servers are started, they access the Configuration Registry Database to obtain needed
configuration parameters.

The Database Administrator has access to a Configuration Registry GUI for viewing and editing
configuration data in the database. Therefore, it is necessary to coordinate with the Database
Administrator when changes to configuration parameters are needed. Also, as previously
mentioned, changes to configuration-controlled parameters are subject to approval through the
site CM process.

Default and adjusted values assigned to system parameters vary from site to site. For guidance
concerning the assignment of values to parameters included in the Configuration Registry refer
to document 910-TDA-022, Custom Code Configuration Parameters for ECS. The document is
available at http://cmdm.east.hitc.com/baseline/ under “Technica Documents.”

The following parameters are examples of parameters whose values may be modified to enhance
system functioning or performance:

* AppLogSize [parameter appliesto all servers).
— Maximum size of the application log (ALOG) file for a particular application.
— Recommended size varies considerably depending the nature of the application
for which the fileis being written.
* AppLoglLevel [parameter appliesto all servers).
— Level of detail provided in the ALOG file for a particular application.
— Acceptablevalues are0, 1, 2, or 3.
— A setting of “0” provides the most data.
* DebugLevel [parameter appliesto all servers|.
— Levd of detail provided in the debug log file for a particular application.
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— Normally acceptable valuesare 0, 1, 2, or 3.

— A setting of "0" turns off logging; a setting of “3” provides a significant amount
of data.

— STMGT offers "enhanced" debugging based on bitmaps including Level 7 (the 4
bit), which provides detailed database debugging, and Level 15 (the 8 hit), which
frequently dumps the in-memory request queue (in the Request Manager). [Both
Level 7 and Level 15 quickly create enormouslog files.]

* DBMaxConnections [EcDsDistributionServer and EcDsDdistGui parameter].

— Maximum number of database open connections (e.g., 15) allowed a particular
application.

— Increasing the assigned value may prevent other applications from getting access
to the database.

. FtpPushThreshoId [EcDsDistributionServer parameter].
Maximum number of bytes (e.g., 15000000000) per ftp push request.

— The FtpPushThreshold should always be greater than the size of the largest input
granule used by the Planning and Data Processing Subsystems (PDPS) to ensure
that PDPS distribution requests are processed without manual intervention.

— When adistribution request exceeds a threshold (e.g., FtpPushThreshold or
FtpPull Threshold), the request is suspended in DDIST.

»  FtpPull Threshold [EcDsDistributionServer parameter].

— Maximum number of bytes (e.g., 20000000000) per ftp pull request.
* MaxThreads [EcDsDistributionServer parameter].

— Worker threads (created at start up) used to process active requests.

— Needs to be greater than or equal to the sum of all priority thread limits.
* RETRIEVAL_CHUNK_SIZE [EcDsDistributionServer parameter].

— Number of per-request archived files (e.g., 40) to be retrieved from the archive
Server.

— Must be greater than zero (0).

— Should not be greater than half the number of service threads used by the STMGT
cache managers for archive reading.

» SocketLimit [EcDsDistributionServer parameter].

— Number of connections (e.g., 620) to a server through the Hubble Space
Telescope (HST) sockets middleware.

— Too low anumber misses connections.

— Too high anumber may adversely affect the memory of the server's host.

» CheckSumsStoreFreq [EcDsStArchiveServer parameter].
— Percentage of StoreFile requests to be checksummed.
» CheckSumRetrieveFreq [ EcDsStCacheManagerServer parameter].
— Percentage of checksummed files to be checksummed for file retrieve requests.

When the value assigned to a parameter has been changed and saved in the Configuration
Registry, the modified value does not take effect until the affected server has been restarted. For
example, if the debug level for the Distribution Server log has been changed from “2” to “3” in
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the Configuration Registry, the modification does not affect the recording of data in the log until
after a warm restart of the Distribution Server (at which time the server would read the
parameters in the Configuration Registry).

Checksum Status

It is possible to have a checksum calculated for each file stored (inserted) in the archive. In
addition, there is an option for having a checksum computed for each file retrieved from the
archive and validating it by comparing it with the checksum previously computed.

The extent of check-summing is determined by the values assigned to the following two
configuration parameters in the Configuration Registry:

*  CheckSumStoreFreq.
* CheckSumRetrieveFreq.

CheckSumStoreFreq is an archive server (EcDsStArchiveServer) parameter that specifies the
percentage of StoreFile requests to be checksummed. CheckSumRetrieveFreq is a cache
manager server (EcDsStCacheManagerServer) parameter that specifies the percentage of file
retrieve requests to be checksummed. The recommended value for both parameters is 100 (i.e.,
calculate a checksum for 100% of requests). If either value needs to be modified, coordinate the
change with the Database Administrator.

Tuning System Parameters in the Storage Management and Data Distribution
Database

Staging Area Size and Read-Only Cache Size

Cache and staging disk space requirements are defined in separate columns in different database
tables in the Storage Management and Data Distribution Database.

» The Total StagingSpace column in the DsStStagingDiskServer table contains the
overall size of the space (in blocks) available for a staging disk.
— It should reflect the available disk space in the file partition that is configured.
* The Total CacheSpace column in the DsStCache table contains the overal size (in
blocks) of a cache.
— TotalCacheSpace is seen as " Original Cache Space" from the Storage
Management Control GUI.
— The value assigned to the cache manager that is configured as the Pull Monitor
(Pull Area Manager) should be the size (in blocks) of the partition that houses the
Pull Area.
— If the value assigned to the Pull Monitor (Pull Area Manager) is changed while
there are filesin the Pull Area, the value should be higher than the cumulative size
of filesin the cache.

NOTE: In Storage Management configurations, capacity ("space") is consistently
specified in blocks. File sizeis specified in bytes.

18-37 611-EMD-001



The change in the specification of staging disk/cache space is an effect of the way cache
structure has been modified. Currently cache has its own path as shown in the following
comparison of staging disk and cache paths:

* EcDsStCacheManagerServerACM 1 cache path:
— Jusr/ecs OPS/CUSTOM/apc/x0acg0l/data/staging/cache (The cache areaisno
longer identified as "userl".)
» EcDsStStagingDiskServerACM 1 root path:
— Jusr/ecs OPS/CUSTOM/apc/x0acg0l/data/staging//disks (Now each staging
disk has a unique number (e.g., disk1132), even across servers.)

The cache and staging disk space parameters are modified using the Storage Management
Control GUI. [Refer to the Modify System Parameters in the Storage Management and
Data Distribution Database Using the Storage Management Control GUI procedure
(Section 18.4.1).]

Setting Expiration Thresholds for Cache Managers

A just-enough-cache cleanup strategy is used in Storage Management. A principal effect of the
strategy is that caches (including the Pull Area) generally remain full because each cache
manager (including the cache manager that is configured as the Pull Monitor or Pull Area
Manager) identifies and removes just enough old files to accommodate new ones.

In the DsStCache database table there is an ExpirationThreshold column that contains the
number of hours it takes for files to expire in the cache area managed by each cache manager.
The ExpirationThreshold for the cache manager that is configured as the Pull Monitor (i.e,
EcDsStCacheManagerServerPULL) specifies the number of hours it takes for files to expire in
the Pull Area.

When setting the ExpirationThreshold for each cache manager the following factors should be
taken into consideration:

» ExpirationThreshold specifies the number of hoursalien will be held against a
cached file,

» If alien expires and spaceisrequired, the lien will be automatically removed unless
the ConfirmDelete flag (for expired files) isset to "Yes."

» ExpirationThreshold entries are typically set at 72 (hours) but may be set at some
other value (usually in the range of 24 - 72).
— Too short atime limits the ability of usersto get their data beforeit is deleted (if

ConfirmDeleteis set to "No").

— Too long atime increases the chance of filling up the cache.

» The ConfirmDelete column in the DsStCache table is a flag that indicates whether to
automatically delete upon reaching the ExpirationThreshold.
— Typicaly set to "No" (do not require confirmation before deleting).
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* Filesare pulled to the Pull Areaby the Pull Monitor (Pull Area Manager); they are
not pushed there by the ftp server.
* TheFault Level and Warning Level parameters are ignored.

Expiration thresholds and ConfirmDelete flags for expired files are modified using the Storage
Management Control GUI. [Refer to the Modify System Parameters in the Storage
Management and Data Distribution Database Using the Storage M anagement Control GUI
procedure (Section 18.4.1).]

Storage Management Service Thread Allocation

Service threads process requests submitted to the applicable server (eqg.,
EcDsStRequestM anager Server, EcDsStArchiveServer, EcDsStCacheM anager-Server,
EcDsStStagingDiskServer, EcDsStFtpServer). The number of service threads assigned to a
server should be set on the basis of the resources available and the server throughpui.

The DsStServiceThreadConfig database table contains the number, types, and priorities of
service threads for Storage Management servers.

» Thefollowing columnsin the DsStServiceThreadConfig database table indicate the
number of service threads assigned to each priority:
— XpressThreads
— VhighThreads
— HighThreads
- Normal Threads
— LowThreads
» The Pool Type column identifies the type of threads within a certain poal. (i.e.,
Service Threads, Read Threads, Write Threads) applicable to the server.
— In Storage Management Read Threads and Write Threads apply to the archive
serversonly.
*  The NumThreads column contains the number of threadsin a particular pool.

Table18.4-2 lists representative default values as listed in the DsStServiceThreadConfig

database table. In the table Serverld 1 refers to EcDsStArchiveServerACM4 and Serverld 2
refersto EcDsStArchiveServerDRP3.

Table 18.4-2. Representative Default Values Listed in the
DsStServiceThreadConfig Database Table (1 of 2)

Serverld PoolType Num Xpress Vhigh High Normal Low
Threads | Threads | Threads | Threads | Threads | Threads
1 ReadThreadPool | 30 0 10 10 0 10
1 ThreadPool 30 0 10 10 0 10
1 WriteThreadPool | 30 0 10 10 0 10
2 ReadThreadPool | 10 0 0 0 0 10
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Table 18.4-2. Representative Default Values Listed in the
DsStServiceThreadConfig Database Table (2 of 2)

Serverld PoolType Num Xpress Vhigh High Normal Low
Threads | Threads | Threads | Threads | Threads | Threads

2 ThreadPool 50 0 10 10 0 30

2 WriteThreadPool | 100 0 20 70 0 10

Storage Management service thread-related values are modified using the Storage M anagement
Control GUI. [Refer to the Modify System Parameters in the Storage Management and
Data Distribution Database Using the Storage Management Control GUI procedure
(Section 18.4.1).]

Data Distribution Priority Thread Allocation

Data Distribution (DDIST) has been enhanced to support a DAAC-configurable number of
thread pools with each pool having a separate thread limit. The pools are defined in a DDIST
database table called DsDdThreadPool. Each row in the table contains a unique pool identifier, a
thread pool name, and the number of threads (thread limit) associated with the pool.
Table 18.4-3 shows an example of DsDdThreadPool table contents.

Table 18.4-3. Example of DsDdThreadPool Table Contents

ThreadPoolld ThreadPoolName ThreadLimit
13 SUB_LARCINGMGR 15
14 DEFAULT 10
15 PRODUCTION 20
16 SUB_ASTERGDS 10
17 SUB_NOAASOAP 20
18 SUB_JSMITH 20
19 PDS 30
20 USER_FTPPUSH 35
21 USER_FTPPULL 10
22 S4POPS 20
23 SUB_PRIVUSER 80
24 SUB_REGUSER 60

The DsDdThreadPool table in the example (Table 18.4-3) defines the following 12 pools:

 SUB_LARCINGMGR (15 threads maximum).
* DEFAULT (10 threads maximum).
*  PRODUCTION (20 threads maximum).
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* SUB_ASTERGDS (10 threads maximum).
*  SUB_NOAASOAP (20 threads maximum).
* SUB_JSMITH (20 threads maximum).

* PDS (30 threads maximum).

 USER _FTPPUSH (35 threads maximum).
* USER_FTPPULL (10 threads maximum).
e SAPOPS (20 threads maximum).

» SUB_PRIVUSER (80 threads maximum).

* SUB_REGUSER (60 threads maximum).

There must always be a DEFAULT pool present in the DsDdThreadPool table because a
distribution request that fails to match any of the other rules for assigning requests to thread
poolsis automatically assigned to the DEFAULT pool.

The rules for assigning requests to thread pools are specified in the DsDdAssignmentRule table.
The rules are DAAC-configurable and are based on request attributes. The following attributes
are used for establishing a thread pool assignment:

o ECSUserld.
* Priority.

e EsdiType.

* MediaType.

e EmailAddress.
*  NumberOfGranules.

Each row in the DsDdAssignmentRule table defines an assignment rule. Table 18.4-4 shows an
example of DsDdA ssignmentRule table contents.

Table 18.4-4. Example of DsDdAssignmentRule Table Contents (1 of 2)

SegqNum | Thread | ECSUserld Priority | Esdt Media EmailAddress NumberOf
Poolld Type Type Granules

50 14 ANY ANY ANY scp ANY ANY
100 15 $EcDpPreM ANY ANY ANY ANY ANY
200 16 aster_gds NORMAL | ANY ANY ANY ANY
300 13 LarcingMgr NORMAL | ANY ANY ANY ANY
400 17 NOAA/SOAP ANY ANY ANY ANY ANY
500 18 jsmith NORMAL | ANY ANY ANY ANY
600 19 $PDS3 ANY ANY ANY ANY ANY
900 22 s4opsaaf ANY ANY ANY ANY ANY
1000 22 s4opsaar ANY ANY ANY ANY ANY
1100 22 s4opsamf ANY ANY ANY ANY ANY
1200 22 sd4opsamr ANY ANY ANY ANY ANY
1300 22 s4opsdpf ANY ANY ANY ANY ANY
1400 22 sd4opstmf ANY ANY ANY ANY ANY
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Table 18.4-4. Example of DsDdAssignmentRule Table Contents (2 of 2)

SegNum | Thread | ECSUserld Priority | Esdt Media EmailAddress NumberOf
Poolld Type Type Granules
1500 22 sdopstmr ANY ANY ANY ANY ANY
1600 23 PrivUser ANY ANY | FtpPush | userops@x0ins02. 2
daac.ecs.nasa.gov
1700 24 RegUser ANY ANY ANY ANY ANY
1800 17 NoneUser ANY ANY ANY ANY ANY
1900 20 ANY ANY ANY | FtpPush ANY ANY
2000 21 ANY ANY ANY FtpPull ANY ANY

For each new request, the rules (in the DsDdAssignmentRule table) are evaluated in order by
SegNum until a rule is found where al conditions evaluate to true, in which case the request is
assigned to the pool specified in the ThreadPoolld column. A rule evaluates to true if the values
of all of the request attributes (i.e., ECSUserld, Priority, EsdtType, MediaType, EmailAddress,
and NumberOfGranules) match the values contained in the rule’s row in the table. Note that a
value of "ANY" automatically evaluates to true for that attribute. So, in the example, any
request with the ECSUserld "s4opsaaf” is alocated to ThreadPoolld 22 (i.e., the S4POPS thread
pool in Table 2) and any FtpPull request that does not meet the conditions specified for any other
assignment rule are allocated to ThreadPoolld 21 (the USER_FTPPULL thread pool). Any
request that fails to match the rules for any of the thread pool IDs in the assignment rule table is
assigned to the DEFAULT thread pool.

In addition to enforcing rules for assigning requests to thread pools (as specified in the
DsDdAssignmentRule table) Data Distribution has another mechanism for preventing certain
types of requests from monopolizing distribution resources. The mechanism is called dynamic
FTP server assignment and it involves using a set of rules in the DsDdA ssignmentRuleHWCI
table to evaluate each distribution request and allocate it to the appropriate Data Distribution FTP
Server.

The rules for assigning a distribution request to a specific FTP server (identified by HWCI) are
DAAC-configurable and are based on request attributes. The following attributes are used for
making an HWCI assignment:

 ECSUserld.

* SeniorClient.
* Medialype.
* EsdiType.

* PushDest.

¢ EmailAddress.

Each row in the DsDdAssignmentRuleHWCI table defines an HWCI assignment rule.
Table 18.4-5 shows an example of DsDdA ssignmentRuleHWCI table contents.
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Table 18.4-5. Example of DsDdAssignmentRuleHWCI Table Contents

SegNum HWCI ECSUserld | Senior Media Esdt PushDest EmailAddress
Client Type Type
100 DRP1 $PDS ANY ANY ANY ANY ANY
200 DRP1 ANY PD ANY ANY ANY ANY
300 DRP1 ANY IN ANY ANY ANY ANY
400 DRP1 $PDS3 ANY ANY ANY ANY ANY
500 DRP2 PrivUser ANY FtpPush | ANY ANY ANY
600 DRP1 RegUser ANY FtpPush | ANY ANY ANY
700 DRP1 sdopsaaf ANY FtpPush | ANY ANY ANY
800 DRP1 s4opsaar ANY FtpPush | ANY ANY ANY
900 DRP1 s4opsamf ANY FtpPush | ANY ANY ANY
1000 DRP1 sdopsamr ANY FtpPush | ANY ANY ANY
1100 DRP2 sdopsdpf ANY FtpPush | ANY ANY ANY
1200 DRP1 sdopstmf ANY FtpPush | ANY ANY ANY
1400 DRP1 s4opstmr ANY FtpPush | ANY ANY ANY
1500 | DRP1_auto ANY ANY scp ANY ANY ANY

In the example shown in Table 18.4-5, FtpPush requests from either PrivUser or s4opsdpf that do
not have a senior client of either “PD” or “IN” are assigned to DRP2 (EcDsStFtpServerDRP2).
All other requests are alocated to DRP1 (EcDsStFtpServerDRP).

When DDIST receives a request, a stored procedure executes to assign the request to the
appropriate thread pool based on the rules contained in the DsDdAssignmentRule table
(Table 18.4-4).

Once al threads in agiven thread pool have been allocated, new requests assigned to
that pool are put in a"pending” state until athread becomes available.

Requests are no longer automatically assigned to threads in other poolsif there are no
available threads in their assigned pool.

Pending requests for each pool are activated in first-in-first-out order by request
priority.

Another stored procedure executes to map the request to an HWCI based on the rules contained
in the DsDdA ssignmentRuleHW(CI table (Table 18.4-5).

DAACs may adjust configurations by updating the DsDdThreadPool, DsDdAssignmentRule,
and DsDdA ssignmentRuleHWCI tables.

Assignment rules may be added, deleted or updated at any time without warm-

starting DDIST.

— Changes to assignment rules take effect immediately upon being entered in the
database.
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— All new requests entering DDIST are subject to the updated rules.

* The ThreadLimit attribute in the DsDdThreadPool table may be dynamically changed
aswell.

— The DDIST server reloads thread limits every 90 seconds so thread limit changes
take effect within 90 seconds after being entered.

— New thread pools can be added by inserting rows in the DsDdThreadPool table.

— However, they are not used until the DDIST server is warm-started.

— A thread pool can be deleted as long as there are no rulesin the
DsDdAssignmentRule table that point to the thread pool and al requests that have
been assigned to the thread pool have been completed and have migrated out of
the DDIST database.

When DDIST iswarm-started, all requests are reassigned to thread pools based on the current set
of rules.

If necessary, it is possible to reassign requests after they have been assigned to a thread pool.
The following processis used:

» Update the rulesin the DsDdA ssignmentRul e table as necessary to ensure that the
request will be assigned to the desired thread pool.
*  Warm-start DDIST (EcDsDistributionServer).

There is no GUI support for making changes to either the thread pool configuration or the FTP
server assignment. Thread pool configuration or FTP server assignment changes are made by a
DAAC DBA using the isgl interface to update the DsDdThreadPool, DsDdAssignmentRule
and/or DsDdA ssignmentRuleHW(CI tables in the database.

The following guidelines are provided for tuning DDIST priority thread allocation:

* In most cases, each FtpPush destination site should have its own thread pool.

» For each FtpPush destination, the DAAC should determine the number of concurrent
filetransfersit takesto fully utilize the available network bandwidth.

— The number represents a parameter called "MaxTransfers."

» For subscription-based FtpPush distribution, the thread limit for the associated thread
pool should be set to 130% of MaxTransfers (rounded up).

— This should provide a sufficient number of threads to utilize the available network
bandwidth plus allow for one or more threads to be concurrently staging data out
of the AMASS cache.

» For non-subscription-based FtpPush distribution, the thread limit for the associated
thread pool should be set to 200% of MaxTransfers (rounded up).

— Thisshould provide sufficient threads to utilize the avail able network bandwidth
plus alow for staging of data from archive tapes.

* Thetota number of threads in DsDdThreadPool (i.e., sum of ThreadLimit for all
rows) represents the maximum number of threads that can be active concurrently n
DDIST.

— Thetotal must be less than the number of worker threads configured for DDIST.
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— The default number of worker threads configured for DDIST is 228.

» Although DDIST thread pools can be configured around request attributes other than
priority, it isimportant to remember that STMGT CacheManager thread pools are
organized by priority; consequently, it isimportant to ensure that STMGT thread
pools are configured to optimally handle the likely mix of request priorities.

» During warm-start, it takes DDIST 0.83 second to recover each active or pending
request; consequently, for a 2000-request backlog, it takes DDIST approximately 28
minutes to reach the end of start monitoring and begin accepting new requests.

— However, note that DDIST immediately begins to work off its request backlog as
reguests are assigned to thread pools.

Methods for modifying thread pools and thread-pool-assignment rules are described in the
Modify System Parameters in the Storage Management and Data Distribution Database
Using 1 SQL procedure (Section 18.4.2) and the Modify Parameters in the DsDAT hreadPool
Table Using | SQL procedure (Section 18.4.3).

18.4.1 Modify System Parameters in the Storage Management and Data
Distribution Database Using the Storage Management Control GUI

The effects on system functioning and performance must be considered before modifying system
parameters. In addition, when making or requesting a change to system parameters, the CM
process at the particular site must be followed (if applicable). Depending on circumstances (e.g.,
operator permissions) at a particular site, it may be necessary to request that someone else make
parameter modifications using the Storage Management Control GUI. The procedure that
follows is provided to assist Distribution Technicians who have to make parameter modifications
using the Stor age M anagement Control GUI.

Table 18.4-6 presents (in a condensed format) the steps required to modify system parametersin
the Storage Management and Data Distribution Database using the Storage Management
Control GUI. If you are already familiar with the procedures, you may prefer to use the quick-
step table. If you are new to the system, or have not performed this task recently, you should use
the detailed procedures that follow.

1 If necessary, launch the Stor age M anagement Control GUI (refer to Section 18.2.2).
* The Storage Management Control GUI isdisplayed.

2 If necessary, single-click on the Storage Config. tab.
3 Single-click on the appropriate server type in the Configuration Parameter Reporting
window on the Storage Config. tab.

» Theselected server typeis highlighted in the Configuration Parameter Reporting
window on the Storage Config. tab.
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* Thefollowing server types are listed in the Configuration Parameter Reporting
window on the Storage Config. tab:
- 8MM (8mm Stacker Server).
- ARCHIVE (Archive Server).
- CACHE MANAGER (Cache Management Server).
— CDROM (CDROM Device Server).
— DLT (DLT Stacker Server).
— DTF (DTF Device Server).
- FTP (FTP Server).
- REQUEST MANAGER (Request Manager Server).
— STAGING DISK (Staging Disk Server).
» Associated servers are listed in the server information window on the Storage
Config. tab.

Single-click on the appropriate server in the server information window on the Storage

Config. tab.

» The selected server is highlighted in the server information window on the Storage
Config. tab.

» For example, if CACHE MANAGER were selected from the Configuration
Parameter Reporting window on the Stor age Config. tab, the following servers
might be listed in the server information window:

— EcDsStCacheManagerServerACM 1.
— EcDsStCacheManagerServerDRP3.
— EcDsStCacheManagerServerPULL.
- EcDsStCacheManagerServerWK S1.

Single-click on the Modify Server/View Stacker s button.

* The applicable server configuration dialogue box is displayed.

* For example, if CACHE MANAGER had been selected, the Cache Manager
Server Configuration dialogue box would be displayed. The Cache Manager
Server Configuration dialogue box displays data in the following fields (as
applicable):

— Server Name.

— RPC [remote procedure call] Tag.

— Original Cache Space (blocks).

— Auvailable Cache Space (blocks) [cannot be modified from GUI].

— Allocation Block Size (bytes).

— Description [e.g., "Cache Manager"].

— Expiration Threshold (hours).

— Expired Files Confirm Delete [option button with Y es and No as the options].
— Disk Capacity: Fault Level [currently ignored].

— Disk Capacity: Warning Level [currently ignored].
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— Filel/O Block Size (bytes) [typically set to 4194304 (4MB)].

- Retries[typically set to 5].

— Sleeptime (seconds) [typicaly set to 2].

— Service Threads[number of worker threads that are allocated within the server
instance to process requests - modified through the Allocate by Priority button].

— Pull Area Manager [option button with Y es and No as the options].

- Cache Path.

— User Request Directory.

— FTP Notification File.

- FTP Notification Freq (Sec).

» Refer to theinstallation instructions for the applicable software release to find

recommended values for the configuration of Storage Management servers.

- Installation instructions for each software release are available at
http://cmdm.east.hitc.com/baseline/ under "Pre-Ship Reviews."

In the appropriate field(s) of the server configuration dialogue box enter:
<value>

If service-thread (or read-thread or write-thread) priority allocations are to be modified,

single-click on the corresponding Allocate by Priority button.

» Theappropriate Allocate by Priority window (e.g., the Service Threads: Allocate
by Priority window) is displayed.

If thread priority allocations are being modified, in the appropriate field(s) of the
Allocate by Priority window enter:

<value>

» When entering desired values in the appropriate fields of the Allocate by Priority
window, start with the Total field.

» Lower-priority threads may be used to service higher priority requests, but never vice
versa.

» By default, al service threads are created as low priority service threads, since they
may be pre-empted by any priority request.

» The number of low threads is automatically re-cal culated whenever the number of
any of the other thread typesis changed.
— Consequently, the total of the numbersin each of the five different thread type

fields equals the number in the Total field.

If thread priority allocations are being modified, single-click on the appropriate button
from the following selections:
* OK - to approve the new value(s) and dismiss the Allocate by Priority window.

— The Cache Manager Server Configuration dialogue box is displayed.
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» Cancd - toreturn to the Cache Manager Server Configuration dialogue box
without saving the new value(s).
— The Cache Manager Server Configuration Dialogue Box is displayed.

NOTE: Sometimes when a secondary window (such as Service Threads: Allocate by

10

11

Priority Window) has been accessed to modify parameters (e.g., to configure
service threads), changes that were previously made in the primary window (such
as the Cache Manager Server Configuration Dialogue Box) are | ost.
Consequently, it is recommended that either values be changed in the secondary
window first or that changes already made in the primary window be verified
after the secondary window has been closed.

When new values have been entered in all fields to be modified, single-click on the
appropriate button from the following selections:
* OK - to approve the new value(s) and dismiss the configuration dialogue box.
— The Storage Config. screen is displayed.
» Cancd - toreturn to the Stor age Config. screen without saving the new value(s).
— The Storage Config. screen is displayed.

Repeat Steps 3 through 10 as necessary.

Table 18.4-6. Modify System Parameters in the Storage Management and Data
Distribution Database Using the Storage Management Control GUI - Quick-Step

Procedures
Step What to Enter or Select Action to Take
1 Launch the Storage Management Control GUI | Use procedure in Section 18.2.2
(if necessary)
2 Storage Config. tab single-click
3 <server type> (in Configuration Parameter single-click
Reporting window)
4 <server name> (in the server information single-click
window)
5 Modify Server/View Stackers button single-click
6 <value> [in appropriate field(s) of the server enter text
configuration dialogue box]
7 Allocate by Priority button (if applicable) single-click
8 <value> [in appropriate field(s) of the Allocate by | enter text
Priority window]
9 OK (if applicable) single-click
10 |[OK single-click
11 | Repeat Steps 3 through 10 (as necessary)
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18.4.2 Modify System Parameters in the Storage Management and Data
Distribution Database Using ISQL

The effects on system functioning and performance must be considered before modifying system
parameters. In addition, when making or requesting a change to system parameters, the CM
process at the particular site must be followed (if applicable). Depending on circumstances at a
particular site it may be necessary to request that the Database Administrator modify parameters
in the Storage Management and Data Distribution database. The procedures that follow are
provided to assist Distribution Technicians who have to make the database modifications
themselves.

The procedures vary somewhat depending on what database table is to be modified. For
example:

* Moadifications can be made to the DsDdA ssignmentRule or
DsDdAssignmentRuleHWCI table at any time as described in the M odify System
Parametersin the Storage M anagement and Data Distribution Database Using
I SQL procedure that follows.

— If the Distribution Server is running when the table is updated, the changes will
take effect immediately (i.e., any new distribution requests will be allocated to a
thread pool using the updated rules).

— Consequently, rule changes to one of the tables must be self-consistent and are
typically made within the scope of a single Sybase transaction.

* Modifications to the DsDdThreadPool table must be made while the Distribution
Server isidle, as described in the M odify Parametersin the DsDAT hreadPool
TableUsing I SQL procedure (Section 18.4.3).

Table 18.4-7 presents (in a condensed format) the steps required to modify system parametersin
the Storage Management and Data Distribution Database using isqgl. If you are aready familiar
with the procedures, you may prefer to use the quick-step table. If you are new to the system, or
have not performed this task recently, you should use the detailed procedures that follow.

NOTE: If modifications to the DsDdThreadPool table are to be made, go to the M odify
Parametersin the DsDdThreadPool Table Using | SQL procedure
(Section 18.4.3).

1 Access aterminal window logged in to the Access/Process Coordinators (APC) Server

host.
» Examplesof APC Server host namesinclude eDacgl1, g0acgO1, I0acg02, and
nOacgO01.

» For detailed instructions refer to the Log in to ECS Hosts procedure (Section 18.2.1).
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At the UNIX command line prompt enter:
isgl -U <user ID> -S <database server>

» <user | D> isthe database user'sidentification; e.g., ssmgt_role.
» <database server> isthe database server; e.g., xOacgO1l srvr.
* For example:

isgl —U stmgt_role —Sx0acg01_srvr

At the Password: prompt enter:
<database passwor d>

» <database password> isthe password for logging in to the database using the
specified <user 1D>.

* A 1> prompt is displayed, indicating that a connection has been made with the
database.

At the 1> prompt enter:
use <database name>

* The<database name> islikely to be one of the following names:
— stmgtdbl [OPS mode].
— stmgtdbl TS1 [TS1 mode].
- stmgtdbl TS2 [TS2 mode].

* A 2> prompt isdisplayed.

At the 2> prompt enter:

go
e A 1> prompt isdisplayed.

At the 1> prompt enter:
select * from <table name>
* For example:

select * from DsDdAssignmentRule
* Alternatively, at the 1> prompt enter:

select <column name> from <table name>

— For example:

select ThreadPoolld from DsDdAssignmentRule
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* Another dternativeisto enter:

select <column name 1>,<column name 2>[,<column name 3>,...] from <table

name>
- For example:

select ThreadPoolld,Priority from DsDdAssignmentRule

e A 2> prompt isdisplayed.

At the 2> prompt enter:

go
» Table contents are displayed.

- If * (wildcard) was specified, al entriesin the table are displayed.
- If specific columnNames were entered, the data associated with those columns

only are displayed.
* For example:

1> select * from DsDdAssignmentRule

2> go

SeqNum  ThreadPoolld ECSUserId

Priority EsdtType
MediaType
EmailAddress
Number OfGranules

100 15 $EcDpPreM

ANY ANY

200 16 aster_gds
NORMAL ANY
ANY

ANY

ANY

300 13 LarcingMagr

NORMAL ANY
ANY
ANY
ANY
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600
ANY
ANY
ANY
ANY
900
ANY
ANY
ANY
ANY
1000
ANY
ANY
ANY
ANY
1100
ANY
ANY
ANY
ANY
1200
ANY
ANY
ANY
ANY
1300
ANY
ANY
ANY
ANY
1400
ANY
ANY
ANY
ANY
1500
ANY
ANY
ANY
ANY
1700
ANY

19 $PDS3
ANY

22 sAopsaaf
ANY

22 sAopsaar
ANY

22 sAopsamf
ANY

22 sAopsamr
ANY

22 sAopsdpf
ANY

22 sAopstmf
ANY

22 Aopstmr
ANY

24 RegUser
ANY
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ANY

ANY

ANY

1800 17 NoneUser
ANY ANY
ANY

ANY

ANY

1900 20 ANY
ANY ANY
FtpPush

ANY

ANY

2000 21 ANY
ANY ANY
FtpPull

ANY

ANY

400 17 NOAA/SOAP

ANY ANY
ANY

ANY

ANY

601 19 $PDS
ANY ANY
ANY

ANY

ANY

500 18 gones
NORMAL ANY
ANY

ANY

ANY

1600 23 PrivUser
ANY ANY
FtpPush

user ops@x0ins02.daac.ecs.nasa.gov

2
(29 rows affected)
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11

If updating arow in a database table, at the 1> prompt enter:

update <table name> set <column name 1>=<value 1> where <column name
2>=<value 2>

* For example:
update DsDdAssignmentRule set ECSUserld="jsmith" where ThreadPooll d=18

— The effect of the modification shown in the example would be to change the
ECSUserld in the row(s) of the database table containing ThreadPoolld 18 from
“gones’ to "jsmith."

—  Subsequently al distribution requests with an ECSUserld of "jsmith" would be
assigned to ThreadPool Id 18.

— Distribution requests with an ECSUserld of "gones’ would no longer be assigned
to ThreadPoolld 18.

* Goto Step 12.

If deleting arow in adatabase table, at the 1> prompt enter:
delete <table name> wher e <column name 1>=<value 1>
* For example:

1> delete DsDdAssignmentRule where ThreadPooll d=16

— The effect of the modification shown in the example would be to delete any
database row(s) with "16" in the ThreadPoolld column.
e Goto Step 12.

If adding arow in a database table, at the 1> prompt enter:
insert <table name> (<column name 1>,<column name 2>,<column name 3>...)
* For example:

1> insert DsDdAssignmentRule
(SeqNum, ThreadPoolld,ECSUser Id,Priority,EsdtType,MediaType,
EmailAddress,Number Of Granules)

If adding arow in adatabase table, at the 2> prompt enter:
values (<value 1>,<value 2>,<value 3>...)
* For example:
2> values (1550,23," MODAPS' " HIGH" " ANY" " FtpPush" ," ANY" ," ANY")
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At the > prompt (e.g., 2> or 3>) enter:

go

The effect of the modification shown in the examplesin Steps 10 and 11 would beto
insert in the DsDdA ssignmentRul e database table a row containing the following

values:

- 1550 (SegNum column).

- 23 (ThreadPool Id column).

- MODAPS  (ECSUserld column).

- HIGH (Priority column).

- ANY (EsdtType column).

- FtpPush (MediaType column).

- ANY (Email Address column).

- ANY (NumberOfGranules column).

If modifying the DsDdA ssignmentRul e table (as shown in the examplesin this
procedure) the following attributes must be specified for each row:

Seq

SegNum.
ThreadPoolld.

ECSUserld.

Priority.

EsdtType.

MediaType.

Num.

Determines the order in which arule is evaluated.

Integer whose value is greater than or equal to zero.

Each rule must have a unique sequence number.

Rules are evaluated in order from the lowest sequence number to the highest
sequence number.

It is recommended that sequence numbers not be created consecutively (e.g.,
instead of numbering 1, 2, 3, use 100, 200, 300) so new rules can be inserted
without having to renumber subsequent rules.

ThreadPoolld.

Unique identifier of the thread pool to be assigned if the ruleisthe first oneto
evaluate to true.

Integer with a value greater than zero.

Must match one of the values in the ThreadPoolld column in the
DsDdThreadPool table.

Multiple rules can assign the same ThreadPoold.

ECSUserld.

User identifier associated with a distribution request.

String of up to 24 charactersin length.

If the user identifier of a distribution request matches the string, the attribute
evaluates to true.
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If the string is set to the reserved word "ANY ," the attribute always evaluates to
true.

String comparisons are case-sensitive.

Priority.

Request priority associated with a distribution request.

String that must be set to one of the following six values: "XPRESS", "VHIGH",
"HIGH", "NORMAL", "LOW", or "ANY".

If the priority of adistribution request matches the string then the attribute
evaluates to true.

If the string is set to the reserved word "ANY ," the attribute always evaluates to
true.

String comparisons are case-sensitive.

EsdtType.

M

Data type associated with a distribution request.

String of up to twelve (12) charactersin length.

Must be set to avalid ESDT name and version number or the reserved words
"MULTIPLE" or "ANY."

When an ESDT name and version number are specified, the string has the form
"Name.Version" (e.g., "MOD021KM.003").

A distribution request hasits EsdtType set to "MULTIPLE" if granules from more
than one ESDT are being distributed. If the data type of a distribution request
matches the string, the attribute evaluates to true.

If the string is set to the reserved word "ANY ," the attribute always evaluates to
true.

String comparisons are case-sensitive.

ediaType.

Type of distribution medium to be used in fulfilling a distribution request.
String that must be set to one of the following seven values: "FtpPush",
"FtpPull", "8MM", "CDROM", "DLT", "scp”, "ANY."

If the "mediatype" of adistribution request matches the string then the attribute
evaluates to true.

If the string is set to the reserved word "ANY ," the attribute always evaluates to
true.

String comparisons are case-sensitive.

Currently “8MM”, “CDROM”, and “DLT” never appear in distribution requests
because media requests are redirected to PDS.

Email Address.

An e-mail address that can be used to distinguish among different accounts with
the same ECSUserld (e.g., to map specific ECSGuest requests to the appropriate
thread pools).
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14

The e-mail addressis especialy useful when a particular ECSGuest user submits
SO many requests that it is necessary to control how much of the distribution
capacity those requests can utilize at any given time.

If the "e-mail address’ associated with a distribution request matches the string,
the attribute evaluates to true.

If the string is set to the reserved word "ANY ," the attribute always evaluates to
true.

String comparisons are case-sensitive.

¢ NumberOfGranules.

Number of granulesin a distribution request.

The NumberOf Granules criterion can be used to map distribution requests to
thread pools based on the size (in terms of granules) of the request.
NumberOfGranules is useful in controlling the distribution capacity available to
large requests versus small requests. So it can be used to avoid having small
requests back up behind large requests.

If the "NumberOfGranules® of a distribution request matches the value stored in
the database, the attribute evaluatesto true.

If the value of NumberOfGranules in the database is set to the reserved word
"ANY " the attribute always evaluates to true.

To start verification of the update at the 1> prompt enter:
select * from <table name>

» Alternatively, use one of the options described in Step 6.

At the 2> prompt enter:

go

» Table contents are displayed.
» Specified value(s) should have been updated.
* For example:

1> select * from DsDdAssignmentRule
2>go
SegNum  ThreadPoolld ECSUserlId

Priority EsdtType
MediaType
EmailAddress
Number OfGranules

18-57 611-EMD-001



100 15 $EcDpPreM
ANY ANY
ANY

ANY

ANY

200 16 aster_gds
NORMAL ANY
ANY

ANY

ANY

300 13 LarcingMgr
NORMAL ANY
ANY

ANY

ANY

600 19 $PDS3
ANY ANY
ANY

ANY

ANY

900 22 SAopsaaf
ANY ANY
ANY

ANY

ANY

1000 22 sAopsaar
ANY ANY
ANY

ANY

ANY

1100 22 sAopsamf
ANY ANY
ANY

ANY

ANY

1200 22 sAopsamr
ANY ANY
ANY

ANY

ANY

1300 22 Aopsdpf
ANY ANY
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ANY
ANY
ANY
1400
ANY
ANY
ANY
ANY
1500
ANY
ANY
ANY
ANY
1700
ANY
ANY
ANY
ANY
1800
ANY
ANY
ANY
ANY
1900
ANY
FtpPush
ANY
ANY
2000
ANY
FtpPull
ANY
ANY
400
ANY
ANY
ANY
ANY
601
ANY
ANY
ANY

22 Aopstmf
ANY

22 Aopstmr
ANY

24 RegUser
ANY

17 NoneUser
ANY

20 ANY
ANY

21 ANY
ANY

17 NOAA/SOAP
ANY

19 $PDS
ANY
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ANY

500 18 jsmith
NORMAL ANY
ANY

ANY

ANY

1600 23 PrivUser
ANY ANY
FtpPush

user ops@x0ins02.daac.ecs.nasa.gov
2

(29 rows affected)

— The preceding example indicates that the DsDdA ssignmentRul e table has been
updated (from what was shown in the examplein Step 7) to change the
ECSUserld from “sones’ to “jsmith” in the row containing “18” for

ThreadPoolld.

To exit fromisgl at the 1> prompt enter:
quit

* The connection with the database is discontinued.
* A UNIX command line prompt is displayed.

Table 18.4-7. Modify System Parameters in the Storage Management and Data
Distribution Database Using the ISQL - Quick-Step Procedures (1 of 2)

Step What to Enter or Select Action to Take
1 UNIX window (APC Server) single-click or use procedure in
Section 18.2.1

2 isql —U <user ID> -S <database server> enter text, press Enter

3 <database password> enter text, press Enter
select * from <table name> * from <table enter text, press Enter
name>

5 go enter text, press Enter

6 select * from <table name> enter text, press Enter

7 go enter text, press Enter

8 update <table name> set <column name enter text, press Enter
1>=<value 1> where <column name 2>=<value
2> (if applicable)

9 delete <table name> where <column name enter text, press Enter

1>=<value 1> (if applicable)
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Table 18.4-7. Modify System Parameters in the Storage Management and Data
Distribution Database Using the ISQL - Quick-Step Procedures (2 of 2)

Step What to Enter or Select Action to Take

10 |insert <table name> (<column name enter text, press Enter
1>,<column name 2>,<column name 3>...) (if
applicable)

11 |values (<value 1>,<value 2>,<value 3>...) (if enter text, press Enter
applicable)

12 |go enter text, press Enter

13 |select * from <table name> enter text, press Enter

14 |go enter text, press Enter

15 |quit enter text, press Enter

18.4.3 Modify Parameters in the DsDdThreadPool Table Using ISQL

Modifications to the DsDdThreadPool table must be made while the Distribution Server isidle,
as described in the procedure that follows.

Table 18.4-8 presents (in a condensed format) the steps required to modify parameters in the

DsDdThreadPool table using isql.

If you are already familiar with the procedures, you may

prefer to use the quick-step table. If you are new to the system, or have not performed this task
recently, you should use the detailed procedures that follow.

If any rulein the DsDdA ssignmentRul e table references a thread pool that is going to be
deleted from the DsDdThreadPool table, update the rules in the DsDdA ssignmentRule
table so that no additional requests will be assigned to the thread pool that isto be

deleted.

* Refer to the Modify System Parametersin the Storage Management and Data
Distribution Database Using | SQL procedure (Section 18.4.2).
» Thread pool assignment rules are defined by the rows in the DsDdAssignmentRule

table.

» A thread pool should not be deleted while any rule in the DsDdAssignmentRule table

references that thread pool.

If any request in the DsDdRequest table references a thread pool that isto be deleted,
wait until al requests that are currently assigned to the thread pool have been completed

before continuing.

» A thread pool should not be deleted while there is arequest in the DsDdRequest table

that references the thread pool.
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When there are no current requests assigned to any thread pool to be deleted (if any),
make a request to the Operations Controller/System Administrator to bring down (stop)
the Distribution Server (EcDsDistributionServer) in the appropriate mode.
* If anew pool is added to DsDdThreadPool and new rules are added to
DsDdA ssignmentRule while the Distribution Server is running and the new rules
result in arequest being assigned to the new pool, the request will be suspended with
aDsEDdMissingPool error code.
— The suspended request cannot be resumed until the Distribution Server is warm-
started.

Wait until the Distribution Server has stopped.

If athread pool isto be deleted, useisgl to set the ThreadLimit in the DsDdThreadPool

table to zero.

» Refer to the Modify System Parametersin the Storage Management and Data
Distribution Database Using | SQL procedure (Section 18.4.2).

If athread pool isto be added to the DsDdThreadPool table or an existing thread pool is
to modified, modify the DsDdThreadPool table using isql.
» Refer to the Modify System Parametersin the Storage Management and Data
Distribution Database Using | SQL procedure (Section 18.4.2).
» Each thread pool is defined by arow in the DsDdThreadPool table.
» Thefollowing attributes must be specified for each row in the DsDdThreadPool table:
— ThreadPoolld.
— ThreadPoolName.
— ThreadLimit.
» ThreadPoolld.
— Unique identifier for the thread pool.
— Integer with avalue greater than zero.
— Eachrow in DsDdThreadPool must have a unique TheadPoolld.
» ThreadPoolName.
— Name of the thread pool.
- String with alength less than or equal to 24 characters.
— Eachrow in DsDdThreadPool must have a unique ThreadPoolName.
e ThreadLimit.
— Number of threads available for processing requests assigned to the thread pool.
— Integer with avalue greater than or equal to zero.
— If the ThreadLimit for a given thread pool is zero, any requests that are assigned
to the thread pool will remain in the pending state until the ThreadLimit isset to a
value greater than zero.
— If the ThreadLimit for a given thread pool is updated from a non-zero value to
zero, no new requests assigned to the thread pool will be activated; however, any
currently active requests will be allowed to complete.
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— Thetotal of the thread limits for all thread pools must be less than the number of

worker threads configured for DDIST.

— The default worker thread configuration for DDIST is 228 threads.

When the appropriate modifications to the DsDdThreadPool table have been made using
isgl, make arequest to the Operations Controller/System Administrator to perform a
warm start of the Distribution Server (EcDsDistributionServer) in the appropriate mode.

If athread pool isto be deleted (i.e., the ThreadLimit in the DsDdThreadPool table has
been set to zero), wait until all completed requests that were assigned to the thread pool
have been subject to garbage collection from the DsDdRequest table before continuing.
* A waiting time of 24 hours should be adequate.

If athread pool isto be deleted (i.e., the ThreadLimit in the DsDdThreadPool table has
been set to zero) and the waiting period has expired, useisgl to delete the relevant row

from DsDdThreadPool table.

» Refer to the Modify System Parametersin the Storage Management and Data
Distribution Database Using | SQL procedure (Section 18.4.2).

Table 18.4-8. Modify Parameters in the DsDdThreadPool Table Using ISQL -
Quick-Step Procedures (1 of 2)

Step

What to Enter or Select

Action to Take

1

Update the rules in the DsDdAssignmentRule
table so that no additional requests will be
assigned to the thread pool that is to be deleted
(if applicable)

Use procedure in Section 18.4.2

Wait until all requests that are currently assigned
to the thread pool have been completed before
continuing (if applicable)

wait

Make a request to the Operations
Controller/System Administrator to bring down the
Distribution Server in the appropriate mode (if
applicable)

contact Operations Controller

Wait until the Distribution Server has stopped

wait

Use isgl to set the ThreadLimit in the
DsDdThreadPool table to zero (if applicable)

Use procedure in Section 18.4.2

Modify the DsDdThreadPool table using isql

Use procedure in Section 18.4.2

Make a request to the Operations
Controller/System Administrator to perform a
warm start of the Distribution Server in the
appropriate mode (if applicable)

contact Operations Controller
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Table 18.4-8. Modify Parameters in the DsDdThreadPool Table Using ISQL -
Quick-Step Procedures (2 of 2)

Step What to Enter or Select Action to Take

8 Wait until all completed requests that were wait
assigned to the thread pool have been subject to
garbage collection from the DsDdRequest table
(if applicable)

9 Use isql to delete the relevant row from Use procedure in Section 18.4.2
DsDdThreadPool table (if applicable)

18.5 Monitoring/Controlling Order Manager Operations

The Order Manager (OM) GUI provides ECS operators with access to the Order Manager
database. The GUI is based on web standards. It performs most of its functions by accessing the
database directly, in contrast to most current ECS operator GUIs, which interface with servers.
The GUI allows operators to view and modify requests that the Order Manager Server has placed
on hold because they require operator intervention. In addition, operators can resubmit requests
or portions of arequest that failed.

For Synergy IV, the OM GUI incorporates many of the functions of the Data Distribution
Operator GUI with the expectation that the OM GUI can provide an efficient, centralized
interface. Note that the Data Distribution Operator GUI is still functional, asisthe ECS Data
Order Tracking GUI, which aso shares a number of functions with the OM GUI.

New operator GUI security standards require the following two levels of permissions for the OM
GUI:

* Full Capability.

* Limited Capability.
Full-capability operators have the ability to configure parameters and perform all other actions
that can be accomplished with the OM GUI. Limited-capability operators are able to view alot

of information; however, on the limited-capability GUI some buttons and links have been
disabled so it is not possible to perform certain actions or access certain pages.

Order Manager activities in which the Distribution Technician is likely to be involved are
performed using the following OM GUI pages:

* Request Management.
— Open Interventions.
— Completed Interventions.
— Distribution Requests.
— FTP Push Distribution Requests.
— Staging Requests.
— Operator Alerts.
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FtpPush Monitor.

— FTP Push Distribution Requests.

— Suspended Destinations.

OM Status Pages.

-  OM Queue Status.

- Staging Status: Media Type.

— Staging Status: FTP Push Destination.
OM Configuration.

— Aging Parameters.

- Server/Database.

- Media

— FTPPush Palicy.

Help.

— About HelpOnDemand.

- Hep.
Logs.

— OM GUI Log Viewer.

Table 18.5-1, below, provides an Activity Checklist for monitoring/controlling Order Manager
operations.

Table 18.5-1. Monitoring/Controlling Order Manager Operations - Activity

Checklist (1 of 4)

Order

Role

Task

Section

Complete?

1

Distribution
Technician
[full-capability or
limited-capability]

Launch the Order Manager GUI

(P) 18.5.1

Distribution
Technician
[full-capability or
limited-capability]

View Open Intervention Information on
the OM GUI

(P) 18.5.2

Distribution
Technician
[full-capability or
limited-capability]

Set Refresh Options on OM GUI Pages

(P) 18.5.2.1

Distribution
Technician
[full-capability only]

Respond to an Open Intervention

(P) 18.5.2.2

Distribution
Technician
[full-capability
(limited-capability:
monitor only)]

Monitor/Control Distribution Request
Information on the OM GUI

(P) 18.5.3
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Table 18.5-1. Monitoring/Controlling Order Manager Operations - Activity

Checklist (2 of 4)

Order

Role

Task

Section

Complete?

6

Distribution
Technician
[full-capability or
limited-capability]

Filter Data Displayed on the Distribution
Requests Pages

(P) 18.5.3.1

Distribution
Technician
[full-capability only]

Change the Priority of a Distribution
Request Using the OM GUI

(P) 18.5.3.2

Distribution
Technician
[full-capability only]

Suspend, Resume, Cancel, or
Resubmit a Distribution Request Using
the OM GUI

(P) 18.5.3.3

Distribution
Technician
[full-capability only]

Edit FtpPush Parameters

(P) 18.5.3.4

10

Distribution
Technician
[full-capability or
limited-capability]

View Operator Alerts on the OM GUI

(P) 18.5.4

11

Distribution
Technician
[full-capability or
limited-capability]

View Completed Intervention
Information on the OM GUI

(P) 18.5.5

12

Distribution
Technician
[full-capability or
limited-capability]

Filter Data Displayed on the Completed
Interventions Page

(P) 18.5.5.1

13

Distribution
Technician
[full-capability
(limited-capability
view only)]

View and Respond to Suspended FTP
Push Distribution Destinations

(P) 18.5.6

14

Distribution
Technician
[full-capability
(limited-capability
view only)]

View and Respond to Destination
Details on the OM GUI

(P) 18.5.6.1

15

Distribution
Technician
[full-capability
(limited-capability
check only)]

Check/Modify OM Queue Status

(P) 18.5.7

16

Distribution
Technician
[full-capability or
limited-capability]

Check Staging Status

(P) 18.5.7.1
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Table 18.5-1. Monitoring/Controlling Order Manager Operations - Activity

Checklist (3 of 4)

Order Role Task Section Complete?
17 Distribution Check/Modify Aging Parameters (P) 18.5.8
Technician
[full-capability
(limited-capability
check only)]
18 Distribution Check/Modify OMS Server or Database | (P) 18.5.9
Technician Parameters
[full-capability
(limited-capability
check only)]
19 Distribution Check/Modify Media Parameters (P) 18.5.10
Technician
[full-capability
(limited-capability
check only)]
20 Distribution Check/Modify FTP Push Policy (P) 18.5.11
Technician Configuration
[full-capability
(limited-capability
check only)]
21 Distribution Add Destinations to the Frequently (P)18.5.11.1
Technician Used Destinations List
[full-capability only]
22 Distribution Modify Values Assigned to Parameters | (P) 18.5.11.2
Technician of Frequently Used Destinations
[full-capability only]
23 Distribution View the OM GUI Log (P) 18.5.12
Technician
[full-capability or
limited-capability]
24 Distribution Prepare Input Files for Use with the (P) 18.5.13
Technician OMS ClI
[full-capability only]
25 Distribution Start the OMS CI (P) 18.5.14
Technician
[full-capability only]
26 Distribution Process Input Files Specified for (P) 18.5.15
Technician Synergy |l Exceptions
[full-capability only]
27 Distribution Configure How Long Order-Tracking (P) 18.5.16
Technician Information is Kept in the OMS
[full-capability only] | Database
28 Distribution Switch Between Synergy IV and (P) 18.5.17
Technician Synergy lll Operations

[full-capability only]
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Table 18.5-1. Monitoring/Controlling Order Manager Operations - Activity

Checklist (4 of 4)

Order Role Task Section Complete?
29 Distribution Get OMS CI Help (P) 18.5.18

Technician

[full-capability only]

18.5.1 Launch the Order Manager GUI

Launching the Order Manager GUI is accomplished using the Netscape browser. Table 18.5-2
presents (in a condensed format) the steps required to launch the Order Manager GUI. If you
are aready familiar with the procedures, you may prefer to use the quick-step table. If you are
new to the system, or have not performed this task recently, you should use the detailed
procedures that follow.

Access aterminal window logged in to a host (e.g., the Operations Workstation or Sun

external server) that has access to the Netscape web browser.

» Examples of Operations Workstation host names include e0acs03, g0acs02, 10acs01,
and nOacs03.

» Examplesof Sun external server host names include e0ins01, g0ins01, 10ins01, and
nOinsO1.

» For detaled instructions refer to the Log in to ECS Hosts procedure (Section 18.2.1).

In the terminal window, at the command line prompt, enter:
netscape &

* It may be necessary to type the path as well as the netscape command (e.g.,
/toolg/bin/netscape & ).

* It may be necessary to respond to dialogue boxes, especidly if the browser is already
being used by someone else who has logged in with the same user ID.

* The Netscape web browser is displayed.

If abookmark has been created for the OM GUI, select the appropriate bookmark from
those listed on the browser’ s Bookmar ks button (or the Communicator — Bookmarks
pull-down menu).

» Thesecurity login Prompt is displayed.

If no bookmark has been created for the OM GUI, in the browser’s L ocation (Go To)
field enter:

http://<host>:<port>/<path>/
* For example:
http://x0dps01.daac.ecs.nasa.gov: 54321/cgi-bin/
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» The security login Prompt is displayed.

In the User Name box of the security login Prompt enter:
<user name>

In the Password box of the security login Prompt enter:
<passwor d>

NOTE: If the security login prompt reappears after the first time the user name and

password have been entered (and the OK button has been clicked), it may not be
due to adataentry problem. Try againto log in using the same user name and
password. Sometimesit is necessary to enter the user name and password for the

GUI more than once.

Single-click on the appropriate button from the following selections:
* OK - to complete the log-in and dismiss the dialogue box.

— The dialogue box is dismissed.

— TheOrder Manager Page [“Home" Page] is displayed.
» Cancd - to dismiss the dialogue box without logging in.

— The dialogue box is dismissed.

— The Netscape web browser is displayed.

Table 18.5-2. Launch the Order Manager GUI - Quick-Step Procedures

Step

What to Enter or Select Action to Take

UNIX window with access to Netscape browser single-click or use procedure in
(Operations Workstation, Interface Server 02, Section 18.2.1
etc.)

netscape & enter text, press Enter

<OM GUI bookmark> (if available) single-click

http://<host>:<port>/<path>/ (if necessary) enter text, press Enter

<user name> enter text

<password> enter text

N|o|joaf~h|lWN

OK single-click

18.5.2 View Open Intervention Information on the OM GUI

The Open Interventions page provides the full-capability operator with a means of viewing and
responding to open interventions. (The limited-capability operator can view but cannot work on
(respond to) open interventions.)
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Table 18.5-3 presents (in a condensed format) the steps required to view open intervention
information on the OM GUI. If you are already familiar with the procedures, you may prefer to
use the quick-step table. If you are new to the system, or have not performed this task recently,
you should use the detailed procedures that follow.

1 If it is not already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).

The Order Manager GUI isdisplayed.

2 If it has not been expanded already, single-click on the Request Management link in the
navigation frame of the OM GUI.

The Request Management menu is expanded.

3 Single-click on the Open Interventionslink in the navigation frame of the OM GUI.

The Open Interventions page is displayed.
The Listing table has the following columns:
— Order Id.

- Request Id.

- Media.

- Status.

- Worked by.

- Created.

— Acknowledged.

- Explanation(s).

4 Observe information displayed in the Listing table of the Open I nterventions page.

The Show rows at a time window provides a means of selecting the maximum

number of rows of datato be displayed at atime.

— For example, if Show rows at atimeis being displayed, selecting 50 from
the option button would result in the display of a page of data containing up to 50
rows of data

Single-clicking on alink (underlined word) in the column header row of the table

causes table contents to be sorted on that column.

— For example, clicking on the Created link causes the table to be organized by
“Creation Time,” with the most recent request requiring intervention in the top
row of the table.

Single-clicking on a specific Order ID brings up a screen containing more detailed

data concerning that particular order.

— The ECS Order page displays the following types of data concerning the order:
Request ID(s), Order Type, Order Source, Receive Date, Last Update,
Description, Start Date, User ID, Status, Ship Date, Order Home DAAC.
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— If the order isabundling order (Order Type “Bundled Order” or “BQO”), the ECS
Order pageincludes alink to the Spatial Subscription Server GUI.

— Clicking on the Netscape browser Back button causes the Open Interventions
page to be redisplayed.

Single-clicking on a specific Request ID in the Listing table of the Open

I nter ventions page brings up a screen containing detailed data concerning the

intervention for that particular request (refer to Steps 5 and 6).

Horizontal and vertical scroll bars appear when necessary to allow viewing data that

are not readily visible in the window.

If AutoRefresh is ON, the Open I nterventions page refreshes automatically as often

as specified in the Refresh screen every x minutes window.

- If adifferent refresh option is preferred, perform the Set Refresh Optionson OM
GUI Pages procedure (Section 18.5.2.1).

To manually update (refresh) the data on the screen, single-click on the Netscape

browser Reload button.

The Netscape browser Edit — Find in Page menu provides a means of performing a

keyword search of the data currently being displayed on the screen.

Thefirst, previous, next, and last links provide means of displaying additional pages

of data.

Single-click on a specific Request ID in the Listing table of the Open Interventions
page to bring up a screen containing detailed data concerning the intervention for that
particular request.

For example, clicking on Request ID 0400080905 brings up an Open Intervention
Detail page (i.e., Intervention for Regquest 0400080905).

Observe information displayed on the Open I ntervention Detail page.

The following items are displayed on the Open Intervention Detail page.
- User ID.

- email.

— Order ID.

- Request ID.

- Size(est, MB).

- MediaType.

- Priority.

- Explanation(s).

— Worked by.

- Created.

- Acknowledged.

- Status.

- User String:

— Worked by: dataentry field.
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10

— Assign New Worker button or Override Current Worker button.

— GranulelList: DBID; ESDT; Size (MB); Status; RESUBMIT (button);
Explanation; Action; Fail button(s) (if applicable).

— Request Attributes: Change Media to: option button; Change Priority to:
option button; Disable limit checking box; Update FtpPush Parameters box (if
applicable.

— Request Level Disposition: Keep on hold; Submit; Fail Request; Partition;
(Partition) Interval: d days h hours boxes.

— OPERATOR NOTES.

- Apply button.

- Reset button.

» Clicking on the Netscape browser Back button causes the Open I nter ventions page
to be redisplayed.

To work on the intervention being displayed on the Open Intervention Detail page,
perform the Respond to an Open Intervention procedure (Section 18.5.2.2).

To view the details of another open intervention first single-click on the Netscape
browser Back button then return to Step 4.

* The Open Intervention Detail page is dismissed.

* TheOpen Interventions page is displayed.

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?
Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:
* OK - todismissthe dialogue box and complete the log-out.
— The dialogue box is dismissed.
— The Netscape browser is dismissed.
» Cancd - to dismiss the dialogue box without logging out.
— Thedialogue box is dismissed.
- The OM GUI isdisplayed.
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Table 18.5-3. View Open Intervention Information on the OM GUI - Quick-Step

Procedures
Step What to Enter or Select Action to Take

1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 Request Management link (Order Manager single-click

Page [*Home” Page])
3 Open Interventions link single-click
4 Observe information displayed in the Listing read text

table of the Open Interventions page
5 <Request ID> (in the Listing table of the Open single-click

Interventions page)
6 Observe information displayed on the Open read text

Intervention Detail page
7 Work on the intervention (if appropriate) Use procedure in Section 18.5.2.2
8 Netscape browser Back button (if applicable) single-click
9 Return to Step 4 (if applicable)
10 |Log Out link (when applicable) single-click
11 | OK (when applicable) single-click

18.5.2.1 Set Refresh Options on OM GUI Pages

Buttons at the bottom of OM GUI pages provide the Distribution Technician (whether full-
capability or limited capability operator) with a means of setting refresh options. Table 18.5-4
presents (in a condensed format) the steps required to set refresh options on OM GUI pages. If
you are already familiar with the procedures, you may prefer to use the quick-step table. If you
are new to the system, or have not performed this task recently, you should use the detailed
procedures that follow.

Observe the AutoRefresh Control Panel at the bottom of the OM GUI page.
* One of the following AutoRefresh statuses is displayed:

- ON.
- OFF.

If applicable, single-click on the appropriate radio button in the AutoRefresh Control

Panel at the bottom of the OM GUI page.

» Thefollowing AutoRefresh options are available:

- on.
- off.
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* Itisuseful to “auto refresh” when working with current orders/requests that are
expected to change status at any time and it is desirable to see the new status right

away.

* Itisuseful to suspend refresh when alarge volume of orders/requestsis being
processed and it is desirable to preserve the orders/requests displayed on the current

screen.

To change the refresh rate (assuming AutoRefresh is ON), single-click on the Refresh
screen every X minutes option button to display a menu of numbers of minutes then

single-click on the desired selection.
» Thefollowing choices are available:
- 1L
- 5
- 10.
- 15
- 30.
- 45,
- 60.

» Selected number is displayed in the Refresh screen every x minutes window.

Return to the procedure that recommended setting refresh options on OM GUI pages.

Table 18.5-4. Set Refresh Options on OM GUI Pages - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Observe the AutoRefresh Control Panel read text
2 AutoRefresh option (i.e., on button or off button | single-click
on the AutoRefresh Control Panel) (if
applicable)
3 <minutes> (Refresh screen every x minutes single-click
option button) (if applicable)
4 Return to the procedure that recommended

setting refresh options on OM GUI pages

18.5.2.2 Respond to an Open Intervention

The Open Intervention Detail page provides the full-capability operator with a means of
performing the following kinds of interventions (limited-capability operators are not alowed to
work on open interventions):

» Select adifferent granule to replace agranule that is unavailable.

» Fail selected granule(s).
» Disablelimit checking.
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» Change the distribution medium for arequest.

* Resubmit arequest.

* Fail arequest.

» Partition (divide) arequest.
Table 18.5-5 presents (in a condensed format) the steps required to respond to an open
intervention. If you are already familiar with the procedures, you may prefer to use the quick-
step table. If you are new to the system, or have not performed this task recently, you should use
the detailed procedures that follow.

NOTE: The response to an intervention may require coordination between the
Distribution Technician and a User Services representative, especially when
determining a more suitable type of distribution medium, selecting a replacement
granule, or taking any other action that would require contacting the person who
submitted the order. In fact, depending on the circumstances and DAAC policy it
may be appropriate for User Services to assume responsibility for the eventual
disposition of some interventions.

1 Observe the information displayed in the Wor ked by column of the Open Intervention
Detail page.
» If the Open Intervention Detail pageis not being displayed on the OM GUI, goto
the View Open Intervention Information on the OM GUI procedure

(Section 18.5.2).

» |If someoneisalready working on the intervention, that person isidentified in the

Worked by: field of the Open Intervention Detail page.

— In genera working on an intervention isleft to the person who has already been
signed up to work on it unless the change is coordinated with that person or they
are going to be unavailable (e.g., due to illness or vacation).

* If necessary (e.g., dueto illness, vacation, or prior coordination), it is possible to
override the assignment of a person to work on an intervention.

2 To assign oneself to work on the intervention, on the Open I ntervention Detail page in
the Worked by: text entry box enter:

<name>

-or -

<user 1D>

» If necessary, overwrite the ID of the previously assigned person.

3 To continue the process of assigning oneself to work on the intervention, single-click on
the Assign New Worker button or Override Current Worker button (as applicable).
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If no granulein the request isto be “failed” or if al granulesin the request are to be
“failed,” skip Steps 5 through 10 and go to Step 11.

If agranuleisto bereplaced (e.g., because of an “Invalid UR/Granule Not Found” entry
in the Explanation column of the Granule List), in the DBID text box enter:

<Database | D>

* TheDBID for areplacement granule can be determined by doing a search using the
EDG.

To continue the process of specifying areplacement granule, single-click on the Apply
button associated with the DBID.
» A diaogue box is displayed to confirm the change to the granule.

To continue the process of specifying a replacement granule, single-click on the
appropriate button from the following selections:
* OK - to confirm the specification of areplacement granule and dismiss the dialogue
box.
— The dialogue box is dismissed.
— The Open Intervention Detail pageis displayed.
» Cance - to dismiss the dialogue box without specifying a replacement granule.
— The dialogue box is dismissed.
— The Open Intervention Detail pageis displayed.

If agranuleisto be“failed” (e.g., because of an “Invalid UR/Granule Not Found” entry
in the Explanation column of the Granule List), single-click on the Fail button in
Action column of the row for the granule in the Granule List.

» A diaogue box is displayed to confirm the change to the granule.

NOTE: “Failing” agranuleis a permanent action and cannot be canceled after having

10

been confirmed.

To continue the process of failing a granule, single-click on the appropriate button from
the following selections:
* OK - to confirm the failure of the granule and dismiss the dialogue box.
— Thedialogue box is dismissed.
— The Open Intervention Detail pageis displayed.
» Cancd - to dismiss the dialogue box without failing the granule.
— The dialogue box is dismissed.
— The Open Intervention Detail pageis displayed.

Repeat Steps 5 through 9 (as necessary) to replace or fail any additional granules.
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11

12

13

14

15

16

If limit checking should be disabled, single-click on the Disable limit checking box.

» If the Disable limit checking attribute is sel ected and subsequently applied, the
request size limit checking is disabled.

» TheDisablelimit checking option makes it possible to override the standard media
capacity limits for a particular mediatype and is most likely to be applied to anon-
physical mediatype (i.e., ftp push or ftp pull).

» TheDisable limit checking option should be used for unusually large requests only.

If the distribution medium should be changed, single-click on the Change M edia to: box

to display a menu of mediathen single-click on the desired selection.

» Thefollowing choices are available: - -, FtpPull, FtpPush, CDROM, DL T, DVD,
8MM, scp.

» Selected medium is displayed in the Change M edia to: box.

If the priority of the request should be changed, single-click on the option button

associated with the Change Priority to: box to display a menu of priorities then single-

click on the desired selection.

» Thefollowing choices may be available (the current priority will not be listed): - -,
LOW, NORMAL, HIGH, VHIGH, XPRESS.

» Selected priority is displayed in the Change Priority to: box.

If the ftp push parameters should be changed, single-click on the Update FtpPush
Par ameter s box.
* The Update FtpPush Parameter s option appears when applicable (i.e., when the
current distribution medium for the request is ftp push).
— The Update FtpPush Parameter s option provides a means of editing the existing
ftp push information when the intervention is closed.

If anote should be entered concerning the request, in the OPERATOR NOTES text box
enter:

<text>

» For example, the note may explain the reason for resubmitting the request.

To select the disposition for the request single-click on the appropriate button from the

following selections:

» Keep on hold - to delay applying any intervention action (keep the intervention open)
and dismiss the Open Intervention Detail page.

— Placing an intervention on hold does not allow changing the request’s attributes,
but saves the operator notes and allows opening the intervention at alater time
(essentialy, the intervention is being “ saved”).

» Submit - to apply the intervention actions (if any) specified in the Granule List and

Request Attributes sections of the Open Intervention Detail page and dismiss the

Open Intervention Detail page.
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» Fail Request - to fail the entire request (including all granules) and dismiss the Open
Intervention Detail page.

» Partition - to start the process of partitioning a request that exceeds maximum
reguest size.

17 If the Partition button was selected in the preceding step and distribution of the granules
should be spread over a period of time, in the corresponding text box(es) enter:

<number of days>

<number of hours>

NOTE:

There are Apply and Reset buttons at the bottom of the Open Intervention
Detail page. The Reset button does not cancel any changes made to the request
or changes made to the DBIDs (changed or failed). It simply resets the form
buttons for the Request L evel Disposition section to their original states.

18 Single-click on the Apply button.
* A Close Confirmation pageis displayed.

The Close Confirmation page displays the actions to be taken; for example, the
following types of actions may be listed: Disposition [e.g., keep on hold, submit,
fail, or partition], Limit Checking Disabled [yes, no, or blank], New Media [no,
yes. (type), or blank], New Priority [no, yes:. (type), or blank].

If the intervention involved changing the medium from an electronic medium to a
physical medium, text boxes for entering the following types of shipping
information are displayed on the Close Confirmation page: Address 1,

Address 2, Address 3, City, State/Province, Country, Zip/Postal Code,

If the intervention involved changing the medium to ftp push or updating the ftp
push parameters, text boxes for the following ftp push parameters are displayed
on the Close Confirmation page: Ftp node [Destination host name], Ftp
Address [FTP user name], Password, Confirm Password, User String [message
to be sent to the user], Destination Directory [full path].

If it was necessary to fail arequest or granule(s) within arequest, the Close
Confirmation page includes options for either appending additional text to the
default e-mail message to be sent to the requester or choosing not to send an
e-mail message to the requester. An Additional e-mail text text box for
appending text (if desired) to the standard e-mail text is displayed on the Close
Confirmation page; aDon’t send e-mail box to suppress the sending of an
e-mail message is displayed on the Close Confirmation page.
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20

21

22

23

If the intervention involved changing the medium from an electronic medium to a
physical medium, in the corresponding text boxes enter:

<Address 1>
<Address 2>
<Address 3>
<City>
<State/Province>
<Country>

<Zip/Postal Code>

If the intervention involved changing the medium to ftp push or updating the ftp push
parameters, perform the Edit FtpPush Parameter s procedure (Section 18.5.3.4).

If the intervention involved failing arequest or granule(s) within arequest, partitioning a
request, or modifying the granules in arequest, and additional text isto be appended to
the corresponding standard e-mail text, in the Additional e-mail text text box on the
Close Confirmation page enter:

<text>

If the intervention involved failing arequest or granule(s) within arequest, partitioning a

request, or modifying the granulesin arequest, and no e-mail message is to be sent,

single-click on the Don’t send e-mail box on the Close Confirmation page to suppress

the sending of an e-mail message indicating request/granule failure.

* Unlessthe Don’'t send e-mail box is checked, an e-mail message indicating
request/granul e failure will be sent to the requester.

Single-click on the appropriate button from the following selections:
* OK -to apply the specified intervention actions (if any) and dismiss the Close
Confirmation page.
— The Close Confirmation page is dismissed.
— AnIntervention Closed pageisdisplayed
» Cancd - to dismiss the Close Confirmation page without applying the specified
intervention actions.
— The Close Confirmation page is dismissed.
— A warning dialogue box is displayed with the message “WARNING: The
disposition and actions you have taken for thisintervention will be lost.
Continue?’
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25

26

27

If awarning dialogue box is displayed with the message “WARNING: The disposition
and actions you have taken for this intervention will belost. Continue?’ single-click on
the appropriate button from the following selections:
* OK - todismissthe warning dialogue box and the Close Confirmation page and
return to the Open Inter vention Detail page.
» Cance - to dismiss the warning dialogue box and return to the Close Confirmation

page.

To exit from the I ntervention Closed page, click on the OK button.
* Thelntervention Closed pageis dismissed.

* TheOpen Interventions page is displayed.

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?

Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate

button from the following selections:

* OK - todismissthe dialogue box and complete the log-out.

— The dialogue box is dismissed.
— The Netscape browser is dismissed.

» Cancd - to dismiss the dialogue box without logging out.

— The dialogue box is dismissed.
— The OM GUI isdisplayed.

Table 18.5-5. Respond to an Open Intervention - Quick-Step Procedures (1 of 2)

Step What to Enter or Select Action to Take

1 Observe the information displayed in the Worked | read text
by column

2 <name> (or <user ID>) enter text

3 Assign New Worker button or Override Current | single-click
Worker button (as applicable)

4 <Database ID> (DBID text box) (if applicable) enter text

5 Apply button (if applicable) single-click

6 OK button (if applicable) single-click

7 Fail button (in Action column of the row for the single-click
granule) (if applicable)

8 OK button (if applicable) single-click

9 Repeat Steps 4 through 8 (as necessary)

10 | Disable limit checking box (if applicable) single-click
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Table 18.5-5. Respond to an Open Intervention - Quick-Step Procedures (2 of 2)

Step What to Enter or Select Action to Take

11 | <medium> (Change Media to: option list) (if single-click
applicable)

12 | <priority> (Change Priority to: option list) (if single-click
applicable)

13 | Update FtpPush Parameters box (if applicable) | single-click

14 | <text> (OPERATOR NOTES text box) (if enter text
applicable)

15 | Keep on hold button (if applicable) single-click

16 | Submit button (if applicable) single-click

17 | Fail Request button (if applicable) single-click

18 | Partition button (if applicable) single-click

19 | <number of days> (day(s) text box) (if enter text
applicable)

20 | <number of hours> (hours text box) (if enter text
applicable)

21 | Apply button single-click

22 | <Address 1> (Address 1 text box) (if applicable) | enter text

23 | <Address 2> (Address 2 text box) (if applicable) | enter text

24 | <Address 3> (Address 3 text box) (if applicable) | enter text

25 | <City>( City text box) (if applicable) enter text

26 | <State/Province> (State/Province text box) (if | enter text
applicable)

27 | <Country> (Country text box) (if applicable) enter text

28 | <Zip/Postal Code> (Zip/Postal Code text box) |enter text
(if applicable)

29 | Edit FtpPush parameters (if applicable) Use procedure in Section 18.5.3.4

30 | <text> (Additional e-mail text text box) (if enter text
applicable)

31 | Don’t send e-mail button (if applicable) single-click

32 | OK button (to dismiss the Close Confirmation single-click
page)

33 | OK button (to dismiss the warning dialogue box) | single-click
(if applicable)

34 | OK button (to exit from the Intervention Closed |single-click
page) (when applicable)

35 | Log Out link (when applicable) single-click

36 | OK (to complete logging out) (when applicable) single-click
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18.5.3 Monitor/Control Distribution Request Information on the OM GUI

The following three OM GUI pages provide the full-capability operator with a means of viewing
distribution request information on the OM GUI and a means of taking actions with respect to
distribution requests:

» Distribution Requests page.
e Staging Distribution Requests page.
» FtpPush Distribution Requests page.

The pages allow the full-capability operator to take the following kinds of actions with respect to
distribution requests:

» Changethe priority of adistribution request while granules for the request still need
to be staged or while granules for the request still need to be pushed.

* Resubmit arequest in aterminal state (e.g., aborted, cancelled, terminated, or
shipped).

»  Suspend arequest that still needs to be staged or while granules for the request still
need to be pushed.

* Resume arequest that was suspended by the OM GUI operator or while the
processing of new requests by the OMS is suspended.

» Cancel arequest that isnot in aterminal state and while granules for the request still
need to be staged or pushed.

The limited-capability operator can use the Distribution Requests page to view distribution
request information but is not allowed to take action on distribution requests.

Table 18.5-6 presents (in a condensed format) the steps required to monitor/control distribution
request information on the OM GUI. If you are already familiar with the procedures, you may
prefer to use the quick-step table. If you are new to the system, or have not performed this task
recently, you should use the detailed procedures that follow.

1 If it isnot already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
* TheOrder Manager GUI isdisplayed.

2 If it has not been expanded already, single-click on the Request M anagement link in the
navigation frame of the OM GUI.
* TheRequest Management menu is expanded.

3 Click on the Distribution Requests link in the navigation frame of the OM GUI.
» TheDistribution Requests page is displayed.
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* TheCurrent Filters areaof the Distribution Requests page describes how the
current listing of distribution requests has been filtered.

It isimportant to check the filter settings when opening any of the distribution
reguests pages because changes to the filter settings tend to persist, even from one
session to another.

To filter the Distribution Requests Listing in adifferent way, perform the Filter
Data Displayed on the Distribution Requests Pages procedure

(Section 18.5.3.1).

» The Options area of the Distribution Requests page has the following buttons:

Change Filter [refer to the Filter Data Displayed on the Distribution Requests
Pages procedure (Section 18.5.3.1)].

Either Suspend New Requests or Resume New Requests (as applicable) [refer
to Steps 7 and §].

* TheListing table has the following columns:

Ord Typ/Prc Mod [Order Type/Processing Mode] [Order typesinclude
“Regular” and “BO” (Bundling Order). Processing mode is either “ S3”
(Synergy I11) or “S4” (Synergy 1V). Processing mode appears only when the
request mode is different from the current OM S mode.]

OrderID.

RequestiD.

Request Size (MB).

Gran Cnt [Granule Count].

Media.

Priority.

Request Status.

ESDT.

UserlD.

Resub Cnt [Resubmit Count].

Created.

Last Update.

Actions[Actions (e.g., Resubmit, Cancel, Suspend, or Resume) for which the
request is eligible.].

4 Observe information displayed in the Listing table of the Distribution Requests page.
* The Show rows at a time window provides a means of selecting the maximum
number of rows of data to be displayed at atime.

For example, if Show rowsat atimeis being displayed, selecting 50 from
the option button would result in the display of a page of data containing up to 50
rows of data

* Single-clicking on alink in the column header row of the table causes table contents
to be sorted on that column.

For example, clicking on the Created link causes the table to be organized by
date, with the most recent distribution request in the top row of the table.
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Single-clicking on a specific Order ID or Request ID brings up a screen containing
more detailed data concerning that particular order or request.

For example, clicking on Order ID 0400078765 brings up an ECS Order page
(i.e., ECS ORDER 0400078765) that displays the following types of data
concerning the order: Request 1D(s), Order Type, Order Source, Receive Date,
Last Update, Description, Start Date, User ID, Status, Ship Date, Order Home
DAAC.

If the order is a bundling order (Order Type “Bundled Order” or “BO”), the ECS
Order pageincludes alink to the Spatial Subscription Server GUI.

Clicking on the Netscape browser Back button causes the Request M anagement
page Distribution Requests page to be redisplayed.

For example, clicking on Request 1D 0400083900 brings up a Distribution
Request Detail page (i.e., DISTRIBUTION REQUEST 0400083900) that
displays the following types of data concerning the request: UserID; E-mail;
Request Size (MB); # Granules; # Granules Staged; # Granules FTP Pushed;
Receive Date/Time; Start Date/Time; Last Update; End Date/Time; Orderld;
Order Type; Ext. Requestld; Priority; Request Status; Destination; Edit FtpPush
Parameters [button]; Resubmit Count; Media Type; Resource Class; [Action
button(s) (e.g., Resubmit, Cancel, Suspend, and/or Resume)]; Mailing Address:
Title; First Name; Middle Name; Last Name; Email; Organization; Address; City;
State/Province; Country; Zip/Postal code; Telephone; Fax; Shipping Address:
Title; First Name; Middle Name; Last Name; Email; Address; City;
State/Province; Country; Zip/Postal code; Telephone; Fax; Billing Address: Title;
First Name; Middle Name; Last Name; Email; Organization; Address; City;
State/Province; Country; Zip/Postal code; Telephone; Fax; Granule List: DB ID;
DPL ID; ESDT; Size (MB); Granule Status; Completion Time; Explanation.

Single-clicking on a specific User ID brings up a screen that shows user profile
information for that user, including the following types of data:

Contact Information: Name, E-Mail Address, Organization, User ID, User
Verification Key, Affiliation, Project, Home DAAC, Primary area of study,
Account Information, Date created, Expiration date, Privilege level, NASA user,
Access privilege, VO Gateway user type, VO Gateway category.

Contact Address: Address, City, State/Province, Country, Zip/Postal code,
Telephone, Fax.

DAR [Data Acquisition Request] Information: Aster category, DAR
expedited data, Shipping Address, Title, First Name, Middle Initial, Last Name,
Email, Address, City, State/Province, Country, Zip/Postal code, Telephone, Fax.
Billing Address [Same fields as Shipping Address]

Horizontal and vertical scroll bars appear when necessary to allow viewing data that
are not readily visible in the window.
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* If AutoRefresh isON, the Distribution Requests page refreshes automatically as
often as specified in the Refresh screen every x minutes window.
- If adifferent refresh option is preferred, perform the Set Refresh Optionson OM
GUI Pages procedure (Section 18.5.2.1).
* To manually update (refresh) the data on the screen, click on the Reload Page link.
* The Netscape browser Edit — Find in Page menu provides a means of performing a
keyword search of the data currently being displayed on the screen.
* Thefirst, previous, next, and last links provide means of displaying additional pages
of data.
* TheGodirectly to row... window provides a means of displaying a page of data
starting with a particular row of the table.
— For example, if Go directly torow of 415 rows is being displayed, typing
315 in the window and clicking on the ok button would result in the display of a
page of data containing rows 315 through 364.

If the list of distribution requests shown in the Listing table of the Distribution Requests
page needs to be filtered (e.g., arequest to be viewed is not listed in the table), filter the
data.

» For detailed instructions refer to the Filter Data Displayed on the Distribution
Requests Pages procedure (Section 18.5.3.1).

Observe information displayed in the Listing table of the Distribution Requests page.

To suspend all new distribution requests (when applicable), single-click on the Suspend

New Requests button in the Options area of the Distribution Requests page.

* The Suspend New Requests button changes to a Resume New Requests button
when new reguests have been suspended.

» The Suspend New Requests button should be visible only when new requests are not
already being suspended.

To resume processing of new requests (when applicable), single-click on the Resume

New Requests button in the Options area of the Distribution Requests page.

* TheResume New Requests button changes to a Suspend New Requests button
when new reguests have been resumed.

* The Resume New Requests button should be visible only when new requests are
currently being suspended.

To change the priority of adistribution request (when applicable), perform the Change

the Priority of a Distribution Request Using the OM GUI procedure
(Section 18.5.3.2).
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To either suspend a distribution request or resume processing of a suspended request
(when applicable), perform the Suspend, Resume, Cancel, or Resubmit a Distribution
Request Using the OM GUI procedure (Section 18.5.3.3).

To cancel adistribution request (when applicable), perform the Suspend, Resume,
Cancd, or Resubmit a Distribution Request Using the OM GUI procedure
(Section 18.5.3.3).

To review and/or respond to an open intervention for a particular distribution request first
single-click on the Open Intervention link in the Request Status column for the request
inthe Listing table.

To review and/or respond to an open intervention go to the procedure View Open
Intervention Information on the OM GUI procedure (Section 18.5.2).

To reprocess a distribution request that has failed, been cancelled, or been shipped (when
applicable), perform the Suspend, Resume, Cancel, or Resubmit a Distribution
Request Using the OM GUI procedure (Section 18.5.3.3).

To edit ftp push parameters for a particul ar distribution request (when applicable),
perform the Edit FtpPush Parameter s procedure (Section 18.5.3.4).

To view operator alerts, perform the View Operator Alertson the OM GUI procedure
(Section 18.5.4).

To view the Staging Distribution Requests page, first (if it has not been expanded
already) single-click on the FtpPush Monitor link in the navigation frame of the OM
GUI.

* TheFtpPush Monitor menu is expanded (as applicable).

To view the Staging Distribution Requests page single-click on the Staging Requests

link in the navigation frame of the OM GUI.

» The Staging Distribution Requests pageis displayed.

» The Staging Distribution Requests page displays the same types of information (for
each request in the list) and has the same kinds of links as the Distribution Requests
page; however, the Staging Distribution Requests page has a couple of differences:
— The Resour ce Class column shows each request’ s archive resource demand in

terms of one of the following values: C [Cheap], M [Moderate], E [Expensive].

— Sorting the table by Resour ce Class (by clicking on the Resour ce Class column
header) provides a convenient way to determine which request(s) is (are) having
the most significant effects on archive resources. That may lead to suspending or
canceling certain requests.
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- The Gran Cnt/Staging Complete column shows the number of granules
associated with the request and the number of granules that have completed

staging.

To view the FtpPush Distribution Requests page, first (if it has not been expanded
aready) single-click on either Request M anagement or the FtpPush Monitor link in
the navigation frame of the OM GUI.

* TheRequest Management or FtpPush Monitor menu is expanded (as applicable).

To view the FtpPush Distribution Requests page single-click on the FtpPush

Distribution Requestslink in the navigation frame of the OM GUI.

» TheFtpPush Distribution Requests page is displayed.

» TheFtpPush Distribution Requests page displays the same types of information
(for each request in the list) and has the same kinds of links as the Distribution
Requests page; however, there are several differences:

— Thereisno Media column (all requests use the same type of medium — ftp push).

— The Destination column shows the name of the destination.

— The Gran Cnt/FtpPush Complete column shows the number of granules
associated with the request and the number of granules that have completed ftp
push.

— The Resour ce Class column shows each request’ s archive resource demand (as
on the Staging Distribution Requests page).

» Tofilter thelist of distribution requests shown in the Listing table of the FtpPush
Distribution Requests page perform the Filter Data Displayed on the Distribution
Requests Pages procedure (Section 18.5.3.1).

If thereisan OM GUI failure, perform the applicable procedure(s) in the
Troubleshooting DDIST and Order Manager GUI Problems section (Section 18.6).

Repeat Steps 4 through 21 as necessary to monitor distribution requests.

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?
Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:

* OK - todismissthe dialogue box and complete the log-out.
— The dialogue box is dismissed.
— The Netscape browser is dismissed.
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Table 18.5-6. Monitor/Control Distribution Request Information on the OM GUI -

» Cancd - to dismiss the dialogue box without logging out.

— The dialogue box is dismissed.
— The OM GUI isdisplayed.

Quick-Step Procedures (1 of 2)

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 Request Management link (if necessary) single-click
3 Distribution Requests link single-click
4 Observe information displayed in the Listing read text
table of the Distribution Requests page
5 Filter the data displayed in the table (if necessary) | Use procedure in Section 18.5.3.1
6 Observe information displayed in the Listing read text
table of the Distribution Requests page
7 Suspend New Requests button (if suspending single-click
new requests)
8 Resume New Requests button (if resuming new | single-click
requests)
9 Change the priority of a distribution request Use procedure in Section 18.5.3.2
(when applicable)
10 | Suspend a distribution request or resume Use procedure in Section 18.5.3.3
processing of a suspended request (when
applicable)
11 | Cancel a distribution request (when applicable) Use procedure in Section 18.5.3.3
12 | Open Intervention link (when applicable) single-click
13 | Review and/or respond to an open intervention Use procedure in Section 18.5.2
(when applicable)
14 | Reprocess a distribution request that has failed, Use procedure in Section 18.5.3.3
been cancelled, or been shipped (when
applicable)
15 | Edit ftp push parameters for a particular Use procedure in Section 18.5.3.4
distribution request (when applicable)
16 | View operator alerts (when applicable) Use procedure in Section 18.5.4
17 | FtpPush Monitor link (to view the Staging single-click
Distribution Requests page) (when applicable)
18 | Staging Requests link (to view the Staging single-click
Distribution Requests page) (when applicable)
19 | Either Request Management or the FtpPush single-click

Monitor link (to view the FtpPush Distribution
Requests page) (when applicable)
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Table 18.5-6. Monitor/Control Distribution Request Information on the OM GUI -

Quick-Step Procedures (2 of 2)

Step

What to Enter or Select Action to Take

20 | FtpPush Distribution Requests link (to view the | single-click

FtpPush Distribution Requests page) (when
applicable)

21 | Troubleshoot OM GUI failure (when applicable) Use applicable procedure(s) in Section 18.6

22 | Repeat Steps 4 through 21 (as necessary)

23 | Log Out link (when applicable) single-click
24 | OK button (to complete logging out) (when single-click
applicable)

18.5.3.1 Filter Data Displayed on the Distribution Requests Pages

The Change Filter buttons in the Options area of the Distribution Requests page, Staging
Distribution Requests page, or the FtpPush Distribution Requests page provide the
Distribution Technician (whether full-capability or limited capability operator) with a means of
filtering data displayed on the screen.

Table 18.5-7 presents (in a condensed format) the steps required to filter data displayed on the
Distribution Requests page, Staging Distribution Requests page, or the FtpPush
Distribution Requests page. If you are already familiar with the procedures, you may prefer to
use the quick-step table. If you are new to the system, or have not performed this task recently,
you should use the detailed procedures that follow.

NOTE:

NOTE:

By default, distribution requests are filtered by “creation time” within the last 24
hours, all statuses, and all mediatypes. However, changes made to the filter
settings tend to persist, even from one session to another. To restore the default
filtering criteriasingle-click on the Apply Defaults button in the filter pop-up
window.

The session ID provides a means of tracking which GUI pages are accessed and
what filter options are used during a particular session. Such datais especialy
important when several operators are using the OM GUI in the same mode at the
sametime. For example, an individual operator’s previously selected filter
options can be retrieved from the session data so the filter options do not have to
be reentered every time the same type of search is performed.

Single-click on the Change Filter button in the Options area of the Distribution
Requests page, Staging Distribution Requests page, or the FtpPush Distribution
Requests page.

A Distribution Requests Filters pop-up window is displayed.

18-89 611-EMD-001




» The Distribution Requests Filters pop-up window contains fields for changing various
filters.

— TheDistribution Requests Filters, Staging Distribution Requests Filters, and
FtpPush Distribution Requests Filter s pop-up windows are similar except the
FtpPush Distribution Requests Filter s pop-up window has no Media Type
Select List window (because al requests on the page are ftp push requests).

NOTE: The pop-up window may not open enough to display all of the features of the
filters. If the three buttons (i.e., Set Defaults, Apply Defaults, and Close
Window) at the bottom of the window are not visible, single-click and hold on
one of the bottom corners of the window and pull down with the mouse to expand
the window and reveal the buttons.

2 If the distribution request(s) associated with a particular Individual Filter only should be
displayed on the Distribution Requests page, Staging Distribution Requests page, or
the FtpPush Distribution Requests page, in the corresponding text box enter:

<Order I1D>
<Request | D>
<E-Mail>
<First Name>

<Last Name>

* Thefollowing text boxes are available for Individual Filters: Order ID, Request ID,
E-Mail, First Name, L ast Name.
» If avalueisentered in one of the text boxes in the preceding list, the other four text
boxes are disabled.
— Toclear afield in which avalue has been entered and enable all fields, either
delete the entered value or single-click on the Clear button.

3 If avalue was entered in one of the text boxesin Step 2, single-click on the Apply
Individual Filters button.
» TheDistribution Requests page, Staging Distribution Requests page, or the
FtpPush Distribution Requests page refreshes.
» Only requests that meet the specified filter criteria appear in the Listing table.

NOTE: Whenever Combined Filters are applied, Status and Media Type options must be
specified (except for the FtpPush Distribution Requests page filter, which has
no Media Type filter because ftp push is assumed).
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If the relevant distribution request(s) has (have) creation time outside the range indicated

inthe Start Month, Start Day, Start Year, Start Hour, Start Minute, End Month,

End Day, End Year, End Hour, and End Minute boxes, as necessary single-click on

each date/time option button to display a drop-down list of month, day, year, hour, or

minute options then single-click on the desired selection.

» Selected number is displayed in each date/time box.

» Filtering by “Creation Time” may be combined with other filtering options (refer to
Steps 5 through 8).

If distribution requests with particular status(es) only should be displayed on the
Distribution Requests page, Staging Distribution Requests page, or the FtpPush
Distribution Requests page, single-click on the desired status(es) in the Status Select
List window to highlight or unhighlight them (while holding down either the Shift key or
the Ctrl key if highlighting multiple selections).

» Toquickly deselect al highlighted statuses, single-click on the Status Select — None
button (clears all selections so individual statuses can be selected).

* Toquickly select all statuses, single-click on the Status Select — All button (all items
are highlighted).

» Thefollowing choices are available: Abort, Aborted, Active, Bundling, Canceled,
Cancelled, Expired, Not Found, Operator Intervention, Partitioned, Pending,
Prep for Distribution, Queued, SDSRV Staging, Shipped, Subset Staging,
Staging, Subsetting, Terminated, Transferring, Waiting for Shipment.

» Selected status(es) is (are) highlighted in the Status Select List window; undesired
status(es) is (are) not highlighted in the Status Select List window.

* Toquickly deselect al highlighted statuses, single-click on the Status Select — None
button.

* Toquickly select all statuses, single-click on the Status Select — All button.

* A vertical scroll bar allows viewing data that are not readily visible in the Status
Select List window.

» Filtering by “ Status” may be combined with other filtering options (refer to Steps 4

through 8).

—  Whenever Combined Filters are applied, Status and Media Type options must be
specified (except for the FtpPush Distribution Requests page filter, which
requires no Media Type because ftp push is assumed).

If al filtering criteria have been selected, go to Step 8.

If distribution requests for particular type(s) of medium only should be displayed on the

Distribution Requests page or the Staging Distribution Requests page, single-click on

the desired medium/mediain the Media Type Select List window to highlight or

unhighlight them (while holding down either the Shift key or the Ctrl key if highlighting

multiple selections).

» Toquickly deselect al highlighted media, single-click on the Media Type Select —
None button (clears all selections so individual media can be selected).
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» Toquickly select all media, single-click on the M edia Type Select — All button (all
items are highlighted).

» Thefollowing Media Type choices are available: FtpPull, FtpPush, CDROM, DLT,
DVD, 8MM, scp [secure copy distribution].

» Selected medium/mediais (are) highlighted in the Media Type Select List window;
undesired medium/mediais (are) not highlighted in the Media Type Select List
window.

* A vertical scroll bar allows viewing datathat are not readily visiblein the M edia
Type Select List window.

» Filtering by “Media Type” may be combined with other filtering options (refer to

Steps 4 through 8).

—  Whenever Combined Filters are applied, Status and Media Type options must be
specified (except for the FtpPush Distribution Requests page filter, which
requires no Media Type because ftp push is assumed).

If al filtering criteria have been selected, go to Step 8.

If the distribution requests associated with a particular User 1D only should be displayed
on the Distribution Requests page, Staging Distribution Requests page, or the
FtpPush Distribution Requests page, in the User 1D text box enter:

<User ID>

If value(s) was (were) specified for any of the filtersin Steps 4 through 7, single-click on

the Apply Combined Filter s button.

» TheDistribution Requests page, Staging Distribution Requests page, or the
FtpPush Distribution Requests page refreshes.

* Only requests that meet the specified filter criteria appear in the Listing table.

When all relevant filtering criteria have been applied (as described in Steps 2 through 8),
single-click on the Close Window button.
» TheDistribution Requests Filterswindow is dismissed.

Return to the procedure that recommended filtering data displayed on the Distribution
Requests pages.

Table 18.5-7. Filter Data Displayed on the Distribution Requests Pages - Quick-

Step Procedures (1 of 2)

Step What to Enter or Select Action to Take
1 Change Filter button single-click
2 <Order ID> (Order ID text box) (if applicable) enter text
3 <Request ID> (Request ID text box) (if enter text
applicable)
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Table 18.5-7. Filter Data Displayed on the Distribution Requests Pages - Quick-
Step Procedures (2 of 2)

Step What to Enter or Select Action to Take
4 <E-Mail> (E-Mail text box) (if applicable) enter text
5 <First Name> (First Name text box) (if enter text
applicable)
6 <Last Name> (Last Name text box) (if enter text
applicable)
7 Apply Individual Filters button (if applicable) single-click
8 <date/time values> (Start Month, Start Day, single-click

Start Year, Start Hour, Start Minute, End
Month, End Day, End Year, End Hour, and End
Minute option buttons) (as applicable)

9 <status> (Status Select List option list) (if single-click
applicable)

10 | <medium> (Media Type Select List option list) | single-click
(if applicable)

11 | <User ID> (User ID text box) (if applicable) enter text

12 | Apply Combined Filters button (if applicable) single-click

13 | Close Window button (when applicable) single-click

14 | Return to the Monitor/Control Distribution Use procedure in Section 18.5.3

Request Information on the OM GUI procedure

18.5.3.2 Change the Priority of a Distribution Request Using the OM GUI

The Change the Priority of a Distribution Request Using the OM GUI procedure is
performed as part of the Monitor/Control Distribution Request Information on the OM GUI
procedure (Section 18.5.3). The priority of an S4 (Synergy 1V) request can be changed while
granules for the request still need to be staged or pushed.

The Priority column in the Distribution Requests table of the Distribution Requests page,
Staging Distribution Requests page, the FtpPush Distribution Requests page or the
Destination Details page on the OM GUI alows the full-capability operator to change the
priority of distribution requests that are in a state that allows the priority to be changed. The
Priority line of the Distribution Request Details page provides the full-capability operator with
an alternative means of changing the priority of the particular distribution request.

The limited-capability operator is not allowed to change the priority of distribution requests.

Table 18.5-8 presents (in a condensed format) the steps required to change the priority of a
distribution request using the OM GUI. If you are already familiar with the procedures, you may
prefer to use the quick-step table. If you are new to the system, or have not performed this task
recently, you should use the detailed procedures that follow.
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1 If thelist of distribution requests shown in the Distribution Requests table needs to be
filtered to include the distribution request for which the priority is to be changed, filter
the data.

» For detailed instructions refer to the Filter Data Displayed on the Distribution
Requests Pages procedure (Section 18.5.3.1).

2 Single-click on the option button in the Priority column of the row associated with the
request to display a menu of priorities then single-click on the desired selection.

» Selected priority is displayed in the Priority column.

* Anadternativeisto bring up the relevant Distribution Request Detail page (by
clicking on the Request ID in the Distribution Requests table), single-click on the
option button on the Priority line to display a menu of priorities, then single-click on
the desired selection.

3 To implement the priority change single-click on the Apply button adjacent to the text
box displaying the desired priority.
*  “Priority changed” isdisplayed in the Priority column for the row associated with the
request.

4 Repeat the preceding steps as necessary to change the priority of additional distribution
requests.

5 Return to the Monitor/Control Distribution Request | nformation on the OM GUI
procedure (Section 18.5.3).

Table 18.5-8. Change the Priority of a Distribution Request Using the OM GUI -
Quick-Step Procedures

Step What to Enter or Select Action to Take

1 Filter the data displayed in the Distribution Use procedure in Section 18.5.3.1
Requests table (if necessary)

2 <priority> (option button in the Priority column single-click
of the row associated with the request)

3 Apply button (adjacent to the text box displaying | single-click
the desired priority)

4 Repeat the preceding steps (to change the enter text
priority of additional distribution requests) (as
necessary)
5 Return to the Monitor/Control Distribution Use procedure in Section 18.5.3

Request Information on the OM GUI procedure

18-94 611-EMD-001




18.5.3.3 Suspend, Resume, Cancel, or Resubmit a Distribution Request Using
the OM GUI

The Action column in the Distribution Requests table of the Distribution Requests page,
Staging Distribution Requests page, the FtpPush Distribution Requests page, or the
Destination Details page on the OM GUI provides the full-capability operator with a means of
taking the following kinds of actions with respect to distribution requests:

» Suspend arequest that still needs to be staged or while granules for the request still
need to be pushed.
* Resume arequest that was suspended by the OM GUI operator or while the
processing of new requests by the OMS is suspended.
» Cancel arequest that isnot in aterminal state and while granules for the request still
need to be staged or while granules for the request still need to be pushed.
* Resubmit arequest in aterminal state (e.g., aborted, cancelled, terminated, or
shipped).
The Distribution Request Details page provides the full-capability operator with an alternative
means of taking the preceding kinds of actions with respect to a particular distribution request.

The limited-capability operator is not allowed to suspend, resume, cancel, or resubmit
distribution requests.

Table 18.5-9 presents (in a condensed format) the steps required to suspend, resume, cancel, or
resubmit a distribution request using the OM GUI. If you are aready familiar with the
procedures, you may prefer to use the quick-step table. If you are new to the system, or have not
performed this task recently, you should use the detailed procedures that fol low.

NOTE: If adistribution request is to be canceled or if acompleted distribution request is
to be resubmitted, proper justification and authorization are necessary. Canceling
or resubmitting requests may require coordination between the Distribution
Technician and a User Services representative, especialy when changing the type
of distribution medium, specifying a replacement granule, or taking any other
action that would require the approval of the person who submitted the order. In
fact, depending on the circumstances and DAAC policy it may be appropriate for
User Services to assume responsibility for canceling or resubmitting some
requests.

1 If the list of distribution requests shown in the Distribution Requests table needsto be
filtered to include the distribution request on which action is to be taken, filter the data.
» For detailed instructions refer to the Filter Data Displayed on the Distribution
Requests Pages procedure (Section 18.5.3.1).
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2

3

NOTE:

To suspend, resume, cancel, or resubmit a distribution request, single-click on the
appropriate button in the Action column for the row associated with the request.

The following choices are among those that may be available (buttons are available
only for actions that are appropriate for the request):

Suspend [request that still needs to be staged or granules for the request still need
to be pushed]; a Suspend Request dialogue box is displayed.

Resume [request that was suspended by the OM GUI operator or while the
processing of new requests by the OMS is suspended]; a Resume Request
Confirmation dialogue box is displayed.

Cancel [request that isnot in aterminal state and while granules for the request
still need to be staged or while granules for the request still need to be pushed]; a
Canced Request Confirmation dialogue box is displayed.

Resubmit [request in aterminal state (e.g., aborted, cancelled, terminated, or
shipped)]; a Resubmit Request Confirmation dialogue box is displayed.

An dternative isto bring up the relevant Distribution Request Detail page (by
clicking on the Request ID in the Distribution Requests table), then clicking on the
appropriate button.

If a Suspend Request dialogue box is displayed, single-click on the OK button:

The dialogue box is dismissed.

Theinitia page[i.e., the Distribution Requests page, Staging Distribution
Requests page, the FtpPush Distribution Requests page, or the Destination Details
page] is displayed.

“Suspended” is displayed in the Action column for the row associated with the
request.

The Resume Request Confirmation dialogue box or Cancel Request
Confirmation dialogue box may not open enough to display the buttons at the
bottom of the window. If the Apply...Action and Cancdl...Action buttons at the
bottom of the window are not visible, single-click and hold on one of the bottom
corners of the window and pull down with the mouse to expand the window and
reveal the buttons.

If aResume Request Confirmation dialogue box or Cancel Request Confirmation
dialogue box is displayed, in the Worker text box enter:

<name>

_Or_

<user ID>

<name> or <user | D> refersto either the name or user ID of the person making the
request to resume or cancel the request.
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If aResume Request Confirmation dialogue box or Cancel Request Confirmation
dialogue box is displayed, in the Reason for Action text box enter:

<reason=>

» <reason> isthejustification for resuming or canceling the request.

If aResume Request Confirmation dialogue box or Cancel Request Confirmation

dialogue box is displayed, single-click on the appropriate button from the following

selections:

* Apply [“Resume’ or “ Cancel”] Action - to apply the specified action and dismiss
the dialogue box.

— Theaction (i.e, “resume” or “cancel” as applicable) is applied.

— The dialogue box is dismissed.

— Theinitia page[i.e., the Distribution Requests page, Staging Distribution
Requests page, the FtpPush Distribution Requests page, or the Destination
Details page] is displayed.

— Theaction (i.e., “Resumed” or “Canceled”) is displayed in the Action column for
the row associated with the request.

» Canced [*Resume’ or “Cancel”] Action - to dismiss the dialogue box without
applying the specified action.

— The dialogue box is dismissed.

— Theinitia page[i.e., the Distribution Requests page, Staging Distribution
Requests page, the FtpPush Distribution Requests page, or the Destination
Details page] is displayed.

If aResubmit Request Confirmation dialogue box is displayed, first single-click on the
appropriate button from the following selections:
* OK - to create an open intervention and dismiss the dial ogue box.
— Thedialogue box is dismissed.
— The Open Intervention Detail (Intervention for Request x) page is displayed.
» Cancd - to dismiss the dialogue box without resubmitting the request.
— The dialogue box is dismissed.
— Theinitia page[i.e., the Distribution Requests page, Staging Distribution
Requests page, the FtpPush Distribution Requests page, or the Destination
Details page] is displayed.

If aResubmit Request Confirmation dialogue box was displayed and OK was clicked
in response to the Resubmit Request Confirmation dialogue box, respond to the open
intervention.

» For detailed instructions refer to the Respond to an Open Intervention procedure
(Section 18.5.2.2).
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9 Repeat the preceding steps as necessary to act on additional distribution requests.

10 Return to the Monitor/Control Distribution Request | nformation on the OM GUI
procedure (Section 18.5.3).

Table 18.5-9. Suspend, Resume, Cancel, or Resubmit a Distribution Request
Using the OM GUI - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Filter the data displayed in the Distribution Use procedure in Section 18.5.3.1
Requests table (if necessary)
2 Suspend button (in the Action column for the single-click

row associated with the request) (if applicable)

3 Resume button (in the Action column for the row | single-click
associated with the request) (if applicable)

4 Cancel button (in the Action column for the row | single-click
associated with the request) (if applicable)

5 Resubmit button (in the Action column for the single-click
row associated with the request) (if applicable)

6 OK button (in Suspend Request dialogue box) (if | enter text
applicable)

7 <name> (or <user ID>) (in the Worker text box) | enter text
(if applicable)

8 <reason> (in the Reason for Action text box) (if | enter text
applicable)

9 Apply Action (in Resume Request enter text
Confirmation dialogue box or Cancel Request
Confirmation dialogue box) (if applicable)

10 | OK (in Resubmit Request Confirmation enter text
dialogue box) (if applicable)

11 | Respond to the open intervention (if applicable) Use procedure in Section 18.5.2.2

12 | Repeat the preceding steps (to act on additional | enter text
distribution requests) (as necessary)

13 | Return to the Monitor/Control Distribution Use procedure in Section 18.5.3
Request Information on the OM GUI procedure

18.5.3.4 Edit FtpPush Parameters

The Edit FtpPush Parameters procedure is performed as part of other procedures [e.g.,
Respond to an Open Intervention (Section 18.5.2.2) or Monitor/Control Distribution
Request Information on the OM GUI (Section 18.5.3)].

The Edit FtpPush Parameters button on the Distribution Request Details page provides the
full-capability operator with a means of editing the FtpPush parameters for a particular
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distribution request. The limited-capability operator is not allowed to edit FtpPush parameters
for distribution requests using the OM GUI.

Table 18.5-10 presents (in a condensed format) the steps required to edit FtpPush parameters. |f
you are already familiar with the procedures, you may prefer to use the quick-step table. If you
are new to the system, or have not performed this task recently, you should use the detailed
procedures that follow.

1 If thelist of distribution requests shown in the Distribution Requests table needs to be
filtered to include the distribution request for which the FtpPush parameters are to be
changed, filter the data.

» For detailed instructions refer to the Filter Data Displayed on the Distribution
Requests Pages procedure (Section 18.5.3.1).

2 If the Edit FtpPush Parameter s page is not already open, single-click on the applicable
Request ID in the Distribution Requests table.
* The corresponding Distribution Request Detail page is displayed.

3 If the Edit FtpPush Parameter s page is not already open, single-click on the Edit
FtpPush Parameter s button on the Distribution Request Detail page.
* The Edit FtpPush Parameters page isdisplayed.

4 In the corresponding text boxes (as necessary) enter:
<Ftp node>

<Ftp Address>
<Passwor d>
<Confirm Passwor d>
<User String>

<Destination Directory>

» <Ftp node> isthe destination host name.

* <Ftp Address> isthe FTP user name.

* <User String> isamessage to be sent to the user.

» <Destination Directory> isthe full path to the target directory on the host.

5 Single-click on the appropriate button from the following selections:
* Change ThisRequest - to apply the specified FtpPush parameters to the current
request only and dismiss the Edit FtpPush Parameter s page.
— The Edit FtpPush Parameter s page is dismissed.
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» Change All Requests - to apply the specified FtpPush parametersto all requests for
the listed destination and dismiss the Edit FtpPush Parameters page.
— The Edit FtpPush Parameter s page is dismissed.

* Cancd - to cancel al changesto FtpPush parameters and dismiss the Edit FtpPush

Parameter s page.

— The Edit FtpPush Parameter s page is dismissed.

6 Return to the procedure that recommended editing the FtpPush parameters.
Table 18.5-10. Edit FtpPush Parameters - Quick-Step Procedures
Step What to Enter or Select Action to Take
1 Filter the data displayed in the Distribution Use procedure in Section 18.5.3.1
Requests table (if necessary)
2 <Request ID> (in the Distribution Requests single-click
table) (if necessary)
3 Edit FtpPush Parameters button (on the single-click
Distribution Request Detail page) (if necessary)
4 <Ftp node> (in the Ftp node text box) (if enter text
applicable)
5 <Ftp Address> (in the Ftp Address text box) (if | enter text
applicable)
6 <Password> (in the Password text box) (if enter text
applicable)
7 <Password> (in the Confirm Password text enter text
box) (if applicable)
8 <User String> (in the User String text box) (if enter text
applicable)
9 <Destination Directory> (in the Destination enter text
Directory text box) (if applicable)
10 | Change This Request button or Change All single-click
Requests button (as applicable)
11 | Return to the procedure that recommended

editing the FtpPush parameters.

18.5.4 View Operator Alerts on the OM GUI

“Alerts’ are non-fatal warnings or errors that do not cause an Operator Intervention, but do
provide valuable information concerning distribution resources. An example might be a
suspended FTP Push destination.

The Operator Alerts page provides the Distribution Technician (whether full-capability or
limited capability operator) with a means of viewing operator aerts. The following types of
operator aerts can be displayed:
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* FTP Push Destination Alerts (problems with the destination not sufficient to cause an
Operator Intervention).

» DataPool File System Alerts.

* Archive Server Alerts.

* ECS Server Alerts (warnings about SDSRV or PDS errors).

Table 18.5-11 presents (in a condensed format) the steps required to view operator alerts on the
OM GUI. If you are aready familiar with the procedures, you may prefer to use the quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
detailed procedures that follow.

1

If it is not already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
 TheOrder Manager GUI isdisplayed.

If it has not been expanded already, single-click on the Request Management link in the
navigation frame of the OM GUI.
* TheRequest Management menu is expanded.

Single-click on the Operator Alertslink in the navigation frame of the OM GUI.
* TheOperator Alerts pageisdisplayed.
* ThelListing table has the following columns:

- Alert Info.

- Explanation.

— Creation Time.

Observe information displayed in the Listing table of the Operator Alerts page.

» Thefollowing types of operator alerts are displayed on the Operator Alerts page:
— FTP Push Destination Alerts (problems with the destination not sufficient to

cause an Operator Intervention).
— Data Pool File System Alerts.
— Archive Server Alerts.
— ECS Server Alerts (warnings about SDSRV or PDS errors).

* By default all types of alerts are displayed in the Listing table on the Operator
Alerts page.

» Tofilter the Listing table in a different way, single-click on the option button
associated with the Display alerts box then single-click on the desired
selection.

— Thefollowing choices are available: ALL, Archive, Data Pool, FTP Push, PDS,
SDSRV.
— The selected filter is displayed in the Display alerts box.
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— The Operator Alerts pageisrefreshed and the filter is applied, so the specified
type(s) of alert(s) is (are) displayed in the Listing table on the Operator Alerts
page.

» Thelist of alertsis sorted in ascending order by date (i.e., the oldest Alerts appear
first).

e The Show rows at a time window provides a means of selecting the maximum
number of rows of datato be displayed at atime.

— For example, if Show rows at atimeis being displayed, selecting 50 from
the option button would result in the display of a page of data containing up to 50
rows of data

» Horizontal and vertical scroll bars appear when necessary to allow viewing data that
are not readily visible in the window.

* If AutoRefresh isON, the Operator Alerts page refreshes automatically as often as
specified in the Refresh screen every x minutes window.

- If adifferent refresh option is preferred, perform the Set Refresh Optionson OM
GUI Pages procedure (Section 18.5.2.1).

* To manualy update (refresh) the data on the screen, single-click on the Netscape
browser Reload button.

* The Netscape browser Edit — Find in Page menu provides a means of performing a
keyword search of the data currently being displayed on the screen.

* Thefirst, previous, next, and last links provide means of displaying additional pages
of data (if applicable).

» Thefollowing message is displayed at the bottom of the Operator Alerts page:

Note: All operator alertsare also sent as email to: address.

— To change the e-mail address for receiving operator aerts, single-click on the
Change link adjacent to the message and change the value of the Global
Configured Email parameter (for details refer to the procedure for
Checking/M odifying OM S Server or Database Parameters).

5 To view detailed information concerning the cause and/or requests affected by the aert,
single-click on the corresponding detailslink in the Alert Info column.
» A page describing the aert is displayed.

NOTE: Unlike an operator intervention, no specific action can be taken to close an aert.

The Order Manager Server automatically clears each aert when the condition(s)
that caused it go to a satisfactory state.

6 Repeat Steps 4 and 5 as necessary to view operator alerts.

7 Return to the procedure for Monitoring/Controlling Distribution Request I nfor mation
on the OM GUI (if applicable).
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To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?

Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate

button from the following selections:

* OK - todismissthe dialogue box and complete the log-out.

— The dialogue box is dismissed.
— The Netscape browser is dismissed.

» Cancd - to dismiss the dialogue box without logging out.

— The dialogue box is dismissed.
— The OM GUI isdisplayed.

Table 18.5-11. View Operator Alerts on the OM GUI - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 Request Management link single-click
3 Operator Alerts link single-click
4 Observe information displayed in the Listing read text
table of the Operator Alerts page

5 details link in the Alert Info column (if applicable) | single-click

6 Repeat Steps 4 and 5 (as necessary)

7 Return to the Monitor/Control Distribution Use procedure in Section 18.5.3
Request Information on the OM GUI procedure
(if applicable)

8 Log Out link (when applicable) single-click

9 OK button (to complete logging out) (when single-click

applicable)

18.5.5 View Completed Intervention Information on the OM GUI

The Completed Interventions page provides the Distribution Technician (whether full-
capability or limited capability operator) with a means of viewing completed intervention
information on the OM GUI.

Table 18.5-12 presents (in a condensed format) the steps required to view completed intervention
information on the OM GUI. If you are already familiar with the procedures, you may prefer to
use the quick-step table. If you are new to the system, or have not performed this task recently,
you should use the detailed procedures that follow.
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If it isnot already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
* TheOrder Manager GUI isdisplayed.

If it has not been expanded already, single-click on the Request Management link in the
navigation frame of the OM GUI.
* TheRequest Management menu is expanded.

Single-click on the Completed Interventionslink in the navigation frame of the OM
GUI.
* TheCompleted Interventions page is displayed.
* TheListing table has the following columns:

— Order Id.

- Reguest Id.

- User ID.

- Size (MB).

- Media.

- Worked by.

- Created.

- Completed.

— Disposition.

Observe information displayed in the Listing table of the Completed I nterventions
page.
* By default, data concerning up to 50 requests with completed interventions (and

“completion time” within the last 24 hours) are displayed at atime.

— Itisimportant to check the filter settings when opening the Completed
I nter ventions page because changes to the filter settings tend to persist, even
from one session to another.

— Tofilter the Completed Interventions Listing in adifferent way, perform the
Filter Data Displayed on the Completed I nter ventions Page procedure
(Section 18.5.5.1).

* Single-clicking on alink in the column header row of the table causes table contents
to be sorted on that column.

— For example, clicking on the Worked By link causes the table to be organized
alphabetically by the IDs of the people who worked on the interventionsin the
list.

» Single-clicking on a specific Order ID or Request ID brings up a screen containing
more detailed data concerning that particular order or request.

» Horizontal and vertical scroll bars appear when necessary to allow viewing data that
are not readily visible in the window.
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* To manually update (refresh) the data on the screen, single-click on the Netscape
browser Reload button.

* The Netscape browser Edit — Find in Page menu provides a means of performing a
keyword search of the data currently being displayed on the screen.

* Thefirst, previous, next, and last links provide means of displaying additional pages
of data.

If the desired request with completed intervention is not listed in the Listing table of the
Completed I nterventions page, filter the data.
» For detailed instructions refer to the Filter Data Displayed on the Completed

I nter ventions Page procedure (Section 18.5.5.1).

If request filtering was necessary, return to Step 4.

Single-click on a specific Request ID in the Requests with Completed I nterventions

table of the Request Management page Requests with Completed I nterventions

screen to bring up a screen containing more detailed data concerning that particul ar

request.

» For example, clicking on Request 1D 0400011698 brings up a Completed
Intervention Detail (i.e., Completed Intervention for Request 0400011698) page.

Observe information displayed on the Completed I ntervention Detail (Completed
Intervention for Request x) page.
» Thefollowing items are displayed on the Completed I ntervention Detail page.
- User Id.
- email.
- Priority.
— Order ID.
- Size (est, MB).
- Media.
- Worked by.
- Created.
- Acknowledged.
— Digposition.
— Explanation.
— GranulelList: DBID, ESDT, Granule Type, Size (MB), Status, Explanation.
- OPERATOR NOTES.
» Usethe Netscape browser Back button to redisplay the Completed I nterventions

page.

Return to Step 4 to view information concerning another completed intervention (if
applicable).
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10

11

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?

Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate

button from the following selections:

* OK - todismissthe dialogue box and complete the log-out.

— The dialogue box is dismissed.
— The Netscape browser is dismissed.

» Cancd - to dismiss the dialogue box without logging out.

— The dialogue box is dismissed.
— The OM GUI isdisplayed.

Table 18.5-12. View Completed Intervention Information on the OM GUI - Quick-
Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 Request Management link single-click
3 Completed Interventions link single-click
4 Observe information displayed in the Listing read text

table of the Completed Interventions page
5 Filter requests displayed in the Listing table of Use procedure in Section 18.5.5.1
the Completed Interventions page (if
necessary)
6 Return to Step 4 (if applicable)
7 <Request ID> (Requests with Completed single-click
Interventions table)
8 Observe information displayed on the Completed | read text
Intervention Detail (Completed Intervention
for Request x) page
9 Return to Step 4 to view information concerning
another intervention (if applicable)
10 |Log Out link (when applicable) single-click
11 | OK button (to complete logging out) (when single-click

applicable)
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18.5.5.1 Filter Data Displayed on the Requests with Completed Interventions
Screen

Features at the top of the Completed Interventions page provide the Distribution Technician
(whether full-capability or limited capability operator) with a means of filtering data displayed
on the Completed Interventions page. By default, data concerning up to 50 requests with
completed interventions (and “ completion time” within the last 24 hours) are displayed at atime.

Table 18.5-13 presents (in a condensed format) the steps required to filter data displayed on the
Requests with Completed Interventions screen. If you are aready familiar with the
procedures, you may prefer to use the quick-step table. If you are new to the system, or have not
performed this task recently, you should use the detailed procedures that fol low.

NOTE: The session ID provides a means of tracking which GUI pages are accessed and
what filter options are used during a particular session. Such datais especially
important when several operators are using the OM GUI in the same mode at the
sametime. For example, an individual operator’ s previously selected filter
options can be retrieved from the session data so the filter options do not have to
be reentered every time the same type of search is performed.

NOTE: By default, completed interventions are filtered by “completion time,” providing
access to all interventions completed within the last 24 hours. However, changes
made to the filter settings tend to persist, even from one session to another. To
restore the default filtering criteriasingle-click on the Reset button in the Filter
area near the top of the Completed Interventions page.

NOTE: Completed interventions are not permanently available on the Completed
Interventions page. If filtering does not cause data concerning the desired
intervention(s) to be displayed, check the Delete Complete I nterventions After
parameter to seeif the window of opportunity has already closed. (For detailed
instructions refer to the procedure for Checking/M odifying OM Configuration
Parameters.)

1 If the filters on the Completed | nter ventions page are not visible, single-click on the
Filter link.

» Thefilters are displayed on the Completed | nter ventions page.

2 If interventions “worked by” a particular individual only should be displayed on the
Completed I nterventions page, single-click on the Worked by: option button to display
amenu of individuals then single-click on the desired selection.

* Inadditionto alist of individuals, the Worked by: option button hasan ALL option.

» Selected individual (or “ALL") isdisplayed on the Worked by: option button.

» Filtering by the individual who worked on interventions may be combined with
filtering by “Completion Time” (refer to Step 3).

» If “Completion Time” filtering criteria are not going to be selected, go to Step 4.

18-107 611-EMD-001



3 If the intervention(s) to be viewed has (have) “Completion Time” outside the range
indicated in the Start Month, Start Day, Start Year, Start Hour, Start Minute, End
Month, End Day, End Year, End Hour, and End Minute boxes, as necessary single-
click on each date/time option button to display a drop-down list of month, day, year,
hour, or minute options then single-click on the desired selection.

» Selected number is displayed in each date/time box.

4 When all relevant filtering criteria have been selected (as described in Steps 2 and 3),

single-click on the Apply button.

* The Completed I nterventions page refreshes.

* Only requests that meet the specified filter criteria appear in the Listing table on the
Completed I nterventions page.

5 Return to the View Completed Intervention Information on the OM GUI procedure
(Section 18.5.5).

Table 18.5-13. Filter Data Displayed on the Requests with Completed
Interventions Screen - Quick-Step Procedures
Step What to Enter or Select Action to Take
1 Filter link single-click
2 <individual> (Worked by: option button) (if single-click
applicable)
3 <date/time values> (Start Month, Start Day, single-click
Start Year, Start Hour, and Start Minute option
buttons) (as applicable)
4 <date/time values> (End Month, End Day, End | single-click
Year, End Hour, and End Minute option buttons)
(as applicable)
5 Apply button single-click
6 Return to the View Completed Intervention Use procedure in Section 18.5.5

Information on the OM GUI procedure

18.5.6 View and Respond to Suspended FTP Push Distribution Destinations

The Suspended Destinations page provides the full-capability operator with a means of viewing
suspended FTP push destinations and a means of taking the following kinds of actions with
respect to suspended FTP push destinations:

* Resume suspended destinations.
» Suspend active destinations.
* View details of active or suspended destinations.
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The limited-capability operator can use the Suspended Destinations page to view suspended
FTP push destinations but is not allowed to take action on (e.g., resume) suspended FTP push
destinations.

Table 18.5-14 presents (in a condensed format) the steps required to view and respond to
suspended ftp push distribution destinations. If you are already familiar with the procedures, you
may prefer to use the quick-step table. If you are new to the system, or have not performed this
task recently, you should use the detailed procedures that follow.

1

If it isnot already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
* TheOrder Manager GUI isdisplayed.

If it has not been expanded already, single-click on the FtpPush Monitor link in the
navigation frame of the OM GUI.
* TheFtpPush Monitor menu is expanded.

If the Suspended Destinations page is not already being displayed, single-click on the
Suspended Destinations link in the navigation frame of the OM GUI.
* The Suspended Destinations page is displayed.

Observe information displayed on the Suspended Destinations page.
* The Suspended Destinations page has the following columns:
— Destination Name.
- Host Name.
— Time of Suspension (if applicable, date and time when the destination was
suspended).
— Granules Queued Count (number of granules that are queued).
— GranulesQueued Size MB (total sizein MB of all granules that are queued).
— Suspend Reason (why the destination was suspended).
— Resume (buttons for resuming the destination).
» Horizontal and vertical scroll bars appear when necessary to allow viewing data that
are not readily visible in the window.
* To manualy update (refresh) the data on the screen, single-click on the Netscape
browser Reload button.
» The Netscape browser Edit — Find in Page menu provides a means of performing a
keyword search of the data currently being displayed on the screen.

To resume a suspended destination, single-click on the Resume button in the

destination’ s Resume column.

* Thedestination is resumed.

» The Suspended Destinations page refreshes and the resumed destination is no longer
on the list of suspended destinations.
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10

To start the process of either suspending an active destination or viewing destination
details (for an active or suspended destination), in one of the corresponding text fields
enter:

<Destination Name>
- Or -

<FTP Node>

To suspend an active destination (after making the appropriate entry in either the

Destination Name text field or the FTP Node text field), single-click on the Suspend

button in the Active Destination area.

* Thedestination is suspended.

» The Suspended Destinations page refreshes and the suspended destination is
included in the list of suspended destinations.

* Anadternative isto suspend the active destination from the Destination Details page
—goto Step 8.

To view ftp push requests associated with either an active destination or a suspended
destination (after making the appropriate entry in either the Destination Name text field
or the FTP Node text field), single-click on the View Requests button in the Active
Destination area

* The Destination Details pageis displayed.

- Thefollowing types of data are displayed in the FTP Push Oper ations that
Caused the Suspension area (if applicable): Request Id, ECS Granule Id, DPL
Granule Id, Last Update, Size (MB), Explanation.

— Thefollowing types of data are displayed in the FTP Push Requests That Are Not
In A Terminal State area: Ord Typ/Prc Mod, OrderID, RequestlD, Request Size
(MB), Gran Cnt/FtpPush Complete, Priority, Request Status, Resource Class,
ESDT, UserID, Resub Cnt, Created, Last Update, Actions.

» Torespond to conditionsindicated on the Destination Details page refer to the View
and Respond to Destination Details on the OM GUI procedure (Section 18.5.6.1).

Repeat Steps 4 through 8 as necessary to view and respond to information concerning
suspended FtpPush distribution destinations on the OM GUI.

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?
Thiswill close your browser.” is displayed.
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11 To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:
* OK - todismissthe dialogue box and complete the log-out.
— The dialogue box is dismissed.
— The Netscape browser is dismissed.
» Cancd - to dismiss the dialogue box without logging out.
— The dialogue box is dismissed.
— The OM GUI isdisplayed.

Table 18.5-14. View and Respond to Suspended FTP Push Distribution
Destinations - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 FtpPush Monitor link (if necessary) single-click
3 Suspended Destinations link (if necessary) single-click
4 Observe information displayed on the read text
Suspended Destinations page

5 Resume button (if resuming a suspended single-click
destination)

6 <Destination Name> or <FTP Node> (if enter text

suspending an active destination or viewing
destination details for an active or suspended
destination)

7 Suspend button (in the Active Destination area) | single-click
(if suspending an active destination)

8 View Requests button (in the Active single-click
Destination area) (if applicable)

9 Repeat Steps 4 through 8 (as necessary)

10 |Log Out link (when applicable) single-click
11 | OK button (to complete logging out) (when single-click
applicable)

18.5.6.1 View and Respond to Destination Details on the OM GUI

The Destination Details page (e.g., Ftp Push Monitor — Active Destination Name OTHER)
provides the full-capability operator with a means of viewing detailed data concerning a
particular destination and a means of taking the following kinds of actions:

»  Suspend an active destination.

* Resume a suspended destination.

» Change the priority of adistribution request associated with the FtpPush destination
while granules for the request still need to be staged or while granules for the request
still need to be pushed.
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» Suspend arequest that still needs to be staged or while granules for the request still
need to be pushed.

* Resume arequest that was suspended by the OM GUI operator or while the
processing of new requests by the OMS is suspended.

» Cancel areguest that isnot in aterminal state and while granules for the request still
need to be staged or while granules for the request still need to be pushed.

The limited-capability operator can use the Destinations Detail page to view detailed data
concerning a particular destination but is not allowed to take action on ftp push requests for any
destination.

Table 18.5-15 presents (in a condensed format) the steps required to view and respond to
destination details on the OM GUI. If you are aready familiar with the procedures, you may
prefer to use the quick-step table. If you are new to the system, or have not performed this task
recently, you should use the detailed procedures that follow.

1 If it is not already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
 TheOrder Manager GUI isdisplayed.

2 If the Destination Details page is not already being displayed, perform the View and
Respond to Suspended FTP Push Distribution Destinations procedure
(Section 18.5.6) to display the page.
* TheDestination Details pageis displayed.

3 Observe information displayed on the Active Destinations Detail page.

» Thefollowing types of data are displayed in the FTP Push Operationsthat Caused
the Suspension area (if applicable):
- Request Id.
- ECSGranuleld.
- DPL Granuleld.
— Last Update.
- Size (MB).
- Explanation.

» Thefollowing types of data are displayed in the FTP Push Requests That Are Not
In A Terminal State area:
— Ord Typ/Prc Mod.
- OrderiD.
- RequestID.
- Request Size (MB).
— Gran Cnt/FtpPush Complete.
— Priority.
— Request Status.
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- Resource Class.

- ESDT.

— UselD.

- Resub Cnt.

- Created.

— Last Update.

- Actions.

Single-clicking on alink in the column header row of the table causes table contents

to be sorted on that column.

— For example, clicking on the RequestI D link causes the table to be organized in
numerical order by Request ID.

Single-clicking on a specific Order ID or Request ID brings up a screen containing

more detailed data concerning that particular order or request.

Single-clicking on a specific User ID brings up a screen that shows user profile

information for that user.

The Show rows at a time window provides a means of selecting the maximum

number of rows of data to be displayed at atime.

— For example, if Show rows at atimeis being displayed, selecting 50 from
the option button would result in the display of a page of data containing up to 50
rows of data

Horizontal and vertical scroll bars appear when necessary to allow viewing data that

are not readily visible in the window.

If AutoRefresh is ON, the Distribution Requests page refreshes automatically as

often as specified in the Refresh screen every x minutes window.

- If adifferent refresh option is preferred, perform the Set Refresh Optionson OM
GUI Pages procedure (Section 18.5.2.1).

To manually update (refresh) the data on the screen, single-click on the Reload Page

link.

The Netscape browser Edit — Find in Page menu provides a means of performing a

keyword search of the data currently being displayed on the screen.

Thefirst, previous, next, and last links provide means of displaying additional pages

of data.

The Go directly to row... window provides a means of displaying a page of data

starting with a particular row of the table.

— For example, if Go directly torow of 415 rows is being displayed, typing
315 in the window and clicking on the ok button would result in the display of a
page of data containing rows 315 through 364.

To suspend an active destination (if applicable) single-click on the Suspend Destination
button.

The destination is suspended.
The Suspend Destination button becomes a Resume Destination button.
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To resume a suspended destination, single-click on the Resume Destination button.
* Thedestination is resumed.
* The Resume Destination button becomes a Suspend Destination button.

To change the priority of a particular distribution request (when applicable), perform the
Changethe Priority of a Distribution Request Using the OM GUI procedure
(Section 18.5.3.2).

To either suspend a particular distribution request or resume processing of a suspended
request (when applicable), perform the Suspend, Resume, Cancel, or Resubmit a
Distribution Request Using the OM GUI procedure (Section 18.5.3.3).

To cancel a particular distribution request (when applicable), perform the Suspend,
Resume, Cancel, or Resubmit a Distribution Request Using the OM GUI procedure
(Section 18.5.3.3).

To review and/or respond to an open intervention for a particular distribution request first
single-click on the Open Intervention link in the Request Status column for the request
inthe Listing table.

To review and/or respond to an open intervention go to the procedure View Open
Intervention Information on the OM GUI procedure (Section 18.5.2).

Repeat Steps 3 through 10 as necessary to view and respond to destination details.

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “ Are you sure you want to log out?
Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:

* OK - todismissthe dialogue box and complete the log-out.
— Thedialogue box is dismissed.
— The Netscape browser is dismissed.

» Cance - to dismiss the dialogue box without logging out.
— Thedialogue box is dismissed.
- The OM GUI isdisplayed.
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Table 18.5-15. View and Respond to Destination Details on the OM GUI - Quick-
Step Procedures

Step What to Enter or Select Action to Take

1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1

2 Perform the View and Respond to Suspended | Use procedure in Section 18.5.6
FTP Push Distribution Destinations procedure
(if necessary)

3 Observe information displayed on the Active read text
Destinations Detail page

4 Suspend Destination button (if suspending an single-click
active destination)

5 Resume Destination button (if resuming a single-click
suspended destination)

6 Change the priority of a distribution request Use procedure in Section 18.5.3.2
(when applicable)

7 Suspend a distribution request or resume Use procedure in Section 18.5.3.3
processing of a suspended request (when
applicable)

8 Cancel a distribution request (when applicable) Use procedure in Section 18.5.3.3

9 Open Intervention link (when applicable) single-click

10 | Review and/or respond to an open intervention Use procedure in Section 18.5.2
(when applicable)

11 | Repeat Steps 3 through 10 (as necessary) enter text

12 | Log Out link (when applicable) single-click

13 | OK button (to complete logging out) (when single-click
applicable)

18.5.7 Check/Modify OM Queue Status

The OM Queue Status page provides the full-capability operator with a means of checking and
modifying OM gqueue status. The OM Queue Status page allows the full-capability operator to
monitor and change the current status of request queues for all media as well as the request
gueues for PDS, SDSRV, e-mail, and staging. (The limited-capability operator can monitor but
cannot change the status of queues.) In addition, the OM Queue Status page alows both full-
capability and limited-capability operators to determine the status (“up” or “down”) of the Order
Manager Server.

Table 18.5-16 presents (in a condensed format) the steps required to check and modify OM
Queue status. If you are already familiar with the procedures, you may prefer to use the quick-

step table. If you are new to the system, or have not performed this task recently, you should use
the detailed procedures that follow.
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1 If it isnot already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
* TheOrder Manager GUI isdisplayed.

2 If it has not been expanded already, single-click on the OM Status Pageslink in the
navigation frame of the OM GUI.
 The OM Status Pages menu is expanded.

3 If the OM Queue Status page is not already being displayed, single-click on the OM
Queue Statuslink in the navigation frame of the OM GUI.
* The OM Queue Status pageis displayed.
» If the OM Queue Status page is not displayed within aminute, it islikely that the
OM Server is not operating properly.
— For example, it may have stalled while trying to process requests that it could not
process.
* The OM Queue Status page has the following columns:
- ALL QUEUES.
- PDS.
- SDSRV.
- EMAIL.
- STAGING.

4 Observe information displayed in the Current Request Processing States table.
» Directly under the Current Request Processing States header, one of the following
statements is displayed:
— The OM Server is. UP [indicates that the OM Server is currently operating].
- The OM Server is: DOWN [indicates that the OM Server is not currently
operating].

NOTE: The status of the OM Server is determined by a program called “ Sweeper,” which
makes an attempt to connect with the OM Server. If a connection cannot be
made, it is assumed that the OM Server is down. If Sweeper was not installed
correctly, either the error screen is displayed with a Sweeper error message or the
Sweeper error message is displayed right on the OM Queue Status page itself.
This does not necessarily mean that the OM Server is down.

* The column header line of the Current Request Processing States table includes
codes that indicate the status of the request queues for the following four groupings:
- PDS.
- SDSRV.
- EMAIL.
- STAGING.
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» The code in parentheses next to each entity indicates the corresponding request queue
status, specifically:
- A —Active.
— S—Suspended by server.
— O — Suspended by operator.
— Although rare, if astate is simply not available from the Order Manager Database,

itislisted as ERROR: State not available.

» Theleft-hand column of the Current Request Processing States table includes
codes that indicate the status of the request queues for the following types of queues:
- FtpPull.
- FtpPush.
- CDROM.
- DLT.
- DVD.
- 8MM.
— scp [secure copy distribution].
- Archiveservers.

» Option buttons are available for full-capability operators to change the request queue
states.

» If AutoRefresh isON, the OM Queue Status page refreshes automatically as often
as specified in the Refresh screen every x minutes window.
- If adifferent refresh option is preferred, perform the Set Refresh Optionson OM

GUI Pages procedure (Section 18.5.2.1).

* To manualy update (refresh) the data on the screen, single-click on the Netscape
browser Reload button.

* The Netscape browser Edit — Find in Page menu provides a means of performing a
keyword search of the data currently being displayed on the screen.

If it is necessary to either activate or suspend all request queues (and thereis
authorization to do s0), single-click onthe ALL QUEUES Change State option button
to display amenu of states then single-click on the desired selection.
* Thefollowing states are available:

- Activate All.

— Suspend All.

If it is necessary to change the state of a group of request queues or an individual request
gueue (and there is authorization to do so), single-click on the corresponding Change
State option button to display a menu of states then single-click on the desired selection.
» Thefollowing states are available:

— Activate [or Activate All].

— Suspend [or Suspend All].
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Repeat Step 6 as necessary to indicate a change of state for additional request queues.

If applicable, when the appropriate settings have been made on the Change State option
buttons, single-click on the appropriate button from the following selections:
* Apply - to apply the modification of statesto the queues.
- An OM Queue Status Change Confirmation dialogue box is displayed.
* Reset - to change the states displayed on all request queue Change State option
buttons back to Change State.
— The states displayed on all request queue Change State option buttons change
back to Change State.

If an OM Queue Status Change Confirmation dialogue box is displayed, single-click
on the appropriate button from the following selections:
* OK - to apply the modification of states to the queues and dismiss the dialogue box.
— The specified modification(s) of state(s) is (are) applied to the queue(s).
— The dialogue box is dismissed.
— The OM Queue Status page refreshes and displays the modified state(s).
» Cance - to cancel the specified modification(s) of state(s) to the queue(s) and dismiss
the dialogue box.
— No changes are made to the states of the queues.
— The dialogue box is dismissed.

To check staging status perform the Check Staging Status procedure (Section 18.5.8).

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “Are you sure you want to log out?
Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:
* OK - todismissthe dialogue box and complete the log-out.
— The dialogue box is dismissed.
— The Netscape browser is dismissed.
» Cancd - to dismiss the dialogue box without logging out.
— The dialogue box is dismissed.
— The OM GUI isdisplayed.
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Table 18.5-16. Check OM Queue Status - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 OM Status Pages link single-click
3 OM Queue Status link single-click
4 Observe information displayed in the Current read text

Request Processing States table

5 <state> (ALL QUEUES Change State option single-click
button) (if applicable)

6 <state> (Change State option button) (if single-click
applicable)
7 Repeat Step 6 (if applicable)
8 Apply button (if applicable) single-click
9 OK button (if applicable)
10 | Check staging status (if applicable) Use procedure in Section 18.5.8
11 | Log Out link (when applicable) single-click
12 | OK bhutton (to complete logging out) (when single-click
applicable)

18.5.7.1 Check Staging Status

The two Staging Status pages provide the Distribution Technician (whether full-capability or
limited capability operator) with means of checking staging status in either of two ways; i.e.,
by....

* MediaType.

* FTP Push Destination.

The Staging Status pages allow the Distribution Technician to monitor the number of granules
and data volume currently in staging. The staging information is arranged in the following four
categories:

» Granuleswaiting for staging.

* Granulesin staging.

» Granulesthat have been staged but not yet shipped.

» Granulesthat have been staged and shipped.

In addition to the preceding granule information, the data low and high water marks are shown
on the Staging Status pages:

* DHWM —The Data High Water Mark is the maximum volume of datain staging or
already staged but not yet shipped. If the data volume and number of requestsis
above the DHWM, it is assumed the media devices have plenty of work to keep them

busy.
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* DLWM —The DataLow Water Mark is the minimum volume of data that should be
In staging or aready staged but not yet shipped. If the data volumeis below the
DLWM, the media devices may soon becomeidle.

In general it is a good idea to keep the amount of work that isin staging or staged just below the
high water mark of each output queue. This achieves a good balance among ftp output
connections (or in the case of physical media, their various output devices).

The data high water marks can be exceeded in the interest of optimizing the use of the archive
drives or to get high priority work through distribution quickly. For example, an idle archive
would be dispatched even if it means exceeding the DHWM.

The DLWM is used mainly for dispatching high-priority work. Since it is a good idea to keep
the queues at their high water marks, generally the output queues should be fairly full. Asa
result, a high-priority request might have to wait until some of the data gets worked off and the
queue falls below that high water mark. But high-priority requests should go through at a fast
pace.

Table 18.5-17 presents (in a condensed format) the steps required to check staging status. If you
are aready familiar with the procedures, you may prefer to use the quick-step table. If you are
new to the system, or have not performed this task recently, you should use the detailed
procedures that follow.

1 If it isnot already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
* TheOrder Manager GUI isdisplayed.

2 If it has not been expanded already, single-click on the OM Status Pageslink in the
navigation frame of the OM GUI.
 TheOM Status Pages menu is expanded.

3 If the OM Queue Status page is not already being displayed, single-click on the OM
Queue Statuslink in the navigation frame of the OM GUI.
 The OM Queue Status page is displayed.

4 To display staging status by mediatype, single-click on the Media Typelink in the
navigation frame of the OM GUI.
* The Staging Status by Media Type page is displayed.

5 To display staging status by FtpPush destination, single-click on the FTP Push

Destination link in the navigation frame of the OM GUI.
* The Staging Status by FTP Push Destination pageis displayed.
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Observe information displayed in the table on the Staging Status page.

Each Staging Status page (i.e., by Media Type or by FTP Push Destination) has

the following columns:

— [Media or FtpPush destinations (as applicable)].

- DHWM.

- DLWM.

— Waiting for Staging [granule count and volume in MB].

- In Staging [granule count and volume in MB].

— Staged and NOT Shipped [granule count and volume in MB].

— Staged, Shipped & In DPL [granule count and volumein MB].

Whenever thereis little question mark next to a button or text field (e.g., System

Totals), clicking on the question mark opens a dialogue box that describes the item.

- The“HelpOnDemand” feature provides context-sensitive help for each page,
particularly for controls or parameters that may not be entirely self-descriptive.

Horizontal and vertical scroll bars appear when necessary to allow viewing data that

are not readily visible in the window.

If AutoRefresh is ON, the Staging Status by Media Type or Staging Status by

FTP Push Destination page refreshes automatically as often as specified in the

Refresh screen every x minutes window.

— If adifferent refresh option is preferred, perform the Set Refresh Optionson OM
GUI Pages procedure (Section 18.5.2.1).

To manually update (refresh) the data on the screen, single-click on the Reload link.

The Netscape browser Edit — Find in Page menu provides a means of performing a

keyword search of the data currently being displayed on the screen.

Repeat Steps 4 through 6 as necessary to view staging status.

To check or modify OM queue status return to the Check/M odify OM Queue Status
procedure (Section 18.5.7).

To start the process of logging out (if applicable) single-click on the Log Out link in the
navigation frame of the OM GUI.

A log-out dialogue box containing the message “Are you sure you want to log out?
Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:

OK - to dismiss the dialogue box and compl ete the log-out.
— Thedialogue box is dismissed.

— The Netscape browser is dismissed.

Cancd - to dismiss the dialogue box without logging out.
— Thedialogue box is dismissed.
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- The OM GUI isdisplayed.

Table 18.5-17. Check Staging Status - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 OM Status Pages link single-click
3 OM Queue Status link single-click
4 Media Type link (if applicable) single-click
5 FTP Push Destination link (if applicable) single-click
6 Observe information displayed in the table on the |read text

Staging Status page

7 Repeat Steps 4 through 6 as necessary
8 Check/modify OM queue status (if necessary) Use procedure in Section 18.5.7
9 Log Out link (when applicable) single-click
10 | OK button (to complete logging out) (when single-click
applicable)

18.5.8 Check/Modify Aging Parameters

The OM Configuration pages provide the full-capability operator with a means of checking and
modifying (if necessary) the values assigned to the following types of OM configuration
parameters:

* Aging Parameters.

e OM Server Parameters.

« OM Database Parameters.
* MediaParameters.

e FTP Push Padlicy.

The limited-capability operator can use the OM Configuration page to view the values assigned
to OM configuration parameters but is not allowed to change any parameters.

The Aging Parameter s page provides the full-capability operator with a means of checking and
modifying aging parameters. The limited-capability operator can check but is not allowed to
change any aging parameters.

Aging parameters affect how Distribution Requests are aged over time. The following two aging
parameters are configurable for each ECS Priority Level (i.e., XPRESS, VHIGH, HIGH,
NORMAL, or LOW):

* Age Step.

Maximum Priority.
Age Step is the aging rate by which the effective priority of aregquest increases for every hour it
has been waiting. The range is 0-100, including decimal fractions. If the parameter is set to zero
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(0), waiting requests never increase in priority. For example, if the Age Stepissetto 5.5 and a
request with an initial priority of 100 waits 10 hours to be pushed, the request increases in
priority by afactor of 5.5 every hour until it has been delivered:

Hour O: priority = 100
Hour 1. priority = 105.5

Hour 2: priority = 111

Hour 10: priority = 155

Maximum Priority isthe maximum priority a request can attain through the aging process. For
example, if Maximum Priority were set to 130, once the request had reached a priority of 130, it
would not go any higher [eg., if a Maximum Priority of 130 were applied to the previous
example, at Hour 6 the priority would become 130 and at every hour thereafter (if not delivered)
it would still be 130].

Table 18.5-18 presents (in a condensed format) the steps required to check/modify aging
parameters. If you are already familiar with the procedures, you may prefer to use the quick-step
table. If you are new to the system, or have not performed this task recently, you should use the
detailed procedures that follow.

1 If it isnot already being displayed, launch the Order Manager GUI (refer to
Section 18.5.1).
* TheOrder Manager GUI isdisplayed.

2 If it has not been expanded already, single-click on the OM Configuration link in the
navigation frame of the OM GUI.
* TheOM Configuration menu is expanded.

3 If the Aging Parameter s page is not aready being displayed, single-click on the Aging
Parameterslink in the navigation frame of the OM GUI.
* TheAging Parameters pageis displayed.

4 Observe information displayed in the table on the Aging Parameter s page.

* Thetableisdivided into sections for the various distribution request priorities (e.g.,
XPRESS) and within each section there are rows that indicate the identity and value
of each of the following parameters associated with the priority:

- Age Step.
- Maximum Priority.
— Starting Priority (cannot be changed).
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*  Whenever thereislittle question mark next to a button or text field (e.g., Age Step),
single-clicking on the question mark opens a dialogue box that describes the item.
- The“HelpOnDemand” feature provides context-sensitive help for each page,

particularly for controls or parameters that may not be entirely self-descriptive.

» The Netscape browser Reload button can be used to update the data on (refresh) the
screen.

* The Netscape browser Edit — Find in Page menu provides a means of performing a
keyword search of the data currently being displayed on the screen.

If aging parameter value(s) is (are) to be modified (and there is authorization to do so), in
the text entry box(es) for the relevant parameter(s) enter.

<value>

If aging parameter value(s) is (are) to be modified, single-click on the appropriate button
from the following selections:
* Apply - to apply the new value(s) to the parameter(s).
— Thenew value(s) is (are) applied to the parameter(s).
* Reset - to clear the new value(s) from the text entry box(es) without changing the
current value(s).
— Theoriginal value(s) is (are) retained.

To start the process of logging out (if applicable) single-click on the Log Out link in the

navigation frame of the OM GUI.

* A log-out dialogue box containing the message “ Are you sure you want to log out?
Thiswill close your browser.” is displayed.

To complete the process of logging out (when applicable) single-click on the appropriate
button from the following selections:
* OK - todismissthe dialogue box and complete the log-out.
— The dialogue box is dismissed.
— The Netscape browser is dismissed.
» Cancd - to dismiss the dialogue box without logging out.
— The dialogue box is dismissed.
- The OM GUI isdisplayed.
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Table 18.5-18. Check/Modify Aging Parameters - Quick-Step Procedures

Step What to Enter or Select Action to Take
1 Launch the Order Manager GUI (if necessary) Use procedure in Section 18.5.1
2 OM Configuration link single-click
3 Aging Parameters link single-click
4 Observe information displayed in the table on the |read text

Aging Parameters page

5 <value> [in the text entry box(es) for the relevant | enter text
parameter(s)] (if applicable)

6 Apply button (to implement changes) (if read text
applicable)

7 Log Out link (when applicable) single-click

8 OK button (to complete logging out) (when single-click
applicable)

18.5.9 Check/Modify OMS Server or Database Parameters

The OMS Server and Database Configuration page provides the full-capability operator with
ameans of checking and modifying OMS server or database parameters. The limited-capability
operator can check but is not allowed to change any OMS server or database parameters.

OMS server and database parameters affect how the OM server and database run. The
parameters are dynamically loaded from the OMS database into the configuration pages on the
OM GUI. If aconfiguration parameter is added to the database, it is subsequentl